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Figure 478 Checking Account Administrator User Email

Create Account in Account Service
Clicking the link prompts the user to create a new Account or use an existing Account.

Note

If a user already has an Account in the Account Service, they can use their existing email login to
accept the invite for the new Account. In the global cnMaestro UI, switching between accounts is
accomplished using the choice box in the UI header (upper right).

Login to the Accounts UI
Once the Account Administrator (User) is created, use the URL listed in the Login Path column to login.



Figure 479 A Sample Login URL

Managed Account Administration

Overview
Once Managed Accounts are enabled, there are three ways to administrator the Accounts.

l System View

l Account View

l Account Administrator (User) View

Important Points to Remember
Please note the following points for Account Services administration:

Note

l When a device is moved from one Account to other, it goes offline for one minute before
appearing online. Only active alarms are moved to the new account and other data is retained in
the old account.

l The Managed Accounts feature can be disabled only if all devices in Accounts are deleted or
moved to Base Infrastructure account.

l Administrators of Accounts do not have access to the settings page of the server to change the
account type.

l When Global Super Administrators trigger Configure/Software/Reports Jobs, the Account users
cannot view them.

l When Account Users trigger Configure/Software/Reports Jobs, they are reflected under the
Global Super Administrator view along with respective Job IDs enrolled in the respective
Accounts.

l The devices that have not started Software/Configure Jobs cannot be moved across Accounts.

l The Global Super Administrator and the Account Administrator cannot trigger a Software or
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Configure Job simultaneously on the same device.

l The Lock AP configuration can be enabled only by the Global Super Administrator. But whenever
a device configuration is changed outside of cnMaestro by either a Global Super Administrator or
an Accounts Administrator, the Auto Synchronization Job starts automatically with the
configuration job ID as in Accounts and reflects in both the Global Super Administrator and
Accounts Administrator accounts.

System View
At the System level, one can view APs, AP Groups, or Sites across all Managed Accounts in a single, unified table.
This allows one to review the status of all accounts in context to each another. The following figure displays the
AP table, and specifies which APs are mapped to Accounts.

Figure 480 System View

Account View
The Managed Accounts > Accounts page allows you to select individual Accounts, which launches the Account
View. This provides full status and configuration for all components of the Account, including Dashboard,
Notifications, Configuration, Software Update, Reports, Clients, etc.

Figure 481 Account View

Account Administrator (User) View
The Account Administrator View presents the branded Account UI, without having to explicitly log into it. It is
accessed through the Account drop-down in the UI header. Selecting a specific Account (rather than All) updates
the UI to the Account Administrator's view. From here, the Global Administrator can update the configuration and
monitor issues.



Figure 482 Managed Account Administrator (User) View

System Dashboard
The System Dashboard integrates Accounts into the global health component. It ranks the top Accounts based
upon device count.

Figure 483 System Dashboard
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Account Administration
AP Groups, WLANs, and Switch Groups have three types of accessibility scope as shown below:

State Description
Base Infrastructure The object is only available for the global account.
Managed Account The object belongs to a Managed Account.
Shared The object is shared among all Managed Accounts. It can be mapped to devices in the

Account, but it cannot be modified. To change the configuration, it needs to be copied
into the Account and then updated.

Table 107 Types of Scope

Note

Once the scope has been configured on an object, it cannot be changed.

Device Management
Devices are added at the global System level or within Managed Accounts. Devices added at the System level can
be moved into Accounts at a later time.

System Onboarding
Onboarding at the global System level supports both MSN and Cambium ID. In the example below, a Management
Account can be selected for all devices onboarded in the MSN batch.

Figure 484 System Onboarding

Device Onboarding
Onboarding devices through the Managed Account UI automatically places the devices in the Account.

Note

cnMaestro supports onboarding through either MSN or Cambium ID. Within Accounts, only MSN
onboarding is supported.

Moving a Device Between Accounts
You can move a device from one Managed Account to another by using the Change option in the device
configuration page.



Figure 485 Moving a Device Between Accounts

In Enterprise view, the device can be moved between Accounts using the Managed Account ( ) icon in the
AP Groups > <AP-group-name> > Devices > List tab.

Figure 486 Moving a device between Accounts in Enterprise View

Account Deletion
Note

All devices must be removed from the Account before deleting the account.

To delete a Managed Account, navigate to the Account Services page and click the delete icon.

Figure 487 Account Deletion
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Disabling the Managed Accounts feature
The Managed Accounts feature can be disabled within the system only after all the devices are deleted or moved
to the Global context. By disabling Account Services, the Account field will be disabled across all the tables, such
as Clients, Notifications, Inventory.

Managing subscribers (end-customer)
To enable a subscriber to manage the router using the Android or iOS application, you must add a subscriber
profile in cnMaestro and send an invitation to the subscriber.

This pocess involves the following actions:

1. Adding a Subscriber Service Profile

2. Adding a subscriber

a. Modifying the owner details for the Subscriber App

3. Claiming the Home Mesh Router

Adding a Subscriber Service Profile
To add a subscriber service profile, complete the following steps:

1. Navigate to the Manage Services > Managed Subscribers > Subscriber Service Profiles tab.

The Subscriber Service Profiles page appears.

2. Click Add New.

The Add Subscriber Service Profile window appears.



3. Select the Home Mesh Router configuration to which you want to associate with the subscriber service profile
and configure the parameters as described in Table 108.

Table 108 Subscriber Service Profile parameters

Parameter Description
Name Name of the subscriber service profile.
Description Brief description for the subscriber service profile.
Download (Mbps) Download speed (in Mbps) configured for the profile.
Upload (Mbps) Upload speed (in Mbps) configured for the profile.
Type Displays the device type as RV22 Home Mesh.

This field cannot be modified.
Device
Configuration

Specifies the Wi-Fi AP group (created for the Home Mesh Router device type) that
must be associated with the service profile.

Select the group from the drop-down list.
Subscriber App
Branding

Specifies the cnMaestro Subscriber application branding that must be used in this
profile.

All routers sent to subscribers in this service profile contain the selected branding logo
and information.

Select the required branding from the drop-down list.

If no branding is present, create one by clicking the add ( ) icon. See cnMaestro
Subscriber application branding for more information.

4. Click Save.
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Adding a subscriber
5. Click the Subscribers tab on the Managed Subscribers page.

6. Click Add New.

The Add Subscriber window appears.

7. In the Add Subscriber window, configure the details of the subscriber in the Basic Information section, as
described in Table 109.

Table 109 Subscriber > Basic tab parameters

Parameter Description
Full Name Name of the subscriber.
Email ID Email address of the subscriber.

This email address receives the invitation to join the Home Mesh Router (RV22) site.
Through this email address the user will be able to access and manage the router as a
primary user and invite other users (secondary users), through the mobile application,
to manage the routers.

Note

You can edit this email address at anytime. However, editing this email
address will remove all existing users, both primary and secondary. For
information about how to modify the email ID, refer to Modifying the
owner details for the Subscriber App.



Parameter Description
Phone Number Phone number of the subscriber.
Customer ID Unique ID for the subscriber.
Address Address of the subscriber where the routers will be installed.

8. Click Next.

The Service Configuration tab is displayed.

9. Select the subscriber service profile to be associated with this subscriber from the Service Profile drop-down
list.

10. Click Save.

A new tab, Devices appears, where you can link (or claim) the Home Mesh Router to the subscriber. See
Claiming the Home Mesh Router.

The cnMaestro Subscriber application invitation email is sent to the subscriber with the link to join the account.

11. Click Devices.

12. Select one of the following options in the Deployment Type field to filter the available deployment types:
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l Fiber—Select the Optical Network Unit (ONU) device that you want to associate with the subscriber's
router by searching in the ONU search box.

l Fixed Wireless—Select the Subscriber Module (SM) device that you want to associate with the
subscriber's router by searching in the SM search box.

l Home Site—Select the home site you want to associate with the subscriber's router by searching in the
Home Site search box. To add a home site, see Adding a Home Site.

13. Before linking the Home Mesh Router to the subscriber, click Save.

Modifying the owner details for the Subscriber App
You can modify the owner details for the Subscriber App by modifying the email ID.

Warning

Modifying the email address will remove all existing users, both primary and secondary.

To modify the email address, complete the following steps:

1. Navigate to the Manage Services > Managed Subscribers > Subscribers tab.

2. In the list of subscribers, click the subscriber name for which you want to modify the email ID.

The corresponding subscriber details are displayed.

3. Under the Email parameter, click Change Owner.

The Change Owner window is displayed.

4. Enter the new email ID for the subscriber.

5. Click Update.



Claiming the Home Mesh Router
After adding a subscriber profile and a subscriber, you must now associate the Home Mesh Router to the
subscriber by claiming the router in cnMaestro.

To claim the router, complete the following steps:

1. Navigate to the Manage Services > Managed Subscribers > Subscribers tab.

2. In the list of subscribers, select the subscriber name for which you want to associate the Home Mesh Router.

3. Click the Devices tab.

4. In the Add Devices to Subscriber section, click Add New.

The Link Subscriber window appears.

5. In the Link Subscriber window, link the Home Mesh Router to the subscriber by using any of the following
methods:

l To claim a new router that is not onboarded to cnMaestro, select the Claim new and assign option and
enter the serial number of the device to be claimed.

You can claim multiple routers by adding multiple serial numbers separated by commas.
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l To claim a router that is already onboarded to cnMaestro, select the Search for inventory and assign
option.

Enter the details of the router you want to claim.

6. Click Assign.

The assigned router appears in the Add Devices to Subscriber section.

Note

Click the unlink ( ) icon to unlink the router from the subscriber.



Network Services
This section includes the following topics:

l API Client

l RESTful API

l Guest Access

l EasyPass

l RADIUS Proxy

l CBRS

l Organization

l LTE

l Managing Edge Controller

l cnArcher Summary

l Spectrum Analyzer
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API Client

Overview
The cnMaestro RESTful API allows customers to manage their deployment programmatically using their own client
applications. The API is supported over HTTPS, and messages are exchanged in JSON format. Modern
programming languages have rich support for RESTful interfaces.

Note

cnMaestro currently provides monitoring data over the API (such as inventory, statistics,
events, and alarms).

API Clients
API Clients are external applications that access the RESTful API over HTTPS using OAuth 2.0 Authentication. They
require a Client ID and Client Secret for access, both of which are detailed later in this chapter. For more
information, refer to RESTful API Specification.

To add API Client:

1. Navigate to Network Services > API Clients.

2. Click Add API Client.

3. Enter Name.
4. Enter Description.
5. Enter Expiration Time.
6. Enter Token Renewal Time.
7. Click Save.
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Once the API Clients is added you can able to view or download credentials shown in the OAuth 2.0 Access
Credentials.

RESTful API Specification

Authentication
API Authentication uses OAuth2. The client retrieves an Access Token to start the session. It then sends API
requests until the Access Token times out, at which point the token can be regenerated.

Establish a Session
A session is created by sending the Client ID and Client Secret to the cnMaestro server. These are generated in the
cnMaestro UI and stored within the application. The Client ID defines the cnMaestro account and application, and
the Client Secret is a private string mapped to the specific application. The Client Secret should be stored securely.



If the session is established successfully, an Access Token is returned along with an expiration string. The Access
Token is used to authenticate the session. The expiration is the interval, in seconds, in which the Access Token
remains valid. If the Access Token expires, a new session needs to be created.

API Access
The application sends the Access Token, in every API call. The token is sent in an Authentication header. Details
are provided later in this document.

Session Expiration
If a token expires, an expiration error message is returned to the client. The client can then generate a new token
using the Client ID and Client Secret. The token expires immediately if the Client API account is deleted. The
default expiration time for a token is 3600 seconds (1 hour). The session expiration is configurable in the UI.

Rate Limiter
The Rate Limiter API request helps in improving the availability of API based services by avoiding resource
starvation.

This API calculates the rate limit per customer based on various factors such as system configuration, number of
devices onboarded, Network, Towers, Sites, etc.

The API limits the number of NBI API calls to a single cnMaestro account per minute. Once the limit is reached, the
API receives a standard HTTP Response Status code such as 429 or 503.

HTTP
Response
Status
Code

Response
Headers

Explanation Action to be taken

429 RateLimit-
Limit: 10

Number of API calls
allowed for the
cnMaestro account per
minute

If the RateLimit-Remaining value is 0, then the client
application waits for the number of seconds to Reset-
RateLimit before sending the next subsequent API
requests

RateLimit-
Remaining:
0

Number of remaining
API calls for the current
minute is zero

RateLimit-
Reset: 35

Number of seconds
remaining to reset the
rate limit

503 Retry-After Number of seconds
during which users
wait before retrying

If the value of Retry-After is greater than 0, then the client
application waits for the number of seconds to Retry-After
before sending the next subsequent API requests

The following table below displays the approximate limit calculated by the system on a 4 vCPU, 8 GB RAM Cloud
instance.

Devices GET POST/Others
101 10 3
501 24 3
1001 47 5
2001 92 10
4001 163 17
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Example of a Python client:

import sys

import requests

import json

import base64

import time

HOST = # host here

CLIENT_ID = # client id here

CLIENT_SECRET = # client secret here

TOKEN_URL = # token url here

# Retrieve access parameters (url, access_token, and expires_in).

def get_access_parameters(token_url, client_id, client_secret):

    """

    Authenticates to API.

    Parameters:

        `token_url` - Endpoint to authenticate to\n

        `client_id` – Auth client id\n

        `client_secret` – Auth client secret\n

    Returns:

        `(access_token, expiry)`

    """

    data = "%s:%s" % (client_id, client_secret)

    encoded_credentials = base64.b64encode(data.encode('ascii')).decode('ascii')

    headers = {

      "Authorization":"Basic %s" % encoded_credentials,

      "Content-Type":"application/x-www-form-urlencoded"

    }

    body = "grant_type=client_credentials"

    r = requests.post(token_url, body, headers=headers, verify=False)

    print ("Status Code: %s" % r.status_code)

    return r.json()['access_token'], r.json()['expires_in']

def call_api(method, host, path, access_token):

    """



    Makes HTTP call to an API with given method.

    Parameters:

        `method` -
 method for the new Request object: GET, OPTIONS, HEAD, POST, PUT, PATCH, or DELE
TE\n

        `host` – host for the url\n

        `path` – path for the url\n

        `access_token` – a valid access token for header

    Returns:

        `(response_status_code, headers, body)`

    """

    api_url = "https://%s%s" % (host, path)

    headers = {

      "Authorization":"Bearer %s" % access_token,

    }

    response = requests.request(method=method, url=api_
url, headers=headers, verify=False)

    headers = response.headers

    body = response.json()

    response_status_code = int(response.status_code)

    return response_status_code, headers, body

def main():

    try:

        # Getting the access token using client id and client secret

        access_token, expires_in = get_access_parameters(TOKEN_URL, CLIENT_
ID, CLIENT_SECRET)

        # For the purpose of the example, let's send 100 requests back to back

        for i in range(100):

            # Calling the endpoint with GET method

            status_code, header, body = call_api
('GET', HOST, '/api/v2/devices/statistics', access_token)

            # identifying any client or server side error codes

            client_errors = (status_code - status_code%100) == 400

            server_errors = (status_code - status_code%100) == 500
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            # handling error status code

            if client_errors or server_
errors: # check for all 400 and 500 responses

                print("Failure: [%s]-[%s]" %(status_code, (json.dumps
(body, indent=2))))

                # For 429, wait until `RateLimit-Reset` seconds 

                if (status_code == 429):

                    sleep_time = 10 # default wait time

                    # try block prevents any dict value exception

                    try:

                        # Reading the header

                        sleep_time = int(header["RateLimit-Reset"])

                    except: pass

                    # if sleep_
time is not greater than 0, defaulting to 10 seconds

                    sleep_time = sleep_time if sleep_time > 0 else 10

                    print("Sleeping for %d seconds" % sleep_time)

                    # sleeping the main thread

                    time.sleep(sleep_time)

                if (status_code == 503):

                    sleep_time = 10 # default wait time

                    # try block prevents any dict value exception

                    try:

                        # Reading the header

                        sleep_time = int(header["Retry-After"])

                    except: pass

                    # if sleep_
time is not greater than 0, defaulting to 10 seconds

                    sleep_time = sleep_time if sleep_time > 0 else 10

                    print("Sleeping for %d seconds" % sleep_time)

                    # sleeping the main thread

                    time.sleep(sleep_time)

            else:

                # process response

                print("Success: [%s]" %(json.dumps(body, indent=2)))

    except Exception as E:



        print("Failure: [%s]"%E)

        sys.exit()

if __name__ == "__main__":

    main()

Swagger API

Introduction
The RESTful API documentation is supported through Swagger, which allows visualization and interaction with the
API resources.

To access Swagger, perform the following steps:

1. Navigate to Services > API Client grid.

2. Click Swagger API documentation.

Sample Swagger UI

Generating Client ID and Client Secret

cnMaestro User Interface
To create the Client Id and Client Secret in the cnMaestro UI, perform the following steps:

1. Navigate to Services > API Client.
Each client application should be added as an API Client.
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2. Click Add APIClient to add a client.
Add API Client window pops up.

3. Enter Name and Description.
4. Click Save.

Download the Client ID and Client Secret
You can download and store the Client ID and Client Secret by clicking Download Credentials. The Client Id is
required to create an API session.

API Session

Introduction
The cnMaestro API leverages the Client Credentials section of the OAuth 2.0 Authorization Framework (RFC 6749).
An API session can be created using any modern programming language. The examples below highlight how
messages are encoded and responses returned.



Retrieve Access Token
Access Token Request (RFC 6749, section 4.4.2)
To generate a session, the client should retrieve an Access Token from cnMaestro. This is done by base64
encoding the Client_ID and Client_Secret downloaded from the cnMaestro UI and sending them to the cnMaestro
server. The Authorization header is created by base64 encoding these fields as defined below.

Note

The fields are separated by a colon (:).

Authorization: Basic BASE64(<client_id>:<client_password>)

In the body of the POST the parameter grant_type must be set to client_credentials.

POST /api/v2/access/token HTTP/1.1
Host: server.example.com
Authorization: Basic czZCaGRSa3F0MzpnWDFmQmF0M2JW
Content-Type: application/x-www-form-urlencoded

grant_type=client_credentials

Alternatively, the credentials can be passed within the body of the POST without using the Authorization header.

POST /api/v2/access/token HTTP/1.1
Host: server.example.com
Content-Type: application/x-www-form-urlencoded

grant_type=client_credentials&client_id=s6BhdRkqt3&client_secret=7Fjfp0ZBr1KtDRbnfVdmIw

Access Token Response (RFC 6749, section 4.4.3)
The response returned from cnMaestro includes the Access_Token that should be used in subsequent requests.
The expires_in field defines how many seconds the token is valid.

HTTP/1.1 200 OK
Content-Type: application/json;charset=UTF-8
Cache-Control: no-store
Pragma: no-cache
{
"access_token":"2YotnFZFEjr1zCsicMWpAA",
"token_type":"bearer",
"expires_in":3600

}

Sample 200 response body.

HTTP/1.1 200 OK
Content-Type: application/json;charset=UTF-8
Cache-Control: no-store
Pragma: no-cache
{
"access_token": "290eeaba71d3f4885405eac2fd18a4f3c300448d",
"expires_in": 3600,
"token_type": "bearer",
"redirect_uri": https://10.110.241.252

}
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Note

The returned redirect_uri should be used to generate the session.

Error Response (RFC 6749, section 5.2)
If there is an error, an HTTP 400 (Bad Request) error code is returned along with one of the following error
messages as shown below:

Table 110 Error Responce

Message Details
invalid_request Required parameter is missing from the request.
invalid_client Client authentication failed.
unauthorized_client The client is not authorized to use the grant type sent.
unsupported_grant_type The grant type is not supported.

An example error response is below:

HTTP/1.1 400 Bad Request
Content-Type: application/json;charset=UTF-8
Cache-Control: no-store
Pragma: no-cache
{

"error": "invalid_request"
}

Access Resources
When the Access_Token is retrieved, API requests are sent to cnMaestro server using the format below. The
Access_Token is sent within the HTTP Authorization header.

GET /api/v2/devices
Accept: application/json
Authorization: Bearer ACCESS_TOKEN

API Details

HTTP Protocol
HTTP Response codes
Table 111 lists the response codes that are supported in cnMaestro and may be returned through the HTTP
protocol.

Table 111 HTTP Response codes returned

Code Description Use in cnMaestro
200 OK Standard response for successful HTTP requests.
400 Bad Request Status field in request validation related errors.
401 Unauthorized User tried to access a resource without authentication.
403 Forbidden An authenticated user tries to access a non-permitted resource.



Code Description Use in cnMaestro
404 Not Found Server could not locate the requested resource.
405 Method Not Allowed A method (GET, PUT, POST) is not supported for the resource.
413 Payload Too Large The request is larger than the server is willing to handle
422 Unprocessable Entity The server understands the request but cannot process it.
429 Too Many Requests The client has sent too many requests in a given interval.
431 Request Header Fields Too Large The header fields are too large to be processed.
500 Internal Server Error A server-side error happened during processing the request.
501 Not Implemented The request method is not recognized.
502 Bad Gateway Internal server error that may require a reboot.
503 Service Unavailable Internal server error that may require a reboot.

HTTP Response codes
Table 112 lists the HTTP request codes supported in cnMaestro.

Table 112 Request Headers

Header Details
Accept Set to application/json
Authorization Used in every API request to send the Access Token. Example: Authorization: Bearer <Access-

Token>
Content-Type Set to application/json

REST Protocol
Resource URLs
The format for cnMaestro path and parameters are the following:

Access a collection of resources:

/api/{version}/{resource}?{parameter}={value}&{parameter}={value}

Access a single resource:

/api/{version}/{resource}/{resource_id}?{parameter}={value}&{parameter}={value}

Access a sub-resource on a collection (this is also possible on single resources):

/api/{version}/{resource}/{sub-resource}?{parameter}={value}&{parameter}={value}

For example – read the statistics for MAC, Type, and IP on all devices:

/api/v2/devices/statistics?fields=mac,type,ip_wan

Version
The version is equal to v2 in this release.

Resource
Resources are the basic objects in the system. Examples include:
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Table 113 Resource

Context Details
alarms Current active alarms.
alarms/history Historical alarms, including active alarms.
devices Devices, including ePMP, PMP, and WiFi.
events Historical events.
msp MSP managed services.
networks Configured networks.
sites Configured WiFi sites.
towers Configured Fixed Wireless towers.

Sub-Resources
Sub-Resources apply to top-level resources. They provide a different view of the resource data, or a filtered
collection based upon the resource. Examples include:

Table 114 Sub-Resources

Context Details
alarms Alarms mapped to the top-level resource.
alarms/history Historical alarms mapped to the top-level resource.
clients Wireless LAN clients mapped to the top-level resource.
devices Devices mapped to the top-level resource.
events Events mapped to the top-level resource.
mesh/peers Wireless LAN mesh peers mapped to the top-level resource.
operations Operations available to the top-level resource
performance Performance data for the top-level resource.
statistics Statistics for the top-level resource.

Responses

Successful Response
In a successful HTTP 200 response, data is returned using the following structure. The payload is presented in
JSON format.

The request URL is:
/api/v2/devices?fields=mac,type&limit=5

Response:

{
"paging": {
"offset": 0,
"limit": 5,
"total": 540

},
"data": [
{

"mac": "C1:00:0C:00:00:21",
"type": "wifi-home"



},
{

"mac": "C1:00:0C:00:00:18",
"type": "wifi-home"

},
{

"mac": "C1:00:0C:00:00:12",
"type": "wifi-home"

},
{

"mac": "C1:00:0C:00:00:15",
"type": "wifi-home"

},
{

"mac": "C1:00:0C:00:00:06",
"type": "wifi-home"

}
]

}

Error Response
Error Responses return a message and an error cause.

{
"error": {
"message": "Missing required property: stop_time \n Missing required property:

start_time",
"cause": "InvalidInputError"

}
}

Parameters
Most APIs can filter the data and limit the number of entries returned. The parameter options are listed below. The
specific fields and the appropriate values vary for each API.

Field selection
Field selection is supported through the optional Fields parameter, which can specify the data to return from the
server. If this parameter is missing, all available fields will be returned.

Table 115 Fields

Parameter Details
fields Define exactly what fields should be returned in a request. The names are provided as a comma-

separated list.

Fields can limit which JSON parameters are returned as shown below:

Example: To retrieve name, type and location information for all devices.

Request:
/api/v2/devices?fields=mac,type

Response:

{
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"paging": {
"total": 3,
"limit": 100,
"offset": 0

},
"data": [
{

"mac": "00:44:E6:34:89:48",
"type": "wifi-enterprise"

},
{

"mac": "00:44:16:E5:33:E4",
"type": "wifi-enterprise"

},
{

"mac": "00:44:26:46:32:22",
"type": "wifi-enterprise"

}
]

}

Filtering
A subset of fields support filtering. These are defined as query parameters for a particular resource, and they are
listed along with the API specification.

Table 116 describes the standard filtering parameters as shown below:

Table 116 Filtering

Field Details
network (Devices) Configured Network name.
severity (Alarms, Events) Alarm or Event severity (critical, major, minor, notice).
site (Devices) Configured Site name.
state (Alarms) Alarm state (active, cleared).
status (Devices) Device status (online, offline, onboarding).
tower (Devices) Configured Tower name.
type (Devices) Device type (60ghz-cnwave, cnreach, cnmatrix, epmp, pmp, wifi-enterprise, wifi-home, wifi,

ptp) (wifi includes wifi-home and wifi-enterprise).

Filters can be used simultaneously for Resources and Sub-Resources.

Example: Retrieve all WiFi devices that are online.

Request:
/api/v2/devices?type=wifi&status=online

Response:

{
"paging": {
"total": 1,
"limit": 100,
"offset": 0
},
"data": [



{
"ip": "233.187.212.38",
"location": {
"type": "Point",
"coordinates": [
77.55310127974755,
12.952351523837196

]
},
"mac": "C1:00:0C:00:00:24",
"msn": "SN-C1:00:0C:00:00:24",
"name": "Hattie",
"network": "Bangalore",
"product": "cnPilot R201",
"registration_date": "2017-05-23T21:28:37+05:30",
"status": "online",
"site": "Bangalore_Industrial",
"type": "wifi-home",
"hardware_version": "V1.1",
"software_version": "2.4.4",
"status_time": 1495560086

}
]

}

Time Filtering
Events, Alarms, and Performance data can be filtered by date and time using ISO 8601 format.

Example: January 12, 2015 UTC would be encoded as 2015-01-12.
Example: January 12, 2015 1:00 PM UTC would be encoded as 2015-01-12T13:00:00Z.

If the parameters that are described in the Table 117 are not specified, then the start or stop times will be open-
ended.

Table 117 Time Filtering

Parameter Details
start_time Inclusive start time of interval.
stop_time Inclusive stop time of interval.

Sorting
Sorting is supported on a subset of fields within certain requests. Sort is used to specify sorting columns. The sort
order is ascending unless the path name is prefixed with a ‘-‘, in which case it would be descending.

Table 118 Sort

Parameter Details
sort Used to get the records in the order of the given attribute.

Example: To retrieve devices in sorted (ascending) order by name.

Request:
/api/v2/devices?sort=name

Example: To retrieve devices in sorted (descending) order by mac.

Request:
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/api/v2/devices?sort=-mac

Pagination
The limit and offset query parameters are used to paginate responses.

Table 119 Pagination

Parameter Details
limit Maximum number of records to be returned from the server.
offset Starting index to retrieve the data.

Example: To retrieve the first 10 ePMP devices

Request:
/api/v2/devices?offset=3&limit=1

Response:

{
"paging": {
"total": 6,
"limit": 1,
"offset": 3

},
"data": [
{

"status": "online",
"product": "cnPilot E400",
"network": "Mumbai",
"software_version": "3.3-b14",
"registration_date": "2017-04-28T08:57:33+00:00",
"site": "Central",
"hardware_version": "Force 200",
"status_time": "3498",
"msn": "Z834275ABCDH",
"mac": "00:04:36:46:34:AA",
"location": { 
"type": "Point",
"coordinates": [
0,
0

]
},
"type": "wifi-enterprise",
"name": "E400-4634AA"

}
]

}

Internal Response limits
When clients try to access a resource type without pagination, the server will return the first 100 entries that match
the filter criteria. The response will always carry metadata to convey total count and current offset and limit.
Maximum number of results at any point is 100 even when the provided is more than 100.

Example: To retrieve all devices.

Request:
/api/v2/devices



Response:

{
data: {devices: [ {name: ‘ePMP_5566’, type:’ePMP’, location:’blr’} , {….}… ] },
paging:{ 
"limit":25,
"offset":50,
"total":100

}
}

The response returns the following values in the paging section:

Table 120 Internal Response limits

Parameter Details
limit Current setting for the limit.
offset Starting index for the records returned in the response (begins at 0).
total Total number of records that can be retrieved.

Access API

Token (basic request)

POST
/api/v2/access/token

The access API generates token using the Client ID and Client Password created in the cnMaestro UI. The token
can be leveraged by API calls through the expiration time. Only one token is supported for each Client ID at any
given time.

Request
Table 121 describes about the header and its values as shown below:

Table 121 Headers

Header Value
Accept (optional) application/json.
Authorization Basic czZCaGRSa3F0MzpnWDFmQmF0M2JW.
Content-Type application/x-www-form-urlencoded.

The client_id and client_secret are encoded and sent in the Authorization header. The encoding is:
BASE64(client_id:client_secret)

Body

The body needs to have the grant_type.
grant_type=client_credentials

Response
The response returns credentials for API access.

Body
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Name Details
access_token Access token to return with each API request.
expires_in Time in seconds that the API session will remain active.
token_type This will always be bearer.
{

"access_token":"2YotnFZFEjr1zCsicMWpAA",
"token_type":"bearer",
"expires_in":3600

}

Example

Request
curl https://10.110.134.12/api/v2/access/token \
-X POST -k \
-u 8YKCxq72qpjnYmXQ:pcX5BmdJ2f4QLM5RfgsS4jOtxAdTRF \
-d grant_type=client_credentials

Response
{"access_token":"d587538f445d30eb2d48e1b7f7a6c9657d32068e","token_type":"
bearer","expires_in":86400}

Token (alternate request)

POST
/api/v2/access/token

An alternative form is supported in which the client_ID and client_secret are sent in the body, rather than the
Authorization header.

Request
Headers

Header Value
Accept (optional) application/json
Content-Type application/x-www-form-urlencoded

Body

grant_type=client_credentials&client_id=s6BhdRkqt3&client_secret=7Fjfp0ZBr1KtDRbnfVdmIw

Response
The response to both forms is the same.

Body

Name Details
access_token Access token to return with each API request.
expires_in Time in seconds that the API session will remain active.
token_type This will always be bearer.



Name Details
{

"access_token":"2YotnFZFEjr1zCsicMWpAA",
"token_type":"bearer",
"expires_in":3600

}

Example

Request
curl https://10.110.134.12/api/v2/access/token \
-X POST -k \
-d grant_type=client_credentials \
-d client_id=8YKCxq72qpjnYmXQ \
-d client_secret=pcX5BmdJ2f4QLM5RfgsS4jOtxAdTRF

Response
{"access_token":"ee4e077cf457196eb4d27cf6f02686dc07763059","token_type":"
bearer","expires_in":86400}

Validate Token

GET
/api/v2/access/validate_token

Verify if an Access Token is valid and return the time remaining before it expires.

Request
HTTP Headers

Header Value
Accept (optional) application/json
Authorization Bearer <ACCESS_TOKEN>

Response
Body

Name Details
expires_in Time in seconds that the API session will remain active.
{

'expires_in': 86399
}

Example

Request
curl https://10.110.134.12/api/v2/access/validate_token \
-X GET -k \
-H "Authorization: Beareree4e077cf457196eb4d27cf6f02686dc07763059"

Response
{"expires_in":85643}
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Selected APIs

Overview
cnMaestro APIs are defined within the Swagger specification, accessed here
https://docs.cloud.cambiumnetworks.com/api/5.1.1/index.html. This section only presents additional details for the
Device, Statistics and Performance APIs, which have unique responses based upon Device Type, and are difficult
to present within Swagger.

cnMaestro v2 API
Beginning with cnMaestro 3.0.0, the API version changes from v1 to v2. The v1 version will be supported through
3.1.0, but Cambium recommends updating existing API code to use v2. For most commands, swapping v1 in the
URL with v2 should be sufficient. However, the following APIs may need to be rewritten while moving to the v2
version.

l AP Groups

l Devices

l Statistics

l Performance

l Mesh Peers

l Operations

There are unique API responses such as:

l Devices API Response (v2 Format)

l Statistics API Response (v2 Format)

l Performance API Response (v2 Format)

Devices API Response (v2 Format)

Name Details ePM
P

PM
P

Wi-
Fi

cnRea
ch

cnVisi
on

PT
P

PT
P

8xx

cnMatr
ix

60
GHz
cnWav
e

cnWav
e 5G
Fixed

NS
E

profile_
attached

Profile
attached to
the device

ap_group AP Group
cbrs_state CBRS state
cbrs_status CBRS status
config.sync_
reason

Configuration
synchronizati
on reason

config.sync_
status

Configuration
synchronizati
on status

config.variabl Device is



Name Details ePM
P

PM
P

Wi-
Fi

cnRea
ch

cnVisi
on

PT
P

PT
P

8xx

cnMatr
ix

60
GHz
cnWav
e

cnWav
e 5G
Fixed

NS
E

es mapped to
configuration
variables

config.version Current
configuration
version

country Country

country_code Regulatory
band

description Description
hardware_
version

Hardware
version

inactive_
software_
version

Inactive
software
version

ip IP address
ipv6 IPv6
last sync Last

Synchronized
last_reboot_
reason

Reason for
the last reboot
(see 24.1)

link_symmetry Link symmetry
location Location
mac MAC address
managed_
account

Managed
account name

maximum_
range

Maximum
range (KM)

mode Mode type
msn Manufacturer

serial number
name Device name
network Network
onboarding.er
ror_code

Error code of
the device if it
fails to
onboard
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Name Details ePM
P

PM
P

Wi-
Fi

cnRea
ch

cnVisi
on

PT
P

PT
P

8xx

cnMatr
ix

60
GHz
cnWav
e

cnWav
e 5G
Fixed

NS
E

onboarding.st
ate

Onboarding
state of the
device

online Offline or
online

product Product name
registration_
date

Registration
date

role
site Site
site_id Site unique

identifier
software_
version

Active
Software
version

status Status (online,
offline,
onboarding).

status_time Uptime/downt
ime time
interval (sec)

temperature Temperature
tower Tower
type Device type

(epmp, pmp,
wifi-home,
wifi-
enterprise,
cnreach, ptp,
cnmatrix,
60ghz-
cnwave, nse)

Devices onboarding error codes

Error Codes Details
ERR_UNSUPPORTED_
DEVICE

Claiming {{type}} devices is not currently supported.

ERR_NON_ENTERPRISE_
WIFI_TYPE

Only cnPilot Enterprise (ePMP Hotspot), Enterprise Wi-Fi (E-Series and XE/XV-Series)
and cnMatrix devices are allowed into Enterprise account.

ERR_NON_WIFI_TYPE Cannot claim non Wi-Fi device under a Site.
ERR_UNSUPPORTED_ Unsupported device type in current account view - {{view}}.



Error Codes Details
TYPE
ERR_UNKNOWN_DEVICE Unknown Device.
ALREADY_CLAIMED Device already claimed.
LTE_CLAIMED cnRanger devices are not supported in production accounts.
ERR_INVALID_MSN Invalid Serial Number.
ERR_OWNER_DIFFERENT Device is claimed into another account.
ERR_INTERNAL System encountered an internal error; please try again later. If the problem persists,

contact support.
ERR_INVALID_MAC Invalid MAC.
ERR_DUPLICATE_KEY The device is already claimed.
UNPROCESSABLE Device state does not allow to cloud sync.
CBRS_ERROR_DEVICES MAC is already claimed. It cannot be claimed on CBRS.
SUBSCRIPTION_FAIL Device could not acquire slot.
SUBSCRIPTION_FAIL_
FEATURE_MISMATCH

Device is mapped to another onprem instance.

SUBSCRIPTION_FAIL_
TOO_MANY_ASSOCS

Device is mapped to another onprem instance.

Statistics API Response (v2 Format)
Statistics API Response v2 format are shown for the following devices:

l 60 GHz cnWave

l cnMatrix

l cnReach

l Fixed Wireless

l PTP

l PTP 820/850

l Wi-Fi

l cnWave 5G Fixed

60 GHz cnWave

General

Name Details Mode
cpu CPU utilization All
last_sync Last synchronization (UTC Unix time milliseconds) All
mac MAC address All
IP IP address All
managed_account Managed account name All
memory Available memory All
mode Device mode All
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Name Details Mode
name Device name All
network Network All
site Site name All
site_id Site ID All
status Status [online, offline, claimed, waiting, onboarding] All
status_time Uptime/downtime interval (seconds) All
sync_mode Radio Sync mode [RF, GPS, None] All
type Device type All

Networks

Name Details Mode
ipv6 IPv6 address All

Radios (Array format)

Name Details Mode
radios[].channel Channel All
radios[].id Radio Id All
radios[].mac Radio MAC All
radios[].rx_bps Receive bits per second All
radios[].sync_mode Radio Sync mode [RF, GPS, None] All
radios[].tx_bps Transmit bits per second All

Ethernet Ports (Array format)

Name Details Mode
ethports[].port Port name All
ethports[].rx_pkts Received packets All
ethports[].rx_errors Received packets errors All
ethports[].rx_pkts_drop Dropped received packets All
ethports[].speed Port speed and duplex All
ethports[].tx_pkts Transmitted packets All
ethports[].tx_errors Transmitted packets errors All
ethports[].tx_pkts_drop Dropped transmitted packets All

cnMatrix

General

Name Details
cpu CPU utilization
config_version Configuration version
last_sync Last synchronization (UTC Unix time milliseconds)



Name Details
mac MAC address
managed_account Managed account name
memory Available memory
mode Device mode
name Device name
network Network
site Site name
site_id Site unique identifier
status Status [online, offline, claimed, waiting, onboarding]
status_time Uptime/downtime interval (seconds)
tower Tower name
type Device type

Networks

Name Details
ip IP address

cnReach

General

Name Details Mode
config_version Configuration version All
connected_sms Connected SM count All
last_sync Last synchronization (UTC Unix time milliseconds) All
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
status Status [online, offline, claimed, waiting, onboarding] All
status_time Uptime/downtime interval (seconds) All
tower Tower name All
type Device type All

Networks

Name Details Mode
ip IP address All
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Radios (Array format)

Name Details Mode
radios[].device_id Device ID Radios

radios[].id Radio Id Radios
radios[].linked_with Linked with Radios
radios[].mac Radio MAC Radios
radios[].margin Margin Radios
radios[].mode Radio mode [ap, ep, rep] Radios
radios[].neighbors Radio neighbors Radios
radios[].network_address Network address Radios
radios[].noise Average noise (dB) Radios
radios[].power Transmit power Radios
radios[].rssi RSSI value (dB) Radios
radios[].rx_bytes Receive bytes Radios
radios[].software_version Current software version. Radios
radios[].temperature Radio temperature Radios
radios[].type Radio type [ptp, ptmp] Radios
radios[].tx_bytes Transmit bytes Radios

Fixed Wireless (cnVision, ePMP and PMP)

General

Name Details cnVision ePMP PMP
ap_mac AP MAC SM SM SM
config_version Configuration version AP/SM AP/SM AP/SM
connected_sms Connected SM count AP AP AP
cpu CPU utilization AP/SM
distance SM distance (KM) SM SM SM
gain Antenna gain (dBi) AP/SM AP/SM AP/SM
gps_sync_state GPS synchronization state AP/SM AP/SM
last_sync Last synchronization (UTC Unix time milliseconds) AP/SM AP/SM AP/SM
mac MAC address AP/SM AP/SM AP/SM
managed_account Managed account name AP/SM AP/SM AP/SM
mode Device mode AP/SM AP/SM AP/SM
name Device name AP/SM AP/SM AP/SM
network Network AP/SM AP/SM AP/SM
reboots Reboot count AP/SM AP/SM
status Status [online, offline, claimed, waiting, onboarding] AP/SM AP/SM AP/SM
status_time Uptime/downtime interval (seconds) AP/SM AP/SM AP/SM
temperature Temperature AP/SM



Name Details cnVision ePMP PMP
tower Tower name AP AP AP
type Type AP/SM AP/SM AP/SM
vlan VLAN AP/SM

Networks

Name Details cnVision ePMP PMP
default_gateway Default gateway AP/SM AP/SM AP/SM
ip IP address AP/SM AP/SM AP/SM
ipv6 IPv6 address AP/SM AP/SM
ip_dns DNS AP/SM AP/SM AP/SM
ip_dns_secondary Secondary DNS AP/SM
ip_wan WAN IP AP/SM AP/SM
lan_mode_status LAN mode status [no-data, half, full] AP/SM AP/SM
lan_mtu MTU size SM SM
lan_speed_status LAN speed status AP/SM AP/SM
lan_status LAN status [down, up] AP/SM AP/SM AP/SM
netmask Network mask AP/SM AP/SM AP/SM

Radios

Name Details cnVision ePMP PMP
radio.auth_mode Authentication mode SM SM
radio.auth_type Authentication type ePMP [open, wpa1, eap-

ttls]

PMP [disabled, enabled]

AP/SM AP/SM AP/SM

radio.channel_width Channel width ePMP [5 MHz, 10 MHz, 20
MHz, 40 MHz]

PMP […]

AP/SM AP/SM AP/SM

radio.color_code Color code AP/SM
radio.dfs_status DFS status ePMP:

[not-applicable, channel- availability-check,
in-service, radar- signal-detected, alternate-
channel- monitoring, not-in- service]

PMP: [Status String]

AP/SM AP/SM AP/SM

radio.dl_err_drop_pkts Downlink error drop packets SM SM
radio.dl_err_drop_pkts_
percentage

Downlink error drop packets percentage SM SM

radio.frequency RF frequency AP/SM AP/SM AP/SM
radio.frame_period Frame period AP
radio.dl_frame_utilization Downlink frame utilization AP
radio.dl_lqi Downlink Link Quality Indicator SM
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Name Details cnVision ePMP PMP
radio.dl_mcs Downlink MCS SM SM
radio.dl_modulation Downlink Modulation SM
radio.dl_pkts Downlink packet count AP/SM AP/SM AP/SM
radio.dl_pkts_loss Downlink packet loss AP/SM
radio.dl_retransmits Downlink Retransmission AP/SM AP/SM
radio.dl_retransmits_pct Downlink Retransmission percentage AP/SM AP/SM
radio.dl_rssi Downlink RSSI SM SM SM
radio.dl_rssi_imbalance Downlink RSSI imbalance AP
radio.dl_snr Downlink SNR (dB) SM SM
radio.dl_snr_h Downlink SNR (dB) horizontal SM
radio.dl_snr_v Downlink SNR (dB) vertical SM
radio.dl_throughput Downlink throughput AP/SM AP/SM AP/SM
radio.mac Wireless MAC AP/SM AP/SM
radio.mode Radio mode

[eptp-master, eptp- slave, tdd, tdd-ptp, ap/sm] AP/SM AP/SM
radio.sessions_dropped Session drops AP AP AP/SM
radio.software_key_throughput Software key – max throughput SM
radio.ssid SSID AP/SM AP/SM
radio.sync_source Synchronization source AP
radio.sync_state Synchronization state AP
radio.tdd_ratio TDD ratio ePMP [75/25, 50/50, 30/70,

flexible]

PMP […]

AP AP AP

radio.tx_capacity SM transmit capacity SM SM
radio.tx_power Radio transmit power AP/SM AP/SM AP/SM
radio.tx_quality SM transmit quality SM SM
radio.ul_err_drop_pkts Uplink error drop packets SM SM
radio.ul_err_drop_pkts_
percentage

Uplink error drop packets percentage SM SM

radio.ul_frame_utilization Uplink frame utilization AP
radio.ul_mcs Uplink MCS AP/SM AP/SM
radio.ul_modulation Uplink Modulation example [2X MIMO-B)] SM
radio.ul_lqi Uplink Link Quality Indicator SM
radio.ul_pkts Uplink packet count AP/SM AP/SM AP/SM
radio.ul_pkts_loss Uplink packet loss AP/SM
radio.ul_retransmits Uplink Retransmission SM SM
radio.ul_retransmits_pct Uplink Retransmission percentage AP/SM AP/SM
radio.ul_rssi Uplink RSSI SM SM SM
radio.ul_snr Uplink SNR (dB) SM SM



Name Details cnVision ePMP PMP
radio.ul_snr_h Uplink SNR (dB) horizontal SM
radio.ul_snr_v Uplink SNR (dB) vertical SM
radio.ul_throughput Uplink throughput AP/SM AP/SM AP/SM
radio.wlan_status WLAN status [down, up] AP/SM AP/SM

PTP 650/670/700

General

Name Details Mode
config_version Configuration version All
connected_sms Connected SM count Master
gain Antenna gain (dBi) All
last_sync Last synchronization (UTC Unix time milliseconds) All
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
status Status [online, offline, claimed, waiting, onboarding] All
status_time Uptime/downtime interval (seconds) All
temperature Temperature All
tower Tower name All
type Device type All
vlan VLAN All

Networks

Name Details Mode
default_gateway Default gateway All
ip IP address All
ip_dns DNS All
ip_dns_secondary Secondary DNS All
lan_status LAN status [down, up] All
netmask Network mask All

Ethernet Ports (Array format)

Name Details Mode
ethports[].port Port name All
ethports[].rx_frames Ports receive frames oversize All
ethports[].rx_util Ports receive bandwidth utiliization All
ethports[].speed Ports speed and duplex All
ethports[].tx_util Ports transmit bandwidth utiliization All
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Radios

Name Details Mode
radio.byte_error_ratio Byte Error Ratio All
radio.channel_width Channel width

ePMP: [5 MHz, 10 MHz, 20 MHz, 40 MHz]

PMP: […]

All

radio.color_code Color code All
radio.rx_frequency Receive frequency All
radio.tx_frequency Transmit frequency All
radio.tx_power Radio transmit power All

PTP 820/850

General

Name Details Mode
ip IP address All
last_sync Last synchronized All
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
status Status [online, offline, claimed, waiting, onboarding] All
status_time Uptime/downtime interval (seconds) All
temperature Temperature All
tower Uptime/downtime interval (seconds) All
type Device type All

Radio

Name Details Mode
radios[].defective_blocks Radio defective blocks All
radios[].id Radio Id All
radios[].radio_location Radio location All
radios[].rx_bps Receive bits/second All
radios[].rx_level Receive level All
radios[].rx_frequency Receive frequency All
radios[].tx_bps Transmit bits/second All
radios[].tx_level Transmit level All
radios[].tx_frequency Transmit frequency All
radios[].tx_mute_status Transmit mute status All
radios[].modem_mse Modem Mean Square Error (MSE) in dB All
radios[].modem_xpi Modem Cross-Polar Isolation (XPI) in dB All



Interfaces

Name Details Mode
interfaces[].admin_state Admin state All
interfaces[].auto_negotiation Auto Negotiation All
interfaces[].interaface_location Interface location All
interfaces[].mac MAC address All
interfaces[].media_type Media type All
interfaces[].operational_status Operational Status All
interfaces[].port_duplex Interface duplex type All
interfaces[].speed Interface speed All

Wi-Fi
Note

Mode is Enterprise, Home, or All.

General

Name Details Mode
config_version Configuration version All
cpu CPU utilization All
mac MAC address All
managed_account Managed account name All
memory Available memory All
mode Device mode All
name Device name All
network Network All
parent_mac Parent MAC All
site Site name All
site_id Site unique identifier All
status Status [online, offline, claimed, waiting, onboarding] All
status_time Uptime/downtime interval (seconds) All
type Device type All

Networks

Name Details Mode
ip IP address All
ipv6 IPv6 address All
ip_dns DNS All
ip_dns_secondary Secondary DNS All
ip_wan WAN IP All
lan_mode_status LAN mode status [no-data, half, full] Enterprise
lan_speed_status LAN speed status All
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Name Details Mode
lan_status LAN status [down, up] Home
netmask Network mask All

Radios (Array format)

Name Details Mode
radios[].airtime Airtime All
radios[].band Radio band All
radios[].bssid Radio mac Enterprise
radios[].channel Channel All
radios[].id Radio Id All
radios[].multicast_rate Multicast rate Enterprise
radios[].noise_floor Noise floor Enterprise
radios[].num_clients Number of clients All
radios[].num_wlans Number of WLANs Enterprise
radios[].power Transmit power All
radios[].quality RF Quality description Enterprise
radios[].radio_state Radio state Enterprise
radios[].rx_bps Receive bits/second All
radios[].rx_bytes Receive bytes All
radios[].tx_bps Transmit bits/second All
radios[].tx_bytes Transmit bytes All
radios[].unicast_rates Unicast rates Enterprise
radios[].utilization Radio utilization Enterprise

cnWave 5G Fixed

General

Name Details Mode
cpu CPU utilization All
last_sync Last synchronization (UTC Unix time milliseconds) All
mac MAC address All
managed_account Managed account name All
ip IP Address All
mode Device mode All
name Device name All
network Network All
tower Tower name All
status Status [online, offline, claimed, waiting, onboarding] All
status_time Uptime/downtime interval (seconds) All
config_version Current config version All
type Device type All



Name Details Mode
connected_cpe Number of CPEs connected to the BTS BTS
registered_cpe Number of CPEs registered with the BTS BTS
cpe_registration_state CPEs Registration State CPE
cpe_registration_count CPEs Registration Count CPE
cpe_imsi CPE Device Identity CPE

Boot

Name Details Mode
startup_count Startup Count for the device BTS
startup_reason Startup Reason for the device BTS

Shutdown (Array format)

Name Details Mode
shutdown[].date Shutdown Date BTS
shutdown[].detail Shutdown Detail BTS
shutdown[].index Shutdown Index BTS
shutdown[].reason Shutdown Reason BTS

Interface Config

Name Details Mode
sfp1_speed SFP1 Speed BTS
sfp2_speed SFP2 Speed BTS

Interfaces (Array format)

Name Details Mode
interfaces[].port_name Port name BTS
interfaces[].in_octets Received octets BTS
interfaces[].out_octets Transmitted octets BTS
interfaces[].in_ucast_pkts Received unicast packets BTS
interfaces[].out_ucast_pkts Transmitted unicast packets BTS
interfaces[].in_mcast_pkts Received multicast packets BTS
interfaces[].out_mcast_pkts Transmitted multicast packets BTS
interfaces[].in_bcast_pkts Received broadcast packets BTS
interfaces[].out_bcast_pkts Transmitted broadcast packets BTS
interfaces[].in_discards Received discarded packets BTS
interfaces[].out_discards Transmitted discarded packets BTS
interfaces[].in_errors Received errored packets BTS
interfaces[].out_errors Transmitted errored packets BTS
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Radio

Name Details Mode
dl_throughput Received Throughput BTS
ul_throughput Transmitted Throughput BTS
frequency Frequency BTS
max_eirp Maximum EIRP BTS
polarization Polarization All
link_symmetry Link Symmetry BTS
bandwidth Bandwidth BTS
ul_target_rxPower Transmitted Target Power BTS
ul_tx_power_init Transmitted Initial Power BTS
ul_tx_power_cont Transmitted Control Power BTS
ul_frame_util Transmitted Frame Utilization BTS
dl_frame_util Received Frame Utilization BTS
dl_mcs Downlink MCS CPE
ul_mcs Uplink MCS CPE
alignment_active Alignment Active Status CPE
cpe_range Range of CPE CPE
current_eirp Current Effective radiated power CPE
ul_backoff Uplink Backoff CPE
dl_backoff Downlink Backoff CPE
ul_sounding_state Uplink Sounding State CPE
dl_sounding_state Downlink Sounding State CPE
ul_channel_distortion Uplink Channel Distortion CPE
dl_channel_distortion Downlink Channel Distortion CPE
ul_evm Uplink EVM CPE
dl_evm Downlink EVM CPE
ul_rx_power Uplink Received Power CPE
dl_rx_power Downlink Received Power CPE
ul_spatial_freq Uplink Spatial Frequency CPE
dl_spatial_freq Downlink Spatial Frequency CPE

Wireless and Ethernet interfaces

Name Details Mode
in_octets Received octets CPE
out_octets Transmitted octets CPE
in_ucast_pkts Received unicast packets CPE
out_ucast_pkts Transmitted unicast packets CPE
in_mcast_pkts Received multicast packets CPE
out_mcast_pkts Transmitted multicast packets CPE



Name Details Mode
in_bcast_pkts Received broadcast packets CPE
out_bcast_pkts Transmitted broadcast packets CPE
in_discards Received discarded packets CPE
out_discards Transmitted discarded packets CPE
in_errors Received errored packets CPE
out_errors Transmitted errored packets CPE

Performance API Response (v2 Format)
Performance API Response v2 Format are shown for following devices:

l 60 GHz cnWave

l cnMatrix

l cnReach

l Fixed Wireless

l PTP 650/670/700

l PTP 820/850

l Wi-Fi

l cnWave 5G Fixed

60 GHz cnWave

General

Name Details Mode
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
online_duration Duration of device connection with server (seconds) All
site Site All
timestamp Timestamp All
type Device type All
uptime Device online time (seconds) All

Radios (Array format)

Name Details Mode
radios[].id Radio ID All
radios[].rx_bps Receive bits per second All
radios[].tx_bps Transmit bits per second All
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Ethernet Ports (Array format)

Name Details Mode
ethports[].max_rx Ports maximum receive bytes All
ethports[].max_tx Ports maximum transmit bytes All
ethports[].min_rx Ports minimum receive bytes All
ethports[].min_tx Ports minimum transmit bytes All
ethports[].port Port name All
ethports[].rx Ports receive bytes All
ethports[].tx Ports transmit bytes All
ethports[].rx_bps Ports receive bits per second All
ethports[].tx_bps Ports receive bits per second All
ethports[].min_rx_bps Ports minimum receive bits per second All
ethports[].min_tx_bps Ports minimum transmit bits per second All
ethports[].max_rx_bps Ports maximum receive bits per second All
ethports[].max_tx_bps Ports maximum transmit bits per second All

cnMatrix

General

Name Details
mac MAC address
managed_account Managed account name
mode Device mode
name Device name
network Network
site Site
timestamp Timestamp
tower Tower
type Device type

Switch

Name Details
switch.rx.broadcast_pkts Receive broadcast packets
switch.dl_kbits Downlink usage (in kbits on hour or minute basis)
switch.dl_throughput Downlink throughput (Kbps)
switch.ul_kbits Uplink (in Kbits on hour or minute basis)
switch.rx.multicast_pkts Receive multicast packets
switch.ul_throughput Uplink throughput (Kbps)
switch.rx.pkts_err Receive Packet error
switch.rx.unicast_pkts Receive unicast packets
switch.tx.broadcast_pkts Transmit broadcast packets



Name Details
switch.tx.multicast_pkts Transmit multicast packets
switch.tx.pkts_err Transmit packet error
switch.tx.unicast_pkts Transmit unicast packets

cnReach

General

Name Details Mode
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
online_duration Duration of device connection with server (seconds) All
sm_count Connected SM count All
timestamp Timestamp All
tower Tower All
type Device type All
uptime Device online time (seconds) All

Radios (Array format)

Name Details Mode
radios[].id Radio ID Radios
radios[].neighbors Radio neighbors Radios
radios[].noise Average noise Radios
radios[].power Transmit power Radios
radios[].rssi RSSI value Radios
radios[].rx_bytes Receive bytes Radios
radios[].throughput Total throughput Radios
radios[].tx_bytes Transmit bytes Radios

Fixed Wireless (cnVision, ePMP and PMP)

General

Name Details cnVision ePMP PMP
mac MAC address AP/SM AP/SM AP/SM
managed_account Managed account

name
AP/SM AP/SM AP/SM

mode Device mode AP/SM AP/SM AP/SM
name Device name AP/SM AP/SM AP/SM
network Network AP/SM AP/SM AP/SM
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Name Details cnVision ePMP PMP
online_duration Duration of device

connection with
server (seconds)

AP/SM AP/SM AP/SM

sm_count Connected SM count AP AP AP
sm_drops Session drops AP/SM AP/SM AP
timestamp Timestamp AP/SM AP/SM AP/SM
tower Tower AP/SM AP/SM AP/SM
type Device type AP/SM AP/SM AP/SM
uptime Device online time ( 

seconds)
AP/SM AP/SM AP/SM

Radios

Name Details cnVision ePMP PMP
radio.dl_frame_utilization Downlink frame

utilization
AP

radio.dl_kbits Downlink usage (in
Kbits on hour or
minute basis)

AP/SM AP/SM

radio.dl_mcs Downlink MCS SM SM
radio.dl_modulation Downlink modulation SM
radio.dl_pkts Downlink packet

count
AP/SM AP/SM

radio.dl_pkts_loss Downlink packet loss AP/SM
radio.dl_retransmits_pct Downlink

retransmission
percentage

AP/SM AP/SM

radio.dl_rssi Downlink RSSI SM SM SM
radio.dl_rssi_imbalance Downlink RSSI

imbalance
SM

radio.dl_snr Downlink SNR SM SM
radio.dl_snr_h Downlink SNR (dB)

horizontal
SM

radio.dl_snr_v Downlink SNR (dB)
vertical

SM

radio.dl_throughput Downlink Throughput
(Kbps)

AP/SM AP/SM AP/SM

radio.ul_frame_utilization Uplink frame
utilization

AP

radio.ul.kbits Uplink usage (in Kbits
on hour or minute
basis)

AP/SM AP/SM

radio.ul_mcs Uplink MCS SM SM
radio.ul_modulation Uplink modulation SM



Name Details cnVision ePMP PMP
radio.ul_pkts Uplink packet count AP/SM AP/SM
radio.ul_pkts_loss Uplink packet loss AP/SM
radio.ul_retransmits_pct Uplink Retransmission

percentage
AP/SM AP/SM

radio.ul_rssi Uplink RSSI SM SM SM
radio.ul_snr Uplink SNR SM SM
radio.ul_snr_h Uplink SNR (dB)

horizontal
SM

radio.ul_snr_v Uplink SNR (dB)
vertical

SM

radio.ul_throughput Uplink Throughput
(Kbps)

AP/SM AP/SM AP/SM

PTP 650/670/700

General

Name Details Mode
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
sm_count Connected SM count Master
timestamp Timestamp All
tower Tower All
type Device type All

Ethernet Ports (Array format)

Name Details Mode
ethports[].max_rx Ports maximum receive bytes All
ethports[].max_tx Ports maximum transmit bytes All
ethports[].min_rx Ports minimum receive bytes All
ethports[].min_tx Ports minimum transmit bytes All
ethports[].pkt_error Ports packet error All
ethports[].port Port name All
ethports[].rx Ports receive bytes All
ethports[].tx Ports transmit bytes All
ethports[].rx_bps Ports receive bits per second All
ethports[].tx_bps Ports receive bits per second All
ethports[].min_rx_bps Ports minimum receive bits per second All
ethports[].min_tx_bps Ports minimum transmit bits per second All
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Name Details Mode
ethports[].max_rx_bps Ports maximum receive bits per second All
ethports[].max_tx_bps Ports maximum transmit bits per second All

Ethernet

Name Details Mode
ethernet.link_loss Link loss All
ethernet.pcb_temperature PCB temperature All
ethernet.rx_channel_util Receive channel utilization All
ethernet.rx_capacity Receive capacity All
ethernet.ssr Signal strength ratio All
ethernet.rx_power Receive power All
ethernet.sfp_interface.tx SFP transmit bytes All
ethernet.rx_throughput Receive throughput All
ethernet.tx_channel_util Transmit channel utilization All
ethernet.tx_capacity Transmit capacity All
ethernet.tx_power Transmit power All
ethernet.tx_throughput Transmit throughput All
ethernet.vector_error Vector error All

PTP 820/850

General

Name Details Mode
mac MAC address All
managed_account Managed account name All
mode Device Mode All
name Device name All
network Network All
online_duration Duration online All
timestamp Timestamp All
tower Tower All
type Device type All
uptime Device online time ( seconds) All

Radio

Name Details Mode
radios[].id Radio ID All
radios[].max_rsl Radio Maximum Receiver Signal Level All
radios[].max_tsl Radio Maximum Transmission Signal Level All
radios[].min_rsl Radio Minimum Receiver Signal Level All



Name Details Mode
radios[].min_tsl Radio Minimum Transmission Signal Level All
radios[].peak_throughput Radio Peak Throughput All
radios[].radio_location Radio Location All
radios[].throughput Radio Throughput All
radios[].modem_max_mse Modem maximum MSE in dB All
radios[].modem_min_mse Modem minimum MSE in dB All
radios[].modem_max_xpi Modem maximum XPI in dB All
radios[].modem_min_xpi Modem minimum XPI in dB All
radios[].modem_max_mrmc_profile Modem maximum MMRC All
radios[].modem_max_mrmc_profile Modem minimum MMRC All

Radio Groups

Name Details Mode
radios_groups[].id Radio Group ID All
radios_groups[].peak_throughput Radio Group peak throughput All
radios_groups[].radio_location Radio Group location All
radios_groups[].throughput Radio Group throughput All

Wi-Fi

General

Name Details Mode
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
online_duration Duration of device connection with server ( seconds) All
site Site All
timestamp Timestamp All
type Device type All
uptime Device online time ( seconds) All

Radios (Array format)

Name Details Mode
radios[].clients Number of clients All
radios[].id Radio ID All
radios[].rx_bps Receive bits/second All
radios[].throughput Total throughput All
radios[].tx_bps Transmit bits/second All
radios[].band Radio band (2.4 GHz/5 GHz) All
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cnWave 5G Fixed

General

Name Details Mode
mac MAC address All
managed_account Managed account name All
mode Device mode All
name Device name All
network Network All
online_duration Duration of device connection with server (seconds) All
timestamp Timestamp All
type Device type All
uptime Device online time (seconds) All
cpe_registered Registered CPEs count BTS
cpe_connected Connected CPEs count BTS
cpe_registrationCnt Number of times the CPE registered with the BTS CPE

Radio

Name Details Mode
ul_throughput Uplink Throughput BTS
dl_throughput Downlink Throughput BTS
cpe_ul_throughput Uplink Throughput CPE
cpe_dl_throughput Downlink Throughput CPE
cpe_ul_evm Uplink EVM CPE
cpe_dl_evm Downlink EVM CPE
cpe_ul_mcs Uplink MCS CPE
cpe_dl_mcs Downlink MCS CPE
cpe_ul_rxPower Uplink Rx Power CPE
cpe_dl_rxPower Downlink Rx Power CPE

Client API Response (v2 Format)
Client details API Response v2 format are shown below:

Name Details Wi-Fi
ap_mac AP MAC
client_type Client type(Client | Guest Client)
download_quota Download quota (Note: only applicable for Guest Client)
download_quota_balance Download quota balance (Note: only applicable for Guest

Client)
ip IP address of client
mac Client MAC



Name Details Wi-Fi
managed_account Managed account name
manufacturer Manufacturer name
name Client name
radio.band Band(2.4 GHz/5 GHz)
radio.rssi RSSI
radio.rx_bytes Received bytes
radio.snr SNR
radio.ssid SSID

External Guest Access Login API
Integrates an external captive portal with the Cambium Networks AP while posting directly to cnMaestro. This API
provides the support for the external captive portal to make login requests.

POST /api/v2/ext-portals/login

Request:

curl -X
/api/v2/ext-portals/login" -H "accept: */*" -H "Authorization: Bearer
e88916f5b663c1ea966af835c8a0a19c20d17686" -H "Content-Type: application/json"-d

Body
"{\"ga_ap_mac\":\"11-22-33-44-55-66\",\"ga_cmac\":\"11-22-33-44-55-65\",\"ga_
Qv\":\"eUROBR86HBgAGDEEVgQAGw4UWRUCACYVMgFPMV5ZWVFfUVdGX1ZFJXxZR1dLBhMUMww\",\"ga_
user\":\"test-user\",\"ga_pass\":\"test-pass\"}"

Response:

{
“data”: {

“mType”: 3,
“msgId”:28,
“status”:<integer values>,
“prefixQs”:<true/false>,
“expiry”:<integer values>,
“action”:<integer values>,
“cmac”:<client mac>,
“msg”:<Radius Returned Message>,
“extURL”:<external url string>
}

}

The status value description is provided in the table below.

Status Description
0 Login is successful.
1 Invalid login request, the client is not currently associated to the AP which is being requested for login

here.
2 RADIUS reject due to invalid username/password.
3 RADIUS timeout, AP didn’t received the RADIUS response.
4 Missing RADIUS server config on the WLAN config of the AP.

807 | RESTful API Specification Cambium cnMaestro Cloud | User Guide



808 | RESTful API Specification Cambium cnMaestro Cloud | User Guide

Status Description
5 If LDAP configured on the AP for authentication then LDAP server responded back with reject.
6 LDAP timeout happened on the AP for the request.
7 Missing LDAP configuration on the WLAN configuration of the AP.
8 Logout is successful.
9 Logout failed due to missing session on the AP. Most likely client session is already deleted from this

AP.

The response parameter name and details is shown below.

Name Details
action 0: On success action redirects the user to AP onboard logout page.

1: On success redirects user to an external URL.

2: On success redirects user to its original URL.
cmac MAC address of the client.

expiry Displays the session time for the given guest session.
msg Message is based on RADIUS attribute reply message (18) in the RADIUS Access Accept or Reject

message.
prefixQs True: Add query strings to landing URL on success.

False: Remove query strings from landing URL on success.

prefixQs and action values are driven based on WLAN configuration.

60 GHz cnWave RESTful API
cnMaestro supports configuration overrides for 60 GHz cnWave E2E Network, E2E Controller, and Node(s) using
the RESTful API.

E2E Network
To determine the configuration parameters available in an E2E Network, navigate to E2E Network > Configuration
> Advanced. Search for the desired Field, and review its Description, allowed Values, and Override status. Use
the RESTful API to override single or multiple fields.

GET /api/v2/cnwave60/networks/{network_id}/configuration

PUT /api/v2/cnwave60/networks/{network_id}/configuration



Field names are separated by dots. Each substring between the dots will be converted to objects and the last
substring will be the key and value.

Example
In case of field name radioParamsBase.fwParams.wsecEnable,payload will be:

{
"radioParamsBase": {
"fwParams": {

"wsecEnable": 1
}

}
}

Warning

Partial update is not allowed. Always send full configuration that needs to be pushed to E2E Network.

Optimization
To determine the optimization parameters available in an E2E Network, navigate to E2E Network > Configuration
> Advanced.

GET /api/v2/cnwave60/networks/{network_id}/optimization/{optimization_type}

PUT /api/v2/cnwave60/networks/{network_id}/optimization/{optimization_type}

Available values :

controlSuperframeAllocation,

dpaZoneAllocation

clearNodeAutoConfig
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Example

{
"clearUserConfig": true,
"nodes": [
"string"

],
"configPaths": "string"

}

Device (Node) Configuration
To update Device configuration, navigate to Node > Configuration > Advanced. Search for the Field, and review
its Description, allowed Values, and Overrides status. Use the RESTful API to override those fields.

GET /api/v2/cnwave60/networks/{mac}/configuration

PUT /api/v2/cnwave60/networks/{mac}/configuration

Field names are separated by dots. Each substring between the dots will be converted to objects and the last
substring will be the key and value.

Example
In case of field name linkParamsBase.fwParams.minTxPower, object to send in the API payload will be:

{
"linkParamsBase": {

"fwParams": {
"minTxPower": 6
"maxTxPower": 8

}
}

}

The below two APIs are introduced in Release 3.1.0 to update multiple device configurations overrides.

GET /api/v2/cnwave60/networks/{network_id}/devices/overrides

PUT /api/v2/cnwave60/networks/{network_id}/devices/overrides



Warning

Partial update is not allowed. Always send full configuration that needs to be pushed to 60 GHz
cnWave Devices.

The example payload for PUT request is seen from cnMaestro UI.

Example

{
"device1_name": {
"radioParamsBase": {
"fwParams": {
"txPower": 6

}
}
},
"device2_name": {

"popParams": {
"POP_IFACE": "nic2"
}

}
}

Note

You can download the full config of the node by clicking on the Show Full Configuration
as well and then get the JSON key and pass in RESTful API.

E2E Controller
To update E2E Controller configuration, navigate to E2E Network > Configuration > E2E Controller. Search for the
desired Field, and review its Description, allowed Values, and Override status. Use the RESTful API to override
those fields.

GET /api/v2/cnwave60/networks/{network_id}/controller/configuration

PUT /api/v2/cnwave60/networks/{network_id}/controller/configuration

Field names are separated by dots. Each substring between the dots will be converted to objects and the last
substring will be the key and value.
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Example
In case of field name prefixAllocParams.seedPrefix,payload will be:

{
"prefixAllocParams": {
"seedPrefix": "fd00:ceed:1992:1400::/56"
}

}

Warning

Partial update is not allowed. Always send full configuration that needs to be pushed to the E2E
Controller.

Guest Access

This section describes how to configure Guest Access using cnMaestro. This feature allows the clients to connect
to the internet through Free Tier, Vouchers, or Paid Access types.

Note

From cnMaestro 5.1.0 release onwards, the Guest Access Portal configuration wizard is
deprecated, and a new wizard called EasyPass is introduced, as shown in Figure 488.



Figure 488 Network Services

Note

For information on EasyPass, see EasyPass.

The Guest Access feature creates a separate network for guests by providing Internet access to guest wireless
devices such as mobiles, tabs, and laptops.

Note

The Guest Access feature is supported only on Enterprise Wi-Fi devices.

Configuration
l Create the Guest Access Portal in cnMaestro

l Map the device to cnMaestro

Creating the Guest Access Portal in cnMaestro
1. Basic Details

2. Access Portal

3. Design Page

4. Sessions

5. Guests
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Procedure for Creating Guest Access

1. Navigate to Network Services > Guest Access Portal.

2. Click Add Portal. A maximum of four portals can be created per account.

3. Enter a name and brief description for the portal.

4. Click Save.

Basic Details
The Basic details page contains the Managed Account Type, Name, and Description.



Note

A name once created for the Portal cannot be changed.

Access Portal
The Access Portal tab has four different access types:

l Free

l Enterprise X access through one of the following options:
o Microsoft Azure
o Sponsored Guest
o Self Registration
o Google

l Paid X

l Vouchers

The parameters under each access method can be configured only after the corresponding access method is
enabled.

Note

Microsoft Azure and Google-based access are not supported on devices running release version 4.x.
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Free Access Type Configuration

Free Access type contains configurable parameters such as:

l Session validity

l Renewable frequency

l Client rate limits

l Social login

You can select authentication using Google, Facebook, Twitter and Office 365, or all. You will need to enter the
App ID of your social login App. If you enable Facebook login you will also need to enter your Facebook App
secret.

Parameter Description
Add Whitelist Options for configuring the IP address or the domain name.
Client Rate Limit Options for configuring downlink and uplink parameters in kbps to limit the data transfer rate to

or from the client. If a client rate limit parameter is blank, no limits are applied.

Table 122 Free Access Type Parameters



Parameter Description
Client Quota
Limit

The data quota limit feature has been added for RADIUS-based as well as controller-based
guest portals. For controller-based, it is either directional or total data quota limit. Once the
client logs in as a guest, the data quota limit is enforced and the values are sent to the AP to
which the client is connected. The access point keeps track of the data limits and sends client
statistics to the controller every 30 minutes. In case of multiple devices allowed for a given
policy, the data quota limits enforcement has some limitations and works with the latency of 30
minutes during which the cumulative data quota limits of the devices can be exceeded beyond
the configured data quota limits.

The similar behavior is supported through RADIUS attributes for RADIUS-based onboard guest
access clients.

RADIUS_VENDOR_ID_CAMBIUM 9 (17713)

RADIUS_VENDOR_ATTR_CAMBIUM_WIFI_QUOTA_UP (151)

RADIUS_VENDOR_ATTR_CAMBIUM_WIFI_QUOTA_DOWN (152)

RADIUS_VENDOR_ATTR_CAMBIUM_WIFI_QUOTA_UP_GIGWORDS (153)

RADIUS_VENDOR_ATTR_CAMBIUM_WIFI_QUOTA_DOWN_GIGWORDS (154)

RADIUS_VENDOR_ATTR_CAMBIUM_WIFI_QUOTA_TOTAL (155)

RADIUS_VENDOR_ATTR_CAMBIUM_WIFI_QUOTA_TOTAL_GIGWORDS (156)

The gigwords attributes are used for supporting data quota limits above 4 GB when
required.

Renewable
Frequency

Once the session duration for the client expires, the client needs to wait for the period
specified by renewal frequency before logging in again.

Session
Duration

The duration for which the client is provided access.

SMS
Authentication

SMS OTP supports Twilio, SMS Country, and SMS Gupshup SMS gateway providers. Any one
of the gateway providers can be used to support the SMS OTP to be delivered to the cell
phone of the end user. Once OTP is received the client can enter the OTP to get Internet
access.

Social Login Consists of the following options:

l Domain URL: The redirected URL used by the client when trying to access the Internet.

l Google: Consists of ID and Secret options to configure, which admin can create from
https://console.cloud.google.com/.

l Facebook: Consists of ID and Secret options to configure, which admin can create from
https://developers.facebook.com/apps/.

l Twitter: Consists of consumer key, consumer secret key, and callback URL.

l Office 365: Consists of ID and Replyback URL.

Table 122 Free Access Type Parameters

Note

l Renewal frequency should be greater than session expiration.

l Client will get Social login options only when enabled in Access Control page in Portal.

l If Social login is enabled, it is mandatory in free access method for client to login through
Google/Facebook/Twitter/Office 365.
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Enterprise Wi-Fi Access using Microsoft Azure Login, Sponsored Guest, Self Registration, or
Google

Note

l Microsoft Azure and Google-based access are supported only on Enterprise Wi-Fi 6 APs running
firmware version 6.5.1 and later.

l Microsoft Azure is supported on cnMaestro 4.1.0 and later versions.

l Google-based access is supported on cnMaestro 5.0.0 and later versions.

Microsoft Azure

Enterprise Microsoft Azure access page enables Microsoft Azure users to log in to access the Enterprise Wi-Fi. To
set up users to authenticate from Microsoft Azure, navigate to Network Services > Guest Access Portal > Access
> Enterprise > Microsoft Azure, complete the following parameters and click Save:

Sponsored Guest

In this type of access, guests must provide their own email address and their sponsor's email address to request
Internet access.



To allow sponsored guests to access the Wi-Fi, navigate to Network Services > Guest Access Portal > Access >
Enterprise > Sponsored Guest complete the following parameters, and click Save:

Self Registration

Self registration enables guests to register themselves when connecting to the Wi-Fi network for the first time. The
Wi-Fi administrator can configure the self registration process to require a sponsor approval or not. The sponsor
approval can also be configured to be manual or automatic confirmation.

To configure self registration, navigate to Network Services > Guest Access Portal > Access > Enterprise > Self
Registration and configure the following parameters.
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Parameter Description
Enable Self Registration Select the check box to enable self registration feature and configure

the following parameters.
Sponsor Guest Settings

The guests must enter a sponsor email address when registering to connect to the wireless network. The
administrator can choose to configure whether the sponsor must manually approve each request or the approval
is automatic.
Require Sponsor Select the check box if you want the self registration to be approved by a

sponsor.

The guests must enter the sponsor email address when registering for
access to the SSID.

Sponsor Type Specifies whether the sponsor approval for guest internet access must
be automatic or manual. The following options are available:

l Manual Confirmation—The sponsor receives an email for
approving the guest's access request. After approval, the guest
receives an email confirmation along with the password to connect
to the wireless network.

l Automatic Confirmation—If the guest provides a configured
sponsor's email address, the password to access the network is
automatically emailed to the guest and the sponsor is also notified
via email.

Sponsor Email List Configure the list of sponsor email addresses for approving access
requests.

Table 123 Self Registration Parameters



Parameter Description
Receive password via text

By default, the guests receive the password to their email address. However, if you want the guests to receive
the password to their mobile devices as well, configure the following parameters.
Enable Select the check box to send the password to the guest's mobile device.
SMS Gateway Provider Select the SMS gateway to be used to send the OTP to the guest's

mobile device.

The following gateways are supported (each of the gateways have their
own respective parameters that must be configured):

l Fast SMS

l Generic SMS API

l SMS Country

l SMS Gupshup

l SMSAPI

l Twilio

l Victory Link SMS

Each of the above gateways must be configured with their respective
parameters.

Client-related parameters

Client Session—Session Duration Specifies the maximum duration (in minutes) that the guest can browse
the internet in a single session.

Supported range: 1-2628000 minutes
Client Rate Limit Specifies the download and upload speed limit (in Kbps) for the guests.

Configure the speed limit in the Downlink and Uplink fields.
Client Quota Limit
Quota Type Specifies the type of quota for configuring the data usage limit.

The following options are supported:

l None—No limit is configured for data usage. Guests can access
unlimited data in the configured session duration.

l Directional—Configure limits separately for downlink and uplink
directions. The Downlink and Uplink fields are enabled.

l Total—Configure the limit for both directions totally. The Total field
is enabled.

Downlink Specifies the downlink data usage limit (in either MB or GB, selected
from the drop-down list).

This field is available only when you select Directional in the Quota
Type field.

Uplink Specifies the uplink data usage limit (in either MB or GB, selected from

Table 123 Self Registration Parameters
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Parameter Description
the drop-down list).

This field is available only when you select Directional in the Quota
Type field.

Total Specifies total data usage limit for both the directions (in either MB or
GB, selected from the drop-down list).

This field is available only when you select Total in the Quota Type field.
Device Limit Specifies the number of devices that the guest can connect to the

wireless network.

Default: 5.

Table 123 Self Registration Parameters

Google-based access

Google-based access enables users with a Google account to connect to the wireless network by synchronizing
the active directory. When enabled, if a guest who is part of the supported group tries to connect to the Wi-Fi
network, the AP provides access to the guest.

Note

To configure Google-based access, you must have a Google Workspace account.

To configure Google-based access, navigate to Network Services > Guest Access Portal > Access > Enterprise
> Google and configure the following parameters.

Parameter Description
Enable Google Login Select the check box to enable Google-based Wi-Fi access and configure the following

parameters.
Device Limit Specifies the number of devices that the guest can connect to the wireless network.

Table 124 Google Parameters



Parameter Description
Default: 5.

Google Login
Enable Directory
Synchronization

Select the check box to enable synchronization of Google Apps Domain Directory.

This functions requires authorization. Click Follow these steps for information on
configuring your Google Apps Domain Directory.

Allowed Domains List of domains to be allowed for Google-based access. Enter the domain name in the
text box.

Client-related parameters
Client Session—
Session Duration

Specifies the maximum duration (in minutes) that the guest can access internet in a
single session.

Supported range: 1-2628000 minutes
Client Rate Limit Specifies the download and upload speed limit (in Kbps) for the guests.

Configure the speed limit in the Downlink and Uplink fields.
Client Quota Limit
Quota Type Specifies the type of quota for configuring the data usage limit.

The following options are supported:

l None—No limit is configured for data usage. Guests can access unlimited data in
the configured session duration.

l Directional—Configure limits separately for downlink and uplink directions. The
Downlink and Uplink fields are enabled.

l Total—Configure the limit for both directions totally. The Total field is enabled.
Downlink Specifies the downlink data usage limit (in either MB or GB, selected from the drop-

down list).

This field is available only when you select Directional in the Quota Type field.
Uplink Specifies the uplink data usage limit (in either MB or GB, selected from the drop-down

list).

This field is available only when you select Directional in the Quota Type field.
Total Specifies total data usage limit for both the directions (in either MB or GB, selected from

the drop-down list).

This field is available only when you select Total in the Quota Type field.

Table 124 Google Parameters

Designing the Guest Access Login Page and Email Templates
To design the guest login page for users to see when requesting access, navigate to Network Services > Guest
Access Portal > Design > Login Page, complete the following parameters, and click Save:
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To design the email template that should be used to send approval request to the sponsor (in Sponsored Guest
and Self Registration access types), navigate to Network Services > Guest Access Portal > Design > Email
Template > Sponsor, complete the following parameters, and click Save:



To design the email template that should be used to send approved access details to the guest, navigate to
Network Services > Guest Access Portal > Design > Email Template > Guest, complete the following parameters,
and click Save:
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Paid AccessX

Paypal has been added as a payment gateway service where end users can purchase Internet connectivity using a
credit card or their existing PayPal accounts. For purchasing Internet plans, clients are directed to PayPal portal
where they purchase the plan and then they are automatically redirected to guest access portal where the
purchased voucher is displayed. The user should ensure to save this Voucher information if s/he plans to use it on
multiple devices.



Table 125 Paid Access Type Parameters

Parameter Description
General Plan Name: The name of the plan.

Session Duration: The duration for which the client is allowed to access the network.
Client Rate Limit: The uplink and the downlink values in kbps to limit the data transfer rate to or
from the client. If a client rate limit parameter is blank, no limit s are applied.
Device Limit: The device limit allow that number of devices to be connected or select the
unlimited to connect any number of devices.

Voucher Access Type Configuration

Important Points to Remember

l Vouchers can only be generated after enabling Vouchers and creating at least one Voucher plan.

l A maximum of 50,000 Vouchers per portal can be created on cnMaestro.

Note

User is allowed to add only 1000 vouchers at a time. In order to create 50,000
vouchers user needs to add 50 times.

l A maximum of 1,000 Vouchers per portal can be created on cnMaestro Cloud
(https://cloud.cambiumnetworks.com/).

l Total number of generated Vouchers = Vouchers Unclaimed + Vouchers Claimed + Vouchers Expired.

l The admin can export all/valid/current page Voucher codes as PDF/CSV document.

Voucher contains options to add new plans and Vouchers. Based on user requirements, the plans can be created
with different validity and rate limits.

827 | Guest Access Cambium cnMaestro Cloud | User Guide



828 | Guest Access Cambium cnMaestro Cloud | User Guide

1. Create a plan

l Navigate to Network Services > Access Control Portal page and select Access Control tab.

l Enable Vouchers.

l Click Add New Plan button. The window with general and design parameters for the plan is displayed.

Parameter Description
Design l Color: There are options to modify colors for the title, message, code, and background.

l Background Image: You can browse and select a background image for this page.

l Title: The title of the voucher plan.

l Message: Detailed information about the plan.

l Access Code Message: 8 digit access code will be provided to use the voucher.

With all the above parameters, administrators can create their own design for the card with
text, color, and message to be displayed on card.

General l Name: The name of the plan.

l Session Duration: The duration for which the client is allowed network access.

l Voucher Expiry: The expiry time for the generated Vouchers. Once this time lapses, the
Vouchers cannot be used.

l Client Rate Limit: The uplink and the downlink values in kbps to limit the data transfer
rate to or from the client. If a client rate limit parameter is blank, no limits are applied.

l Voucher Device Limit: Limit the devices to use the voucher.

Table 126 Voucher Access Type Parameters



2. Once a plan is configured, Vouchers can be generated for it. Each Voucher is a unique, randomized
alphanumeric code.

Figure 489 Select a plan

Figure 490 Add Vouchers

3. Once the plan is created and the Vouchers are generated, the following page is displayed.
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Figure 491 Sample Voucher Code

Note

The modified values in the Access Portal page is reflected on the design page only when
the design page is saved after making the changes.

Design Page
The Design page refers to the page to which a wireless client is redirected when it connects to the guest portal.
Administrators can create their own Design page by modifying the default logo, background, and text to be
displayed in the Design page with different colors and fonts.

l If Free is selected in Access Portal, the client only sees free access related parameters.

l If Voucher is selected in Access Portal, the client only sees Voucher related parameters with a text box to
enter the Voucher code.

l If both Free and Voucher are selected, then the client sees both Free and Voucher related parameters.

Parameter Description
Accept Terms
Message

Text to appear as the accept terms message.

Advanced Expand Advanced option. Browse and select the advanced fields.
Background Browse and select the image that needs to be displayed as the background.

l Recommended image resolution—1024 pixels × 800 pixels

Table 127 Design Page Parameters



Parameter Description
l Maximum supported image file size—5 MB

l Supported file formats—JPEG, JPG, PNG, and GIF
Background
Placement

Choose the option from the drop-down for placing the background image in the Design page.

Custom Fields Expand Custom Field option. The user can customize the fields in the Design page by choosing
the Custom Field option in the Guest Access Portal page and clicking Add New button.

Enter Voucher
Code
Message

Enter the text to appear in Voucher Code Message.

Free Label Enter the text that should appear on the Free Label.
Login Button Enter the text that should appear on the window to submit.
Login Failure
Message

Message to appear when any error occurs during login.

Login Success
Message

Message to appear after successful login.

Login Title Title of the login section.
Logo Browse and select the logo that needs to be displayed on the Design page.

l Recommended image resolution—300 pixels × 50 pixels

l Maximum supported image file size—3 MB

l Supported file formats—JPEG, JPG, PNG, and GIF
Message Text to appear as the welcome text. You can choose the font style and size for the welcome

text.
On Success
Redirect to
URL

Enter the URL to be redirected to a page, such as Google, Twitter, and Facebook.

Opacity The transparency of background image.
Page Title Text to appear as the title of the page. You can choose the font style and size for the title.
Please wait
Message

Text to appear in the waiting screen.

Repeat
Background

Enable the check box if you want the background image to be repeated.

Select Plans
Label

Enter the text to appear in the label to select plan.

Server Error
Message

Text to appear if there is an error while contacting server.

Terms and
Conditions
Title

Text to appear as the title for the terms and the conditions.

Terms and
Conditions

Text to appear as the terms and conditions.

Terms Agree Text to appear in the terms agree button.

Table 127 Design Page Parameters
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Parameter Description
Button
Terms Cancel
Button

Text to appear in the terms cancel button.

Text Design Choose the appropriate colors for the background, logo in the background, content area, and
for the text.

Voucher Code Enter the text to appear in Voucher Code, Voucher Label, Enter Voucher Code Message, and
Voucher Code Error Message.

Voucher Code
Error Message

Enter the text to appear in Voucher Code Error Message.

Voucher Label Enter the text to appear in Voucher Label.
Failure Enter the text to appear in Google Authentication Failure Message, Twitter Authentication

Failure Message, and Facebook Authentication Failure Message.
WIFI4EU WiFi4EU provides free, high-quality Internet access only across the European Union.

Table 127 Design Page Parameters

WIFI4EU
WiFi4EU provides free, high-quality Internet access across the European Union. Administrators can enable the
WiFi4EU checkbox to provide access to the free internet.

Table 128 WiFi4EU Parameters

Parameter Description
General l Network UUID: Universally Unique Identifier (UUID) that the EC attribute is generated when

the network installation is created in the Installation.

l Language: Allows to select the preferred language.

l Enable Self Test Mode: Allows the browsers background script verification.

l Show Logo: Displays the WiFi4EU logo provided by the European union.

Sessions
Sessions tab contains Client MAC address, Access Point MAC address, Access Type as Free (Google or Facebook)
or Voucher, WLAN-SSID of client connected AP, Remaining time and Disconnect option.



Administrator can check how many clients are connected, Access Type (Free/Voucher) of the client, and can
disconnect the clients.

Client Login Events table creates events of client login sessions. It maintains the login events for 7 days. This table
has Client MAC address, Portal Name, SSID, Access point MAC, Voucher code (if client connected with Voucher),
Access type (Google/Facebook/Voucher).

Admin can export the client login events as PDF / CSV.

Parameter Description
Access Point MAC address of the Access Point.
Access Type Access type as Free or Voucher.
Client MAC MAC address of the client.
Disconnect Displays if the client is disconnected from the network.
Remaining
Time

The time left for the client to access the Internet. It depends upon the session duration configured
in the Access Portal.

Voucher Displays the valid applied voucher.
WLAN SSID of the network.

Table 129 Sessions Parameters

Note

For Free access method, the client MAC address is displayed even after the free session
duration expires. Delete the MAC address of the client after the Renewable Frequency
completes.

Users table displays details of users accessing the network using Enterprise Google-based access.
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Parameter Description
Email Email address of the registered user.
Group Name of the group to which the user belongs.
Registered Devices MAC address of the registered devices.

Table 130 Users Table Parameters

Guests
The Guests page allows you to view details of self registered guests connecting to the wireless network. However,
to view this page, you must first enable and configure self registration under Network Services > Guest Access
Portal > Access Type > Enterprise > Self Registration.

You can also add new guest details on this page. These users can directly access the wireless network after
entering the required details in the access portal.

To add a new user, complete the following steps:

1. Click Add New on the Guests page.

The Add New User window is displayed.

2. Configure the name and email address of the guest in the Name and Email fields.

Add a description, if required, in the Notes field.

3. Click Add.

The details of the Enterprise self registered guests that are connected to the Wi-Fi network are displayed in



the table

Parameter Description
Name Name of the guest that was entered at registration.
Email Email address of the guest.
Status Displays the whether the guest is connected or offline.
Device Count Displays the number of devices that the guest has connected to the network.
Notes Displays the comments or description provided when adding the guest.
Activation Displays the date and time when the guest first connected to the network.
Expiration Displays the date and time when the guest disconnected from the network.

For currently connected guests, this field displays the date and time of session expiration.

Table 131 Guests Table Details

Mapping the device to Guest Access Portal in cnMaestro
The administrator needs to configure the name of the Guest Access Portal in the device which redirects the device
to cnMaestro for client connectivity.

Note

The client gets the fully configured Design page for login only if the Access Point is
onboarded to the server.

Configuration at device level
To configure the Guest Access at device level, perform the following:

1. Login to the device.

2. Navigate to Configuration > WLAN > Guest Access.

835 | Guest Access Cambium cnMaestro Cloud | User Guide



836 | Guest Access Cambium cnMaestro Cloud | User Guide

3. Enable the Guest Access check box.

4. Choose the Portal Mode radio as cnMaestro.

5. In the Guest Portal Name text box, select the name of the portal that was created in cnMaestro and enter the
respective parameters.

Configuration at cnMaestro side
The administrator can push the configuration from cnMaestro through policy or advanced configuration.



Access Types
The following table describes the parameters described in configuring SMS authentication parameters:

To configure SMS Authentication on cnMaestro, perform the following:

1. Enable SMS Authentication feature.

2. In SMS Gateway provider, select your required gateway from the drop-down.

3. Enter the User Name.

4. Enter the Sender ID. This field is optional. This allows user to send SMS through the ID which he chooses.

5. Enter API Key.

6. Select your Account Type from the drop-down.
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7. Enter the OTP Template. The OTP template should include “%code%. %code% replaces the OTP code in the
SMS.

Guest Access using Social Login
Configuration
To achieve cnMaestro Guest Access using Social Logins like Google, Twitter, Facebook, and Office 365, perform
the following steps:

To create Guest Access profile on cnMaestro, do the following:

1. Login to cnMaestro and navigate to Network Services > Guest Access Portal > Add Portal.

2. Enter Portal Name, Description, enable logging for client login events.

3. Click Save.

4. Click Edit Guest Portal Details.

5. Navigate to Access tab and expand Social Login.



6. Select Google, Twitter, Facebook, Office 365 based on your requirement.

API Key Generation
Perform the following steps to create APIs for cnMaestro to integrate with Google, Twitter, Facebook, and Office
365:
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l Google

l Twitter

l Facebook

l Office 365

Google

1. Login to Google Account and navigate to https://console.cloud.google.com/.

2. Click Select a Project and create a New Project.

3. Give a name to the Project and click CREATE..

4. Click Credentials under this project.

5. Under Credentials tab, create OAuth Client ID.



6. Click Configure Consent Screen

7. Assign a name to the application, map to an email address, add cambiumbnetworks.com to the authorized
domain and click Save.
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8. Once clicked Save for above page it redirects to creation of OAuth Client ID.

9. Select Application type as Web Application, give a Name, add Guest Portal Hostname URL/IP which you will
get from cnMaestro UI and click Create.

10. Clicking Create on above page it redirects to the screen showing Client ID and Client Secret.



11. Copy the Client ID and paste it to the cnMaestro enabling Google under Social Logins and click Save.

Twitter

1. Login to Twitter Account and access https://developer.twitter.com/en/apps and click Create an app.
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2. Click Keys and Tokens and copy Consumer API Key and Consumer API Secret Key..

3. Paste them to cnMaestro GUI for Twitter social login.



Facebook

1. Login to Facebook Account and access https://developers.facebook.com/apps/ and click Add a New app.

2. Enter App Display Name, Contact Email, and click on Create App ID.

3. Select a Scenario as Integrate Facebook Login and click Confirm.
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4. Navigate to Settings tab under Facebook Login and add Guest Portal Hostname from cnMaestro to Valid
OAuth Redirect URLs section and click Save Changes.

5. Navigate to Settings > Basic and copy App ID and App Secret.



Office 365

1. Login to Office 365 Account and access https://apps.dev.microsoft.com/ and click Add an app.
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2. Upon Adding your App name and clicking Create application, it redirectes to App page.

3. Copy Application ID and paste it to cnMaestro Guest Access page under Office 365.

4. Click Generate New Password.

5. Copy Reply URL from cnMaestro and paste it under Redirect URLs.

6. Add my.centrify.com to the Whitelist on the cnMaestro.



Sample Template
Sample of client login page is displayed below:

Guest Access Portal Logout
To logout from cnMaestro Guest Access Portal perform as follows:

1. Navigate to Services > Guest Access Portal page and select the respective Guest Portal Name.

2. Select Access tab.

3. Select Enable Logout functionality for the guest client check box.

4. Click Save.

The users can access and use the Guest Access Portal at any time within the specified Renewal Frequency and
Session Duration provided.
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SMS Authentication
The gateway provider sends a text SMS containing the OTP to the end user's phone number. Once OTP is
received the client can enter the OTP and get Internet access.

Twilio, SMS Country, and SMS Gupshup are the SMS gateway providers that support the SMS OTP. Also there is a
generic SMS gateway option, which provides flexibility to configure any preferred SMS gateway by cnMaestro
users. Configuring SMS Gateway through this generic SMS gateway does require a little more involvement to
review the integration specifications of the given SMS gateway. Please follow the guidelines as mentioned on the
Generic SMS Gateway configuration section.

Generic SMS Gateway configuration
SMS Service providers expose a SMS API which typically works over HTTP GET or HTTP POST requests. Most of
the SMS Gateways use username and password in the API requests to validate a given SMS send a request and
some use special authorization token in the HTTP Headers.

Apart from that many API have specific tokens that need to be passed into the request along with the
authentication part. To start off one has to first go through the SMS API document of the given SMS provider and
understand all components do that need to be provided in the HTTP request and then build the corresponding
cnMaestro configuration.

In general, all SMS API documents show example curl commands which can be used to create an SMS request with
the server. Curl examples demonstrate the required components in the request and help to find the right
configuration for the cnMaestro Guest Portal Generic SMS API.

The cnMaestro Generic SMS API configuration is split into multiple components which makes it easy to configure
the static and the dynamic parts of the SMS API request. It also provides a way to handle the SMS API response
and validate the API success or failure case. To handle the reply type, refer the Advanced options.

SMS Gateway provider name
Provide the SMS Gateway name which is used for reference purposes. This is not part of API request so please
provide a meaningful name to identify this SMS Gateway service provider.

HTTP Request type
Based on the SMS gateway provider and the API document information, identify the SMS API. The SMS API uses
HTTP GET or HTTP POST requests for communication with the SMS gateway server.

Example HTTP GET API request

https://smsapiserver.com/service/sms/send?user=xxx&password=yyyyy&message=”Your OTP is
ABCD”&mobileNumber=123456789&dnd=yes&sid=SenderID&v=1.1&messagType=N

Curl command to do HTTP GET request
Curl -v https://smsapiserver.com/service/sms/send?user=xxx&password=yyyyy&message=’Your OTP
is ABCD’&mobileNumber=123456789&dnd=yes&sid=SenderID&v=1.1&messagType=N

Example HTTP POST request

HTTP POST URL

https://smsapiserver.com/service/sms/send

HTTP POST Form Content

user=xxx&password=yyyyy&message=”Your OTP for Internet Access is
QW123”&mobileNumber=123456789&dnd=yes&sid=SenderID&v=1.1&messagType=N

Curl command to do HTTP POST request



curl -v “https://smsapiserver.com/service/sms/send” -H "Content-Type: application/x-
www-form-urlencoded" -X POST \
--data-urlencode 'user=xxx' \
--data-urlencode 'passwd=yyyyy' \
--data-urlencode 'mobilenumber=1234567789' \
--data-urlencode 'message=Your OTP for Internet access is QW123' \
--data-urlencode 'sid=Sid' \
--data-urlencode 'v=1.1' \
--data-urlencode 'mtype=N' \
--data-urlencode 'dnd=yes' \
--data-urlencode 'DR=Y'

If the SMS Gateway is using an authorization token, then below example curl request shows how the Authorization
field is added into a HTTP header.

curl -v -H "Authorization: Bearer nZYIoU7QoUxfD03ct1CC2YvInqI7DmUAH6RYz01K1" \
"https://smsapiserver.com/service/sms/send?\
from=Test&\
to=123456789&\
message=’Your OTP for Internet access is QW123’&\
format=json"

All the SMS API have components as follows:

• Static components which are part of the request.
• Two dynamic components which are part of the mobile number, to which the SMS needs to be sent and the
message which contains the OTP.

Static components
API URL
Based on the above curl request example the URL configures as https://smsapiserver.com/service/sms/send
where the request needs to be sent.

API URL information
From the example curl request please find the static components of the URL. Based on our above example this
configures as user=xxx&password=yyyyy&dnd=yes&sid=SenderID&v=1.1&messagType=N.

Remove the message and mobile number query strings from that URL and configure the rest. This is what a static
component is for a given SMS API so identify what all options are required for the SMS API request and add it in the
format: key1=value1&key2=value2….

HTTP request header key
Based on the above example, If the SMS Gateway Provider API uses some HTTP header field like authorization
token, etc. The corresponding HTTP header field name will be configured as Authorization.

HTTP request header key value
Based on the above example, the SMS gateway API configuration settings expose some authorization token or
auth token, and the provided HTTP header key value will be configured as Bearer
nZYIoU7QoUxfD03ct1CC2YvInqI7DmUAH6RYz01K1 in this configuration.
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Dynamic components
Message parameter name
From the example curl request or the SMS gateway provider the parameter name used for the message key
component where the OTP is added. It could be something like message|text|msg or whatever custom parameter
name is used for sending the message component.

For example curl request, we have used “message” and this is what configures based on the example curl request.

Mobile number parameter name
From the example curl request or the SMS gateway provider the parameter name used for the mobile number key
component where the OTP has to be sent. It could be something like To|mobile|mobile number or whatever
custom parameter name is used for sending the mobile number component.

In our example curl request, we have used mobile number and this is what configures based on the example curl
request.

Advanced options
If you care for adding functionality for parsing the SMS API response on the cnMaestro and find if the request was
successful or if the server returned an error. Then one can use this advanced configuration to let cnMaestro parse
the SMS API reply.

The usual HTTP response code is anyway handled by default and this advanced config parses the reply content is
configured. This should be configured by advanced users only and in case if there is any failure seen in SMS
functionality then disable this and report the issue to Cambium Networks support.

Reply type
The SMS gateway API sends back a response to let the client know about the request results, this result could be
in text format or in json/xml format. So based on the SMS API document select the reply type here as TEXT.

Success
Configure the text to match the success case as follows:

l Typically, servers may respond with a text message in reply like success or sent, then configure the exact
message which should be matched in the response.

l If a server response is like success, sent message to xxxxx, then configure just success which matches in the
reply.

Error
Configure the text which matches the failure case as follows:

l Typically, servers may respond with a text message in reply like Error or Failure, then configure the exact
message which should be matched in the response.

l If a server response is like ERROR, failed to send SMS to xxxxx, out of credit, then configure just ERROR which
matches in the reply to mark it as an error.

Reply Type JSON
JSON reply success key name
Please look for the SMS gateway provider API document in detail and find the JSON examples for the reply and
identify the key which contains the successful response status value.



cnMaestro guest portal generic SMS supports nested JSON too and one has to configure the complete path for the
given result key which contains the SMS message sent status. Example JSON replies are given below to be
configured for this configuration:

Example 1

{
"messages": {
"to": "123456789",
"status": {
"id": 0,
"groupId": 0,
"groupName": "ACCEPTED",
"result": [
{
"status": "MESSAGE_ACCEPTED"
}
],
"description": "Message accepted"
},
"smsCount": 1,
"messageId": "2250be2d4219-3af1-78856-aabe-1362af1edfd2"
}
}

Success key name to be configured based on the above example messages.status.result[0].status.

Example 2

{
"count": 1,
"list": [
{
"id": "1460978572913968440",
"points": 0.16,
"number": "48500500500",
"date_sent": 1460978579,
"submitted_number": "48500500500",
"status": "QUEUE"
}
]
}

Success key name to be configured based on the above example list [0]. Status.

Example 3

{
“status”: “Sent”
}

Success key name to be configured based on the above example is status.

JSON reply success key value
The success status can be single or multiple values based on the SMS Gateway provider and SMS gateway can
respond back with a status as a message successfully sent or successfully queued, which is also a success case
that the queued message sents out shortly.

Based on our examples the status or the result field can be mapped to multiple values like as follows:
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l Sent

l Queued

l Success

l Message Accepted

So in this configuration one can add multiple such values that should be matched for the success case for the value
as received for the JSON reply success key name field.

JSON reply failure key name
Look for the SMS Gateway Provider API document in detail and find the JSON examples for the reply and identify
the key which contains the Error/Failure response status value.

cnMaestro guest portal generic SMS supports nested JSON too and one has to configure the complete path for the
given result key which contains the SMS message sent failure field. Example JSON replies are given below to be
configured for this configuration:

Example

{
"invalid_numbers": [

{
"number": "456456456",
"submitted_number": "456456456",
"message": "Invalid phone number"
}

],
"error": 13,
"message": "No correct phone numbers"

}

JSON reply failure key name to be configured based on the above example is error.

JSON reply key value
The error/failure status can be single or multiple values based on the SMS Gateway provider and SMS gateway can
respond back with a status as a message sent error or multiple error codes for the corresponding error.

Based on our examples the error can be mapped to multiple values like 13|12|-1 etc. So in this configuration, one
can add multiple such values which should be matched for the failure case for the value as received for the JSON
reply failure key name field. reply type XML.

Reply type XML
XML reply success element
Look for the SMS gateway provider API document in detail and find the XML examples for the reply and identify the
elements which contain the successful response status value.

cnMaestro guest portal generic SMS supports nested XML too and one has to configure the complete path for the
given result element which contains the SMS message sent status. Example XML replies are given below to be
configured for this configuration:

Example 1

<items>
<item id="0001" type="result">
<status>Success</status>
</item>



</items>

Success Element Name to be configured based on the above example is items/item/status.

Example 2

<?xml version="1.0" encoding="utf-8"?>
<int xmlns="http://tempuri.org/">-11</int>

Success Element Name to be configured based on the above example.

XML reply success element value
The success status can be single or multiple values based on the SMS Gateway provider and SMS gateway can
respond back with a status as a message successfully sent or successfully queued, which is also a success case
that the queued message sents out shortly.

Based on our examples the status or the result field can be mapped to multiple values like as follows:

l Sent

l Queued

l Success

l Message Accepted

So in this configuration one can add multiple such values that should be matched for the success case for the value
as received for the XML Reply Success Element field.

SMS message sent failure field. Example XML replies are given below to be configured for this configuration:

Example 1

<items>
<item id="0001" type="result">
<error>-12</status>
</item>
</items>

XML Reply Failure Key Name to be configured based on the above example is items/item/error.

Example 2

<items>
<item id="0001" type="result">
<status>Error</status>
</item>
</items>

XML Reply Failure Key Name to be configured based on the above example is items/item/status.

Example 3

<?xml version="1.0" encoding="utf-8"?>
<int xmlns="http://tempuri.org/">-11</int>

XML Reply Failure Key Name to be configured based on the above example is int.
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XML reply failure element value
The error/failure status can be single or multiple values based on the SMS Gateway provider and SMS gateway can
respond back with a status as a message sent error or multiple error codes for the corresponding error.

Based on our examples the error can be mapped to multiple values like 13|12|-1 etc so in this configuration, one can
add multiple such values which should be matched for the failure case for the value as received for the XML reply
failure element field.

Sample configuration in the cnMaestro
Figure 492 : Guest Access Portal

EasyPass

cnMaestro supports a guest access solution which provides an intuitive interface for various guest access methods
used in the customer deployments. It allows the clients to connect to the internet through free tiers, vouchers, or
paid access types. It also creates a separate network for guests by providing internet access to wireless devices
such as mobile phones, tablets, and laptops.

Note

From cnMaestro 5.1.0 release onwards, the Guest Access Portal configuration wizard is
deprecated and a new wizard, EasyPass, is introduced (as shown in Figure 493).



Figure 493 Network Services > EasyPass

When you create a new portal in the Guest Access Portal page, a window appears notifying that guest portals are
discontinued and EasyPass must be used (as shown in Figure 494).

Figure 494 The Add Guest Portal window

The EasyPass access services provide secure and controlled access to users and visitors on your Wi-Fi network.

Table 132 lists the supported devices and their compatibility with EasyPass.

Device EasyPass support
Wi-Fi 5 Yes

Note: Azure and GSuite are not supported.
Wi-Fi 6 Yes
Wi-Fi 7 Yes
Xirrus APs No

Table 132 List of supported devices - EasyPass

EasyPass portal types are grouped into the following categories:

l Guest/Public Access

l Employee/Student Access

l Combined

Each category serves a different purpose and provides distinct features to accommodate various user
requirements and access levels.
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Guest/Public Access

This category includes the following portal types:

l One Click— All guests have access after agreeing to terms of use without needing to create an account. The
Social Login options are integrated with One Click.

l Self Registration X— Guests must register themselves when connecting to the Wi-Fi network for the first time.
The administrator can configure the self-registration process to determine whether sponsor approval is
required. The sponsor approval can also be configured as manual or automatic confirmation. Additionally, the
SMS Gateway Provider option is available as a self-registration method.

l Sponsored Guest X— Guests must provide their email address and their sponsor's email address to request
internet access.

l Voucher— Users can access the network using a pre-assigned voucher. A voucher allows network
administrators to create unique guest keys in bulk for retailers, hotels, conventions, and enterprises providing
temporary visitor Wi-Fi access. These keys can be exported into a CSV file and integrated with other systems
as point-of-sale (POS), property management, ticketing, or registration systems. Voucher also allows
administrators to set a device limit for guests. If a guest tries to connect with more devices than allowed, the
system alerts the guest with a warning message. Guests can manage their devices by deleting some of the
device accounts without IT assistance.

l Paid X— IP Pay and Quickpay payment methods allow users to purchase internet services using a credit card.
For purchasing internet plans, users are directed to a portal where they purchase the plan and then they are
automatically redirected to the guest access portal where the purchased voucher is displayed. The users must
save the voucher information if they use it on multiple devices.

l WiFi4EU— Provides free internet access only across the European Union (EU) to citizens and visitors through
free-of-charge Wi-Fi hotspots in public spaces such as parks, squares, administrations, libraries, and health
centers.

Note

indicates that the feature is available only in cnMaestro .

Employee/Student Access

This category includes the following portal types:

l Microsoft Azure X—A single sign-on process allows seamless access to Microsoft Azure X by integrating Wi-Fi
and authentication.

l Google Login X—A single sign-on process allows seamless access to Google Login X by integrating Wi-Fi and
authentication.

Note

Azure and Google Workspace are available on 6.x and later versions supporting firmware AP.

Combined

This category includes the following portal types:

l One Click + Voucher—Combines the benefits of both One Click access and voucher-based promotions,
providing users with an easy and cost-effective way to access services.

l One Click + Paid X—Combines the benefits of One Click access with paid access to services.

l Voucher + Paid X—Combines the benefits of voucher-based promotions and paid access to services.



Note

l Using Essentials, you can create a maximum of four EasyPass
portals.

l Using cnMaestro-X, you can create a maximum of 500 EasyPass
portals.

Implementation of EasyPass portals for various types of users
Table 133 lists the various types of users for whom the EasyPass portals can be implemented or best suited:

Table 133 Implementation of EasyPass portals for various types of users

EasyPass
portal
type

BYOD
Employ
ee or
Student

Co-
workin
g
Space
User

Busines
s Visitor

MDU
Reside
nt

Residen
ce Hall
Student

Hotel
Gues
t

Retail
Custom
er

Convention/F
air Attendee

Sport
s
Event
Fan

Publi
c Wi-
Fi
user

Self
Registrati
on X
Sponsore
d Guest X
Voucher

One Click

Paid X

WiFi4EU

Microsoft
Azure X
Google
Login X

EasyPass configuration
You can configure EasyPass using the cnMaestro UI. The EasyPass configuration process involves the following
tasks:

l Creating a portal
o Creating One Click portal
o Creating Self Registration X portal
o Creating Sponsored Guest X portal
o Creating Voucher portal
o Creating Paid X portal
o Creating WiFi4EU portal
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o Creating Microsoft Azure X portal
o Creating Google Login X portal
o Creating One Click + Voucher portal
o Creating One Click + Paid X portal
o Creating Voucher + Paid X portal

l Configuring common parameters
o The Basic screen parameters
o The Limits screen parameters
o The Design screen parameters
o The Voucher screen parameters
o The Plans screen parameters

l Accessing the common tabs
o Sessions
o Guests

n Adding a new guest user
o Vouchers
o Paid Transactions X
o Users X

Creating a portal
Complete the following steps to create a portal:

1. From the home page of cnMaestro UI, navigate to Network Services > EasyPass.

The Network Services > EasyPass screen appears.

Figure 495 The EasyPass screen

2. Click the Add Portal button.

The Select Portal Type window appears.

Note

The options in the Select Portal Type window are different for cnMaestro Essentials
and cnMaestro X.

Figure 496 displays the options available for cnMaestro Essentials.



Figure 496 The Select Portal Type window—cnMaestro Essentials

Figure 497 displays the options available for cnMaestro X.

Figure 497 The Select Portal Type window—cnMaestro X

Note

The WiFi4EU option is applicable only to users in the EU region. Users from Asia-
Pacific (APAC), Americas, and other non-EU regions do not have access to this
option.

3. In the Name field, enter a name for the portal. For example, test1.

A name once created for the portal cannot be changed.

The Name field supports:
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l A minimum of five and maximum of 64 characters.

l Only alphanumeric, underscore (_), and dashes (-).

4. Select the required option from the Managed Account drop-down list. For example, Base Infrastructure.

Note

l When creating the EasyPass service, select the required managed account to which the
service must be mapped.

5. Select the required option from the Select Portal Type window.

6. Click the Save and Continue button.

The portal is created and the Basic screen appears.

For information on parameters of the Basic screen, see The Basic screen parameters.

7. Click the next tab.

Depending on the option you select, you will either see a Limits screen or portal-specific screen.

l For a Self Registration X portal type, follow the additional steps described in Creating Self Registration X
portal.

l For the Sponsored Guest X portal type, follow the additional steps described in Creating Sponsored
Guest X portal.

l For the Voucher portal type, follow the additional steps described in Creating Voucher portal.

l For the WiFi4EU portal type, follow the additional steps described in Creating WiFi4EU portal.

l For the Microsoft Azure X portal type, follow the additional steps described in Creating Microsoft Azure X
portal.

l For the Google Login X portal type, follow the additional steps described in Creating Google Login X
portal.

8. Configure the parameters of the Limits screen.

For information on parameters of the Limits screen, see The Limits screen parameters.

9. Click the Design tab.

The Design screen appears.

10. Configure the parameters of the Design screen.

For information on parameters of the Design screen, see The Design screen parameters.

11. Click the WLANs tab.

The WLANs screen appears.



Figure 498 The WLANs screen

12. Click the Assign WLANs button.

The Assign WLANs window appears.

Figure 499 The Assign WLANs window

13. Select the required WLAN(s) and click Assign. For example, testWLAN.

The selected WLAN is added to the WLANs page.

Figure 500 Assigned WLAN

l Use the unlink ( ) icon to unlink a WLAN.

l Use the Save button to apply the changes.

l Use the Close button to exit from the portal.

These buttons are available across all portal types.

Note

l The Voucher, One Click + Voucher, and Voucher + Paid X portal types have
some common parameters that you must configure on their respective Voucher
screens. For information on parameters of the Voucher screen, see The
Voucher screen parameters.
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l The Paid X, One Click + Paid X, and Voucher + Paid X portal types have some
common parameters that you must configure on their respective Plans screens.
For information on parameters of the Plans screen, see The Plans screen
parameters.

14. Click Save.

Configuring common parameters
The following are the common parameters required for creating various portal types in EasyPass:

l The Basic screen parameters

l The Limits screen parameters

l The Design screen parameters

l The Voucher screen parameters

l The Plans screen parameters

The Basic screen parameters
Figure 501 displays the Basic screen parameters.

Figure 501 The Basic screen

Table 134 describes the Basic screen parameters that appear across all portal types on their respective Basic
screens.

Parameter Description
Description A brief description of the portal.
Client Login Event
Logging

Indicates whether the Client Login Event Logging parameter is enabled or disabled.

By default, this parameter is disabled.
Show Advanced

This section consists of settings related to the landing page and pre-login allowed domains.
Landing Page Determines where the users are directed to after they have viewed or interacted with

a splash page or login screen.

Enter the complete URL with the protocol. For example, https://www.google.com

Note: If the landing page field is kept blank, the users are automatically redirected to

Table 134 The Basic screen parameters



Parameter Description
the URL they were trying to access.

Pre-Login Allowed
Domains

Allows the administrators to specify domains that are allowed for access before the
user logs in.

Enter the IP address or domain name.

Note: You can add multiple IP addresses or domain names.

Table 134 The Basic screen parameters

Note

After configuring the Basic Screen parameters, proceed to step 7 described in the
Creating a portal process.

The Limits screen parameters
Figure 502 displays the Limits screen parameters.

Figure 502 The Limits screen

Table 135 describes the Limits screen parameters that appear across all portal types on their respective Limits
screens.

Parameter Description
Session Expiry The specified duration after which a user's session automatically expires,

disconnecting the user from the Wi-Fi network.

The following options are supported:

l 15 Minutes

l 1 Hour

l 1 Day

l 1 Month

l End of Day (Midnight)

l End of week (Saturday)

l Custom

By default, 15 Minutes is selected.

Select the required option from the drop-down list.
Lockout Time The lockout time restricts the ability to create a new session for the specified duration

when a session expires.

Table 135 The Limits screen parameters
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Parameter Description
The following options are supported:

l None

l 15 Minutes

l 1 Hour

l 1 Day

l 1 Month

l End of Day (Midnight)

l End of week (Saturday)

l Custom

By default, None is selected.

Select the required option from the drop-down list.

Note: The Lockout Time parameter is not available for Self Registration X, Sponsored
Guest X, Voucher, Paid X, Microsoft Azure X, and Google Login X portal types.

Client Rate Limit Indicates the client rate limit.

The following options are supported:

l Limited—When the Limited option is selected, the Downlink and Uplink
parameters appear.

l Unlimited

By default, Unlimited is selected.
Downlink This parameter is applicable only when Client Rate Limit is set to Limited.

Downlink of client rate limit in Kbps.

Maximum value: 1000000
Uplink This parameter is applicable only when Client Rate Limit is set to Limited.

Uplink of client rate limit in Kbps.

Maximum value: 1000000
Client Quota Limit Indicates the client quota limit.

The following options are supported:

l Limited—When the Limited option is selected, the Total parameter appears.

l Unlimited

By default, Unlimited is selected.
Total The total client quota in MB or GB.

You can either select MB or GB option from the drop-down list. By default, MB option
is selected.

Note: This parameter supports:

l A minimum of 1 MB and a maximum of 8000000 MB.

Table 135 The Limits screen parameters



Parameter Description
l A minimum of 1 GB and a maximum of 8000 GB.

Note: An additional parameter, Device Limit, must be configured for the following portal types in the Limits
screen:

l Self Registration X

l Microsoft Azure X

l Google Login X

The Device Limit parameter must also be configured for the following portal types:

l Voucher— Use the Vouchers tab to configure the Device Limit parameter.

l Paid X— Use the the Add New Plan window of the Plans screen to configure the Device Limit parameter.
Device Limit Specifies the number of devices that the guest can connect to the wireless network.

Default value: 1

Maximum value supported: 10

Table 135 The Limits screen parameters

Note

After configuring the Limits screen parameters, proceed to step 9 described in the
Creating a portal process.

The Design screen parameters
Figure 503 displays the Design screen parameters.

Figure 503 The Design screen

Table 136 describes the common Design screen parameters that appear across all portal types on their respective
Design screens.

Parameter Description
Logo Logo for the design page.
Text Style Text style for the design page.

The following options are supported:

l Arial

Table 136 The Design screen parameters
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Parameter Description
l Times New Roman

l Verdana

l Tahoma
Color Color for the design page.
Title Title for the design page.
Message Welcome message for the design page.
Terms and Conditions Terms and Conditions for the design page.
Show Powered By Indicates that a service is provided by an organization.

You can disable this parameter.

By default, this parameter is enabled.
Custom fields Select the required field(s) to include in the design

page by clicking the Add Custom Field button.

The following options are supported:

l Date

l Email

l Name

l Number

l Phone

l Text
Connect An option to provide access for users to the internet.

Click the Connect button to access the internet.

This is the default option available on the design page.
Social Login You can enable the required social login option(s).

The following options are supported:

l Google

l Facebook

When social login option(s) are enabled, the design
page contains Sign in with Facebook and Sign in with
Google options.

Note: When Sign in with Facebook and Sign in with

Table 136 The Design screen parameters



Parameter Description
Google options are enabled, they replace the default
Connect option.

Device-specific view options of the design page The view options on the design page are tailored for
various devices.

The following options are supported:

l Desktop View

l Tablet/iPad View

l Mobile View

By default, Desktop View is selected.

Note: The device-specific view options are available
across all portal types on their respective Design
screens.

Note: For the Self RegistrationX portal type, you must also configure additional parameters using the Preview
tab and the Email Template tab.
Preview tab

The Preview tab is selected, by default. The following fields appear on the design page.
Email Enter the email ID. This field is mandatory.
Password Enter the password. This field is mandatory.
Email Template tab

When you click the Email Template tab, the following email template appears:

Note: For the Sponsored Guest X portal type, configuration of additional parameters is required to identify users,
create personalized accounts, verify email ownership, and send targeted notifications to guests. Additionally,
these fields are necessary to notify users of important updates, promotions, or account-related changes.

Configure the following additional parameters:
Guest Name Enter the guest name.
Guest Email Enter the guest email ID.
Sponsor Email Enter the sponsor email ID.
Note: For the Voucher portal type, configure the following additional parameter:
Voucher Code Indicates a voucher code.

Table 136 The Design screen parameters
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Parameter Description
Enter a voucher code.

This is a mandatory field.
Note: For the Paid X portal type, configure either of the following options:
Select a Plan Select the required plan from the drop-down list.
Payment Code The payment code of the plan.

Enter the payment code.
Note: For the Microsoft Azure X portal type, the following option is available:
Sign in with Microsoft Use this option to sign in with Microsoft.
Note: For the Google Login X portal type, the following option is available:
Sign in with Google Use this option to sign in with Google.
Note: For the One click + Voucher portal type, configure either of the following options:
Free You can select this option to provide free access to the

internet.
Voucher You must enter a voucher code when you select this

option.
Note: For the One click + Paid X portal type, configure either of the following options:
Free You can select this option to provide free access to the

internet.
Paid When you select this option, you can either use Select

a Plan or Payment Code option.
Note: For the Voucher + Paid X portal type, configure either of the following options:
Voucher When you select this option, you must enter a voucher

code.
Paid When you select this option, you can either use Select

a Plan or Payment Code option.

Table 136 The Design screen parameters

Note

After configuring the Design screen parameters, proceed to step 11 described in the Creating a portal
process.

The Voucher screen parameters
Table 137 displays the Voucher screen parameters that appear across Voucher, One Click + Voucher, and
Voucher + Paid X portal types on their respective Voucher screens.

Parameter Description
Voucher Plan Name Name of the voucher plan.

Note: This parameter supports:

l A minimum of one and maximum of 64 characters.

l Only alphanumeric, underscore (_), and dashes (-).

This parameter is mandatory.

Table 137 The Voucher screen parameters



Parameter Description
Quantity Quantity (in integers) of the voucher.

Minimum value: 1

Maximum value: 2000
Voucher Message Message for the voucher.

This parameter supports a minimum of one and maximum of 128 characters.
Session Expiry For information on this parameter, see Table 135.
Voucher Expiry The expiry time of the voucher.

The following options are supported:

l 15 Minutes

l 1 Hour

l 1 Day

l 1 Month

l End of Day (Midnight)

l End of week (Saturday)

l Custom

By default, 1 Day is selected.

This parameter is mandatory.
Client Rate Limit

For information on these parameters, see Table 135.

Downlink
Uplink
Client Quota Limit
Total
Device Limit
Bind Voucher to Device Allows you to associate a voucher with a specific device.

By default, this parameter is disabled.
Unlimited Enable or disable the parameter.

By default, this parameter is disabled.

If you enable the check box, you can connect unlimited number of devices.

Table 137 The Voucher screen parameters

The Plans screen parameters
Figure 504 displays the Plans screen parameters that appear across Paid X, One Click + Paid X, and Voucher +
Paid X portal types on their respective Plans screens.
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Figure 504 The Plans screen

Note

Before selecting a payment gateway, you must add a plan.

To add and manage a plan, complete the following steps:

1. Click the Add Plan button (as shown in Figure 504).

The Add New Plan window appears.

Figure 505 The Add New Plan window

Table 138 describes the common Plans screen parameters that appear across Paid X, One Click + Paid X,
and Voucher + Paid X portal types on their respective Plans screens.



Parameter Description
Plan Name Name for the plan.

This parameter supports a minimum of one and maximum of 32 characters.

Note: Alphanumeric and special characters are supported.

This parameter is mandatory.
Plan Cost Cost for the plan.

This parameter is mandatory.
Currency Currency for the plan.

By default, USD is selected.
Session Expiry

For information on these parameters, see Table 135.

Client Rate Limit
Downlink
Uplink
Client Quota Limit
Total
Device Limit
Unlimited Enable or disable the parameter.

If you disable the check box, you must specify the device limit.

If you enable the check box, you can connect unlimited number of devices.

Table 138 The Add New Plan window parameters

2. Click the Add button (as shown in Figure 505).

The plan is added.

Figure 506 Plan added

Note

Use the edit ( ) icon to modify a plan.

3. Select the required payment gateway option from the Payment Gateway drop-down list (as shown in Figure
507).

Figure 507 Payment gateway options
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The following options are supported:

l IP Pay

l Quickpay

Note

Set the mandatory fields for the selected payment gateway option(s).

Figure 508 displays the parameters available for the IP Pay payment gateway.

Figure 508 The IP Pay option

When you select the IP Pay option, you must configure the parameters described in Table 139.

Parameter Description
Callback URL A URL that is called back by the payment gateway after a transaction is processed.

Configure the Callback URL in the IPPay application settings.
Paypage URL A URL that users are redirected to when they are asked to pay for a transaction. This

URL typically points to a payment page where the user can enter the payment
information.

Enter the paypage URL.

This parameter is mandatory.
Paypage API A paypage API to create and manage payments, and retrieve payment information.

Enter the Paypage API.

This parameter is mandatory.
Merchant ID A merchant ID to identify the merchant.

Enter the merchant ID.

This parameter is mandatory.
Customer ID A customer ID to identify the customer.

Enter the customer ID.

This parameter is mandatory.
Note: Terminal ID and Password fields are populated, by default.
Terminal ID A terminal ID to identify the terminal and authenticate transactions processed through it.

Table 139 Parameters specific to the IP Pay option



Parameter Description
Password A password to authenticate the user.
Note: The parameters of the IP Pay option are also applicable to One Click + Paid X and Voucher + Paid X
portal types.

Table 139 Parameters specific to the IP Pay option

Figure 509 displays the parameters available for the Quickpay payment gateway.

Figure 509 The Quickpay option

Parameter Description
Callback URL A URL that is called back by the payment gateway after a transaction is processed.

Configure the Callback URL in the QuickPay application settings.
Note: Merchant ID and Merchant key fields are populated, by default.
Merchant ID A merchant ID to identify the merchant.
Merchant key A merchant key to authenticate the merchant's identity.
Payment Window
Agreement ID

Payment window agreement ID.

Enter the payment window agreement ID.

This parameter is mandatory.
Payment Window API
Key

Payment window API key.

Enter the payment window API key.

This parameter is mandatory.
Note: The parameters of the Quickpay option are also applicable to One Click + Paid X and Voucher + Paid X
portal types.

When you select the Quickpay option, you must configure the parameters described in Table 140.

Table 140 Parameters specific to the Quickpay option

Accessing the common tabs
The following common tabs are available for various portal types in EasyPass:

l Sessions

l Guests
o Adding a new guest user

l Vouchers
o EasyPass
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l Paid Transactions X

l Users X

Sessions
You can access the Sessions page using the Sessions tab from, as shown in Figure 510, from any of the portals.

Figure 510 The Sessions page

The Sessions tab includes two sections:

l Client Session—Administrators can view the details of all client sessions.

l Client Login Events—Administrators can view the details of all the sessions of client login events.

Note

l The Client Login Events section displays the client login events only if the Client
Login Event Logging check box is selected on the Basic screen. This checkbox is
available across all portal types.

l The Client Login Events section displays the login events for 7 days.

Administrators can export the client login events using the following options:

l Export page as CSV

l Export page as PDF

l Export all as CSV

Guests
The Guests page allows you to view details of self-registered guests connecting to the wireless network.

You can access the Guests page using the Guests tab (as shown in Figure 511).

Figure 511 The Guests page

Note

The Guests tab appears only for the Self Registration X portal type.



Adding a new guest user
You can also add a new guest user from the Guests page.

Complete the following steps to add a new user:

1. On the Guests page, click Add New.

The Add New User window appears.

Figure 512 The Add New User window

2. In the Name field, enter the name of a user. This field is mandatory.

3. In the Email field, enter an email ID of the user. This field is mandatory.

4. In the Notes field, enter the description for creating a new user. This field is optional.

5. Click the Add button.

The User added successfully window appears with a message showing a new password (as shown in Figure
513).

Figure 513 The User added successfully window

6. Click OK.

A new guest user is added (as shown in Figure 514).

Figure 514 The new guest user details

You can view the details of the self registered guest connected to the Wi-Fi network (as shown in Figure 514).
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Note

l Use the disable access ( ) icon to disable
access.

l Use the reset password ( ) icon to reset a
password.

l Use the extend session ( ) icon to extend a
session.

l Use the edit ( ) icon to edit the user details.

l Use the delete ( ) icon to delete a user.

Vouchers
You can access the Vouchers page using the Vouchers tab (as shown in Figure 515).

You can view a list of created vouchers, edit an existing voucher plan, and add a new voucher plan using the
Vouchers tab. You also have options to add vouchers and delete all expired voucher(s).

Figure 515 The Vouchers tab

Note

The Vouchers tab appears only for the Voucher, One Click + Voucher, and Voucher +
Paid X portal types.

Paid Transactions X
You can access the Paid Transactions X page using the Paid Transactions X tab (as shown in Figure 516).

Figure 516 The Paid Transactions X tab

Note

The Paid Transactions X tab appears only for the Paid X, One Click + Paid, and Voucher
+ Paid X portal types.

Users X
You can access the Users X page using the Users X tab (as shown in Figure 517).



Figure 517 The Users X tab

Note

The Users X tab appears only for the Microsoft Azure X and Google Login X portal types.

Creating One Click portal
You can create a One Click portal to provide guests with quick Wi-Fi access, adherence to policies, customized
brand experiences, and secure Wi-Fi management with timing controls.

Figure 518 The One Click option

Note

To create a One Click portal, complete the initial steps described in Creating a portal and
continue with the next steps to configure the parameters of the Basic screen, Limits
screen, Design screen, and WLANs screen.

Creating Self Registration X portal
You can create a self-registration portal to provide guests with easy account management, minimize IT
involvement, offer SMS integration, email password delivery, sponsor workflow approvals, and enhance security
and access control.

This section includes only the additional parameters that you must configure for the Self Registration X portal.

Figure 519 The Self Registration X option

Note

To create a Self Registration X portal, complete the initial steps described in Creating a
portal and continue with the next steps to configure the parameters of the Basic screen,
Self Registration screen, Limits screen, Design screen, and WLANs screen.

Follow these additional steps to create a Self Registration X portal:
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1. From the Basic screen, click the Self Registration tab.

The Self Registration screen appears.

Figure 520 The Self Registration screen

2. Configure the parameters described in Table 141.

Parameter Description
Approval required Enable or disable this option. By default, this option is disabled.

When this parameter is enabled, you must provide the approver email ID(s) in the
Approver Emails field.

When this parameter is enabled, you have an option to select the required mode.
Approver Emails This parameter is applicable when the Approval required check box is selected.

Indicates the approver email ID(s) that must be provided.

This parameter is mandatory.
Mode This parameter is applicable when the Approval required check box is selected.

The following options are supported:

l Manual—The sponsor receives an email with a link to approve the access
request from the guest. Once the sponsor approves, the guest receives an
email confirmation with password to access the network.

l Auto—If the guest provides a configured sponsor's email, the password to
access the network is automatically emailed to the guest and the sponsor is
also notified through email.

Receive password via text

By default, the guests receive the password through email address and text message.
Enable Select the Enable check box. This parameter is disabled by default.

When you select the Enable check box, the SMS Gateway Provider option is
enabled.

SMS Gateway Provider Select the required SMS gateway option to be used to send the OTP to the
guest's mobile device.

Table 141 The Self Registration screen parameters



Parameter Description
By default, the Twilio option is selected.

The following gateway options are supported:

l Fast SMS

l Generic SMS API

l SMS Country

l SMS Gupshup

l SMSAPI

l Twilio

l Victory Link SMS

Each of these gateway options can be configured with their respective
parameters. For more information on the gateway options, see SMS Gateway
Providers section.

Table 141 The Self Registration screen parameters

SMS Gateway Providers
This section describes the different types of SMS gateway providers.

Figure 521 displays the parameters available for the Twilio option.

Figure 521 Twilio option

When you select the Twilio option, you must configure the parameters described in Table 142.

Parameter Description
Note: The Username and Password fields are populated, by default.
Auth Token Auth token.

Enter the auth token.
Account SID Account SID.

Enter the account SID.
From Select the required country code from the drop-down list and enter the mobile

number.
OTP Template OTP template.

Table 142 Parameters of Twilio
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Parameter Description
Enter the password in the OTP Template field.

This parameter is mandatory.

Table 142 Parameters of Twilio

Figure 522 displays the parameters available for the Generic SMS API option.

Figure 522 Generic SMS API option

When you select the Generic SMS API option, you must configure the parameters described in Table 143.

Parameter Description
SMS Gateway Provider
Name

SMS gateway provider name.

Enter a name for the SMS gateway provider.

Enter the user name.

Table 143 Parameters of Generic SMS API



Parameter Description
HTTP Request Type HTTP request type.

The following options are supported:

l HTTP GET Request

l HTTP POST Request
HTTP Request Header
Key

HTTP request header key

HTTP Request Header
Key Value

HTTP request header key value

API URL API URL

Enter the API URL.
API URL Information API URL information.

Enter the API URL information.
Message Parameter
Name

Message parameter name.

Enter the message parameter name.
Mobile Number
Parameter Name

Mobile number parameter name.

Enter the mobile number parameter name.
Show Advanced

This section consists of advanced settings related to API reply type.
API Reply Type API reply type.

Select the required option from the drop-down list.

The following options are supported:

l Text

l JSON

l XML
Text
Success Success message.

Enter the success message.
Failure Failure message.

Enter the failure message.
JSON
JSON Reply Success Key
Name

JSON reply success key name.

Enter the JSON reply success key name.
JSON Reply Success Key
Value

JSON reply success key value.

Enter the JSON reply success key value.
JSON Reply Failure Key
Name

JSON reply failure key name.

Enter the JSON reply failure key name.

Table 143 Parameters of Generic SMS API
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Parameter Description
JSON reply Failure Key
Value

JSON reply failure key value.

Enter the JSON reply failure key value.
XML
XML Reply Success
Element

XML reply success element.

Enter the XML reply success element.
XML Reply Success
Element Value

XML reply success element value.

Enter the reply success element value.
XML Reply Failure
Element

XML reply failure element.

Enter the XML reply failure element.
XMl Reply Failure
Element Value

XML reply failure element value.

Enter the XML reply failure element value.
Country Code Country code.

Select the required country code from the drop-down list. For example, United
States (+1)

OTP Template OTP template.

Enter the password in the OTP Template field.

This parameter is mandatory.

Table 143 Parameters of Generic SMS API

Figure 523 displays the parameters available for the Fast SMS option.

Figure 523 Fast SMS option

When you select the Fast SMS option, you must configure the parameters described in Table 144.

Parameter Description
Username User name.

Enter the user name.

This field is optional.
Note: The Sender ID and API key fields are populated, by default.
Account Type Account type.

Select the required option from the drop-down list.

Table 144 Parameters of Fast SMS



Parameter Description
The following options are supported:

l Transaction

l Promotional

l International

l OTP

l Other
OTP Template OTP template.

Enter the password in the OTP Template field.

This parameter is mandatory.

Table 144 Parameters of Fast SMS

Figure 524 displays the parameters available for the SMS Country option.

Figure 524 SMS Country option

When you select the SMS Country option, you must configure the parameters described in Table 145.

Parameter Description
Note: The Username and Password fields are populated, by default.
Sender ID Sender ID.

Enter the sender ID.
Country Code Country code.

Select the required country code from the drop-down list. For example, United
States (+1)

OTP Template OTP template.

Enter the password in the OTP Template field.

This parameter is mandatory.

Table 145 Parameters of SMS Country

Figure 525 displays the parameters available for the SMS Gupshup option.
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Figure 525 SMS Gupshup option

When you select the SMS Gupshup option, you must configure the parameters described in Table 146.

Parameter Description
Note: The Username and Password fields are populated, by default.
Sender ID Sender ID.

Enter the sender ID.
Country Code Country code.

Select the required country code from the drop-down list. For example, United
States (+1)

OTP Template OTP template.

Enter the password in the OTP Template field.

This parameter is mandatory.

Table 146 Parameters of SMS Gupshup

Figure 526 displays the parameters available for the SMS API option.

Figure 526 SMS API option

When you select the SMS API option, you must configure the parameters described in Table 147.

Parameter Description
Note: The Username and Password fields are populated, by default.

Table 147 Parameters of SMS API



Parameter Description
Access Token Access token.

Enter the access token.
Sender Name Sender name.

Enter the sender name.
Fast Delivery Enable the check box.

By default, the check box is disabled.
Template Name Template name.

Enter the template name.
Country Code Country code.

Select the required country code from the drop-down list. For example, United
States (+1)

OTP Template OTP template.

Enter the password in the OTP Template field.

This parameter is mandatory.

Table 147 Parameters of SMS API

Figure 527 displays the parameters available for the Victory Link SMS option.

Figure 527 Victory Link SMS option

When you select the Victory Link SMS option, you must configure the parameters described in Table 148.

Parameter Description
Note: The Username and Password fields are populated, by default.
Language Language.

Enter the language.
Sender ID Sender ID.

Enter the sender ID.
OTP Template OTP template.

Enter the password in the OTP Template field.

This parameter is mandatory.

Table 148 Parameters of Victory Link SMS
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Creating Sponsored Guest X portal
You can create a sponsored guest portal to enable non-IT staff to create, delete, or extend the validity of guest
accounts.

This section includes only the additional parameters that you must configure for the Sponsored Guest X portal.

Figure 528 The Sponsored Guest X option

Note

To create a Sponsored Guest X portal, complete the initial steps described in Creating a
portal and continue with the next steps to configure the parameters of the Basic screen,
Sponsored Domains screen, Limits screen, Design screen, and WLANs screen.

Follow these additional steps to create a Sponsored Guest X portal:

1. From the Basic screen, click the Sponsored Domains tab.

The Sponsored Domains screen appears.

Figure 529 The Sponsored Domains screen

2. Configure the parameters described in Table 149.

Parameter Description
Sponsor Email Domains Sponsor's domain(s).

This parameter is mandatory.

Table 149 The Sponsored Domains screen parameters

Creating Voucher portal
You can create a voucher portal to create unique guest keys in bulk for retailers, hotels, conventions, and
enterprises providing temporary visitor or guest Wi-Fi access.

This section includes only the additional parameters that you must configure for the Voucher portal.



Figure 530 The Voucher option

Note

To create a Voucher portal, complete the initial steps described in Creating a portal and
continue with the next steps to configure the parameters of the Basic screen, Voucher
screen, Design screen, and WLANs screen.

Follow these additional steps to create a Voucher portal:

1. From the Basic screen, click the Voucher tab.

The Voucher screen appears.

Figure 531 The Voucher screen

2. Configure the parameters described in Table 137.

Creating Paid X portal
You can create a Paid X portal with IP Pay or Quickpay gateway for smooth internet connectivity purchase, and
improving user experience.

Figure 532 The Paid X option

Note

To create a Paid X portal, complete the initial steps described in Creating a portal and
continue with the next steps to configure the parameters of the Basic screen, Plans
screen, Design screen, and WLANs screen.
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Creating WiFi4EU portal
You can create a WiFi4EU portal to provide free Wi-Fi access across the European Union (EU) to citizens and
vistors in public spaces such as parks, squares, administrations, libraries, and health centers.

This section includes only the additional parameters that you must configure for the WiFi4EU portal.

Figure 533 The WiFi4EU option

Note

To create a WiFi4EU portal, complete the initial steps described in Creating a portal and
continue with the next steps to configure the parameters of the Basic screen, WiFi4EU
screen, Limits screen, Design screen, and WLANs screen.

Follow these additional steps to create a WiFi4EU portal:

1. From the Basic screen, click the WiFi4EU tab.

The WiFi4EU screen appears.

Figure 534 General parameters

2. Configure the parameters described in Table 150.

Parameter Description
Language Select the preferred language from the drop-down list.
Network UUID Universally Unique Identifier (UUID) that the EC attributed to the WiFi4EU network

installation.
Enable Self-test
Modus

Allows the browsers background script verification.

Show Logo Displays the WiFi4EU logo provided by the European union.

Table 150 General parameters - WiFi4EU



Creating Microsoft Azure X portal
Creating a Microsoft Azure X portal allows you to combine Wi-Fi access with authentication using Microsoft Office
365 credentials, making it easier for users to connect to the Wi-Fi network and access domain resources.

This section includes only the additional parameters that you must configure for the Microsoft Azure X portal.

Figure 535 The Microsoft Azure X option

Note

To create a Microsoft Azure X portal, complete the initial steps described in Creating a
portal and continue with the next steps to configure the parameters of the Basic screen,
Azure screen, Limits screen, Design screen, and WLANs screen.

Follow these additional steps to create a Microsoft Azure X portal:

1. From the Basic screen, click the Azure tab.

The Azure screen appears.

Figure 536 The Azure screen

Note

Only Microsoft Azure administrator role users can perform the Authorize step.

The Authorize step allows the Easypass Azure application to:

l Make API calls to Microsoft Azure customer

l Sign in users

l Periodically sync the customer Azure directory

l Ensure only active user sessions are maintained or enforce relogin if user group
information changes

2. Click the Authorize button.
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The following screen appears, as shown Figure 537.

Figure 537 Sign in to your account page

NOTE:

For information on how to integrate Active Directory with Azure, see Azure AD
Integration.

Creating Google Login X portal
Creating a Google Login X portal enables users with a Google account to connect to the wireless network by
synchronizing the active directory. When enabled, if a guest who is part of the supported group tries to connect to
the Wi-Fi network, the AP provides access to the guest.

NOTE:

You must have a Google Workspace account before creating a Google Login X portal.

This section includes only the additional parameters that you must configure for the Google Login X portal.

Figure 538 The Google Login X option

Note

To create a Google Login X portal, complete the initial steps described in Creating a
portal and continue with the next steps to configure the parameters of the Basic screen,
Google screen, Limits screen, Design screen, and WLANs screen.

Follow these additional steps to create a Google Login X portal:

1. From the Basic screen, click the Google tab.

The Google screen appears.



Figure 539 The Google screen

2. Configure the parameters described in Table 151.

Parameter Description
Enable
Directory
Synchronizati
on

Select the check box to enable the directory synchronization.

When you select the Enable Directory Synchronization check box, the following screen
appears:

When you click the Follow these steps link, the following window appears describing how to
configure the Google Apps domain category.

Follow the steps to configure your Google Apps domain directory.

Note: For information on how to integrate Active Directory with Google Workspace, see
Google Workspace AD Integration.

When you clear the Enable Directory Synchronization checkbox, you must configure the
Allowed Domains parameter.

Allowed
Domains

Enter the required domain(s).

This is a mandatory parameter.

Table 151 The Google screen parameters

Creating One Click + Voucher portal
Creating a One Click + Voucher portal combines the benefits of both One Click access and voucher-based
promotions, providing users with an easy and cost-effective way to access services.
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Figure 540 The One Click + Voucher option

Note

To create a One Click + Voucher portal, complete the initial steps described in Creating a
portal and continue with the next steps to configure the parameters of the Basic screen,
One Click screen, Design screen, and WLANs screen.

Creating One Click + Paid X portal
Creating a One Click + Paid X portal combines the benefits of One Click access with paid access to services.

Figure 541 The One Click + Paid X option

Note

To create a One Click + Paid X portal, complete the initial steps described in Creating a
portal and continue with the next steps to configure the parameters of the Basic screen,
Plans screen, One Click screen, Design screen, and WLANs screen.

Creating Voucher + Paid X portal
Creating a Voucher + Paid X portal combines the benefits of voucher-based promotions and paid access to
services.

Figure 542 The Voucher + Paid X option

Note

To create a Voucher + Paid X portal, complete the initial steps described in Creating a
portal and continue with the next steps to configure the parameters of the Basic screen,
Voucher screen, Plans screen, Design screen, and WLANs screen.

MarketApps X

This section includes the following topics:



l Overview

l Adding a new MarketApp

l Managed Wi-Fi App
o Basic tab
o Settings tab
o Design tab

l Self-Service Personal Wi-Fi App
o Basic tab
o Personal Wi-Fi configuration

l How to configure units by property managers

Overview
MarketApps is an advanced service within cnMaestro that is designed to enhance network management through
tailored applications. It offers specialized tools that empower Managed Service Providers (MSPs) to deliver greater
value to their customers and end users by addressing their specific needs and challenges.

MarketApps introduces two new apps for the Multi-Dwelling Unit (MDU) market within MarketApps—Managed Wi-
Fi and Self-Service Personal Wi-Fi. These applications simplify management of Wi-Fi services for property
managers, residents, and service providers, by featuring an intuitive and streamlined workflow.

Target audience
l Property managers—MarketApps empowers property managers to centrally administer Wi-Fi access across

their properties. They can set up community-wide Wi-Fi networks and manage personal Wi-Fi networks for
local residents.

l Residents—Residents can set up and manage their own Wi-Fi networks within the community, ensuring
personalized and secure internet access.

l Solution providers—MarketApps helps the solution providers to offer tailored Wi-Fi solutions, enhancing
network performance and user satisfaction in multi-dwelling units and apartment complexes.

Benefits
l Centralized management—Property managers can oversee and control Wi-Fi access across multiple units or

buildings from cnMaestro.

l Customization—Residents can set up personal Wi-Fi networks with customized SSIDs and passwords,
enhancing their user experience.

To access MarketApps, navigate to Network Services > MarketApps in cnMaestro.
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Figure 543 MarketApps

Adding a new MarketApp
To add a new MarketApp, complete the following steps:

1. Navigate to Network Services > MarketApps in cnMaestro.

2. Click the Add New button on the top right corner.

3. A new window Select App Type appears.

4. Enter a name for the new Market App in the Name field.

5. Choose the type of managed account for the app from the Managed Account drop-down box.

6. Select the required app.

7. Click Save and Continue.

The respective app screens appears as discussed in the sections below.

Managed Wi-Fi App
The Managed Wi-Fi App in MarketApps enables property managers to centrally administer and manage Wi-Fi
networks within their properties. This feature provisions both community-wide Wi-Fi networks and personal Wi-Fi
networks for residents, allowing control and customization.



Figure 544 Managed Wi-Fi App type

Basic tab
The Basic tab in MarketApps allows you to provide a description for your Wi-Fi network. The network name and
managed account details are automatically populated and cannot be modified. Enter a brief description to clarify
the network's purpose.

Figure 545 Basic tab parameters

To configure the Basic tab, complete the following steps:

1. Name—Displays the chosen name for the Wi-Fi network.

2. Managed Account—This field is pre-populated based on previous selections.

3. Description—Enter a brief description that clearly explains the intended purpose or specific details of this Wi-
Fi configuration.

4. Click Save.

Settings tab
The Settings tab in MarketApps enables you to configure advanced settings for your Wi-Fi network. You can set up
Community Wi-Fi, Personal Wi-Fi, or other options based on your specific requirements.
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Community Wi-Fi
Community Wi-Fi in MarketApps allows property managers to set up and manage a single SSID for all residents
within a property. This configuration is designed to provide centralized control over Wi-Fi access while ensuring
uniform connectivity for all users.

Figure 546 Community Wi-Fi settings

To configure Community Wi-Fi under the Settings tab in Managed Wi-Fi, complete the following steps:

1. Select the WLAN for the community-wide Wi-Fi network.

Note

Valid WLANs must satisfy the following conditions:

l WLAN’s Personal SSID must be disabled.

l Local ePSK table must not have any existing entries.

l WLAN Security settings must be configured as WPA2 Pre-Shared Keys, WPA3 Pre-Shared
Keys, or WPA2/ WPA3 Pre-Shared Keys.

l WLAN should not be mapped to any existing MarketApps or EasyPass.

2. Select the SSID for the community Wi-Fi from the SSID drop-down list.

3. Click Save.

Personal Wi-Fi
The Personal Wi-Fi option in MarketApps allows residents to set up and manage their own personalized Wi-Fi
networks within the community. This feature provides flexibility and customization for individual units, enhancing
the user experience by allowing residents to manage their SSIDs and passwords.



Figure 547 Personal Wi-Fi settings

To configure Personal Wi-Fi under the Settings tab in Managed Wi-Fi, complete the following steps:

1. Select the WLAN for the personal Wi-Fi network from the WLAN drop-down list.

Note

Valid WLANs must satisfy the following conditions:

l WLAN’s Personal SSID must be enabled.

l WLAN Security settings must be configured as WPA2 Pre-Shared Keys, WPA3 Pre-Shared
Keys, or WPA2/ WPA3 Pre-Shared Keys.

l WLAN should not be mapped to any existing MarketApps or EasyPass.

2. Allow Resident to Change Wi-Fi Settings—Solution providers can enable or disable the option for residents
to configure their own personalized settings.

3. Allow Property Manager to Suspend and Terminate Internet Service—Solution providers can enable or
disable the option for property managers to suspend or terminate internet service.

4. Enter the property manager's email address in the Invite Property Managers text box to send an invitation.
Property managers can activate and oversee internet services for residents within their property.

5. Click Save.

Note

Solution providers can select Community Wi-Fi, Personal Wi-Fi, or both options, depending on their
requirements.

Design tab
The Design tab in MarketApps allows you to customize the branding and appearance of the property manager and
resident portals, ensuring a cohesive and professional user experience.
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Figure 548 Design tab parameters

Table 152 Design tab parameters

Parameter Description
Login Page
Title

Customize a welcome message displayed on the login page

Property Name Specify the property name used for internal identification and email communications.
Logo Upload a logo file (PNG recommended) cropped to the edges and sized up to 200x200 pixels.
Color Theme Customize the portal’s color scheme with a chosen accent color.
Privacy URL Provide the URL to your Privacy Policy that users must acknowledge on first access.
Terms and
Conditions URL

Provide the URL to your Terms and Conditions that users must acknowledge.

Show
"Powered by"

Enable this option to display the Powered by message.

Sample screen The sample screen section includes three views:

1. Property Manager—Displays the Property Manager interface where users can enter their
email and request a one-time link for access.

2. Resident Portal—Shows the Resident Portal interface where users can input their email to
receive a one-time link for accessing their personal Wi-Fi settings.

3. Email—Provides a view of the email format that users receive, which contains a link to
access the Wi-Fi Manager App.



Self-Service Personal Wi-Fi App
The Self-Service Personal Wi-Fi App in MarketApps allows residents to independently manage and customize their
Wi-Fi networks within residential properties. This feature provides residents with the capability to create and
personalize SSIDs for their units, enhancing their control over network settings.

Figure 549 Self-Service Personal Wi-Fi App

Basic tab
The configuration steps for the Basic tab are the same as those detailed earlier in the documentation. For
information on setting the network name, managed account, and description, refer to the Basic tab configuration
steps.

Personal Wi-Fi configuration
Residents can create personalized SSIDs for their units, allowing them to customize their network identification.

Figure 550 Personal Wi-Fi settings

To configure Personal Wi-Fi, complete the following steps:
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1. Select the WLAN for the personal Wi-Fi network from the WLAN drop-down list.

Note

Valid WLANs must satisfy the following conditions:

l WLAN’s Personal SSID must be disabled.

l WLAN Security settings must be configured as WPA2 Pre-Shared Keys, WPA3 Pre-Shared
Keys, or WPA2/ WPA3 Pre-Shared Keys.

l WLAN should not be mapped to any existing MarketApps or EasyPass.

2. Allow Resident to Change Wi-Fi Settings—Solution owners can enable or disable the option for residents to
configure their own personalized configuration.

3. Enable Open SSID option allows residents to connect to the internet, scan the QR code, and access the
resident portal to change their Wi-Fi SSID and password. Administrators can set rate limits for this SSID from
the WLAN settings page.

4. Select the WLAN for the Open SSID network from the WLAN drop-down list.

Note

Valid WLANs must satisfy the following conditions:

l WLAN’s Personal SSID must be disabled.

l WLAN Security settings must be configured as Open or OWE.

l WLAN should not be mapped to any existing MarketApps or EasyPass.

5. Click Save.

How to configure units by property managers
This sections contains the following topics:

l Units managed in the Managed Wi-Fi App
o Assign Unit
o Send Portal Link
o Suspend
o Extend
o Terminate
o View options in the Property Manager App

l Units managed in Self-Service Personal Wi-Fi App

Units managed in the Managed Wi-Fi App
Managed Wi-Fi enables property managers to configure and oversee network settings for units using cnMaestro.

To set up and manage your Wi-Fi networks, complete the following steps:



1. Navigate to the Unit tab and click on the Download Sample Template option to get the sample file.

2. An example of the sample template and parameters is shown below:

Parameter Description
Unit Enter the name or number of the unit (for example, MDU01 and MDU 02 are apartment

numbers).
Serial
Number

Enter the serial number of the device.

VLAN Enter the VLAN ID assigned to the unit.
Personal
SSID

Enter the SSID for the personal WiFi network.

Password Enter the password for the Wi-Fi network.

3. After entering the details, save the Excel file with a new name to ensure you have a copy of the filled template
and import it to cnMaestro. Note this step is crucial to avoid overwriting the original template.

4. During the import, you might encounter validation error messages. Here are some common error messages
and their solutions:

a. Password should be unique—Ensure each unit has a unique password. Modify the password in the
template so no two units share the same password.

b. Device not found in inventory—Ensure the serial number and MAC address entered correspond to
devices that are already registered in the cnMaestro inventory. Make sure to import the details only after
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onboarding the device.

c. Validates the unit—Ensure the unit is less than 32 characters and contains only alphanumeric characters,
underscores (_), hyphens (-), and spaces.

d. Checks for duplicate units—Ensure each unit is unique.

e. Validates the password—Ensure the password is between 8 and 64 characters long and does not include
", ', , /, ?, =, -, +, or spaces.

f. Validates the SSID—Ensure the SSID is less than 32 characters and contains only alphanumeric
characters, underscores (_), hyphens (-), and spaces.

g. Validates the VLAN—Ensure the VLAN is an integer between 1 and 4094.

h. Check if the device is already linked to another EasyApp—Ensure devices are not linked to another
application.

i. Checks for duplicate devices—Ensure each device is unique.

j. Ensures that there is a device present—Verify a device is specified as it is required.

k. Validates that the AP group is linked to the personal WLAN—Ensure the device has an AP group linked
with the personal WLAN.

l. Ensures the SSID is not duplicated—Ensure each SSID is unique.

5. Once the file imports correctly, you can see the Successfully validated the imported CSV message as shown in
the below figure.

6. Click Import and Override to finalize the import process.

Note

After importing, note the following points:



l Ensure the SSID name and password in the Excel sheet remain unchanged unless updated
by the customer.

l Residents can modify their SSID and password through the resident portal later on.

l If Allow residents to change Wi-Fi settings (Figure 547) is enabled, tenants can change
their SSID and password settings, and these changes do not get overwritten later.

7. Once the devices are successfully added, click Save.

8. The property manager receives an email titled Welcome to the Wi-Fi Manager APP and can Sign In.

9. The property manager enters the same email ID provided in the Managed Wi-Fi settings.
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10. clicks Send me a one-time link.

11. The property manager receives an email containing a one-time link for logging into the property manager app.

12. Click Go to Wi-Fi Manager App.

13. The Property Manager app interface is shown below.

Table 153 Wi-Fi Manager App Interface

Options Description
Show All Units Provides a drop-down menu with the following options:

l Show Assigned—Filters the list to display only the assigned units.

l Show Unassigned—Filters the list to display only the unassigned units.

l Show Suspended—Filters the list to display only the suspended units.
Search Allows searching for units or residents by entering the unit number or resident name.



Options Description
Assign Unit Assigns a unit to a resident.
Send Portal Link Sends a link to the resident for accessing the portal.
Suspend Suspends a unit, making it temporarily inactive.
Extend Extends the duration of a unit's assignment.
Terminate Terminates a unit's assignment, making it available for reassignment.

Assign Unit
The Assign Unit option allows property managers to allocate specific units to residents. This feature simplifies
tenant management and facilitates communication between managers and residents.

To assign a unit, follow these steps:

a. Click on Assign Unit in the Property Manager app.

b. A new window titled Assign Unit appears.

c. Select the unit from the Unit drop-down menu.

d. Enter the resident's Full Name.

e. Enter the resident's Email ID.

f. Provide a Description.

g. Set the Start Date for the assignment.

h. Set the End Date for the assignment.

Note: Minimum duration is one day.

i. Review the Duration displayed in days.

j. Click Assign Unit to finalize the assignment.

k. A message confirms Assign Unit action completed successfully.
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l. After updating, if the property manager wants to change any of these parameters, they can do so by clicking
the cursor below the unit as shown.

m. A new window titled Update appears.

n. The property manager can update any details and then click Update.

Send Portal Link
This feature allows you to send the portal link associated with a specific unit to residents or other designated
recipients.

To send a portal link, complete the following steps:

a. Click on the Send Portal Link in the Property Manager app.

b. A new window titled Send Portal Link appears.



c. Select the unit number or name from the Unit drop-down.

d. A new window titled Send Portal Link appears.

e. Click Send Portal Link to send the portal link.

f. A message confirms Send Portal Link action completed successfully.

g. An email is sent to the resident to log in to the resident portal.

Suspend
The Suspend option allows you to temporarily suspend a unit in the Property Manager app.

To suspend a unit, complete the following steps:

a. Click on Suspend in the Property Manager app.

b. A new window titled Suspend appears.

c. Select the unit number or name from the Unit drop-down.
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d. A new window titled Suspend appears.

e. Click Suspend to confirm.

f. A message confirms Suspend action completed successfully.

g. After a unit is suspended, the property owner can resume the unit by clicking the cursor below the unit as
shown below.

h. A new window titled Resume appears.

i. Click Resume to confirm.



j. A message confirms Resume action completed successfully.

Extend
Extend allows you to prolong the duration of a unit's assignment period within the Property Manager app.

To extend a unit, complete the following steps:

a. Click on Extend in the Property Manager app.

b. A new window titled Extend appears.

c. Select the unit number or name from the Unit drop-down.

d. A new window titled Extend appears.

e. Set the End Date for the assignment.

f. Review the Duration displayed in days.

g. Click Extend to confirm.

h. A message confirms Extend action completed successfully.
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Terminate
Terminate allows you to end the assignment of a unit within the Property Manager app.

To terminate a unit, complete the following steps:

a. Click on Terminate in the Property Manager app.

b. A new window titled Terminate appears.

c. Select the unit number or name from the Unit drop-down.

d. A new window titled Terminate appears.

e. Click Terminate to confirm.

f. A message confirms Terminate action completed successfully.

View options in the Property Manager App
In the Property Manager app, there are three different view options to manage units efficiently. These view options
can be accessed using icons located at the top right corner of the Property Manager app interface as shown in
Figure 551.



Figure 551 View options in the Property Manager App

1. Thumbnail View—This view displays units as thumbnails or small images, providing a visual representation of
each unit.

Beneath each thumbnail, you can access options such as Send Portal Link, Suspend, Extend, and Update by
hovering your cursor over the unit.

2. Title View—Units are listed with their names or titles, showing unit name, email ID, start date, and end date for
quick reference.

3. Table View—Table View presents units in a structured table format with columns for Unit, Status, Name, Email,
Start Date, and End Date, allowing for detailed management and organization of unit information.

Units managed in Self-Service Personal Wi-Fi App
Self-Service Personal Wi-Fi App allows users to configure their personal Wi-Fi networks using cnMaestro.

To set up and manage your personal Wi-Fi network settings, complete the following steps:

1. Navigate to the Unit tab and click on the Download Sample Template option to get the sample file.
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2. An example of the sample template and parameters is shown below:

Parameter Description
Unit Enter the name or number of the unit (For example, MDU01 and MDU 02 are apartment

numbers).
Serial
Number

Enter the serial number of the device.

VLAN Enter the VLAN ID assigned to the unit.
Personal
SSID

Enter the SSID for the personal WiFi network.

Password Enter the password for the Wi-Fi network.

3. After entering the details, save the Excel file with a new name to ensure you have a copy of the filled template
and import it to cnMaestro. Note this step is crucial to avoid overwriting the original template.

4. During the import, you might encounter validation error messages. Here are some common error messages
and their solutions:

a. Device does not have an AP group linked with the personal wlan—Ensure each device is only linked to
one application at a time. Verify the device has an AP group associated with the personal WLAN before
proceeding with the configuration.

All the error messages are similar to those described in the Units managed in Managed Wi-Fi sections.

5. Once the file imports correctly, you can see the Successfully validated the imported CSV message as shown
in the below figure.

6. Click Import and Override to finalize the import process.



7. Once the devices are successfully added, click Save.

8. Click the Print All QR Code option on the right side to open a QR scan page.

9. Scan the QR code using your mobile device to get a link.

10. Enter your email ID and click Send me a one time link.
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11. Open the email and click Go to the Wi-Fi Manager App.

12. You see a page titled Welcome to APP and click on Change.



13. A new window titled Change Wi-Fi Settings appears. Change your Personal Wi-Fi Network Name and Wi-Fi
password in the respective fields.

14. Click Update.

15. You receive a message says Wi-Fi settings updated successfully.
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16. Scan the QR code to verify that your Personal Wi-Fi Network Name and Wi-Fi password have been updated.

RADIUS Proxy

Note

l RADIUS Proxy is not supported in cnMaestro Cloud.

l It is available only as a cnMaestro X feature.

Overview
cnMaestro can act as a proxy server to authenticate RADIUS requests for cnPilot Wi-Fi devices. In this scenario,
cnMaestro acts as a Network Access Server (NAS) for the RADIUS server.

The Access Point sends RADIUS packets to cnMaestro , and cnMaestro sends them to the RADIUS server.
cnMaestro can act as a proxy for either authentication or accounting messages, as show in Figure 552.

Figure 552 RADIUS Proxy on cnMaestro On-Premises



Minimum version requirements are as follows:

l Minimum cnPilot AP release version required: 3.3.

RADIUS Proxy Configuration
To configure RADIUS Proxy on cnMaestro , perform the following:

1. Navigate to Shared Settings > AP Groups and WLANs page.

2. Select Enterprise WLAN to edit, and then select AAA Servers.

3. Under AAA servers, select Proxy RADIUS through cnMaestro check box.

4. Configure Authentication Server details.

5. Configure Accounting Server details.

6. Configure NAS-Identifier.

Note

Include NAS-Identifier attribute to use the RADIUS request packets and default the
system name.

7. Push the configuration from cnMaestro to AP.

Figure 553 RADIUS Proxy Configuration

Citizens Broadband Radio Service (CBRS)

This chapter details cnMaestro support for the Citizens Broadband Radio Service (CBRS) subscription which is
required to manage CBRS-compliant devices in the 3.6 GHz band (3550 MHz to 3700 MHz).

This topic describes the following sections:

l Enabling CBRS in Cloud

l Management Tool

l Domain Proxy View

l Actions for Existing CBRS On-Premises Users

919 | Citizens Broadband Radio Service (CBRS) Cambium cnMaestro Cloud | User Guide



920 | Citizens Broadband Radio Service (CBRS) Cambium cnMaestro Cloud | User Guide

Enabling CBRS in Cloud
1. Login to a cnMaestro Cloud NMS account or Cloud Anchor account (if hosting on an On-Premises instance).

2. Navigate to Network Services > CBRS page.

3. Select the preferred SAS vendor from the Spectrum Access System (SAS) drop-down list.

Figure 554 Network Services > CBRS > Account tab

4. Read both the terms and conditions, and accept them by selecting the checkboxes.

5. Click Enable.

6. In the Billing Information window configure the following details:

l Business Contact
o First Name
o Last Name
o Email



o Phone
o Street Address
o Zip Code
o Country
o State

l Technical Contact

Enable Same as Business Contact or enter a separate Technical Contact.
o First Name
o Last Name
o Email

l SAS Portal Contact

Cambium Networks creates the SAS portal account on behalf of the operator.

7. Click Save.

The CBRS account is enabled.

After you save the CBRS account, you must complete the following steps:

1. The Account page displays the following information and configurable parameters:

l Token

l Status

l Total Devices

l SAS

l Contact Details

l Payment Details
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a. Token:

Token used for authenticated communication with SAS through Cambium Domain Proxy. It gets
generated automatically once CBRS is enabled for the Cloud account.

b. Status:

Displays the account status.

Pending Status Success Status

i. Account Creation: Displays as Account Created once the account is enabled. Refer to Step f
for entering contact information and enabling account.

ii. Payment Method: Displays as Verified once the Payment Details are approved. Refer to Step
gPayment Details.

iii. SAS ID: Once the payment details are verified, the SAS ID is allocated automatically.

Note

When the SAS ID allocation is pending or unavailable in the server,



even after the payment details are configured and verified,

It may take up to one day for the SAS ID to be allocated.

iv. Effective:

l Grey: indicates the Pending Status.

l Green: indicates Success Status.

l Red: indicates the account has been Deactivated.

c. Total Devices: Displays the count of Total Devices registered with the SAS using the Token ID.
Usage History provides the list of devices registered with Month and Year.

Note

Initially the device counts will be 0 APs and 0 SMs.

d. SAS: Displays the SAS vendor preferred by the operator.

Note

Contact Cambium support to disable CBRS operation or to change SAS Vendor.

e. SAS: An operator needs to select which SAS vendor they prefer.

f. Contact Details:

For new CBRS account migrations, this information would have already been entered in Citizens
Broadband Radio Service (CBRS). Review and update if necessary, else refer to Payment Details.

Cambium Networks selectively communicates with both the Business Contact and the Technical
Contact with changes of interest: such as SAS administrator updates, CBRS initiative changes from
the CBRS Alliance and WInnForum, and announcements of new Cambium Network CBRS features
and options.

Business Contact

Cambium Networks communicates with the Business Contact for all commercial aspects of the
CBRS Service such as invoicing, payment, change in terms, change in pricing, and other details. This
page requires:

l First Name

l Last Name

l Email

l Phone

l Street Address

l City

l Zip code/Postal Code

l State

l Country
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Technical Contact

Cambium Networks communicate with the Technical Contact: such as software updates, release
notes, learning guides, technical issues, etc.

l First Name

l Last Name

l Email

SAS Portal Contact

Cambium Networks sets up the SAS portal account on behalf of the operator. Please select whether
to use the Business Contact, Technical Contact, or Other.

Note

Google requires a Gmail address for registration.

l Click Update.

Note

Clicking Update on the Account Page overwrites the current entries.

g. Payment Details

Select one of the payment methods below:

l Add Credit Card Details

l Add ACH Payment Method



Add Credit Card Details

Enter the following and click Submit:

l 16 digit Credit Card Number.

l Expiration Date and Year on the card.

l CVV and Cardholder Name.

Add ACH Payment Method

Enter the following details and click Submit:

l ABA/Routing Number.

l Bank Account Number.
o Select one of the following for Account Type:

n Checking

n Saving

n Business Checking
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l Bank Name and Account Holder Name.

Management Tool
The Management Tool allows one to register CBRS devices to the SAS provider before physically connecting
CBRS-complaint devices to the network. The following Cambium CBRS-compliant devices operate in 3.6 GHz band
frequency, ranging from 3550 to 3700 MHz:

Note

The CBRS Multi-Grant feature was first supported in cnMaestro 3.0.2 and PMP 20.2.

l PMP 450b 3 GHz

l PMP 450m AP 3 GHz

l PMP 450i AP and SM 3 GHz

l PMP 450 AP and SM 3.6 GHz

l PTP 450i BHM and BSHS 3 GHz

l PTP 450 BHM and BHS 3.6 GHz

l LTE 3 GHz cnRanger 201 SM

l LTE 3 GHz cnRanger 210 RRH

The CBRS procedure can be performed by an authorized CPI (Certified Professional Installer). CPIs are required to
enter necessary credentials to update the CBRS parameters.

A CBRS sector view is shown below:

Export
The Export button allows one to export multiple device reports in the CSV format.



Relinquish Grant
The Relinquish Grant button relinquishes all grants of selected sector and places devices in the Registered state.
The device will start the Multi-Grant procedure if the Multi-Grant feature is enabled on the device.

Note

l Relinquish Grant can be performed only for the Config_Synced devices running in Single Grant.

l PMP devices must be upgraded to release 20.2, which supports the Multi-Grant feature.

Relinquish grant creates a job in Action page, when relinquish of sector is initiated from Management Tool page.

Creating a Management Tool Sector
A sector can be created by two ways:

l Add AP/BHM/RRH: Add all parameters manually of an AP/BHM/RRH.

l Import Sector: Upload a file with details from all sector devices.

Add AP/BHM

1. Navigate to Services > CBRS > Management Tools and click Add AP/BHM/RRH.

2. Enter all parameters under the following categories when the user selects the Mode as AP/BHM:
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l Common parameters: Device Name, Mode, Device Type, MAC Address, and MSN.

l Location related parameters: Latitude, Longitude, Height, and Height Type, Horizontal Accuracy, and
Vertical Accuracy.

l Antenna related Parameters: External Antenna Gain, Beamwidth, Azimuth, and Down Tilt.

l Co-Existence related parameters: Sector ID, Spectrum Reuse ID, and Include User ID.

Note

Include User ID parameter is applicable only for PMP devices, when SAS is Federated Wireless.

Select Yes or No to Include the user ID.

l Add CPI Certificate: Certificate File, File Password, CPIR Name.

3. Click Add to add a sector.

Add RRH

1. Navigate to Services > CBRS > Management Tools and click Add AP/BHM/RRH.

2. Enter all parameters under the following categories when the user selects the Mode as RRH:

l Common Parameters: Device Name, Mode, Device Type, MAC Address, and MSN.

l Location Related Parameters: Latitude, Longitude, Height and Height Type, Horizontal Accuracy, and
Vertical Accuracy.

l Antenna Related Parameters: External Antenna Gain, Beamwidth, Azimuth, and Down Tilt.

l ECGI Related Parameters: PLMN ID, ECI (eNode ID + PCI), and ECGI.



l Co-Existence Related Parameters: Sector ID and Spectrum Reuse ID.

l Add CPI Certificate: Certificate File, File Password, CPIR Name.

3. Click Add to add a sector.

Note

Refer to CBRS Device Parameters for additional details.

Import Management Tool Sector
To import a sector:
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1. Navigate to Services > CBRS > Management Tool and click Import Sector button.

1. Click Download Template if user does not have an Import Sector template. Users can download two different
template formats:

a. PMP: Excel or ODS

b. LTE: Excel or ODS

2. Click Import Excel to select Import Sector template file. File must be Microsoft Excel format (.xlsx) or
OpenDocument Spreadsheet (ods) format.

3. Enter CPI credentials:

a. Upload CPI Certificate File by clicking Import Certificate.

b. Enter CPI File Password.

c. Enter CPI Registered Name.

4. Enter the Sector ID.

5. Select Spectrum Reuse ID from the drop-down.

6. Select Include User ID.

Selecting Yes in the Include User ID parameter prefixes the User ID to the Sector ID and Spectrum Reuse ID
in the registration message of the SAS.

Note

l Include User ID is applicable only for PMP devices, when SAS is selected as Federated
Wireless.

l See the CBRS Consolidated Procedures Guide and the Cambium PMP Release 20.3 training
slides for more details on when to select Yes or No.

7. Click Import.

Import status is displayed as Success, Info, and Invalid.

8. Details of Success, Info, and Invalid section can be seen by clicking expand ( ) arrow.



9. If the device is already claimed, it can be onboarded by clicking the onboard link.

Management Tool Sector Statistics
To view Sector Statistics:

1. Navigate to Services > CBRS > Management Tool.

2. Click View Sector Statistics under Status.

3. Sector Statistics window pops up.

Note

Refer to the CBRS State Diagram for additional details.

Search Management Tool Sector
To search for a sector:

1. Navigate to Services > CBRS > Management Tool.

2. Select CBSD or MAC.

l For CBSD: Search by CBSD ID.

l For MAC: Search by MAC Address.

3. Enter text in search box to display filtered records.

Note

l If an AP device is entered into Search, it displays both AP devices and the related SM
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devices.

l If an SM devices is entered into Search, it displays only SM devices.

1. Filter AP or sectors can be cleared by clicking or Clear button.

Sector View

1. Click a sector from the Sector AP column to get the list of devices.

2. All devices of the sector are displayed.

Sector Details View

l The Sector Details view displays the following fields by default:
o Device Name, Device Type, Mode, Health, MSN, Latitude, Longitude, Sync Expiry Time, Height, Registered,

Sync State, Actions.

Note

If the device is Config_Synced, the CBSD state of the device will be updated from the device in
real-time.

l SM can be added in the sector by manually entering all parameters using Add SM button or uploading a file
containing all SM details using Import SMs button.

l Action column can edit or delete any device in the sector. Edit and Delete buttons are available depending
upon the device state. Refer to Edit device and Delete device for more details.

l To include additional fields to be displayed in the Sector Details view, select required fields in the column



selector( ).

l User can use following button to control the CBRS procedure:

o Start and Stop: manage to start and stop CBRS procedure of a sector.
o Reinitialize: restarts the CBRS procedure and reinitializes the devices.
o Deregister: deregisters the device (single or multiple).
o Spectrum Inquiry: checks the availability of frequencies.
o Delete: deletes the device (single or multiple).
o Unblock: clears the de-registered state on an LTE, allowing a registration or reregistration request.
o Export: exports the sector data in .xlsx format.
o Import: imports the SM in the sector.
o Relinquish Grant: relinquishes grants generated in Wide-Grant mode.

l Once the sector is authorized (AUTHORIZED state), button transfers grant details from the Management
Tool to real devices.

Add SM or BHS

1. Navigate to Services > CBRS > Management Tool > select a sector.

2. Click Add SM or BHS to add SM in a sector.
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3. Enter all parameters under following categories:

l Common parameters: Device Name, Device Type, MAC Address, and MSN.

l Location related parameters: Latitude, Longitude, Height and Height Type, Horizontal Accuracy, and
Vertical Accuracy.

l Antenna related parameters: Integrated Antenna Gain, Beam width, Azimuth, and Down Tilt.

l Add CPI Certificate: Certificate File, File Password, and CPIR Name.

4. Click Add to add an SM.

Import SMs

1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Import button to import SMs into a sector.

3. Enable the ReImport Devices to overwrite the previous imported data and deregister all existing devices.



4. Click Download Template if user does not have Import Sector template. Users can download two different
template formats:

l PMP: Excel or ODS

l LTE: Excel or ODS

5. Click Import Excel to select Import Sector template file. File must be Microsoft Excel format (.xlsx) or Open
Document Spreadsheet (ods) formats.

6. Enter the following CPI credentials:

l Upload CPI Certificate File by clicking Import Certificate button.

l Enter CPI File Password.

l Enter CPI Registered Name.

7. Click Import.

Import status will be shown under Success, Info, and Invalid sections.

8. Details of Success, Info and Invalid can be seen by clicking .

9. If the devices is already claimed, it can be onboarded by clicking the onboard link.

10. Once the user clicks Import, a job is scheduled.
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Export Sector

1. Navigate to Services > CBRS > Management Tool and then select a sector.

2. Click Export button to export the sector (export as xlsx).

3. Once the user clicks Export, a job is scheduled.

4. Once the Job status is Completed, Download the Sector xlxs.

Note

Download button is enabled only for two hours after the export job completes.

5. User can use the .xlxs file for importing back into the sector. To import, save the file as shown in the below
figure.

Edit Device

1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Stop button if the CBRS procedure is running.

3. Click Edit button to edit device parameters.

4. Enter CPI credentials:

l Upload CPI Certificate File by clicking Import Certificate button.

l Enter CPI File Password.

l Enter CPI Registered Name.

5. After editing the device. The device should go to derigestered state.



6. Click Save.

Delete Device

1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Stop button if the CBRS procedure is running (the CBRS procedure is running if the START procedure
described below has been invoked, and if all devices in AUTHORIZED state).

3. Deleting SM:

l Select SM to deregister if it is not in UNREGISTERED state (Refer to the CBRS State Diagram).

4. Once the SM selected click Delete and display popup All or Selected. click Selected:

l All: Deletes all registered SM devices.

l Selected: Deletes the selected devices.

5. Click Yes to confirm.
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6. Once the user clicks Yes, a job will be scheduled.

7. Deleting AP:

All SMs of the sector must be deregistered and deleted before deleting the AP. Refer to the Deregistration
procedure to deregister all SM devices.

8. Select the AP of the sector to delete.

9. Click Delete.

Note

If the procedure is started for the device and it is registered, then, while deleting the device, you
must select the Deregister checkbox, otherwise the deletion will fail.

Unblock Device

1. Navigate to Services > CBRS > Management Tool and select a sector.

2. If LTE device is Config Synced, and if device deregister flag is enabled, unblock removes the deregistartion
flag on the device.

3. Once the device is selected, click Unblock and choose All or Selected from the drop-down.

l All: Unblocks all registered devices.

l Selected: Unblocks the selected devices.

4. Click Selected display the Please Confirm window.

5. Click Yes to confirm the action.

Start CBRS Procedure
The Start button starts the CBRS procedure for a sector.



1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Start to start CBRS procedure of a sector.

3. Once the user clicks start, the Spectrum Inquiry window pops up.

Note

l Multi-Grant is enabled by default.

l Sorted By Ranking is applicable for users selecting Google or Federated Wireless SAS.

l User can enable or disable the multigrant only if the device version is less than 21, if device
version is 21 and above only multigrant is possible.

4. User can disable the Multi-Grant feature by disabling the checkbox This feature will enable multi grant on
the tool. For more details refer Multiple Grant.

5. Click Edit to edit Co-Existence Configuration and EIRP Computation.

l Spectrum Reuse ID Statistics displays the devices running on different sector, channels, and bandwidth
based on the Spectrum Reuse ID.

6. Once the Spectrum Inquiry is verified, click Save.

The Sector is created displays as shown below:
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Note

l If the device is already synced with the Management Tool, the CBRS Start and Stop
procedures are not applicable for all the synced devices.

l If user does not see the Start button, it means the CBRS procedure is already running.

l If all devices of the sector are in AUTHORIZED or HALT status and the user tries to start the
CBRS procedure, the Start button will go to Stop state (as CBRS procedure is completed for
all devices).

Multi-Grant
Multi-Grant feature divides selected channel bandwidth into multiple of 10 MHz channels. If the selected channel
bandwidth is 5 MHz or low/high frequency contains 5 MHz raster, the slice would be in 5 MHz channel. Each slice
will initiate a separate Grant procedure.

To enable Multiple Grant for a new sector:

1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Start to start CBRS procedure of a sector.

3. Once the user clicks Start.

The Spectrum Inquiry window pops up as shown below.

Note

l Multi-Grant is enabled by default.

l Include User ID is applicable only for PMP devices, if user selects SAS is either Federated
Wireless.



4. Click Edit to edit Co-Existence Configuration and EIRP Computation.

l Spectrum Reuse ID Statistics displays the devices running on different sector, channels, and bandwidth
based on the Spectrum Reuse ID.

5. Accept the checkbox process of the Co-Existence parameters.

Note

The Federated Wireless or Google SAS might need hours to fully process the Co-Existence
parameters in the Registration, (before they are properly reflected in the Spectrum Inquiry
Response). For more details see the CBRS Standalone Procedures Guide.

6. Once the Spectrum Inquiry is verified, click Save.

A Sector created with Multiple Grants will be displayed as shown below:

7. To view the Grant Status click the info ( ) icon.

Relinquish Grant
Relinquish Grant relinquishes all grants of selected sector. This will make devices enter the Registered state. The
device will start Multi-Grant procedure if Multi-Grant feature is enabled on it.

To Relinquish Grant Perform as follows:

1. Navigate to Services > CBRS > Management Tool and select a sector with Single Grant.

2. Once the SM is selected, click Relinquish Grant to display All or Selected. Click Selected.

l All: relinquish all the registered devices.

l Selected: relinquish the selected device.
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3. Click Yes to confirm the action.

Note

Live update information may take upto several minutes to display the changes of reflected
relinquish status.

4. Once the user clicks Yes, Wider Grant gets converted to the Multiple Grants as shown below:

Stop CBRS Procedure
The Stop button stops the CBRS procedure for a sector.

1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Stop button to stop CBRS procedure.

Note

l If the device is already synced with the Management Tool, the CBRS Start and Stop
procedures are not applicable to the synced devices.

l If user does not see the Stop button, it means the CBRS procedure is already in stopped
state, Start and Stop are toggles.

l If all devices of the sector are in AUTHORIZED state, the CBRS procedure will automatically
stop.

Reinitialize CBRS Procedure
The Re-init button allows the user to start the CBRS procedure for a sector and reinitialize selected devices
(Reinitialize = Start of sector + Reinitialization of user selected devices). At least one device must be selected in
order to enable the Re-init button. Clicking Re-init reinitializes selected devices to UNREGISTERED (irrespective of
previous CBRS state).



1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Stop if the CBRS procedure is already running.

3. Select one or more devices to be reinitialized.

Note

You might notice some delay in enabling Re-init button after pressing Stop. It is due to a delay in
properly stopping the CBRS procedure.

4. Click Re-init to start the reinitialization procedure

5. Confirmation window pops up:

l Click Continue or

l Select Spectrum Inquiry to edit the EIRP values as shown in Start procedure.

Note

l Synced devices cannot be reinitialized.

l Reinitialize modifies or corrects the parameters. For example, if a device is in HALT state due to a
parameter error, the user can stop the CBRS procedure and reinitialize the device after
modifying device parameters.

Deregistration
The deregistration procedure allows user to deregister the devices from the SAS server .

1. Navigate to Network Services > CBRS > Management Tool and select a sector.

2. Click Stop button if the CBRS procedure is already running.

3. Select one or many devices which need to be deregistered.

4. Click Deregister button to deregister selected devices.

Once the user clicks Deregister, a job is scheduled.

5. If the deregistration fails, the reasons will be indicated under .

Spectrum Inquiry

1. Navigate to Services > CBRS > Management Tool and select a Sector.

2. Click Spectrum Inquiry button.

3. Spectrum Inquiry status button is enabled once the device is registered (REGISTERED state) to the SAS.

l If the selected SAS is not Google, EIRP is unsupported, and Spectrum Inquiry is displayed as shown
below:
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l If the users is selected SAS is Google, it supports EIRP. Spectrum Inquiry displays as below:

l GAA: General Authorized Access

l PAL: Priority Access License

Spectrum availability can be checked by hovering over frequencies.

Device Sync
The Sync procedure allows user to transfer grant information from Management Tool to respective device.

For a PMP sector, the Sync action can only be performed on an AP or BHM. The SM and BHS gets synced
automatically when it comes online.

For an LTE sector, which supports a Cambium SM with a 3rd party BBU and RRH, the sync action will sync the
Cambium SMs in this sector.

1. Navigate to Services > CBRS > Management Tool and select a sector.

2. Click Sync button to perform sync procedure.

3. Click Yes on the pop-up or click NO to cancel the sync procedure.

Once Yes is clicked, the Management Tool will check the accessibility of AP/BHM before proceeding with sync.

Note

l PMP SM cannot be manually synced. It is only synced automatically.

l Once the device is synced, for both PMP and LTE devices, primary management is transferred
from the tool to the device itself. However, some actions and procedures are still supported on
the tool. See the CBRS Consolidated Procedures Guide for more details.

l Sync procedure copies complete CBRS parameters to device and enables CBRS to transmit with
configured parameters.

Live Status Update
Once the device is Config synced, CBRS details like CBSD ID, Grant ID, CBSD Grant State, and Last Heartbeat
Time are read from the device every 5 minutes.



It displays the possible single Grant state such as:

l Authorized

l Deregistering

l Grant

l Grant Suspended

l Grant Terminate

l Registered

l Registering

l Relinquished Spectrum

l Relinquishing Spectrum

l Unregistered

l Unknown

Domain Proxy View
Note

Domain Proxy View is available only on cnMaestro Cloud and the Cloud Anchor account.

In Domain Proxy view, Sectors and Non-Sector page helps check CBRS-complaint devices connected through this
server and On-Premises server using the token ID of this server. This page displays all the devices connected to
CBRS.

l Sectors Page: displays the devices according to the parenting AP list.

l Non-Sector Page: displays each individual AP and SM of LTE and PMP.

Searching a Domain Proxy Sector
To search a sector:

1. Navigate to Services > CBRS > Domain Proxy View > Sector page.

2. Select search option CBSD or MAC.
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l For CBSD: Search by CBSD ID

l For MAC: Search by MAC ID.

3. Enter text in search box.

Note

l If AP device is entered , it displays the both AP devices and the related SM device in the
search result.

l If SM devices is entered , it displays only the SM devices in the search result.

4. Filtered device can be cleared by clicking Clear button.

Domain Proxy Sector view
1. Click a Sector from Sector AP column to get the list of devices.

2. All the devices of the sector will be displayed.

3. CBSD state shows current status of device and whether it is registered or deregistered with SAS.

4. Click Deregister to deregister the device from CBRS.

5. The Sectors view displays the following columns by default:

Device Name, Device Type, Mode, User ID, Center Frequency (MHz), Channel BW (MHz), CBSD ID, and Active
S/W Version.

Searching a Domain Proxy in Non Sector View
To search for a device in the non-sector view, complete the following steps:

1. Navigate to Services > CBRS > Domain Proxy View > Non Sector page.

2. Select one of the following search options from the drop-down list—CBSD, MAC Address, or Heartbeat
Status.

l For CBSD, search by the CBSD ID

l For MAC Address: search by the MAC address of the device

l For Hearbeat Status, search by the heartbeat status of registered devices:



o Heartbeating
o Not Heartbeating for Last 24 Hours
o Not Heartbeating for Last 7 Days
o Not Heartbeating for Last 30 Days
o Not Heartbeating for Last 60 Days
o Not Heartbeating for Last 90 Days

Note

Information in the Heartbeat Status and Last Heartbeat columns is displayed only for registered
devices.

cnMaestro checks the heartbeat status of a CBRS device every 12 hours. The following statuses are
updated in the Heartbeat Status column, based on whether the device is online or offline:

l Heartbeating: When the device is online and the heartbeat check is successful.

Also, the last successful heartbeat time is updated in the Last Heartbeat column.

l Not Heartbeating: When the device is offline for 24 hours or more.

CBRS State Diagram
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Note

GRANT_SUSPENDED is a temporary suspend state where HEARTBEAT message is sent for an
extended period of time prior to obtaining the AUTHORIZED state.

CBRS Device Parameters

Category Parameter Details

Common

Channel BandWidth
(MHz)

Channel Bandwidth of AP or BHM in MHz.

Center Frequency
(MHz)

Center frequency of AP or BHM in MHz.

Device Name Name given to device on SAS Admin (A maximum of
120 characters are supported. However, this name is
not copied to the device when synchronized.)

Device Type Drop-down selection of supported devices types.
MAC Address MAC address of the device.
MSN Serial number of device.
User ID Unique identifier is assigned by the SAS. The User ID

is part of the registration request message. The wrong
User ID leads to REGISTRATION_FAILED.

Location

Height Device antenna height in meters.
Height Type Should be AGL or AMSL as follows:

l AGL height is measured relative to the ground
level.

l AMSL height is measured relative to the mean sea
level.

Horizontal Accuracy A positive number in meters to indicate the accuracy
of the device antenna horizontal location.

Latitude Latitude of the device antenna location in degrees.
Longitude Longitude of the CBSD antenna location in degrees.
Vertical Accuracy A positive number in meters to indicate the accuracy

of the device antenna vertical location.
Co-
Existence
Related
Parameters

Sector ID The default AP MAC address (allows editing the
default MAC).

Spectrum Reuse ID  The Spectrum Reuse ID defined in the network.
Include User ID Prefixes the User ID to the Sector ID and Spectrum

reuse ID.

ECGI
Related
Parameters

PLMN ID Public and Mobile Network Identifier.
ECI E-UTRAN Cell Identifier. It is a length of 28 bits and

contains the eNodeB-ID.
ECGI Enter the both PLMN ID and ECI parameters and it

displays in the ECGI field.
Azimuth (degrees) Boresight direction of the horizontal plane of the

antenna in degrees with respect to True North.



Category Parameter Details
Antenna
Parameters

Beamwidth (degree) 3-dB antenna beam width of the antenna in the
horizontal-plane in degrees.

Downtilt (degrees) Antenna downtilt in degrees.
External Antenna
Gain (dBi)

Peak gain of external antenna connected to device in
dBi.

Integrated Antenna
Gain (dBi)

Peak gain of integrated antenna in dBi.

Add
Certificate

Certificate File CPI (Certified Professional Installer) certificate.
CPIR Name CPI registered name.
File Password CPI private password.

Actions for Existing CBRS On-Premises Users
Current CBRS On-Premises customers maintain their CBRS billing and SAS configuration in an NMS Account. This
must be updated to support Anchor accounts. To create an anchor account, refer to Manage Instances.

If an action is required for existing Cloud NMS users, the UI will display the following notification:

After clicking the notice, navigate to Services.

l Link an Anchor Account to this Account: Select if managing CBRS devices in both Cloud and On-Premises. It
creates an Organization that shares configuration between a Primary NMS account and a Secondary Anchor
account (without deregistering existing CBRS devices).

l Convert this Account to Anchor Account: Select only if managing devices On-Premises and NMS do not
have any devices. It converts the existing NMS Account to an Anchor Account.
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Link an Anchor Account to this Account
Select this to manage CBRS devices in both Cloud and On-Premises. An Anchor account must be created to
manage the CBRS On-Premises devices without deregistration.

Note

Cambium recommends selecting this option when the user is managing devices in both cnMaestro
Cloud and On-Premises.

Before linking an Anchor account, please do the following:

l Ensure the cnMaestro Anchor account is linked to the cnMaestro On-Premises instance(s).

l Add the Anchor account as a Secondary account to Primary NMS account. Refer to Create Organization.

To convert the existing account:

1. Navigate to Services > CBRS > Account page.

2. Select Anchor Account from the drop-down list.

Note

Users are allowed to select only one Anchor account from the drop-down list.

3. Enable I authorize Cambium Networks to make changes to the selected account.

4. Click Request Support and a Success window pops up.

Note

The Cambium Support team validates the request and creates an Organization from the NMS and
Anchor accounts within 24 hours. Alternately, you can create the Organization yourself using the
directions specified earlier in this document.



Convert this Account to Anchor Account
Select this to manage CBRS devices in On-Premises only. It converts an existing NMS account to an Anchor
account.

Note

Cambium recommends selecting this option when the user only plans to manage devices using
cnMaestro On-Premises. Cloud account devices must be deregisted and deleted from the NMS
account and registered back to On-Premises before the conversion.

To convert the existing account:

1. Navigate to Services > CBRS > Account page.

2. Select Convert this Account to Anchor Account.

Note

l Deregister and remove all devices from the NMS account before the conversion.

l All NMS configuration will be lost when the account is converted to Anchor, including:
o Guest Access Portal
o Templates
o Performance Graph Data, etc.

l The process of converting an NMS account to an Anchor account cannot be reversed.

3. Provide your consent by selecting the I authorize Cambium Networks to make changes to the selected
account checkbox.

4. Click Request Support and the following success message is displayed.

The Cambium Support team validates the request and creates an Organization from the NMS and Anchor
accounts within 24 hours.
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Organizations for CBRS

An Organization allows multiple accounts to share CBRS billing and SAS ID. The Primary Account owns this
configuration, and the Secondary Account can optionally share it. Both accounts must authorize the sharing.

Note

l There is only one Primary Account in an Organization.

l CBRS configuration can be set in the Primary Account and optionally shared to Secondary
Accounts.

This chapter provides the following information:

l Create an Organization

l Remove Accounts

l Disable Secondary Account Services

l Edit Services

l Share CBRS Configuration with the On-Premises Instance

l Organization History

Create an Organization

Primary Account
Perform the following steps on the Primary Account:

1. Navigate to Network Services > Organization > Accounts.

2. Click Add Secondary Account.

Navigate to the planned Secondary Account and copy the Account ID of the Secondary Account using the
Copy to Clipboard.

3. Paste the copied Account ID in the Secondary Account ID text box.

4. Once the Secondary Account is validated, the Cambium ID is displayed as shown below.



5. The Primary Account can offer services such as:

l Shared SAS ID: This allows the Secondary Account to use the CBRS SAS ID configured in the Primary
Account.

l Unified Payments: This allows the Secondary Account to use payment details configured in the Primary
Account.

Note

Sharing the SAS ID automatically enables Unified Payments.

6. Enable the Services Shared SAS ID or Unified Payments.
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7. Click Add. It displays the Success message as shown below:

Note

The Secondary Account administrator must approve this request from the Primary
Account to join the Organization.

8. 1. In the Secondary Accounts table, the Approval Status is displayed as Waiting for approval.

Secondary Account
Login to the Secondary Account to complete Organization creation. The Secondary Account must approve the
request and authorize the shared services. The Secondary Account can also request additional services (which
must be approved by the Primary Account).

Perform the following steps in the Secondary Account:



1. Navigate to Network Services > Organization > Accounts.

2. Click Approve.

3. The Approve Services window pops up. Review the services requested and click Approve.

Additional service requests from the Secondary Account
Additional services can be added after the Secondary Account joins the Organization, such as including the
Unified Payments Service.

Perform the following steps on the Secondary Account:
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1. Navigate to Network Services > Unified Payments and click Enable.

Note

This generates a request to the Primary Account to provide support for Unified
Payments.

2. Once the services are enabled and approved in the Primary Account, the following displays in the Secondary
Account.



3. The enabled services will be displayed in the Primary Account.

Removing Accounts

Remove through Primary Account
Perform the following steps on the Primary Account to remove the Secondary Account:

1. Navigate to Network Services > Organization > Accounts.

2. In the Secondary Accounts, click Delete ( ) icon.
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3. The Remove From Organization window pop up.

4. Enter the Reason.

5. Click Proceed.

Without Active Services

l If services such as Shared SAS ID or Unified Payments are inactive in the Secondary Account, it can be
deleted without any approval.

l The following message displays if successful.

With Active Services

l If services such as Shared SAS ID or Unified Payments are active in the Secondary Account, the services
need to be disabled from the Secondary Account, and the request must be approved by the Secondary
Account administrator.

Note

l User needs to disable the active services such as Shared SAS ID and Unified
Payments before removing the Secondary Account, or an Error message is
shown.

l Shared SAS ID can be removed by contacting Cambium support to deactivate the
current CBRS account to stop using Shared SAS ID.

l Active Services will be highlighted in Green color.

l The following message displays if successful.



l In the Secondary Accounts table, the UI displays the Approval Status as Delete Pending.

The Secondary Account administrator must approve the remove request from the Primary Account. For more
details, refer to Approve Remove Request (with active services).

Remove Organization from Secondary Account
Perform the following steps on the Secondary Account to remove an Organization:

1. Navigate to Network Services > Organization > Accounts.

a. Click Remove From Organization (without active services).

l To remove the Secondary Account from an Organization with no active services.
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l Click Yes in Please confirm window to remove this account.

b. Approve Remove Request (with active services).

Note

Disable active services before Approve Remove Request.

l If the Secondary Account is using services such as Shared SAS ID or Unified Payments, the following
message displays.

l Click Yes in Please confirm window to approve the request.

2. The following message displays if successful.



Disable Secondary Account services
With no active services
The Secondary Account user can disable services without leaving the Organization.

1. Navigate to Services > Organization > Accounts and select Services.

2. Click Disable.

3. Click Yes in the Please confirm window.

4. After disabling, the following displays.
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5. Click Enable to reactivate the services.

With active shared SAS ID services
Note

Active Services are highlighted in Green color.

The Secondary Account user can disable the Shared SAS ID services.



1. Navigate to Services > Organization > Accounts and select Services.

2. Click Disable in the Shared SAS ID.

3. Click Yes in the Please confirm window.

4. If CBRS account is active in Secondary Account, while disabling it displays the following error message.

If an Error message pops up, the user needs to raise a request to Cambium Support for the SAS vendor
cancellation. Cambium Support will disable the CBRS services and deregister all devices associated to the
Secondary Account.

Once disabled, the Secondary Account user can view the SAS vendor page and create a new CBRS account as
shown below.
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For further information on creating a new CBRS account, refer to CBRS.

Note

Services in the Secondary Account cannot be disabled unless CBRS is inactive in
Secondary Account. Contact Cambium Support to disable CBRS operation or change SAS
Vendor.

With active Unified Payments
The Secondary Account user can disable Unified Payments.

1. Navigate to Services > Organization > Accounts and select Services.

2. Click Disable within Unified Payments.

3. Click Yes in Please confirm window.



4. If Unified Payments is active in CBRS of the Secondary Account, it displays an Error message.

If this happens, the user needs to add new CBRS payment details into the Secondary Account.

For further information on Payment details, refer to CBRS.

The user can disable the Unified Payments once the new payment details are added successfully to the
Secondary Account.

Edit Services
Enable services in the Primary Account
The Primary Account can edit or disable services shared with the Secondary Account as shown below:

Note

When the services are active in CBRS of the Secondary Account, the Primary Account cannot disable
those services.

1. Navigate to Accounts > Secondary Accounts tab.

2. Click Edit ( ) icon.

3. Edit Secondary Account window pops up.
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4. Disable the Services and click Update.



5. The following message displays if successful.

Request services from Secondary Account
If the services are disabled, the Secondary Account needs to make a request to the Primary Account to activate
them.

To request activation, perform the following on the Secondary Account:

1. Navigate to Network Services > Organization > Accounts.

2. Click Request.

3. Click Yes in Please confirm window.

4. It displays the Success message as shown below:

5. Once requested, login to the Primary Account page and Approve the request.
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The Primary Account administrator must approve this request from the Secondary Account in order to enable the
services.

Review service request in Primary Account
Perform the following steps on the Primary Account.

1. Navigate to Services > Secondary Accounts tab.

2. Click Review in Pending Service Request.

3. The Review window pops up. Click Approve.



4. Once approved, the requested services are enabled in the Secondary Account.

Share CBRS Configuration with the On-Premises Instance
Note

Starting with version 3.0.3, cnMaestro supports synchronizing CBRS Configuration to On-
Premises instance.

Once On-Premises is connected to the Anchor Account, the user can synchronize CBRS details (SAS ID, Token) to
the cnMaestro On-Premises instance to register CBRS devices.

l If the user shares (sync) CBRS details configured on Anchor account to connected On-Premises and if any
devices are registered in On-Premises with different CBRS token or SAS ID it displays the deregister error as
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shown below.

Organization History
In Organization History user can view changes to the Organization status over time. This includes details of Primary
Account, Secondary Account, Action, Performed by, and Reason.

To view Organization History:

Navigate to Network Services > Organization > History tab.

LTE

cnMaestro supports LTE as part of its cnMaestro deployment. LTE allows customers to onboard the SM with IMSI
into cnMaestro.

System access in cnRanger is dependent on installation of SIM credentials on every BBU in the operator network.
To ease the operations aspects of SIM card management, cnMaestro provides utilities for claiming, managing, and
distributing Cambium Networks cnRanger SIM card credentials (3rd party SIM cards are not currently supported on
cnRanger).

Adding SIM Cards
To add a SIM card, complete the following steps:



1. Navigate to Network Services > LTE.

2. Click Add New SIM Card. The following window appears.

3. Enter appropriate Serial Number of SIM package and click Validate.

4. After successful validation of the serial number, click Add.

Note

User can download the .CSV file from the Cloud account once the Serial Number is validated from the
cnMaestro Cloud database.

Delete SIM Cards
To delete a SIM card from the list, click Delete. The following window appears.

Note

IMSI numbers get deleted with the mapped Serial Number.

Update SIM Details
User can edit the SIM details as follows.
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1. Navigate to Network Services > LTE.

2. Click the edit ( ) icon for the IMSI that you want to edit.

The Update SIM Details window pops-up.

3. Enter a valid IP Address.

4. Enter the MBR (UL) and MBR (DL).

5. Click Save.

Viewing BBU SIM Status
Allows the users to view the status of the SIM connected to the BBU.



1. Navigate to Network Services > LTE.

2. Click View BBU SIM Status.

Managing Edge Controller

This chapter provides the details about how Edge Controllers are configured to discover PTP 820/850 devices in a
network using SNMP protocol. To view the onboarded Edge Controllers in cnMaestro, perform the following steps:

1. Navigate to Network Services > Edge Controller.

A list of onboarded Edge Controllers in a table format is displayed, as shown in Figure 555.

Figure 555 Edge Controllers

The following parameters are available to view in a table format: Name, IP Address, Status, Managed Account,
Version, Duration, and Topology Sync Status. You can perform the following actions in the Edge Controller
page.

l Topology Sync

l Edit

l Delete

Select the required Edge Controller name in the page, to perform the following actions:

l Topology Sync
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l Edit

l Delete

Topology Sync
Click on the Topology Sync ( ) icon to run topology synchronization for the required Edge Controller.

Edit
1. Click the edit ( ) icon in the Edge Controller page.

The Edit name window appears, edit the name of the Edge Controller.

2. Click Save.

Delete
1. Click the delete ( ) icon in the Edge Controller page.

The delete confirmation window appears.

2. Click Yes.

In the Edge Controller page, you can navigate to the following tabs:

l Dashboard

l Configuration

l Tools

l Monitoring

To view the Edge Controller dashboard, click on the name of the Edge Controller. The Edge Controller dashboard
page appears as shown in Figure 556.



Figure 556 The Edge Controller dashboard

Dashboard
The dashboard page displays status of managed and unmanaged PTP 820/850 devices, details of Edge
Controller, disk space availability, and network details of Edge Controller as shown in Table 154.

Figure 557 Edge Controller and PTP 820/850 devices status

Field Description
Host name Name of the host.
Virtualization Type of virtualization such as VMware or Oracle.
Distribution Type of distribution such as Ubuntu and CentOS versions.
Architecture CPU and Operating System installed.
Number of CPUs Total number of CPUs utilized.
CPU Model Type of CPU model.
Memory Available memory.
Timezone Current timezone.

Table 154 Fields in the Edge Controller dashboard

975 | Managing Edge Controller Cambium cnMaestro Cloud | User Guide



976 | Managing Edge Controller Cambium cnMaestro Cloud | User Guide

Field Description
Date & Time Current date and time.
System Clock Sync Configuration of System Clock Synchronization.
Disk Current Disk space usage.
Status Status of Network Interface Online or Offline.
Name Name of the Network Interface.
IPv4 Address Configured IPv4 Address.
IPv4 Gateway Configured IPv4 Gateway.
IPv6 Address Configured IPv6 Address.
IPv6 Gateway Configured IPv6 Gateway.
MTU Maximum Transmission Unit of network interface of Edge Controller.
License Failures Displays MAC, IP Address, and Reason. The reasons for license failure are as follows:

When the discovery exceeds the slot availability.

When the individual devices are already onboarded in other Cloud account.
Topology Sync Status of Topology Sync.
Version Software version of the device.

Table 154 Fields in the Edge Controller dashboard

Configuration
In the Configuration page, you need to configure SNMP rules to discover and onboard PTP 820/850 devices. The
SNMP tab in the Configuration page displays Configuration Status. TheConfiguration Status displays when the
Edge Controller is In Sync or Not Sync with cnMaestro. The synchronization status is shown in days, hours and
minutes. Next discovery and Previous discovery ran is displayed in minutes as shown in Figure 558.

Figure 558 Configuration Status

Rules
To add a new rule, perform the following steps:

1. Click Add New.



The Add New Network Discovery Rule window appears.

2. Type Subnet range in CIDR format (for example, 10.204.88.0/28) to discover PTP 820/850 devices.

The range of IP addresses in the Network Address Range field is displayed.

3. Type Port number.

4. Choose SNMP Version:

For SNMP version v2c, perform the following:

a. Enter preferred community string when you create a SNMP discovery rule.

b. Click Add.

Note

Default community string is private.

For SNMP Version v3, perform the following:

a. Choosing SNMP v3 version allows you to enter the parameters as shown in the following figure.
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b. Enter the following fields:

l Username.

l Context Name field is optional.

c. Choose any one of the Authentication Protocol.

l None

l SHA

l MD5

d. Choose any one of the Privacy Protocol.

l None

l AES128

l DES

e. Type Privacy Password.

f. Click Add.

SNMP Rules added are listed in the Rules table as shown in the following figure.

5. Click Rerun Discovery to start SNMP discovery for the rules added in the table or select specific
Subnet/Range in the table and manually run Rerun Discovery ( ) icon.

Import
To import SNMP rules, perform the following steps:

1. Click Import.

Import window appears.

2. Browse to Select File or Download Sample Template to change or configure the SNMP as per the
requirements in Downloaded Sample Template.

3. Click Import.

Export
To export SNMP rules, perform the following steps:

1. Select one or more SNMP rules required to export.

2. Click Export.



3. It exports the rules in the CSV file format as shown in the following figure.

Note

By default all SNMP rules are exported, if none of the rules are selected from the table.

Delete
To delete SNMP rules in the table, perform the following steps:

1. Select one or more SNMP rules in the table.

2. Click Delete, to delete one or more entries in the table or click Delete ( ) icon to delete specific rule in the
table.

Edit
To edit SNMP rule in the table, perform the following steps:

1. Click Edit ( ) icon to edit SNMP rule.

Edit Network Discovery Rule window appears. Edit the required field values.

2. Click Save.

Blacklist
To blacklist PTP 820/850 devices, perform the following steps:
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1. Click Add New.

Add Blacklist IP Address window appears.

2. Type IP Address.

3. Click Save.

Blacklisted IP Addresses are displayed in the table.

4. Select one or more blacklisted IP addresses in the table.

5. Click Delete, to delete one or more entries in the table or click Delete ( ) icon to delete specific blacklist entry
in the table.

Advanced Settings
In Advanced Settings section, configure the following parameters:

Note

l By default, Auto Discovery option is disabled.

l By default, Auto Discovery Interval option is 24 hours, when enabled and fields are auto-filled.

Enable Auto Discovery if you want to run SNMP discovery rules manually and perform the following steps:

1. Select Auto Discovery Interval option from the drop-down.

2. Enter Timeout in seconds between 5 to 60 seconds.

3. Enter Retries values between 0 and 3.



4. Click Save.

Tools
The Tools page allows you to perform the following actions:

l Diagnostics

l Operations

l Services

Diagnostics
Diagnostics page allows you to gather technical support dump which can be downloaded and sent to Cambium
Networks support team.

Technical Support Dump
The Technical Support Dump gathers important runtime and configuration information from the Edge Controller. It
can be sent to Cambium Support to aid in resolving issues.

1. Navigate to Edge Controller > Tools > Diagnostics.

2. Click Download under Technical Support Dump.
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Diagnostics

Logging Severity
The Logging Severity level of Edge Controller diagnose issues on the running system. The logging severity should
be set to the default (Information) and it should only be changed under guidance of the technical support team.

1. Navigate to Edge Controller > Tools > Diagnostics.

2. In Logging Severity section, select one of the log level from Log level drop-down.

l Error

l Information



l Debug

3. Click Save.

4. Click Reset to revert to the previous Log level option.

Service Logs
The Service Logs allows you to diagnose any issues in the services running in the Edge Controller.

1. Select Service and Duration from the drop-down.

The following list of service and duration (5 minutes, 15 minutes, 30 minutes and last 1 hour) are available from
the drop-down:

l Edge Agent

l Device SNMP

l Core Metadata

l Core Command

l RabbitMQ

l MariaDB

l SFTP

2. Click Show Logs.

The output for the selected criteria appears as shown:
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3. Click download ( ) icon to download the generated output.

4. Click clear ( ) icon to clear the output.

Operations
In the Operations page, you can view the current software version of the Edge Controller. You can also view
history of the last five software updates.

1. 1. Navigate to Tools > Operations.

2. 2. Click Check for new software update, checks for any new available software update.

Services
In Services page you can view the services running in the Edge Controller.



Figure 559 Services

Monitoring
In the Monitor page, you can view details of CPU utilization, CPU Load, Process Activity, Memory Usage, Swap
Usage, and File System.

cnArcher Installation Summary

cnArcher is a mobile application used to install PMP Subscriber Modules (SMs), ePMP (SMs), and cnRanger SMs.
The installation summary provides an overview of the data collected by cnArcher during the installation process.

Note

l cnArcher Installation Summary is a cnMaestro X feature.

l cnArcher Installation summary of PMP SM is available for users in cnMaestro Cloud and
OnPremises from 3.1.0 release.

l cnArcher Installation summary of ePMP SM is available for users in cnMaestro Cloud and
OnPremises from 3.1.1 release.

l ePMP PTP 550 (two radio devices) and ePMP Elevate are not supported for cnArcher Installation
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Summary.

To view the installation summary:

1. Navigate to Network Services > cnArcher Installation Summary.

The cnArcher Installation Summary page appears.

2. You can Search cnArcher Summary details by using MAC Address, Name at Installation, Date and Time,
Added By, and Comments.

Field Description
MAC Address MAC address of the device.
Name at Installation Name given to the device when installed.
Date and Time Date and time of installation.
Installation Duration Duration of installation.
Added By Name of the user adding the device.
Comments Comments about the installation.
State Current state of the device such as Managed or Deleted.

Table 155 Fields in cnArcher Installation Summary

3. Click View Details icon to view detailed Installation Summary.
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Field Description
SM Name Name of the device.
MAC Address MAC address of SM.
MSN Serial number of device.
Product Device model and type.
Software Version Software version of device.
RSSI Receiver Signal Strength Indicator (RSSI) of SM.
SSR Signal Strength Ratio (SSR).
External Antenna Peak gain of external antenna connected to the device.
Start Timestamp Start time of the summary.
End Timestamp End time of the summary.
Added By Name of the user adding the device.
Comment Comments about the installation process.

Table 156 Summary fields in cnArcher Installation

Configuration

IP Address/Setting IP settings such as for DHCP or Static IP allocation.
Subnet Subnet mask of the device.
Gateway IP address of the gateway.
DNS Name of the DNS server.
Management VLAN Configured Management VLAN.
Data VLAN Configured Data VLAN.
Security Security settings.
PSK Type of PSK (Pre-Shared Key): WPA or WPA2.
Status Current SM state such as Onboarded or Already Onboarded.
Software Update Software version provided to upgrade.
Template Name of the configuration template to apply.
Onboarding Details Onboarding details related to SM.

Field Description
Table 157 Configuration fields in cnArcher Installation

Photos and Location
Photos and Location displays the photos taken during installation. You can view a maximum of four photos at a
time.

Link Test Result
Link Test Result displays the link related test results with respect to throughput.



Field Description
Time Time at which the link test was performed.
Mode Modes such as Extrapolated Link Test or Link Test with Bridging.
Throughput Uplink/Downlink Uplink and Downlink Throughput.
Modulation Uplink/Downlink Uplink and Downlink Modulation.

Table 158 Link Test Results fields

AP Scan Result
AP Scan Result displays a list of scanned APs.

Field Description
AP MAC MAC address of the AP.
AP Bandwidth Bandwidth of the AP.
AP Frequency Frequency of the AP.
Registered Details of the registered SM.

Table 159 Fields in AP Scan Result

1. Click the delete ( ) icon to delete single or multiple entries from the cnArcher Installation Summary page.

2. Click Yes to delete.

3. A confirmation message is displayed on a successful delete.

Note

cnArcher uploads Installation Summary with cnMaestro when Internet connection is available to users
mobile device. This feature is support only in Android.

Spectrum Analyzer X

The Spectrum Analyzer feature monitors and analyzes wireless spectrum for PMP AP and SM devices, allowing
users to optimize network performance.

Note

l The Spectrum Analyzer is a cnMaestro X feature.

l Spectrum Analysis is supported on devices running PMP software version 22.1.0 and above.

l Spectrum Analyzer feature is available for users in cnMaestro Cloud and On-Premises.

To view Spectrum Analyzer page:
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1. Navigate to Network Services > Spectrum Analyzer.

2. You can view the Spectrum Analyzer details by using Name, Status, Type, Sector Count, Start Time, and End
Time.

Field Description
Name The user-defined name for the spectrum analysis job or scan.
Status The current status of the spectrum analysis.
Type The type of analysis performed (for example, Now, Weekly).
Sector Count The number of sectors or wireless areas analyzed in the spectrum scan.
Start Time The scheduled start time for the spectrum analysis job.
End Time The scheduled end time for the spectrum analysis job.

Table 160 Fields in Spectrum Analyzer

3. Click View Result icon on top right corner to view the detailed Spectrum Analyzer summary.



Field Description
Name The user-assigned name for the analysis job.
Tower Count The number of towers included in the analysis.
AP Count The number of APs in the analysis.
SM Count The number of SMs in the analysis.
Bands The frequency bands under analysis.
Scanning Bandwidth The width of the frequency band being scanned.
Duration The duration of the analysis job.
Scan Range The spectrum range analyzed.
Scan Status The current status of the analysis job.
Schedule The scheduling details for the analysis job.

Table 161 Job Summary parameters

Field Description
Date and Time The specific date and time when the spectrum analysis is conducted.
Bands The frequency bands included in the analysis.
View Options The viewing options for analyzing the spectrum.

l Uplink (AP)

l Downlink (SM)

l Downlink (Average SM)

l Unavailable Channels
Data Path The data path used for the analysis.

l Combined: Combines data from Path A and Path B for analysis.

l Average: Calculates the average and maximum values for the analysis data.

Table 162 Filters parameters

4. Scan Result displays the scanning result graph.

5. To view the last scan results at the device level:
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a. Navigate to PMP device Dashboard > Spectrum Analyzer Last Scan.

b. The dashboard automatically generates the appropriate graph for AP and SM based on the device type.

c. The default data path for displayed graphs is Combined, and users can customize it to their preferences.

d. The dashboard displays Noise Floor, which provides noise floor information for both Path A and Path B.
These two graphs are displayed for both AP and SM that are part of the scan.

e. Unmapped APs display any APs that are not assigned to a tower.

f. Click Delete icon on the top right corner to delete a job.

To set Alarm Threshold:

1. Navigate to Network Services > Spectrum Analyzer.

2. Click on the Set Alarm Threshold on the top right corner of the Spectrum Analyzer page.



3. Users can set band-specific alarms by configuring threshold values and alarm triggers for specific frequency
bands (for example, 5 GHz, 3 GHz, 2.4 GHz, and 900 MHz).

4. These alarms are applied globally to all PMP devices operating in the same frequency band.

5. After configuration, the alarms are displayed on the alarm page, enabling easy monitoring and timely
responses to network issues.

6. User can override alarm threshold for AP at the device level:

a. Navigate to Dashboard > Override Alarm Threshold.

b. Before overriding, users can review the global alarm threshold values that apply to the entire network.
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c. Choose the specific AP device for which you want to set custom alarm thresholds.

d. Configure and set individual threshold values for the selected device, overriding the global thresholds only
for that specific device.

To create a new job:

1. Navigate to Network Services > Spectrum Analyzer.

2. Click on Add New on the top right corner of the Spectrum Analyzer page.

Field Description
Name Job name to distinguish the analysis job within the Spectrum Analyzer.
Schedule Scheduling options, including:

l Now: Immediate execution of the spectrum analysis.

l Daily: Set up a daily schedule for the analysis job.

l Weekly: Configure a weekly schedule for the analysis job.

l Monthly: Create a monthly schedule for the analysis job.
Scan Range The desired scan range from a drop-down with two options:

Table 163 Add Spectrum Scan parameters



Field Description
l Full Scan: Performs a comprehensive analysis of the entire spectrum.

l Custom Scan: Set the Min Frequency and Max Frequency to precisely choose the
frequency range for a more accurate spectrum analysis.

Scanning
Bandwidth

The specific scanning bandwidth from the available options to adjust the spectrum analysis.

Note

Scanning Bandwidth is not applicable for PMP 450m AP.

Duration The analysis duration in seconds, ranging from 10 to 1000 seconds.

Table 163 Add Spectrum Scan parameters

3. After creating the job, it appears on the home page with a Scheduled status.
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Administration
This section includes the following topics:

l Managing Users

l Cloud Anchor Account

l Settings

l Audit Logs

Users

This chapter provides the following details:

l Managing Users

l Session Management

Managing Users
cnMaestro allows you to add Users using the Administration > Users page.

Note

l cnMaestro X account supports up to 200 users.

l cnMaestro Essentials account supports only up to 10 users.

Figure 560 Adding Users

Role-Based Access
cnMaestro supports the following user Roles:
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l Super Administrator – Super Administrators can perform all operations.

l Administrator – Administrators can modify cnMaestro application functionality, but they are not able to edit
User, API, or Server configuration.

l Operator – Operators are able to configure device-specific parameters and view all configuration.

l Monitor - Monitors have only the view access.

l CPI - CPI can perform onboarding the devices using the CBRS tool and has the view access only.

Note

l cnMaestro allows one to limit the number of concurrent sessions for each Role and display
current active user sessions.

l CPI role is authorized only when the CBRS is Enabled.

Role-Mappings
The table below defines how Roles are authorized to access specific features.

Feature Description
Access Control Policies Configure policies to control users connectivity to the network.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - None
Application Operations Application level operations such as to create, update and delete operations

for Networks, Towers/Sites. Bulk device configuration.

l Super Administrator - All

l Administrator - All

l Operator - None

l Monitor - None

l CPI - None
Application Settings Change global application configuration and onboarding key.

l Super Administrator - All

l Administrator - All

l Operator - None

l Monitor - None

l CPI - None
Assists Scan device configurations and generate assists scores, which in turn helps in

isolating configuration issues in a deployment.

l Super Administrator - All

l Administrator - All

Table 164 Role-Mappings



Feature Description
l Operator - All

l Monitor - All (Fix Now is not allowed)

l CPI - All (Fix Now is not allowed)
Citizen Broadband Radio
Service Subscription (CBRS)

Support CBRS-compliant devices in the 3.6 GHz band (from 3550 MHz to 3700
MHz)

l Super Administrator - All

l Administrator - All

l Operator - None

l Monitor - None

l CPI - All
cnArcher Installation Summary View installation summary of PMP ePMP, and cnRanger SMs installed using the

cnArcher Mobile Application.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - View
Configuration/Software Update Manage configuration/software update jobs.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - None
Custom Applications Configure applications with a specific IP address or a domain name, and apply

filter rules.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - None
Device Operations Device operations such as reboot device, link test, connectivity test, tech

support file download, and Wi-Fi performance test.

l Super Administrator - All

l Administrator - All

l Operator - All

Table 164 Role-Mappings
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Feature Description
l Monitor - None

l CPI - None
Device Overrides Per-device configuration, including updating AP Group and applying

configuration.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - None
EasyPass Create captive portal using EasyPass to allow clients to access the network

through Free Tiers, Vouchers, or Paid Access types.

l Super Administrator - All

l Administrator - All

l Operator -View

l Monitor - View (Sessions Only)

l CPI - None
Floor Plan Floor Plan configuration

l Super Administrator - All

l Administrator - All

l Operator - View

l Monitor - View

l CPI - None
Global Configuration The ability to create and apply configuration for global features such as

Templates, WLANs, AP Groups, and bulk sync configuration.

l Super Administrator - All

l Administrator - All

l Operator -View

l Monitor - None

l CPI - None
Guest Portal Guest Portal configuration.

l Super Administrator - All

l Administrator - All

l Operator -View

l Monitor - View (Sessions Only)

l CPI - None

Table 164 Role-Mappings



Feature Description
LTE Manage cnRanger LTE devices.

l Super Administrator - All

l Administrator - All

l Operator - View and Edit SIM credentials only

l Monitor - None

l CPI - None
Monitoring Display of monitoring data at all levels.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - View

l CPI - View
Notifications Alarms and Events management.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - View

l CPI - View
Onboarding Device approval, modifying individual device configuration, and performing

software update.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - All
Reporting Report generation.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - All

l CPI - All
Session Management Capability to view and logout other users sessions.

l Super Administrator - All

l Administrator - All

Table 164 Role-Mappings
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Feature Description
l Operator - None

l Monitor - None

l CPI - None
Software Upgrade Upgrade the device with the latest software.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - None
Spectrum Analyzer Analyze and monitor wireless spectrum for optimizing network performance on

PMP devices.

l Super Administrator - All

l Administrator - All

l Operator - All

l Monitor - None

l CPI - None
User Management User management operations such as manage users and roles.

l Super Administrator - All

l Administrator - View

l Operator - None

l Monitor - None

l CPI - None

Table 164 Role-Mappings

Creating Users and Configuring User Roles
To add an administrator:

1. Navigate to Administration > Users page.

2. Click Add User button. The following window is displayed:

3. Enter the email address in the Email box.



4. To configure the User Role, select any one of the role for the user from the Role drop-down list:

l Super Administrator

l Administrator

l Operator

l Monitor

l CPI

5. Click Send button to add this user.

To edit or delete a user, click the Edit icon or the Delete icon against the user in the Administration > Users page.

Whitelisting specific domains
Using the Administration > Users page, you can allow (or whitelist) a specific domain (for example, gmail.com).
When users from the whitelisted (or allowed) domain are added, an invite email is sent directly to them. When the
users accept the invite, they are allowed to access a particular cnMaestro UI account.

You can also blacklist or disallow a specific domain to prohibit all users of that domain from accessing the UI
account.

Note

l Domain whitelisting is not applicable to NFR User accounts.

l For users from the whitelisted domains, you can create the MSP user account.

To whitelist or blacklist a specific domain, perform the following steps:

1. Navigate to Administration > Users page.

The Manage Users page appears.

2. To add a new domain (for example, a gmail ID ), click on the Add User button.

The Add User window appears. You must set the fields, as described in the Creating Users and Configuring
User Roles section. The Add User window also displays that the email ID used is a new domain, as shown in
the following example (in this case, gmail.com is the new domain):
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3. Select the Allow users in "gmail.com" domain check box (the domain name varies based on the email ID you
add).

The new domain is added to the database.

When users who belong to this allowed domain (for example, gmail.com) are added (using the Add User
button), an invite email is directly sent to the users. When the users accept the invite, they can access a
particular cnMaestro UI account. The Allow users in "gmailail.com" domain checkbox is available only when
you are adding a new domain.

4. To blacklist or disallow a specific domain, click on the Allowed Domains button on the Manage Users page.

The Allowed Domain window appears with a list of whitelisted domains.

5. Uncheck the required domain check box to blacklist hat specific domain.

6. 1. Select Update.

All users from that blacklisted domain are not allowed to access the UI. To allow the blacklisted domain, you must
check the required domain check box on the Allowed Domain window.

Session Management
View and optionally log out current cnMaestro administrator sessions. The users with Super Administrator role can
logout all other users sessions and the users with Administrator roles can logout Operator and Monitor accounts.

Sessions
Displays the detailed information on the user sessions.



Cloud Anchor Account

This chapter provides the following details:

l Manage Instances

l Inventory

l Administration

l Network Services

l Manage Subscriptions

Manage Instances
Registration of On-Premise customer accounts to Cloud is addressed by this feature. This will allow us to do many
synchronization things in On-Premises instances, similar to Cloud will have the inventory stats from instances.

Manage Instances describes the following

l Onboarding

l On-Premises Instances

l Notifications

Onboarding
To onboard the devices to the Cloud Anchor Account, you need to create the Cloud account before connecting to
cnMaestro On-Premises:

1. Log in to the cnMaestro UI, https://cloud.cambiumnetworks.com.

2. In Account Type, select Anchor.
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3. Enter the On-Premises Onboarding Key.

4. Click I agree to the cnMaestro Terms of Service.

5. Click Create Account.

6. When the Anchor Account is created, an Onboarding Key must be set to allow On-Premises instances to
connect.

7. Navigate to the Manage Instances page as shown below and allows you to change the Onboarding Key and
Disable Onboarding.

This key needs to be entered in the cnMaestro On-Premises UI to connect to the Anchor Account.

On-Premises Instances
Once the On-Premises server has been onboarded with the Key, it will be included in the On-Prem Instances
page. Multiple On-Premises installations can be added to a single Anchor Account.



By clicking the instance host name, you can see the On-Premises server details such as General, Features, System,
and CBRS:

Notifications
Notification page displays the history of the most recent events notification of On-Premises instances with
Severity, Source, Name, Raised Time, and Message.

Click View Details to view the Event Details as shown below:

1006 | Cloud Anchor Account Cambium cnMaestro Cloud | User Guide



1007 | Cloud Anchor Account Cambium cnMaestro Cloud | User Guide

Inventory
The Inventory page displays a list of devices under the selected Node. It presents health and maintenance
information provides a tabular view that allows for sorting and filtering. When selected for a single device, it
presents a detailed customized page of that device.

Administration
Administration provides the following details:

l Users

l Audit Logs

Users
cnMaestro allows to add Users using the Administration > Users page. A maximum of ten users are currently
allowed in the system.



Figure 561 Adding Users

Role-Based Access
On successful authentication, every request from this user is processed in light of their Role.

cnMaestro supports the user Role:

l Super Administrator – Super Administrators can perform all operations.

Creating Users and Configuring User Roles
To add an administrator:

1. Navigate to Administration > Users page.

2. Click Add User button. The following window is displayed:

3. Enter the ID in the Email text box.

4. Click Send button to add this user.

To delete, click the delete icon against the user in the Administration > Users page.

Session Management
View and optionally log out current cnMaestro administrator sessions. The users with Super Administrator role can
logout all other users sessions and the users with Administrator role can log out Operator and Monitor accounts.
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Network Services
Network Services provide the following details:

l CBRS

l Organization

CBRS
Citizens Broadband Radio Service subscription for the CBRS-compliant devices in 3.6 GHz band (3550 MHz to
3700 MHz).

For further information, refer to CBRS.

Organization
An Organization allows multiple accounts to share CBRS billing and SAS ID. The Primary account owns this
configuration, and the Secondary account can optionally share it. Both accounts must authorize the sharing.

For further information, refer to Organization.

Manage Subscriptions
Manage Subscriptions provide the following details:

l Subscriptions

l Devices

l On-Premises Instances

Subscriptions
Subscriptions page describes about the usage summary and a list of pending, active, and expired subscriptions. It
aids planning for renewals and the purchase of new subscriptions.



It also supports editing the system generated subscription names to more user-friendly names for ease of tracking.

To edit the Subscriptions perform the following steps:

1. click edit ( ) icon.

Edit window pops up as shown below.

2. Enter Name and Description.
3. Click Save.

Devices
Devices page manages device subscriptions. It is beneficial when a slots deficit exists to accommodate all the
expired devices or if one wants to swap an expired device subscription with another active device of less
importance. For more info refer to Subscription Management.
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Audit Logs

Note:

Audit Logs are supported only for cnMaestro X subscribers.

Audit Logs record administration activities through both the Web UI and the RESTful API. Audit Log entries usually
include destination and source addresses, a timestamp and user login information. User can access Audit Logs in
the Administration > Audit Logs page.

Figure 562 Audit Logs

The following table describes the Audit Logs parameters and their descriptions.

Parameter Description
Action Displays the action performed by the user (create, delete, download, etc).

Table 165 Audit Log Parameters



Parameter Description
Description Textual description of the task.
Export Enable export as CSV or PDF.
IP Address IP address of the Web browser or API application.
Module Module generating entry (AAA, administrator, alarm).
Result The result of the audit log as Success or Failed.
Source Administrator or API client name.
Time The time when the action was performed.
Type Type of the log entry (configuration, operation, onboarding, security).

Table 165 Audit Log Parameters

Log Action
An action log contains a set of transactions. Each transaction contains one or more Actions. Each Action has a
name and input parameters. Some Actions have output parameters.

The following Actions will be supported for individual Audit Log entries. Each activity performed in the server is
detailed in this table.

Parameter Description
Claim Claim a device in the network operator.
Cloud-Connect Provides the status of the On-Premises to Cloud account connection.
Create Create an object in the network device.
Delete Delete an object in the network device.
Download Download a file.
Edit Edit an existing device detail.
Link Test Perform a Link Test.
Login Login to a device.
Logout Logout from a device.
Mail Mail ID of a device.
Move Move a device from the server.
Reboot Reboot a device.
Reset To reset a device
Upload Upload a file on the server.

Table 166 Log Action Parameters

Audit Modules
Auditing activity is mapped to individual modules within cnMaestro. A breakdown of the available modules is listed
below.

Module Type (s) Description
ACL provisioning Adding Editing Removing the ACL Entries.
administrator provisioning

operations

security

User Management: Login, Users, Roles, Email, etc.
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Module Type (s) Description
alarm provisioning Alarms and Alarm History.
api provisioning API Management: API Clients and Webhooks.
auditing provisioning Auditing Infrastructure.
auto-provision provisioning Auto-Provisioning.
CBRS Services CBRS.
Cloud- Sync Services Synchronizing the Cloud to On-Premises Instances.
data-tunnel provisioning Data Tunneling.
device provisioning

operations

Device management.

Email-
Notifications

operations Add or edit Email notification.

guest-portal provisioning Guest Portal.
infrastructure provisioning Site, Network, Tower Management.
jobs provisioning

operations

Jobs Infrastructure.

license licensing Update license details.
MSP operations Operations covering Managed Services and Managed Account.
onboard provisioning

operations

Onboarding Queue.

report provisioning

operations

Data Reports.

Profile provisioning Create or update a profile.
SIM provisioning SIM claim and delete.
system provisioning

operations

security

System Services: VM management, change log level, system upgrade, system
monitoring, software images, system settings.

template provisioning Template-Based Configuration.
tools provisioning

operations

Technical support dump, networking operations, etc.

webhooks provisioning Webhooks configuration and management.
Wi-Fi provisioning

operations

security

AP Groups, WLANs: edit W-Fi configuration objects.

Settings

Email Notifications
The Email Notifications feature allows the Super Administrator and the Administrator users to add subscribers
(Email IDs) for receiving different types of alerts by means of Emails.



Note

l Only 2 email recipients can be added per cnMaestro Essentials account.

l Up to 10 email recipients can be added per MSP, Base Infra, and system level scope.

For example, if there is one MSP, you can create 10 recipients at MSP, 10 at Base Infra, and 10 at
system level (All accounts scope).

The severity of alerts are classified as follows:

l Critical

l Major

l Minor

The content of the email alert will be in JSON or HTML format. The subscriber will get email alert only when the
global setting is enabled.

Figure 563 Email notifications page
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Adding Recipient to Subscriber Table
1. Navigate to Administration > Settings > Notifications page.

Figure 564 Adding Subscribers

2. Click Add Recipient.

The following window is displayed:

3. Enter the Email ID of the subscriber in the Email textbox.

4. Select the severity level from the Severity list.

5. Select the Managed Account type from the Managed Account list.

6. Choose HTML or JSON radio button for the Content Type.

7. Select the appropriate option (s) for Ignore Notification.

8. Click Add and the entry reflects in the subscriber table.

All alarms of chosen severity and above are sent through email as explained below:



l If severity Critical is selected, then we receive only critical alarms.

l If severity Major is selected, then we receive critical and major alarms.

l If severity Minor is selected, then we receive critical, major, and minor alarms.

HTML Email Example

JSON Email Example

Account Type
cnMaestro supports three separate account types, based upon the composition of devices installed. The type is
set when the account is created initially, but it can be changed later through the Administration > Settings page.

For more information, refer Navigating the cnMaestro UI.

1016 | Settings Cambium cnMaestro Cloud | User Guide



1017 | Settings Cambium cnMaestro Cloud | User Guide

Managing Device software images under Automatically Update
Device Software section
cnMaestro cloud allows one to update the device software during onboarding and for managed devices.

Adding update device software is a manual process as follows:

1. Navigate to Administration > Settings > Software Images > Automatically Update Device Software tab.

2. Select the version file and then click onboarding/Managed Devices checkbox.

Note

Enable the onboarding checkbox, in order to avoid the failure of onboarding devices with
minimum supported version rather than the recommended version.

3. Enable the checkbox as follows:

l Enable Managed Devices flag only for Wi-Fi devices (E-Series, R-Series and XE/XV/X7-Series).

l Enable Sequential Site Update and Both Partitions flag only for only E-Series and XE/XV/X7-Series
devices.

4. click Apply Settings.

Note

l Once auto software update job for managed devices is triggered, it will automatically abort
any manually scheduled software update jobs.

l In order to avoid failures in onboarding devices having minimum supported version other
than recommended version, enable the onboarding check.

Figure 565 Software Images



Appendix
This section includes the following topics:

l Network Port Requirements

l XMS-Enterprise to cnMaestro X

l Converting Tier 2 Unused Slots

Network Port Requirements

Network Port Requirements for Outbound
The following table provides information about network port requirements for outbound:

Port Number Port Type Purpose
443 TCP HTTPS Web Access and Device communication

Table 167 Outbound Port Details

XMS-Enterprise to cnMaestro X

This section describes the process of migration from XMS-Enterprise (XMS-E) to cnMaestro X.

Before you begin migration, upgrade the following to the latest version:

l XMS-E to version 8.4.0

l Xirrus APs to version 8.7.0

Perform the following steps for migration:

1. In XMS-E, perform the following actions:

l Export Golden Configuration

l Migrate to cnMaestro X

2. In cnMaestro X, perform the following actions:

l Create Wi-Fi AP Group

l Approve APs into Wi-Fi AP Group

l Import and Apply AP configuration

XMS-E System
To login to XMS-E, complete the following steps:

1. Launch the Web login page.

2. Enter the username and password.
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3. Click Login.

Export Golden Configuration
Export Golden Configuration for one of the APs. It is saved as a zipped file in the local file system.

To start export golden configuration in XMS-E, navigate to Configure tab > Export.

1. Select Export to cnMaestro.

2. Select the AP to create the golden configuration for a group of APs and click Next.

Note

l Select the AP with the maximum radios and the highest capability.

l During the migration of an AP from XMS-E to cnMaestro, the AP configurations are not
modified.



3. Select group of APs to be added to the spreadsheet and click Next.

4. Click Export.

In Local System unzip the directory and files to local directory.

5. Download the zip files from the browser window.

6. Go to the folder where the zipped files are saved and extract the contents to a folder.

7. Open the directory path where the file has been stored and double-click on the zipped file.
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8. Click Extract all.

9. Extract the folder to the path.

10. Make a note of the folder or file location as you will require this file later.



Migrate to cnMaestro X
Select APs to migrate to cnMaestro X. Perform the following steps:

1. Navigate to the More menu > select Migrate APs to cnMaestro.

2. Enter the IP address or Hostname mapped in DNS for cnMaestro X.

3. Select Delete AP or Put AP(s) out of Service and click OK.

Note

l Out of service APs are not removed from XMS-E, so if there is an issue, select the Return APs to
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Service option and they will return to XMS-E.

l You must reset using the snmp trap host 1 Xirrus-XMS AP CLI command on the AP for the
return to service to work.

l If you select Delete APs, they will be removed and you must rediscover them on the network to
return them to XMS-E.

l You should also remove the Device Network from the Device discovery section to clean up XMS-
E.

A success message from XMS-E for each of the APs migrated to cnMaestro X is displayed.

Create Wi-Fi AP Group
Create Wi-Fi AP Group and Import CLI command file from exported directory.

1. Navigate to Wi-Fi AP Group > Base Infrastructure > click action ( ) icon to add Add AP Group.

2. In the Basic Information page, select Type as Enterprise Wi-Fi (Xirrus-Series) from the drop-down.

3. Select the Auto-Sync.

4. Click Save.



5. In the Full Configuration page, click the Import option.

6. Select the CLI command file from the unzipped directory.

7. Click Import.
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The configuration file is displayed.

8. Click Save.

Approve APs into Wi-Fi AP Group

APs pending for approval in cnMaestro X based on the Migrate APs to cnMaestro X steps as described above.

You can claim APs to approve from the Onboard > Devices page.

Perform the following steps to approve APs from the Onboard > Devices page.

1. Navigate to the Onboard > Devices page and click Approve All (to approve all devices at once) or Approve (to
approve devices individually.)

2. Enter the required details, provision the device for location, and assign to an AP Group.



3. Click Save.

4. In the Onboard > Devices page, select Approval All (to approve all devices at once) or Approve (to approve
devices individually.)

Import and Apply AP configuration
APs imported are ready for basic configuration. Import AP configuration using the CSV file from the exported
directory.

1. Navigate to Wi-Fi AP Group > select AP Group > AP Configuration.

2. Select all APs to configure, click Configure.
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3. In Device Override table, verify AP details and click Import.

Note

Email and Phone fields are auto populated from the .csv file.

4. Select the .csv import file from the unzipped directory folder and click Apply.

All the configuration values from the CSV file are populated for each AP. The data is auto populated to the
User Defined Variables tab. The APs receive complete configurations including all IAP settings.

5. Click Apply Configuration.



When the APs are completely configured, Sync Status is displayed as In Sync.

You have to refresh the page to view the updated Sync Status.

Converting Tier 2 Unused Slots

Cambium Networks has introduced new product family-based cnMaestro X SKUs and pricing for devices such as
Fixed Wireless Broadband APs, cnRanger, cnReach, cnVision, PMP, ePMP, and PTP. Earlier, the Tier 2 subscription
was used to control these devices (pricing). To simplify the purchase and onboarding for these devices, Cambium
Networks has decided to remove the Tier 2 subscription and introduce new four tiers (Tier 21, Tier 22, Tier 23, and
Tier 24).

The Tier 2 subscription is no longer valid now. Due to Tier 2 subscription removal, there can be unused Tier 2 slots
in your account (purchased during the Tier 2 subscription). As a solution, Cambium Networks provides an option to
convert these unused Tier 2 slots into new tiers based on the device family and requirements. You can manually
convert the unused Tier 2 slots to Tier 21, Tier 22, Tier 23, and Tier 24 using the icon located on the Manage
Subscriptions page (cnMaestro UI). This solution helps in better mapping and device management.

Note

The Convert Tier 2 option is effective from March 1, 2024 for Fixed Wireless Broadband APs,
cnRanger, cnReach, cnVision, and PTP devices. You must convert the unused Tier 2 slots in your
account to the new Tier 2x slots before onboarding the devices.

When you convert the unused Tier 2 slots into new tiers, you cannot change the new tiers back to
Tier 2.
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You can convert the unused Tier 2 slots to new tiers, for example, as described in Table 168.

New Tier Device Family and Type
Tier 21 cnVision FLEXr, HUB360

ePMP All AP Models
Tier 22 PMP All AP Models except 450m and 450mv
Tier 23 PMP 450m
Tier 24 cnRanger All BBU Models

cnReach All cnReach Models
PTP All PTP Models

Table 168 Example of converting unused Tier 2 slots

To manually convert the unused Tier 2 slots for a device family, complete the following steps:

1. Log in to your respective cnMaestro UI account.

The Home page appears with a banner, as shown in Figure 566.

Figure 566 The Tier 2 conversion-specific banner

2. From the home page, navigate to the Manage Subscriptions page.

The Manage Subscriptions page appears (as shown in Figure 567), displaying the same banner and details of
tiers.



Figure 567 The Manage Subscriptions page with tier information

3. Select the Tier 2 subscription and click the corresponding icon (as shown in Figure 567).

The Tier 2 subscription window appears with details of unused slots and options to convert to new tiers (Tier
21, Tier 22, Tier 23, and Tier 24).

Figure 568 The Convert Tier 2 window

4. Check the unused slot count and enter a valid value (in integers) in Tier 21, Tier 22, Tier 23, or Tier 24 text
boxes (based on your requirements).

5. Click the Save button (as shown in Figure 568) to apply the changes.
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Value-Tier Wi-Fi for any market
Cambium Networks XV2-21X Wi-Fi 6 Indoor access 
point delivers a high-performance to price ratio 
attractive to any market.

The XV2-21X can be adopted and managed by any 		
of the Cambium Networks management systems, 
cnMaestro™ Cloud, cnMaestro™ X, cnMaestro™ on-
premises, or Swift app-based management. Choose the 
management type you need, and change it at any time. 
Unlike other value-tier access points, the XV2-21X is 
never locked into just one management selection.

Designed for fast installation
The XV2-21X offers multiple installation methods 
included in the same shipping box. Mount the AP to a 
ceiling tile using the included steel plate, mount to an 
existing junction box with 83mm center-to-center holes, 
twist lock the AP onto a 36mm, 24mm and 14mm T-bar, 
or simply mount it to any flat surface using the included 
wall anchors. No accessory brackets are needed.

q u i c k  l o o k :

•	Dual Radio Wi-Fi 6
•	5 GHz (2x2), 2.4 GHz (2x2)
•	1 GbE RJ45 interface

•	Managed by cnMaestro™, Swift

•	Limited lifetime warranty

XV2-21X Wi-Fi 6 Access Point
802.11ax Dual-Radio Indoor Access Point

Back panel with mounting bracket
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XV2-21X Wi-Fi 6 Access Point

Access Point Specifications
Note: Some features will be included on subsequent firmware releases.

FCC   Ch 1–11, 36–48, 100–144, 149–165

ISED  Ch 1–11, 36–48, 100–116, 149–165

ETSI  Ch 1–13, 36–64, 100–140

ROW  Individual country limits may apply. Please contact sales 
          for country specific regulations.
Note: FCC, IC, EU DFS channels not supported in first release

Radios 5 GHz 802.11 a/n/ac Wave 2/ax, 2x2:2
2.4 GHz 802.11 b/g/n/ax, 2x2:2

Wi-Fi 802.11 a/b/g/n/ac Wave 2/ax

SSID 
Security

WPA3-SAE, WPA3-Enterprise, WPA2 (CCMP, AES, 
802.11i), WPA2 Enterprise (802.1x/EAP), WEP, Open

Max PHY
Rate

5 GHz radio 2402 Mbps
2.4 GHz radio 573.5Mbps

Ports 1 x IEEE 10/100/1000 Mbps 

Antenna 5 GHz 6 dBi
2.4 GHz 5 dBi

Max EIRP 5 GHz 33 dBm
2.4 GHz 32 dBm

Power Typical 11W, 802.3af powered device

Dimensions 155 mm x 155 mm x 37 mm
(6.1 in x 6.1 in x 1.46 in)
With Bracket:
155 x 155 x 46 mm
(6.1  x 6.1  x 1.81 in)

Weight 475g (1.05 lbs)

LEDs Multi-color status LEDs, dimmable, on/off

Ambient 
Operation 
Temperature 

0ºC to 50ºC  (32ºF to 122ºF)

Storage
Temperature

-40ºC to 70ºC (-40ºF to 158ºF)

Humidity 95% RH non-condensing

MTBF 1,980,244 hours at 50ºC ambient (estimated)

Mount 
Options

Wall or ceiling, T-bar with included 
locking bracket, ceiling tile plate

Certifications
(Compliance)

Passpoint 3.0, 
802.11 a/b/e/g/i/k/n/r/u/v/w/ac/ax, PP2.0
FCC, IC, ETSI, CE, EN 60601-1-2, IEC60950, 
IEC62368, UL2043, EN 61373
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XV2-21X Wi-Fi 6 Access Point

Network Specifications
Note: Some features will be included on subsequent firmware releases.

Operational 
Modes

Controller-less standalone
Cloud-managed cnMaestro, VM

WLAN 16 WLAN profiles per radio
128 clients per radio, 16 SSIDs,
WPA-TKIP, WPA2 AES, 802.1x
802.11w PMF

Guest Access/
Captive Portal

cnMaestro, On-AP hosted guest portal

Social login, Voucher based login, SMS 
gateway, Payment gateway support. 
Supports radius based authentication.
cnMaestro API support for external captive 
portal integration.

Authentication
Encryption

Hotspot 2.0, 802.1x EAP-SIM/AKA, 
EAP-PEAP, EAP-TTLS, EAP-TLS, MAC 
Authentication local database or RADIUS

Scheduled 
WLAN

On/off by day, week, time of day

Data Limit Client bitrate/time/throughput limit per SSID

Subscriber QoS WMM

Fast Roaming 802.11r, OKC, cnMaestro assisted roam

Mesh Multi-hop, either band

Channel
Selection

Multi-modal channel selection with 
AutoChannel and autotune (cnMaestro)

RF 
Management

Multi-Modal RF optimization supporting 
AutoRF (cnMaestro) performed in the 
intelligent edge AP.  Out of band RF 
spectrum analysis, RF monitor with chn/
noise/interference

Network TCP connection log, NAT logging firewall, 
DHCP server, L2, L3 or DNS based access 
control, VLAN Pooling, RADIUS attribute VID
VLAN per SSID per user

Band Steer
Load Balance

Yes

Tunnel L2TPv2, L2GRE, PPPoE

Network Tools Wired and wireless remote packet capture, 
logging, ZapD

Network and
RF Management
Tools

Wired and wireles remote packet capture, 
ZapD performance tool, rogue AP detection

Services L2-L7 application visibility & control, WiFi 
Calling control, WIDs/WIPs, NTP, Syslog, 
SNMP traps, DNS proxy, auto-off on       
WAN failure

API RESTful management and statistics API
Presence location APIs

IP IPv4, IPv6

Standards

Wi-Fi 
Protocols

VHT MCS rates, 16/64/256/1024-QAM, 20/40/80/160 MHz

TWT, Long OFDM Symbol, Transmit beamforming, Airtime Fairness, AMSDU, AMPDU, RIFS, STBC, LDPC, MIMO Power 
Save, MRC, BPSK, QPSK, CCK, DSSS, OFDM, OFDMA, UL/DL MU-MIMO

IEEE 802.11 a/ac/ax/b/d/e/g/h/i/k/n/r/u/v
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XV2-21X Wi-Fi 6 Access Point

Management

cnMaestro Essentials
License-free management that delivers a disruptive Total Cost 
of Ownership (TCO) for organizations of all sizes.

cnMaestro X
Paid subscription that includes:

•	 Advanced device management capabilities.
•	 Cambium Care Pro for 24x7 technical support.
•	 Accelerated access to L2 engineers and regular 	

software updates.
•	 Upgrades for advanced features.

To serve a growing market for advanced 
management and services functionality, 
Cambium Networks offers cnMaestro™ in 

two different management tiers:

For More information, please visit:

cambiumnetworks.com/products/software/cnmaestro-essentials

cambiumnetworks.com/products/advanced-services/cnmaestro-x
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XV2-21X Wi-Fi 6 Access Point

Front Panel

Back Panel

Front Panel with 
Mounting Bracket

Front Oblique

Back Panel with 
Mounting Bracket

Bottom / Ports
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XV2-21X Wi-Fi 6 Access Point

Antenna Patterns

2.4 GHz Elevation

5 GHz Elevation

2.4 GHz Receive Sensitivity (dBm) Per Chain
HT20 HT40

MCS0 -95.5 MCS0 -93

MCS7 -76.5 MCS7 -74
HE20 HE40
MCS0 -95.5 MCS0 -92.5
MCS7 -76.5 MCS7 -73.5

5 GHz Receive Sensitivity (dBm) Per Chain
VHT20 VHT40 VHT80 VHT160

MCS0 -95.5 MCS0 -94 MCS0 -90 MCS0 -87.5

MCS7 -77 MCS7 -74 MCS7 -71.5 MCS7 -69
HE20 HE40 HE80 HE160
MCS0 -95.5 MCS0 -93.5 MCS0 -90.5 MCS8 -65
MCS7 -76.5 MCS7 -74 MCS7 -71.5 MCS11 -57

5 GHz TX Power Target
Rate Pout (dBm)

MCS0 VHT20 27

MCS7 VHT20 24
MCS0 VHT40, VHT80 27, 27
MCS7 VHT40, VHT80 24, 24
MCS11, HE20, HE40, HE80, HE160 22, 22, 22, 21

2.4 GHz TX Power Target
Rate Pout (dBm)

MCS0 HT20 27

MCS7 HT20 25
MCS8 VHT20 25
MCS9 VHT40 24
MCS11 HE40 23

2.4 GHz Azimuth

5 GHz Azimuth

FRONT

FRONT

BACK

BACK
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XV2-21X Wi-Fi 6 Access Point

Cambium Ordering Information
Regulatory Model XV2-21X

XV2-21X0A00-US XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, US

XV2-21X0A00-EU XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, EU

XV2-21X0A00-RW XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, RW

XV2-21X0A00-CA XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, CA

N000000L142A N000000L142A PoE injector, 60W, 5 GbE, Indoor, Energy Level 6 Supply

N000000L034B PoE, 30.5W, 56V, GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector

N000900L017A PoE, 15.4W, 56V, GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector

XA-DROPTILE15 Recessed ceiling tile Installation Kit for 15mm T-bar, 20mm drop extension. 5 Pack

XA-DROPTILE24 Recessed ceiling tile Installation Kit for 24mm T-bar, 20mm drop extension. 5 Pack

AX-E510RBKT-WW  Shock mount bracket

cnMaestro X Ordering Information

MSX-SUB-XV2-21X-1 cnMaestro X for one XV2-21X AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 
1-year subscription 

MSX-SUB-XV2-21X-3 cnMaestro X for one XV2-21X AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 
3-year subscription 

MSX-SUB-XV2-21X-5 cnMaestro X for one XV2-21X AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 
5-year subscription 
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ABOUT CAMBIUM NETWORKS

Cambium Networks empowers millions of people with wireless connectivity worldwide. Its wireless portfolio is used by commercial and 

government network operators as well as broadband service providers to connect people, places and things. With a single network architecture 

spanning fixed wireless and Wi-Fi, Cambium Networks enables operators to achieve maximum performance with minimal spectrum. End-to-end 

cloud management transforms networks into dynamic environments that evolve to meet changing needs with minimal physical human 

intervention. Cambium Networks empowers a growing ecosystem of partners who design and deliver gigabit wireless solutions that just work.

3800 Golf Road Suite 360, Rolling Meadows, Illinois 60008 USA

XV2-21X Wi-Fi 6 Access Point

L I M I T E D  W A R R A N T Y 

Cambium Networks XV2-21X Wi-Fi 6 Access Point includes a limited 
hardware warranty for a period of 5 years after end of sale.

Cambium Care Ordering Information

CCADV-SUP-XV2-21X-1 Cambium Care Advanced, 1-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, 
and NBD advance replacement for HW

CCADV-SUP-XV2-21X-3 Cambium Care Advanced, 1-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, 
and NBD advance replacement for HW 

CCADV-SUP-XV2-21X-5 Cambium Care Advanced, 3-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support, SW 
updates, and NBD advance replacement for HW 

CCPRO-SUP-XV2-21X-1 Cambium Care Pro, 1-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 

CCPRO-SUP-XV2-21X-3 Cambium Care Pro, 3-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 

CCPRO-SUP-XV2-21X-5 Cambium Care Pro, 5-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 

CCADV-UPG-XV2-21X-1 Cambium Care Advanced Add-on to cnMaestro X, 1-year support for one XV2-21X. 24x7 TAC support,   
SW updates, and NBDS advance replacement for HW 

CCADV-UPG-XV2-21X-3 Cambium Care Advanced Add-on to cnMaestro X, 3-year support for one XV2-21X. 24x7 TAC support,   
SW updates, and NBDS advance replacement for HW 

CCADV-UPG-XV2-21X-5 Cambium Care Advanced Add-on to cnMaestro X, 5-year support for one XV2-21X. 24x7 TAC support,  
SW updates, and NBDS advance replacement for HW
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XV2-21X Wi-Fi 6 Access Point 
802.11ax Dual-Radio Indoor Access Point 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Value-Tier Wi-Fi for Any Market 
Cambium Networks’ XV2-21X Wi-Fi 6 Indoor Access Point 
(AP) delivers a high performance-to-price ratio attractive to 
any market. 

The XV2-21X can be adopted and managed by any of 
the Cambium management systems, including 
cnMaestro Essentials and cnMaestro X, available in 
cloud and on-premises versions. Choose the 
management type you need and change it at any time. 

Unlike other value-tier access points, the XV2-21X is 
never locked into just one management selection. 

Designed for Fast Installation 
The XV2-21X offers multiple installation methods included 
in the same shipping box. Mount the AP to a ceiling tile 
using the included steel plate; mount to an existing junction 
box with 83 mm center-to-center holes; twist lock the AP 
onto a 36 mm, 24 mm, and 14 mm T-bar; or simply mount it 
to any flat surface using the included wall anchors. No 
additional accessory brackets are needed 

 

  

XV2-21X Quick Look: 

• Dual-radio Wi-Fi 6 
• 5 GHz (2x2), 2.4 GHz (2x2) 
• 1 GbE RJ45 interface 
• cnMaestro™ Network Management 
• Limited lifetime warranty 

XV2-21X back panel with 
mounting bracket 



©2024 Cambium Networks, Inc. 2 cambiumnetworks.com 

DATA SHEET  
 

 

 
DATA SHEET  

 
 

 

XV2-21X Wi-Fi 6 Access Point 
 
Specifications 

Radios 5 GHz 802.11 a/n/ac/ax, 2x2:2 
2.4 GHz 802.11 b/g/n/ax, 2x2:2 

 Power Typical 11W, 802.3af powered device 

Wi-Fi 802.11 a/b/g/n/ac/ax  Dimensions 155 mm x 155 mm x 37 mm 
(6.1 in x 6.1 in x 1.46 in) 
With Bracket: 
155 x 155 x 46 mm 
(6.1 x 6.1 x 1.81 in) 

SSID Security WPA3-SAE, WPA3-Enterprise, WPA2 
(CCMP, AES, 802.11i), WPA2 Enterprise 
(802.1x/EAP), OSEN, OWE, Open 

Max PHY Rate 5 GHz radio 2402 Mbps 
2.4 GHz radio 573.5 Mbps 

 Weight 475 g (1.05 lb) 
Mount Options Wall or ceiling, T-bar with included locking 

bracket, ceiling tile plate  
Ports 1 x IEEE 10/100/1000 Mbps  Ambient Operation 

Temperature 
0ºC to 50ºC (32ºF to 122ºF) 

Antenna Gain 5 GHz 6 dBi 
2.4 GHz 5 dBi 

 Storage 
Temperature 

-40ºC to 70ºC (-40ºF to 158ºF) 

FCC Ch 1–11, 36–48, 52–64, 100–144, 149–165  Humidity 95% RH non-condensing 
ISED Ch 1–11, 36–48, 52–64, 100–116, 149–165  MTBF 831,902 hours at 50ºC ambient 
ETSI* Ch 1–13, 36–48, 52–64, 100–140, 149–173  LEDs Multi-color status LEDs, dimmable, on/off 
ROW* Ch 1–14, 36–48, 52–64, 100–144, 149–173  Certifications 

(compliance) 
Wi-Fi Alliance, Passpoint 3.0, 
802.11 a/b/e/g/i/k/n/r/u/v/w/ac/ax, FCC, IC, 
ETSI, CE, EN 60601-1-2, IEC60950, 
IEC62368, UL2043, EN 61373 

  

 
*Individual country limits may apply. Please contact your regional sales manager for country-specific regulations. For Southeast Asia (SEA) countries, refer to 
the SEA Regulatory Details chart in this data sheet. 
 
 
Standards 

Wi-Fi Protocols Data coding support 16/64/256/1024-QAM 
Channel width support under 5 GHz band: 20/40/80/160 MHz 
TWT, long OFDM symbol, transmit beamforming, airtime fairness, AMSDU, AMPDU, RIFS, STBC, LDPC, MIMO power 
save, MRC, BPSK, QPSK, CCK, DSSS, OFDM, OFDMA, UL/DL MU-MIMO 
IEEE 802.11 a/ac/ax/b/d/e/g/h/i/k/n/r/u/v/w 
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XV2-21X Wi-Fi 6 Access Point 
 
Network Specifications 

Operational Modes Controllerless standalone cloud-managed 
cnMaestro, VM 

 RF Management Multi-modal RF optimization supporting Auto-R  
for dynamic channel selection and  dynamic 
power adjustment configured via cnMaestro, 
performed in the intelligent edge AP.  
RF monitor with channel utilization/packet 
error rate/interference. 

WLAN 128 concurrent clients per radio, 256 per AP 
16 SSID per AP  

Security, 
Authentication 
Encryption 

Open, WPA2-AES with PSK, ePSK and 
Enterprise 
WPA3 with PSK (WPA3-SAE), ePSK, 
Enterprise, Enterprise-CNSA, OWE 
(Enhanced Open) 
OSEN and PMF (802.11 W) 
MAC authentication with local database or 
external database using RADIUS protocol 
802.1X with EAP-TTLS, EAP-
TLS/MSCHAPv2, PEAPv0/PEAPv1/EAP-
PEAP/EAP-SIM/AKA/AKA’/FAST 
Hotspot 2.0 WEB authentication 

 Band Steering Yes 
Mesh Multi-hop, either band 
Scheduled WLAN On/off by day, week, time of day 
Data Limit Client bitrate/time/throughput limit per SSID 
Network TCP connection log, NAT logging firewall, 

DHCP server, DHCP Relay option 82, VLAN 
pooling, RADIUS attribute, VID VLAN per 
SSID per user, ePSK with VLAN assignment 
per PSK 
LLDP, IGMP v1, v2 

Wi-Fi Quality of 
Service 

802.11e / WMM (packet marking either with 
802.1p or IP DSCP), WMM-PS, U-APSD 
Multicast to unicast conversion 

 Network Tools Wired and wireless remote packet capture, 
logging, WAN speed test, ZapD, remote 
network connectivity tools 

Service Availability Critical network resource monitor with SSID 
shutdown 

 Tunnel L2TPv2, L2GRE, PPPoE 

Fast Roaming 802.11k/r/v, OKC, cnMaestro-assisted roam  IP IPv4, IPv6 
Guest Access/ 
Captive Portal 
Service (EasyPass)* 

cnMaestro-hosted EasyPass portal 
Multiple authentication methods 
supported to onboard guest user: 

• Radius-based authentication 
• Click-through with simple terms and 

conditions acceptance 
• Social login using Google®, Facebook® 
• SMS-based authentication (X) 
• Voucher-based access 
• Microsoft® Azure AD and Google 

Workspace® (X) 
• Sponsored guest access (X) 
• Self-registration access (X) 

cnMaestro API support for external captive 
portal integration 
802.11u, Hotspot 2.0 

 VLAN 802.11Q, max 4096 
Management 
Interfaces 

HTTP / HTTPS web interface, SSH, Telnet 
SNMP V1, V2, V3 
Syslog, SNMP traps, NTP 

Security Rogue AP detection and termination(X), 
WIDs/WIPs, DoS protection 
L2–L7 firewall with application visibility(X) & 
control(X), DNS based access control(X). 
ACL and AirCleaner tools 

Services Wi-Fi Calling control, NTP, Syslog, DNS 
proxy, SNMP traps, SNMPv1, SNMPv2c, 
SNMPv3, TCP and DNS logging 

Accounting RADIUS accounting, load balancing AAA 
servers, Dynamic Authorization COA, DM 

   

API RESTful management and statistics API via 
cnMaestro X, presence location push APIs 

   

 
*X features available in cnMaestro X. 
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XV2-21X Wi-Fi 6 Access Point 
 
Management 

 
cnMaestro uses a distributed intelligence architecture with cloud-first 
management and edge-intelligent APs that self-optimize for the RF environment. 
cnMaestro delivers a single pane-of-glass management for Cambium broadband 
fixed wireless, cnMatrix Ethernet Switches, enterprise-grade Wi-Fi APs, NSE 
Service Edge, and residential service provider routers. 

cnMaestro can be deployed on cloud or on-premises via a virtual machine.  

To serve a growing market for advanced management and services functionality, 
Cambium Networks offers cnMaestro in two management tiers: 
 

cnMaestro X  
Paid subscription that includes:  

• Advanced device management capabilities 
• Deep packet inspection (DPI) application visibility 

and Control for 2,400+ apps 
• RESTful management and statistics API 
• Presence location push APIs 
• Graphic reports 
• Webhooks 
• Cambium Care Pro for 24x7 technical support 
• Accelerated access to L2 engineers and regular 

software updates 
 

Assists 
• Assesses the network’s configuration and identifies 

weak security settings and proposes a fix to ensure 
the network configuration is up to the top security 
industry standards 

 
 

X Assurance 
• Helps to quickly identify network-wide connectivity 

issues by isolating every element of the client’s 
lifecycle, either radio or network related 

• Gives an overview quality index of the network and 
highlights each element’s contribution to easily 
identify the worst offender 

• Provides insight of probable causes and proposes 
fixes for the administrator to apply 

• Provides individual client connectivity visibility 
throughout the entire lifecycle of its connection to 
easily identify each connection’s result and highlight 
the failure reason, should there be any 

 
EasyPass Portal with Additional Options 

• Self-registration: Form-based access 
• Sponsored guest: Guest ambassador-based access 
• Paid access: Monetize the Wi-Fi access 
• Microsoft Azure: Corporate user login 
• Google Login: Web login using Google accounts 

 
 
cnMaestro Essentials 
License-free cloud management that delivers a disruptive total cost of ownership (TCO) for organizations of all sizes. Includes EasyPass 
for OneClick or voucher-based connection as well as WiFi4EU access. 

 
 

  
Find out more about 

cnMaestro 

https://www.cambiumnetworks.com/products/software/
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XV2-21X Wi-Fi 6 Access Point 
 
 
  

Front Front Oblique 

Back Panel 

Bottom/Ports 

Front Panel with 
Mounting Bracket 

Back Panel with 
Mounting Bracket 
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FRONT 

  

 

XV2-21X Wi-Fi 6 Access Point 
 

Antenna Patterns 
2.4 GHz Elevation 2.4 GHz Azimuth 

  

5 GHz Elevation 5 GHz Azimuth 
  

 
 

2.4 GHz Receive Sensitivity (dBm) per Chain  2.4 GHz TX Power Target 
HT20 HT40  Rate Pout (dBM) 
MCS0 -95.5 MCS0 -93  MCS0 HT20 27 
MCS7 -76.5 MCS7 -74  MCS7 HT20 25 
HE20 HE40  MCS8 VHT20 25 
MCS0 -95.5 MCS0 -92.5  MCS9 VHT40 24 
MCS7 -76.5 MCS7 -73.5  MCS11 HE40 23 

 
5 GHz Receive Sensitivity (dBm) per Chain  5 GHz TX Power Target 
VHT20 VHT40 VHT80 VHT160  Rate Pout (dBm) 
MCS0 -95.5 MCS0 -94 MCS0 -90 MCS0 -87.5  MCS0 VHT20 27 
MCS7 -77 MCS7 -74 MCS7 -71.5 MCS7  -69  MCS7 VHT20 24 
HE20 HE40 HE80 HE160  MCS0 VHT40, VHT80 27, 27 
MCS0 -95.5 MCS0 -93.5 MCS0 -90.5 MCS8 -65  MCS7 VHT40, VHT80 24, 24 
MCS7 -76.5 MCS7 -74 MCS7 -71.5 MCS11 -57  MCS11, HE20, HE40, HE80, HE160 22, 22, 22, 21 

  

BACK 
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XV2-21X Wi-Fi 6 Access Point 
 
XV2-21X Ordering Information 
Regulatory Model XV2-21X 
XV2-21X0A00-US XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, US 
XV2-21X0A00-EU XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, EU 
XV2-21X0A00-RW XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, RW 
XV2-21X0A00-CA XV2-21X Indoor Dual radio WiFi 6 AP, 2x2, GbE, CA 
C000000L141A PoE, 60W, 56V, 10GbE DC Injector, Indoor, Energy Level 6 Supply 
N000000L034B PoE, 30.5W, 56V, GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector 
N000900L017A PoE, 15.4W, 56V, GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector 
XA-DROPTILE15 Recessed ceiling tile Installation Kit for 15mm T-bar, 20mm drop extension. 5 Pack 
XA-DROPTILE24 Recessed ceiling tile Installation Kit for 24mm T-bar, 20mm drop extension. 5 Pack 

 
 
cnMaestro X Subscriptions 
MSX-SUB-XV2-21X-1 cnMaestro X for one XV2-21X AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 1-year 

subscription 
MSX-SUB-XV2-21X-3 cnMaestro X for one XV2-21X AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 3-year 

subscription 
MSX-SUB-XV2-21X-5 cnMaestro X for one XV2-21X AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 5-year 

subscription 
 
 
Cambium Care Support 

CCADV-SUP-XV2-21X-1 
Cambium Care Advanced, 1-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and 
NBD advance replacement for HW 

CCADV-SUP-XV2-21X-3 
Cambium Care Advanced, 3-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and 
NBD advance replacement for HW 

CCADV-SUP-XV2-21X-5 
Cambium Care Advanced, 5-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and 
NBD advance replacement for HW 

CCPRO-SUP-XV2-21X-1 Cambium Care Pro, 1-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCPRO-SUP-XV2-21X-3 Cambium Care Pro, 3-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCPRO-SUP-XV2-21X-5 Cambium Care Pro, 5-year support for one XV2-21X Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 

CCADV-UPG-XV2-21X-1 
Cambium Care Advanced Add-on to cnMaestro X, 1-year support for one XV2-21X. 24x7 TAC support, SW 
updates, and NBDS advance replacement for HW 

CCADV-UPG-XV2-21X-3 
Cambium Care Advanced Add-on to cnMaestro X, 3-year support for one XV2-21X. 24x7 TAC support, SW 
updates, and NBDS advance replacement for HW 

CCADV-UPG-XV2-21X-5 
Cambium Care Advanced Add-on to cnMaestro X, 5-year support for one XV2-21X. 24x7 TAC support, SW 
updates, and NBDS advance replacement for HW 
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XV2-21X Wi-Fi 6 Access Point 
 

EIRP is limited to the countries listed below. 
 

SE Asia Regulatory Details 

Country 

2.4 GHz (EIRP) 5 GHz (EIRP) 
2400–2483.5 MHz 5150–5250 MHz 5250–5350 MHz 5470–5725 MHz 5725–5825 MHz 

Indonesia 27 dBm (500mW) 
indoor 

23 dBm (200mW) 
indoor 

23 dBm (200mW) 
indoor 

Not supported 23 dBm (200mW) 
indoor, 

36 dBm (4W) outdoor 36 dBm (4W) outdoor 
Vietnam 23 dBm (200mW) 23 dBm (200mW) 23 dBm (200mW) 30 dBm (1W) 30 dBm (1W) 

Philippines 26 dBm (400mW) 26 dBm (400mW) 26 dBm (400mW) 26 dBm (400mW) 26 dBm (400mW) 
Malaysia* 27 dBm (500mW) 30 dBm (1W) indoor 30 dBm (1W) indoor 5470–5650 MHz 30 dBm (1W) 

23 dBm (200mW) 
outdoor 

30 dBm (1W) 

Singapore 23 dBm (200mW) 23 dBm (200mW) 23 dBm (200mW) 30 dBm (1W) 30 dBm (1W) 
Thailand 20 dBm (100mW) 23 dBm (200mW) 23 dBm (200mW) 30 dBm (1W) 30 dBm (1W) 

*Malaysia restricts the use of 5650 MHz–5725 MHz for regulatory reasons. 
 
 
 
 
 
 
 

LIMITED WARRANTY 

Cambium Networks XV2-21X Wi-Fi 6 Access Point includes a limited 
lifetime hardware warranty that extends 5 years after end of sale. 

 

 

 

 

 
 
 
 
 

ABOUT CAMBIUM NETWORKS 

Cambium Networks enables service providers, enterprises, industrial organizations, and governments to deliver exceptional digital 

experiences and device connectivity with compelling economics. Our ONE Network platform simplifies management of Cambium 

Networks’ wired and wireless broadband and network edge technologies. Our customers can focus more resources on managing 

their business rather than the network. We make connectivity that just works. 

cambiumnetworks.com 

 
10222024 
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XV2-23T Wi-Fi 6 Outdoor Access Point 
802.11ax Dual-Radio, 2x2 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Value-Tier Wi-Fi for Any Market 
The Cambium Networks’ XV2-23T Wi-Fi 6 Outdoor 
Access Point (AP) delivers a high performance-to-price 
ratio attractive to any market. The XV2-23T can be 
onboarded and managed by your choice of Cambium 
management systems, including cnMaestro™ Essentials 
and cnMaestro X, available in cloud and on-premises 
versions. Choose the management type you need and 
change it at any time. Unlike other value-tier access 
points, the XV2-23T is never locked into just one 
management selection. 

Designed for Fast Installation 
The XV2-23T offers multiple installation methods included 
in the same shipping box. Mount the AP to a pole using the 
included clamps or to a flat surface using the integrated 
bracket. The XV2-23T is a compact size and high-
performance outdoor Wi-Fi 6 AP. 

 
  

XV2-23T Quick Look: 
Value tier outdoor Wi-Fi 6 access point designed for 
cost-effective upgrade to the latest 802.11ax standard 
in Wi-Fi technology. 
• Dual-radio Wi-Fi 6 
• 5 GHz (2x2), 2.4 GHz (2x2) 
• One 1 GbE uplink 
• Outdoor rated IP67 enclosure 
• cnMaestro™ Network Management 
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XV2-23T Wi-Fi 6 Outdoor Access Point 
 
Access Point Specifications 

Radios 5 GHz 802.11 a/n/ac/ax, 2x2 
2.4 GHz 802.11 b/g/n/ax, 2x2 

 Power Typical 20W, 802.3af powered device 

Wi-Fi 802.11 a/b/g/n/ac/ax  Dimensions 300 mm x 200 mm x 84 mm 
(11.8 in x 7.9 in x 3.3 in) 

SSID Security WPA3-SAE, WPA3-Enterprise, WPA2-PSK 
(CCMP, AES, 802.11i), WPA2-Enterprise 
(802.1X/EAP), OSEN, OWE, Open  

Weight 1,200 g (2.65 lbs) 
Security Kensington lock slot 

Ports 1 x IEEE 100/1000 Mbps Ethernet  Mount Options Pole or wall mounting. 
Pole diameter: min 30 mm / max 75 mm 

Antenna Gain 5 GHz 10 dBi, Omni 
2.4 GHz 7 dBi, Omni 

Ambient Operation 
Temperature 

-40ºC to 65ºC (-40ºF to 149ºF) 

Max EIRP* 5 GHz 36 dBm 
2.4 GHz 34 dBm 

 Storage 
Temperature 

-40ºC to 70ºC (-40ºF to 158ºF) 

Max PHY Rate 5 GHz radio 2,402 Mbps 
2.4 GHz radio 573.5 Mbps 

 Humidity 95% RH non-condensing 

Filter LTE Band 38, 40  MTBF 5,077,102 hours @ 25ºC 
1,224,983 hours @ 65ºC 

FCC Ch 1–11, 36–48, 52-64, 100–144, 149–165  LEDs Multi-color status LEDs, dimmable, on/off 
ISED Ch 1–11, 36–48, 52-64, 100–116, 149–165  Certifications 

(compliance) 
WiFi Alliance 802.11a/b/g/n/ac/ax, PP2.0 
FCC, CE, IC, IEC60950, IEC62368, 
EN50121, EN61373 

ETSI* Ch 1–13, 36–64, 52-64, 100–140, 149-173 
ROW* Ch 1–14, 36–48, 52-64, 100–144, 149–177 
 
*Individual country limits may apply.  
 
Standards 

Wi-Fi Protocols VHT MCS rates, 16/64/256/1024/4096-QAM, Channel width support in 5GHz: 20/40/80/160 MHz 

Transmit Beam steering, Airtime Fairness, AMSDU, AMPDU, RIFS, STBC, LDPC, MIMO Power Save, MRC, BPSK, 
QPSK, CCK, DSSS, OFDM, OFDMA, UL/DL MU-MIMO 
IEEE 802.11a/ac/ax/b/d/e/g/h/i/k/n/r/u/v/w 
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XV2-23T Wi-Fi 6 Outdoor Access Point 
 
Network Specifications 

Operational Modes Controllerless standalone 
Cloud-managed cnMaestro or VM  

 RF Management Multi-modal RF optimization supporting 
Auto-RF for dynamic channel selection and 
dynamic power adjustment configured via 
cnMaestro, performed in the intelligent 
edge AP.  
RF monitor with channel utilization/ packet 
error rate / interference. 

WLAN 256 concurrent clients  
16 SSIDs per AP 

Security, 
Authentication 
Encryption 

Open, WPA2-AES with PSK, ePSK and 
Enterprise 
WPA3 with PSK (WPA3-SAE), ePSK, 
Enterprise, Enterprise-CNSA, OWE 
(Enhanced Open) 
OSEN and PMF (802.11 W) 
MAC authentication with local database 
or external database using RADIUS 
protocol 
802.1X with EAP-TTLS, EAP-TLS / 
MSCHAPv2, PEAPv0 / PEAPv1 / EAP-
PEAP / EAP-SIM/AKA/AKA’/FAST 
Hotspot 2.0 WEB authentication 

 Band Steering Yes 
Mesh Multi-hop, either band 
Scheduled WLAN On/off by day, week, time of day 
Data Limit Client bitrate/time/throughput limit per SSID 
Network TCP connection log, NAT logging firewall, 

DHCP server, DHCP Relay option 82, VLAN 
pooling, RADIUS attribute, VID VLAN per SSID 
per user, ePSK with VLAN assignment per PSK  
LLDP, IGMP v1, v2 

Network Tools Wired and wireless remote packet capture, 
logging, WAN speed test, ZapD, remote 
network connectivity tools 

Wi-Fi Quality of 
Service 

WMM (packet marking either with 
802.1p or IP DSCP), WMM-PS, U-APSD 
Multicast to unicast conversion 

 Tunnel L2TPv2, L2GRE, PPPoE 
IP IPv4, IPv6 
VLAN 802.11Q, max 4096 

Service Availability Critical network resource monitor with SSID 
shutdown 

 Management 
Interfaces 

HTTP / HTTPS web interface, SSH, Telnet  

Fast Roaming 802.11k/r/v, OKC, cnMaestro-assisted roam  Security Rogue AP detection and termination(X), 
WIDs/WIPs, DoS protection 
L2–L7 firewall with application visibility(X) & 
control(X), DNS based access control(X). 

ACL and AirCleaner tools 

Guest Access/ 
Captive Portal 
Service (EasyPass)* 

cnMaestro-hosted EasyPass portal 
Multiple authentication methods 
supported to onboard guest user: 

• Radius-based authentication 
• Click-through with simple terms and 

conditions acceptance 
• Social login using Google®, Facebook® 
• SMS-based authentication (X) 
• Voucher-based access 
• Microsoft® Azure AD and Google 

Workspace® (X) 
• Sponsored guest access (X) 
• Self-registration access (X) 

cnMaestro API support for external captive 
portal integration 
802.11u, Hotspot 2.0 

 

Services Wi-Fi Calling control, NTP, Syslog, DNS 
proxy, SNMP traps, SNMPv1, SNMPv2c, 
SNMPv3, TCP and DNS logging  

  

  

Accounting RADIUS accounting, load balancing AAA 
servers, Dynamic Authorization COA, DM 

   

API RESTful management and statistics API via 
cnMaestro X, presence location push APIs 

   

 
*X features available in cnMaestro X. 
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XV2-23T Wi-Fi 6 Outdoor Access Point 
 
Management 

 
cnMaestro uses a distributed intelligence architecture with cloud-first 
management and edge-intelligent APs that self-optimize for the RF environment. 
cnMaestro delivers a single pane-of-glass management for Cambium broadband 
fixed wireless, cnMatrix Ethernet Switches, enterprise-grade Wi-Fi APs, NSE 
Service Edge, and residential service provider routers. 

cnMaestro can be deployed on cloud or on-premises via a virtual machine.  

To serve a growing market for advanced management and services functionality, 
Cambium Networks offers cnMaestro in two management tiers: 
 

cnMaestro X  
Paid subscription that includes:  

• Advanced device management capabilities 
• Deep packet inspection (DPI) application visibility 

and Control for 2,400+ apps 
• RESTful management and statistics API 
• Presence location push APIs 
• Graphic reports 
• Webhooks 
• Cambium Care Pro for 24x7 technical support 
• Accelerated access to L2 engineers and regular 

software updates 
 

Assists 
• Assesses the network’s configuration and identifies 

weak security settings and proposes a fix to ensure 
the network configuration is up to the top security 
industry standards 

 
 

X Assurance 
• Helps to quickly identify network-wide connectivity 

issues by isolating every element of the client’s 
lifecycle, either radio or network related 

• Gives an overview quality index of the network and 
highlights each element’s contribution to easily 
identify the worst offender 

• Provides insight of probable causes and proposes 
fixes for the administrator to apply 

• Provides individual client connectivity visibility 
throughout the entire lifecycle of its connection to 
easily identify each connection’s result and highlight 
the failure reason, should there be any 

 
EasyPass Portal with Additional Options 

• Self-registration: Form-based access 
• Sponsored guest: Guest ambassador-based access 
• Paid access: Monetize the Wi-Fi access 
• Microsoft Azure: Corporate user login 
• Google Login: Web login using Google accounts 

 
 
cnMaestro Essentials 
License-free cloud management that delivers a disruptive total cost of ownership (TCO) for organizations of all sizes. Includes EasyPass 
for OneClick or voucher-based connection as well as WiFi4EU access. 

 
 

  

P339T 6#y

Find out more about 
cnMaestro 

https://www.cambiumnetworks.com/products/software/
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XV2-23T Wi-Fi 6 Outdoor Access Point 
 
 
  

Front Back 

Bottom 

Front Oblique Side 
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XV2-23T Wi-Fi 6 Outdoor Access Point 
 

Antenna Patterns 
2.4 GHz Azimuth 2.4 GHz Elevation 

  

5 GHz Azimuth 5 GHz Elevation 
  

 
2.4 GHz Receive Sensitivity (dBm) per Chain  2.4 GHz TX Power Target 
802.11b 802.11g  Rate Pout (dBM) 
1 Mb -99 1 Mb -94.5  802.11b 1Mb 27 
11 Mb -91 11 Mb -75.75  802.11g 6Mb 27 
HT20 HT40  MCS0 HT20, HT40 27, 27 
MCS0 -95 MCS0 -92.5  MCS7 HT20, HT40 25, 25 
MCS7 -76.5 MCS7 -73.5  MCS0 VHT20, VHT40 27, 27 
HE20 HE40  MCS11 VHT20, VHT40 23, 23 
MCS0 -94.75 MCS0 -92  MCS0 HE20, HE40 27, 27 
MCS11 -64.25 MCS11 -61.25  MCS11 HE20, HE40 23, 23 

 

5 GHz Receive Sensitivity (dBm) per Chain  5 GHz TX Power Target 
VHT20 VHT40 VHT80 VHT160  Rate Pout (dBm) 
MCS0 -95.5 MCS0 -94 MCS0 -90 MCS0 -87.5  802.11a 27 
MCS7 -77 MCS7 -74 MCS7 -71.5 MCS7  -69  MCS0 HT20, HT40 27, 27 
HE20 HE40 HE80 HE160  MCS0 HT20, HT40 24,24 
MCS0 -95.5 MCS0 -93.5 MCS0 -90.5 MCS8 -65  MCS0 VHT40, VHT80, VHT160 27, 27, 27, 27 
MCS7 -76.5 MCS7 -74 MCS7 -71.5 MCS11 -57  MCS11 VHT40, VHT80, VHT160 22, 22, 22, 21 
         MCS0 HE20, HE40, HE80, HE160 27, 27, 27, 27 
         MCS11, HE20, HE40, HE80, HE160 22, 22, 22, 21 
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XV2-23T Wi-Fi 6 Outdoor Access Point 

 
XV2-23T Ordering Information 
Regulatory Model XV2-23T 
XV2-23T0B00-US XV2-23T Outdoor Dual radio WiFi 6 AP, 2x2, 2.5 GbE, IP67, US 
XV2-23T0B00-EU XV2-23T Outdoor Dual radio WiFi 6 AP, 2x2, 2.5 GbE, IP67, EU 
XV2-23T0B00-RW XV2-23T Outdoor Dual radio WiFi 6 AP, 2x2, 2.5 GbE, IP67, RW 
XV2-23T0B00-CA XV2-23T Outdoor Dual radio WiFi 6 AP, 2x2, 2.5 GbE, IP67, CA 
C000000L141A PoE, 60W, 56V, 10GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector 
N000000L034B PoE injector, 30.5W, 56V, 5GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector 
N000900L017A PoE, 15.4W, 56V, GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector 
AX-E510RBKT-WW Shock mount bracket 

 

 
cnMaestro X Subscriptions 
MSX-SUB-XV2-23T-1 cnMaestro X for one XV2-23T AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 1-year subscription 
MSX-SUB-XV2-23T-3 cnMaestro X for one XV2-23T AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 3-year subscription 
MSX-SUB-XV2-23T-5 cnMaestro X for one XV2-23T AP. Creates one Device Tier 3 slot. Includes Cambium Care Pro support. 5-year subscription 

 

 
Cambium Care Support 

CCADV-SUP-XV2-23T-1 Cambium Care Advanced, 1-year support for one XV2-23T Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and 
NBD advance replacement for HW 

CCADV-SUP-XV2-23T-3 Cambium Care Advanced, 3-year support for one XV2-23T Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and 
NBD advance replacement for HW 

CCADV-SUP-XV2-23T-5 Cambium Care Advanced, 5-year support for one XV2-23T Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and 
NBD advance replacement for HW 

CCPRO-SUP-XV2-23T-1 Cambium Care Pro, 1-year support for one XV2-23T Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCPRO-SUP-XV2-23T-3 Cambium Care Pro, 3-year support for one XV2-23T Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCPRO-SUP-XV2-23T-5 Cambium Care Pro, 5-year support for one XV2-23T Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCADV-UPG-XV2-23T-1 Cambium Care Advanced Add-on to cnMaestro X, 1-year support for one XV2-23T. 24x7 TAC support, SW 

updates, and NBDS advance replacement for HW 
CCADV-UPG-XV2-23T-3 Cambium Care Advanced Add-on to cnMaestro X, 3-year support for one XV2-23T. 24x7 TAC support, SW 

updates, and NBDS advance replacement for HW 
CCADV-UPG-XV2-23T-5 Cambium Care Advanced Add-on to cnMaestro X, 5-year support for one XV2-23T. 24x7 TAC support, SW 

updates, and NBDS advance replacement for HW 

LIMITED WARRANTY  

Cambium Networks XV2-23T Wi-Fi 6 Access Point includes a limited 
lifetime hardware warranty for a period of 3 years. 

 

ABOUT CAMBIUM NETWORKS 

Cambium Networks enables service providers, enterprises, industrial organizations, and governments to deliver exceptional digital 

experiences and device connectivity with compelling economics. Our ONE Network platform simplifies management of Cambium 

Networks’ wired and wireless broadband and network edge technologies. Our customers can focus more resources on managing 

their business rather than the network. We make connectivity that just works. 

cambiumnetworks.com 
12062024 
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
802.11ax Tri-Radio 2x2/2x2/4x4 (2+2+4) Access Point with Software-Defined Radio 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Designed for High-Density and Edge Services 

The XE3-4 is a tri-radio Wi-Fi 6/6E, 2x2/2x2/4x4 (2+2+4) 
access point (AP) designed to deliver future-proof 
performance and value for building next-generation 
networks. Wi-Fi 6 delivers faster and more efficient 
wireless network connections than previous generation 
Wi-Fi technologies. Wi-Fi 6E extends the capacity of Wi-Fi 
into the 6 GHz band, more than tripling the wireless 
spectrum available. With a high-speed software-defined 
radio, the XE3-4 enables seamless transition to Wi-Fi 6E 
with the ability to easily change from dual-band to tri-band 
mode (2.4 GHz, 5 GHz, and 6 GHz) when sufficient 6 GHz 
clients are available. 

The XE3-4 is fully backward compatible with existing Wi-Fi 
technology, enabling simultaneous support of new high-
speed clients, legacy clients, low-bitrate IoT devices, and 
more in a single wireless infrastructure. 

The XE3-4 comes with limited lifetime warranty providing 
return and repair service on the access point from date of 
purchase until end of life of the product.

Cloud and On-Premises Management 

The XE3-4 is supported by Cambium ONE Network 
enterprise architecture managed by the cnMaestro™ 
Network Management System. cnMaestro uses a 
distributed intelligence architecture with cloud-first 
management and edge-intelligent Wi-Fi that self-
optimizes for the RF environment. cnMaestro delivers a 
single-pane-of-glass management experience for 
enterprise Wi-Fi APs, cnMatrix™ Ethernet Switches, NSE 
Security Appliance/SD-WAN/Firewall, service provider 
residential routers, and Cambium’s fixed wireless 
broadband and fiber. 

cnMaestro Network Management 
• Wi-Fi, switching, security, and fixed wireless 

broadband 
• Help desk troubleshooting tools 
• Real-time and historical device analytics 
• EasyPass user and device onboarding portals 
• Application visibility and control 
• Graphical reports 
• And more 

 

XE3-4 Quick Look: 

• Tri-radio/tri-band Wi-Fi 6 and 6E 
• 6.6 Gbps aggregate data rate 
• Software-defined 5 GHz/6 GHz radio 
• 2.5 GbE and 1 GbE uplink ports 
• EasyPass with Microsoft Azure and 

Google G Suite integration 
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
 
Access Point Specifications 

Radios 5 GHz/6 GHz: 802.11a/n/ac/ax, 4x4:4 SW 
definable 
5 GHz: 802.11 a/n/ac/ax, 2x2:2 
2.4 GHz: 802.11 b/g/n/ax, 2x2:2 
BLE 4.1 

 Power 32W 802.3bt powered device 
25.5W 802.3at with USB, BT disabled 
Typical 22W (USB disabled) 

Dimensions 215 mm x 215 mm x 42 mm (without bracket) 
(8.46 in x 8.46 in x 1.65 in ) 

Wi-Fi 802.11 a/b/g/n/ac/ax  Weight 900 g (1.98 lb) 
SSID Security WPA3-SAE, WPA3-Enterprise, WPA2-PSK 

(CCMP, AES, 802.11i), WPA2-Enterprise 
(802.1X/EAP), OSEN, OWE, Open 

Security Kensington lock slot 
Mount Options Wall or ceiling, T-bar with included locking 

bracket, ceiling tile plate 
Ports 1 x IEEE 10/100/1000/2500 Mbps Ethernet  

1 x IEEE 10/100/1000 Mbps Ethernet 
1 x USB 2.0 

 Ambient Operation 
Temperature 

0ºC to 50ºC (32ºF to 122ºF) 

Storage 
Temperature 

-40ºC to 70ºC (-40ºF to 158ºF) 

Antenna Gain 6 GHz: 6.29 dBi, Omni 
5 GHz: 6.12 dBi, Omni 
2.4 GHz: 4.85 dBi, Omni 

 Humidity 95% RH non-condensing 
MTBF 668,759 hours at 25C 

314,145 hours at 50ºC 
Max EIRP* 6 GHz: 30 dBm 

5 GHz: 31 dBm 
2.4 GHz: 29 dBm 

 LEDs Multi-color status LEDs, dimmable, on/off 

FCC Ch 1–11, 36–64, 100–144, 149–165  Certifications 
(Compliance) 

Wi-Fi Alliance, Passpoint 3.0 
FCC, IC, CE, EN 60601-1-2, EN 60950-1 
IEC 62368-1 Safety, EN 60601-1-2 Medical 
EMC, EN 61000-4-2/3/5 Immunity, EN 50121-
1 Railway EMC, EN 50121-4 Railway EMC, IEC 
61373 Railway Shock & Vibration, UL 2043 
Plenum 
EN 62311 Human Safety/RF Exposure, WEEE 
& RoHS 

ISED Ch 1–11, 36–64, 100–116, 149–165  
ETSI* Ch 1–13, 36–64, 100–140, 149–173  
ROW* Ch 1–14, 36–64, 100–144, 149–173  

6 GHz Channels 
FCC/IC/ROW 
EU 

 
Ch 1–233 
Ch 1–93 

 
*Individual country limits may apply.  
 
 
Max PHY Data Rate 
Radio Type Band Number of Radios Max Data Rate 
4x4 SW-Defined 5 or 6 GHz 1 4.804 Gbps 
2x2 5 GHz 1 1.201 Gbps 
2x2 2.4 GHz 1 574 Mbps 
Total  3 6.579 Gbps 

 
 
Standards 

Wi-Fi Protocols Data Coding support 16/64/256/1024/4096-QAM, VHT MCS rates 
Channel width support 5GHz and 6GHz band: 20/40/80/160 MHz 
TWT, Long OFDM Symbol, transmit beamforming, Airtime Fairness, AMSDU, AMPDU, RIFS, STBC, LDPC, MIMO Power 
Save, MRC, BPSK, QPSK, CCK, DSSS, OFDM, OFDMA, UL/DL MU-MIMO 
IEEE 802.11 a/ac/ax/b/d/e/g/h/i/j/k/n/r/s/u/v/w 
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
 
Network Specifications 

Operational Modes Controllerless standalone  
Cloud-managed cnMaestro or VM 

 RF Management Multi-modal RF optimization supporting Auto-
RF for dynamic channel selection & dynamic 
power adjustment configured via cnMaestro, 
performed in the intelligent edge AP 
RF monitor with channel utilization/packet 
error rate/interference. 

WLAN 500 clients per radio 1,500 per AP 
16 SSIDs per AP 

Security, 
Authentication 
Encryption 

Open, WPA-TKIP, WPA2-AES with PSK, 
ePSK and Enterprise 
WPA3 with PSK (WPA3-SAE), ePSK, 
Enterprise, Enterprise-CNSA, OWE 
(Enhanced Open) 
OSEN and PMF (802.11 W) 
MAC authentication with local database or 
external database using RADIUS protocol 
802.1X with EAP-TTLS, EAP-TLS / 
MSCHAPv2, PEAPv0 / PEAPv1 / EAP-PEAP / 
EAP-SIM/AKA/AKA’/FAST 
MAC auth fallback to guest portal 
Hotspot WEB authentication 

 Band Steering Yes 
Mesh Multi-hop, all 3 bands 
Scheduled WLAN On/off by day, week, time of day 
Data Limit Client bitrate/time/throughput limit per SSID 
Network LACP (802.3ad), TCP connection log, NAT 

logging firewall, DHCP server, DHCP Relay 
option 82, VLAN pooling, RADIUS attribute, 
VID VLAN per SSID per user, ePSK with VLAN 
assignment per PSK 
LLDP, IGMP v1, v2 

Network Tools Wired and wireless remote packet capture, 
logging, WAN speed test, ZapD, remote 
network connectivity tools 

Wi-Fi Quality of 
Service 

WMM (packet marking either with 802.1p or 
IP DSCP), WMM-PS, U-APSD 
Multicast to unicast conversion 

 Tunnel L2TPv2, L2GRE, PPPoE 

IP IPv4, IPv6 

Service Availability Critical network resource monitor with SSID 
shutdown 

 VLAN 802.11Q, max 4096 

Fast Roaming 802.11k/r/v, OKC, cnMaestro-assisted roam  Management 
interfaces 

HTTP/HTTPS web interface, SSH, Telnet  

Guest Access/ 
Captive Portal 
Service (EasyPass)* 

cnMaestro-hosted EasyPass portal 
Multiple authentication methods 
supported to onboard guest user: 

• Radius-based authentication 
• Click-through with simple terms and 

conditions acceptance 
• Social login using Google®, Facebook® 
• SMS-based authentication (X) 
• Voucher-based access 
• Microsoft® Azure AD and Google 

Workspace® (X) 
• Sponsored guest access (X) 
• Self-registration access (X) 

cnMaestro API support for external captive 
portal integration 
802.11u, Hotspot 2.0 

 Security Rogue AP detection and termination (X), 
WIDs/WIPs, DoS protection 
L2–L7 firewall with application visibility (X) & 
control (X), DNS-based access control (X) 
ACL and AirCleaner tools 

Services Wi-Fi Calling control, NTP, Syslog, DNS proxy, 
SNMP traps, SNMPv1, SNMPv2c, SNMPv3, 
TCP and DNS logging 

  

Accounting RADIUS accounting, load balancing AAA 
servers, Dynamic Authorization COA, DM 

 

API RESTful management and statistics API via 
cnMaestro X, presence location push APIs 

  

 
*X features available in cnMaestro X. 
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
 
Management 

 
cnMaestro uses a distributed intelligence architecture with cloud-first 
management and edge-intelligent APs that self-optimize for the RF environment. 
cnMaestro delivers a single pane-of-glass management for Cambium broadband 
fixed wireless, cnMatrix Ethernet Switches, enterprise-grade Wi-Fi APs, NSE 
Security Appliance/Firewall/SDWAN, and service provider routers. 

cnMaestro can be deployed on cloud or on-premises via a virtual machine.  

To serve a growing market for advanced management and services functionality, 
Cambium Networks offers cnMaestro in two management tiers: 
 

cnMaestro X  
Paid subscription that includes:  

• Advanced device management capabilities 
• Deep packet inspection (DPI) application visibility 

and control for 2,400+ apps 
• RESTful management and statistics API 
• Presence location push APIs 
• Graphic reports 
• Webhooks 
• Cambium Care Pro for 24x7 technical support 
• Accelerated access to L2 engineers and regular 

software updates 
 

Assists 
• Assesses the network’s configuration and identifies 

weak security settings and proposes a fix to ensure 
the network configuration is up to the top security 
industry standards 

 
 

X Assurance 
• Helps to quickly identify network-wide connectivity 

issues by isolating every element of the client’s 
lifecycle, either radio or network related 

• Gives an overview quality index of the network and 
highlights each element’s contribution to easily 
identify the worst offender 

• Provides insight of probable causes and proposes 
fixes for the administrator to apply 

• Provides individual client connectivity visibility 
throughout the entire lifecycle of its connection to 
easily identify each connection’s result and highlight 
the failure reason, should there be any 

 
EasyPass Portal with Additional Options 

• Self-registration: Form-based access 
• Sponsored guest: Guest ambassador-based access 
• Paid access: Monetize the Wi-Fi access 
• Microsoft Azure: Corporate user login 
• Google login: Web login using Google accounts 

 
 
cnMaestro Essentials 
License-free cloud management that delivers a disruptive total cost of ownership (TCO) for organizations of all sizes. Includes EasyPass 
for OneClick or voucher-based connection as well as WiFi4EU access. 

 
 

  
Find out more about 

cnMaestro 

https://www.cambiumnetworks.com/products/software/
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
 
  

Front Back 

Left Side Right Side 

Back  Back 
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
 

Antenna Patterns 
2x2 2.4 GHz Azimuth 2x2 2.4 GHz Elevation 

  

2x2 5 GHz Azimuth 2x2 5 GHz Elevation 

  

4x4 5 GHz Azimuth 4x4 5 GHz Elevation 
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
 

Antenna Patterns 
4x4 6 GHz Azimuth 4x4 6 GHz Elevation 

  
 
 
XE3-4 Ordering Information 
Regulatory Model XE3-4 
XE3-4X00B00-US Indoor Tri-Radio Wi-Fi 6/6E Access Point. SDR 802.11ax 4x4/2x2, US 
XE3-4X00B00-EU Indoor Tri-Radio Wi-Fi 6/6E Access Point. SDR 802.11ax 4x4/2x2, EU 
XE3-4X00B00-RW* Indoor Tri-Radio Wi-Fi 6/6E Access Point. SDR 802.11ax 4x4/2x2, RW 
XE3-4X00B00-CA Indoor Tri-Radio Wi-Fi 6/6E Access Point. SDR 802.11ax 4x4/2x2, CA 
C000000L141A PoE, 60W, 56V, 10GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector 
N000000L034B PoE injector, 30.5W, 56V, 5GbE DC Injector, Indoor, Energy Level 6 Supply, accepts C5 connector 
AX-E510RBKT-WW Shock mount bracket for cnPilot e510 and e505, Wi-Fi 6 XV3-8, XV2-2. XE3-4 
AX-WALLBRKT-WW  Wall Mount L-Bracket for XV and XE series APs. Use to mount the AP horizontally. 

 
 
cnMaestro X Subscriptions 
MSX-SUB-XE3-4-1 cnMaestro X for one XE3-4 AP. Creates one Device Tier3 slot. Includes Cambium Care Pro support. 1-year 

subscription  
MSX-SUB-XE3-4-3 cnMaestro X for one XE3-4 AP. Creates one Device Tier3 slot. Includes Cambium Care Pro support. 3-year 

subscription  
MSX-SUB-XE3-4-5 cnMaestro X for one XE3-4 AP. Creates one Device Tier3 slot. Includes Cambium Care Pro support. 5-year 

subscription  
 
*AP SKU that ends with 00-RW” does not support 6GHz.  The SDR radio is locked to 5GHz mode and cannot be changed to 6GHz.  Contact Cambium Networks 
customer support if you are operating a 00-RW product within a country that has allowed 6GHz operation. 
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XE3-4 Wi-Fi 6/6E Indoor Access Point 
 
Cambium Care Support 

CCADV-SUP-XE3-4-1 Cambium Care Advanced, 1-year support for one XE3-4 Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and NBD 
advance replacement for HW 

CCADV-SUP-XE3-4-3 Cambium Care Advanced, 3-year support for one XE3-4 Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and NBD 
advance replacement for HW 

CCADV-SUP-XE3-4-5 Cambium Care Advanced, 5-year support for one XE3-4 Wi-Fi 6/6E AP. 24x7 TAC support, SW updates, and NBD 
advance replacement for HW 

CCPRO-SUP-XE3-4-1 Cambium Care Pro, 1-year support for one XE3-4 Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCPRO-SUP-XE3-4-3 Cambium Care Pro, 3-year support for one XE3-4 Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCPRO-SUP-XE3-4-5 Cambium Care Pro, 5-year support for one XE3-4 Wi-Fi 6/6E AP. 24x7 TAC support and SW updates 
CCADV-UPG-XE3-4-1 Cambium Care Advanced Add-on to cnMaestro X, 1-year support for one XE3-4. 24x7 TAC support, SW updates, 

and NBDS advance replacement for HW 
CCADV-UPG-XE3-4-3 Cambium Care Advanced Add-on to cnMaestro X, 3-year support for one XE3-4. 24x7 TAC support, SW updates, 

and NBDS advance replacement for HW 
CCADV-UPG-XE3-4-5 Cambium Care Advanced Add-on to cnMaestro X, 5-year support for one XE3-4. 24x7 TAC support, SW updates, 

and NBDS advance replacement for HW 
 
 
 
 
 

LIMITED WARRANTY  

Cambium Networks XE3-4 Wi-Fi 6/6E Access Point includes a limited 
lifetime hardware warranty that extends 5 years after end of sale. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ABOUT CAMBIUM NETWORKS 

Cambium Networks enables service providers, enterprises, industrial organizations, and governments to deliver exceptional digital 

experiences and device connectivity with compelling economics. Our ONE Network platform simplifies management of Cambium 

Networks’ wired and wireless broadband and network edge technologies. Our customers can focus more resources on managing 

their business rather than the network. We make connectivity that just works. 

cambiumnetworks.com 
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Reservation of Rights

Cambium reserves the right to make changes to any products described herein to improve reliability, function, or
design, and reserves the right to revise this document and to make changes from time to time in content hereof
with no obligation to notify any person of revisions or changes. Cambium recommends reviewing the Cambium
Networks website for the latest changes and updates to products. Cambium does not assume any liability arising
out of the application or use of any product, software, or circuit described herein; neither does it convey license
under its patent rights or the rights of others. It is possible that this publication may contain references to, or
information about Cambium products (machines and programs), programming, or services that are not announced
in your country. Such references or information must not be construed to mean that Cambium intends to
announce such Cambium products, programming, or services in your country.

Copyrights

This document, Cambium products, and 3rd Party software products described in this document may include or
describe copyrighted Cambium and other 3rd Party supplied computer programs stored in semiconductor
memories or other media. Laws in the United States and other countries preserve for Cambium, its licensors, and
other 3rd Party supplied software certain exclusive rights for copyrighted material, including the exclusive right to
copy, reproduce in any form, distribute and make derivative works of the copyrighted material. Accordingly, any
copyrighted material of Cambium, its licensors, or the 3rd Party software supplied material contained in the
Cambium products described in this document may not be copied, reproduced, reverse engineered, distributed,
merged or modified in any manner without the express written permission of Cambium. Furthermore, the
purchase of Cambium products shall not be deemed to grant either directly or by implication, estoppel, or
otherwise, any license under the copyrights, patents or patent applications of Cambium or other 3rd Party
supplied software, except for the normal non-exclusive, royalty free license to use that arises by operation of law
in the sale of a product.

Restrictions

Software and documentation are copyrighted materials. Making unauthorized copies is prohibited by law. No part
of the software or documentation may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any language or computer language, in any form or by any means, without prior written permission
of Cambium.

License Agreements

The software described in this document is the property of Cambium and its licensors. It is furnished by express
license agreement only and may be used only in accordance with the terms of such an agreement.

High Risk Materials

Cambium and its supplier(s) specifically disclaim any express or implied warranty of fitness for any high-risk
activities or uses of its products including, but not limited to, the operation of nuclear facilities, aircraft navigation
or aircraft communication systems, air traffic control, life support, or weapons systems (“High Risk Use”).

This product is not restricted in the EU. Any High Risk is unauthorized, is made at your own risk and you shall be
responsible for any and all losses, damage or claims arising out of any High-Risk Use.

© 2024 Cambium Networks Limited. All rights reserved



Contents 3

Contents

Contents 3

About This User Guide 11

Overview of Enterprise Wi-Fi AP products 11

Intended audience 11

Purpose 11

Related documents 11

Supported hardware platforms 12

Premium feature list 13

Quick Start – Device Access 14

Powering up the device 14

PoE switches (802.3af/802.3at/802.3bt) 14

PoE adapter 15

DC power supply 16

Accessing the device 16

Device access using default or fallback IP 16

Device access using zeroconf IP 18

Device access using DHCP IP address 19

LED status 19

Onboarding the Device 21

Overview 21

Device onboarding and provisioning 21

cnMaestro 21

XMS-Cloud 22

Configuring the System 23

Basic 23

Power over Ethernet (PoE) in 25



Contents 4

Power over Ethernet (PoE) Out port 28

Link Layer Discovery Protocol (LLDP) 28

Management 30

Administrator Access 30

HTTPS Proxy server configuration 31

Time settings 32

Event logging 33

SNMP 33

Configuring the Radio 35

Overview 35

Configuring Radio parameters 35

Basic 35

Software-Defined Radio (SDR) capabilities 43

Enhanced Roaming 47

BSS Coloring 48

Target Wake Time (TWT) 48

Receive sensitivity configuration 48

Multicast-snooping and Multicast-to-Unicast conversion 48

Auto-RF 49

Overview 50

Dynamic Channel 50

Dynamic Power 51

Auto-RF behavior on device turn on 51

Configuring Dynamic Channel 51

Configuring Dynamic Power 53

Recommended Configuration 54

Configuring the Wireless LAN 56

Overview 56



Contents 5

Configuring the WLAN parameters 56

Basic 57

WLAN VLAN allowed list 70

ICMPv6 Router advertisement (RA) unicast conversion 70

802.11k/v 70

RADIUS server 71

Guest Access 75

Usage Limits 87

Scheduled Access 88

Access 90

Passpoint 93

RADIUS attributes 95

Enterprise PSK (ePSK) 97

Configuring ePSKs 97

ePSK registration for WPA3 clients 100

Creating a Personal Wi-Fi ePSK 108

RADIUS-based ePSK Premium feature 109

Configuring RADIUS-based ePSK 109

Groupwise Transient Key (GTK) per VLAN 111

Configuring the Network 112

Overview 112

Configuring Network parameters 112

IPv4 network parameters 112

Routes 118

IPv6 network parameters 119

General network parameters 122

Ethernet Ports 123

DHCP 126



Contents 6

Tunnel 127

Point-to-Point Protocol over Ethernet (PPPoE) 130

VLAN Pool 131

Wireless Wide Area Network (WWAN) 132

Configuring Access Control 134

Enabling Access Control Policy 134

User Group Policy 135

Device Policy 136

Managing Filters 138

Overview 138

Filter list 138

Filters 138

Configuring filter CLI 139

Device class filter 143

Wi-Fi Calling support 144

Air cleaner 144

Application control Premium feature 146

Deep Packet Inspection (DPI) 147

Custom Applications X 160

WIDS/WIPSPremium feature 163

Wireless Intrusion Detection Systems (WIDS) 163

Wireless flood detection 163

Neighbor AP detection 164

Rogue APs 164

Honeypot APs 164

Ad Hoc network detection 164

Wired Devices 165

Configuring WIDS 165



Contents 7

Wireless Intrusion Prevention System (WIPS) 166

Configuring Services 168

Overview 168

Configuring services 168

Lightweight Directory Access Protocol (LDAP) 168

NAT Logging 169

User Groups Premium feature 171

Real-Time Location System (RTLS) 172

Speed Test 176

DHCP Option-82 177

Bonjour Gateway 178

Link Aggregation Control Protocol (LACP) 180

Operations 182

Overview 182

Firmware upgrade 182

System 183

LED Test flashing pattern 184

Troubleshoot 186

Overview 186

Logging 186

Events 186

Debug Logs 187

Radio Frequency (RF) 188

Wi-Fi Analyzer 188

Packet capture 189

Performance 190

Speedtest on Access Point 190

Network Connectivity 191



Contents 8

XIRCON tool support 192

XIRCON tool support for Linux 1.0.0.40 193

Management Access 194

Local authentication 194

Device configuration 194

SSH Key authentication 194

Device configuration 194

SSH Key generation 195

RADIUS authentication 197

Device configuration 198

Mesh 199

Deployment scenarios 199

Mesh configurable parameters 201

Order of Mesh profile configuration 203

Mesh Auto Detect Backhaul 210

Scenario 1 210

Scenario 2 211

Scenario 3 211

Mesh Muti-Hop 214

Mesh Roaming 215

Mesh Base configuration 215

Mesh Client configuration 216

Mesh link-Sample configuration 217

VLAN 1 as the management interface 217

Non-VLAN 1 as the management interface 221

Typical use-cases 225

Additional mesh topology supported 226

Guest Access Portal - Internal 227



Contents 9

Introduction 227

Configurable parameters 228

Access policy 229

Splash page 229

Redirect parameters 230

Success message 231

Timeout 231

Whitelist 231

Configuration examples 231

Guest Access Portal - External 233

Introduction 233

Configurable parameters 233

Access policy 234

WISPr 234

External portal post through cnMaestro 234

External portal type 234

Redirect parameters 234

Success message 235

Timeout 235

Whitelist 235

Configuration examples 235

Guest Access – cnMaestro 237

Auto VLAN 238

Device Recovery Methods 239

Factory reset via ‘RESET’ button 239

Boot partition change via power cycle 239

Disable factory Reset Button 240

Command-Line Interface (CLI) 241



Contents 10

Show commands 241

Service commands 244

Service show 244

Service system 245

cnMaestro X Assurance 247

MarketApps 248

Target audience 248

Benefits 248

Glossary 249

Appendix 251

Supported RADIUS Attributes 252

WISPr VSAs (Vendor ID: 14122) 252

Cambium VSAs (Vendor ID: 17713) 253

Standard RADIUS attributes 256

RADIUS attributes in authentication and accounting packets with WPA2-Enterprise security 259

Supported CoA messages 261

Supported DFS channels 263

Supported 6 GHz countries 264

Priority order for parameters 267

Best practices for wireless clients seamless roaming across APs 268

External network recommendations 268

AP WLAN profile configuration recommendations 269

AP group configuration recommendations 271

Cambium Networks 273



About This User Guide 11

About This User Guide
This section describes the following topics:

l Overview of Enterprise Wi-Fi AP products

l Intended audience

l Purpose

l Related documents

l Supported hardware platforms

l Premium Feature List

Overview of Enterprise Wi-Fi AP products
This User Guide describes the features supported by Enterprise Wi-Fi Access Point (AP), and provides
detailed instructions for setting up and configuring Enterprise Wi-Fi AP.

Intended audience
This guide is intended for use by the system designer, system installer, and system administrator.

Purpose
Cambium Network’s Enterprise Wi-Fi AP documents are intended to instruct and assist personnel in the
operation, installation, and maintenance of Cambium’s equipment and ancillary devices. It is recommended
that all personnel engaged in such activities be properly trained.

Cambium disclaims all liability whatsoever, implied or expressed, for any risk of damage, loss, or reduction in
system performance arising directly or indirectly out of the failure of the customer, or anyone acting on the
customer's behalf, to abide by the instructions, system parameters, or recommendations made in this
document.

Related documents
Table 1 provides details of related documents for Enterprise Wi-Fi AP.

Table 1 Related documents

Document Name Location

Enterprise Wi-Fi AP product details https://www.cambiumnetworks.com/products/wifi/

Enterprise Wi-Fi AP Hardware and Installation
Guide

https://support.cambiumnetworks.com/files

Enterprise Wi-Fi AP User Guide (This document) https://support.cambiumnetworks.com/files

https://www.cambiumnetworks.com/products/wifi/
https://support.cambiumnetworks.com/files
https://support.cambiumnetworks.com/files
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Document Name Location

Enterprise Wi-Fi AP Release Notes https://support.cambiumnetworks.com/files

Enterprise Wi-Fi AP Command-Line Interface
Reference Guide

https://support.cambiumnetworks.com/files

Software Resources https://support.cambiumnetworks.com/files

Community http://community.cambiumnetworks.com/

Support https://www.cambiumnetworks.com/support/contact-
support/

Warranty https://www.cambiumnetworks.com/support/warranty/

Feedback support@cambiumnetworks.com

Supported hardware platforms
Table 2 lists the existing hardware platforms in Enterprise Wi-Fi Access Points:

Warning

Release 6.x is no longer supported on Wi-Fi 5 APs. It was provided for the Wi-Fi 5 APs as a
BETA release only. Any issues on these APs running release 6.x will not be supported by the
Cambium Support team.

Table 2 Existing hardware platforms

Hardware Platform Description

XE3-4 4x4:4; 2x2:2; 2x2:2 802.11a/b/g/n/ac wave 2/ax Tri-Radio Indoor Wi-Fi 6e
Access Point with BLE IoT radio

XE3-4TN 4x4:4, 2x2:2, 2x2:2 802.11b/g/n/ac wave 2/ax Tri-Radio Outdoor Wi-Fi 6e
Access point with BLE IoT radio

XE5-8 8x8:8, 4x4:4, 4x4:4, 4x4:4 802.11a/b/g/n/ac wave 2/ax Tri-Band AP with
multi-radio SDR with BLE IoT radio

XV2-2 2x2:2, 2x2:2 802.11a/b/g/n/ac wave 2/ax Dual-Radio Indoor Access Point

XV2-2T0 2x2:2, 2x2:2 802.11a/b/g/n/ac wave 2/ax Dual-Radio Outdoor Access
Point, Omni antenna, PoE out with BLE IoT radio

XV2-2T1 2x2:2, 2x2:2 802.11a/b/g/n/ac wave 2/ax Dual-Radio Outdoor Access
Point, Sector antenna, PoE out with BLE IoT radio

XV2-21X 2x2:2, 2x2:2 802.11a/b/g/n/ac wave 2/ax Dual-Radio Indoor Wi-Fi 6 Access
Point

https://support.cambiumnetworks.com/files
https://support.cambiumnetworks.com/files
https://support.cambiumnetworks.com/files
http://community.cambiumnetworks.com/
https://www.cambiumnetworks.com/support/contact-support/
https://www.cambiumnetworks.com/support/contact-support/
https://www.cambiumnetworks.com/support/warranty/
mailto:support@cambiumnetworks.com
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Hardware Platform Description

XV2-22H 2x2:2, 2x2:2 802.11a/b/g/n/ac wave 2/ax Dual-Radio Indoor Wi-Fi 6 Wall-
Plate Access Point with BLE/Zigbee IoT radio

XV2-23T 2x2:2, 2x2:2 802.11a/b/g/n/ac wave 2/ax Dual-Radio Outdoor Wi-Fi 6
Access Point

XV3-8 8x8:8, 4x4:4 802.11a/b/g/n/ac wave 2/ax Tri-Radio Indoor Access Point
with BLE IoT radio

Premium feature list
Release 6.0 and later releases of Enterprise Wi-Fi AP firmware support certain advanced features that are
available only through a paid subscription to cnMaestro X or XMS-Cloud management. These features are
identified with the label Premium feature in the documentation. With Release 6.5 and later releases, end
users can access these features without a management subscription on a free trial basis and for a limited
time. As Cambium Networks releases new versions, restrictions will be enforced on the use of these
premium features only in conjunction with a current cnMaestro X or XMS-Cloud subscription. If the user
does not have a current subscription at that time, the APs will stop enabling configurations, including these
premium features.

Table 3 Premium feature list

Feature Name Release Details

Wireless Intrusion Detection Systems (WIDS) Release 6.4.2

RADIUS-based ePSK Release 6.4

Stanley AeroScout Location Engine Release 6.3

User Groups Release 6.2

Advanced Filters (QoS, DSCP, Schedule, and Rate limit) Release 6.0

Application Control Release 6.0



Quick Start – Device Access 14

Quick Start – Device Access
This chapter describes the following topics:

l Powering up the device

l Accessing the device

l LED status

Powering up the device
This section includes the following topics:

l PoE switches (802.3af/802.3at/802.3bt)

l PoE adapter

l DC power supply

Enterprise Wi-Fi AP product family can be powered using an Ethernet PoE Switch or a PoE midspan injector.
Note that some APs can be powered by 802.3af, while others may require 802.3at or 802.3bt. Additionally,
some APs can be powered with an external power supply. Refer to the related product datasheet to
determine the options available.

PoE switches (802.3af/802.3at/802.3bt)
Enterprise Wi-Fi APs negotiate the power via the LLDP mechanism. Figure 1 represents the Enterprise Wi-Fi
AP Eth1 port connecting to a switch (PoE PSE Port).

Figure 1 Installation of Enterprise Wi-Fi AP to PSE port

Table 4 provides detailed information on the AP modules that are enabled based on power negotiated via
LLDP.
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Table 4 Power management policy

Platform IEEE 802.3af
(12.95W @ PD)

IEEE 802.3at
(25.5W @
PD)

IEEE 802.3bt
Class - 0/1/2/3/4
(40W @ PD)

IEEE 802.3b
Class - 5/6 (51W
@ PD)

IEEE 802.3b Class
- 7/8 (64W @ PD)

XV3-8 ü ü ü

XV2-2 ü ü

XV2-2T0 ü ü ü ü

XV2-2T1 ü ü ü ü

XE5-8 ü ü ü ü

XE3-4 ü ü ü

XV2-21X ü ü

XV2-23T ü ü

XV2-22H ü ü

XE3-4TN ü ü ü ü ü

PoE adapter
To power up the device using a PoE adapter, perform the following steps:

1. Connect the Ethernet cable from the Eth1/PoE-IN port of the device to the 5 Gigabit Data + Power port of
the PoE adapter.

2. Connect an Ethernet cable from your LAN or computer to the 5 Gigabit Data port of the PoE adapter.

Figure 2 Installation of Enterprise Wi-Fi AP to a PoE adapter
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3. Connect the power cord to the adapter, and then plug the power cord into a power outlet as shown in
Figure 3. Once powered ON, the Power LED should illuminate continuously on the PoE adapter.

Figure 3 Connecting PoE adapter to a power outlet

DC power supply
The Enterprise Wi-Fi AP XV3-8 has an option to power via a DC power adapter through the barrel connector.
If the device is connected to both the DC power adapter and the PoE adapter, then the DC power adapter
takes precedence.

Accessing the device
This section includes the following topics:

l Device access using default or fallback IP

l Device access using zeroconf IP

l Device access using DHCP IP address

Once the device is powered up, ensure it is operational by checking the LED status. The power LED on the
AP should turn green, which indicates that the device is ready for access.

Device access using default or fallback IP
To configure the computer to access the device using the default or fallback IP, perform the following steps:

1. Open Local Area Connection Properties by performing one of the following steps:

l In computers running Windows 7 operating system, go to Control Panel > Network and Internet >
Network Connections > Local Area Connection > Properties (in the Local Area Connection
Status window).

l In computers running Windows 10 operating system, go to Control Panel > Network and Internet >
Network and Sharing Center > Local Area Connection > Properties (in the Local Area
Connection Status window).
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The AP obtains its IP address from a DHCP server. A default IP address of 192.168.0.1/24 is used if an IP
address is not obtained from the DHCP server.

2. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

The Internet Protocol Version 4 (TCP/IPv4) Properties dialog box appears, as shown below:
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3. In the Use the following IP address section, ensure that an appropriate IP address and a subnet
address are provided.

4. Click OK.

5. Ensure that your computer is set up to communicate with the required range of IP addresses.

6. Open a web browser and type the URL - http://192.168.0.1 - to access the device UI. The Sign In page
appears.

7. Type an appropriate username and password.

l Default username: admin

l Default password: admin

8. Click Sign In.

Device access using zeroconf IP
To configure the computer to access the device using the zeroconf IP, complete the following steps:

1. Convert the last two bytes of ESN of the device to decimal. If ESN is 58:C1:CC:DD:AA:BB, last two bytes
of this ESN is AA:BB. Decimal equivalent of AA:BB is 170:187. Zeroconf IP of the device with ESN
58:C1:CC:DD:AA:BB is 169.254.170.187.

2. Configure Management PC with 169.254.100.100/16, as described below:



Quick Start – Device Access 19

3. Access the device UI using http://169.254.170.187 with default credentials as below:

l Username: admin

l Password: admin

Device access using DHCP IP address
To access the device using DHCP IP address, follow the below steps:

1. Plugin the device to the network.

2. Obtain the IP address of the device from the system administrator.

3. Access the device UI using http://<IP address> and default credentials, as listed below:

l Username: admin

l Password: admin

LED status
The Enterprise Wi-Fi AP features a single-color LED. The power LED glows amber when AP is turning on and
turns green once the AP has successfully turned on. The network or status LED glows green if the
connection to XMS or cnMaestro controller or manager is down. It turns blue once the AP is connected
successfully to XMS or cnMaestro.
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Table 5 Enterprise Wi-Fi AP LED status

LED Color Status Indication

The device is turning on.

Note:

If the LEDs remain amber for more than five minutes, it indicates that
the device has failed to turn on.

l The device is successfully up and accessible.

l Wi-Fi services are up, if configured.

l XMS or cnMaestro connection is successful.
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Onboarding the Device
This chapter describes the following topics:

l Overview

l Device Onboarding and Provisioning

Overview
By default, support is available for all the devices at https://cloud.cambiumnetworks.com, no user action is
required to direct devices to contact either cnMaestro Cloud or XMS-Cloud. You can onboard and provision
devices without any additional setup.

If you are using cnMaestro On-Premises, you must direct the devices to connect to the cnMaestro server
using DHCP options or static URL configuration. For more information, refer to the cnMaestro On-Premises
User Guide.

Device onboarding and provisioning
Enterprise Wi-Fi APs support the following onboarding methods:

l cnMaestro
l XMS-Cloud

cnMaestro
cnMaestro is a simple next-generation network management system for Cambium Networks wireless and
wired solutions.

For onboarding devices to cnMaestro, refer to the cnMaestro User Guide.

Supported devices and minimum version

The following table lists the minimum release version of every Enterprise Wi-Fi APs that is required to be
managed by cnMaestro Cloud and On-Premises. It also lists the minimum version of cnMaestro Cloud and
On-Premises required to manage the respective APs.

Note

l The AP version is the minimum version required to manage the APs using cnMaestro
Cloud and On-Premises.

l Similarly, the cnMaestro version is the minimum Cloud or On-Premises versions required
to manage the APs.

https://cloud.cambiumnetworks.com/
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Table 6 Supported minimum AP and cnMaestro versions

AP Model Supported Minimum AP Version Supported Minimum cnMaestro Version

cnMaestro
Cloud

cnMaestro On-
Premises

cnMaestro Cloud cnMaestro On-
Premises

XE3-4 6.6.0.3 6.6.0.3 3.1.0 3.1.0

XE3-4TN 6.6.0.3 6.6.0.3 3.2.0 3.2.0

XE5-8 6.6.0.3 6.6.0.3 3.1.1 3.1.1

XV2-2 6.6.0.3 6.6.0.3 2.4.1 2.4.1

XV2-2T0 6.6.0.3 6.6.0.3 3.1.0 3.1.0

XV2-2T1 6.6.0.3 6.6.0.3 3.1.1 3.1.1

XV2-21X 6.6.0.3 6.6.0.3 3.1.1 3.1.1

XV2-22H 6.6.0.3 6.6.0.3 3.1.1 3.1.1

XV2-23T 6.6.0.3 6.6.0.3 3.1.1 3.1.1

XV3-8 6.6.0.3 6.6.0.3 2.4.1 2.4.1

XMS-Cloud
XMS-Cloud makes it easy to manage networks from a single, powerful dashboard. Zero-touch provisioning
and centralized, multi-tenant network orchestration simplifies network management functions. XMS-Cloud
helps manage Cambium Enterprise Wi-Fi devices.

For onboarding devices to XMS-Cloud, refer to https://www.youtube.com/watch?v=qD-nPsdRc4Y.

https://www.youtube.com/watch?v=qD-nPsdRc4Y
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Configuring the System
This chapter describes the following topics:

l Basic
l Management
l Time settings
l Event Logging
l SNMP

Basic
To configure the basic parameters for the AP, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.

By default, the Basic tab is displayed.

Note

l The following special characters are supported when creating the AP Group and
WLAN passwords:

a-zA-Z_-*&%#@!<>.() []^~`$1234567890.

l By default, the password is not configured. You must configure the password for AP
Groups.

You can also rename the password after creating it.

Table 7 lists the configurable parameters that are available in the Basic tab in the cnMaestro UI.

Table 7 Basic parameters

Parameter Description Range Default

Name Hostname of the device.

Supported maximum length of the hostname: 64 characters

- Enterprise
Wi-Fi AP
Model
Number-
Last 3 Bytes
of ESN

Location Location where the device is placed.

Supported maximum length of location: 64 characters

- -

Contact Contact information for the device. - -
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Parameter Description Range Default

Country Country of operation of the device.

To be set by the administrator only.

The allowed operating channels and the respective transmit
power levels depend on the country of operation. The list of
countries supported depends on the SKU of the device (FCC
and ROW).

Note: Radios remain disabled unless this parameter is
configured.

- -

Placement Enterprise Wi-Fi AP device supports both Indoor and Outdoor
deployments. Based on deployment user can configure it as
follows:

l Indoor: Only indoor channels for configured country code
will be available and operational.

l Outdoor:Only outdoor channels for configured country
code will be available and operational.

- Indoor

PoE Output Enable power over Ethernet to an auxiliary device connected
to PoE OUT port.

- Off

Dual 5 GHz radio Enable Dual 5 GHz radio.

This parameter provides the flexibility of splitting 8x8 5 GHz
radio into two 4x4 5 GHz radios.

- Disabled

LED When enabled, turns on the device LEDs during operation. - Enabled

LLDP Advertises device capabilities and information in the L2
network.

- Enabled

Recommended
Channel
Distribution

Allows unique distribution of channels across radios when
multiple radios are configured with same frequency band.

Note: This option is available only as a CLI-based
configuration. Use the channels-distribution
command.

- Enabled

Default Power
Policy

Provision to configure current power policy. - Sufficient

Power Force
Type

Provision to configure power force type. - None
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Figure 4 The System page

Power over Ethernet (PoE) in
Enterprise Wi-Fi APs first attempt to detect the type and classification of the Power Source (PS) using
standard hardware handshake and control logic. Some PS devices, like the Cambium PoE power injectors,
are passive and cannot be detected by the AP. Therefore, the APs also use LLDP power negotiation to
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request a specific amount of PoE power from the PS. This feature in the Enterprise Wi-Fi APs is called LLDP
power request and it is enabled by default.

The following table lists the PoE power requirements for the Enterprise Wi-Fi APs:

Caution

Although APs may operate in accordance with the power requirements mentioned in the
Hardware Power Requirement column, caution is advised as the results may be unexpected.

Table 8 PoE power requirements for APs

Device PoE Out Hardware Power
Requirement

Maximum Power Draw
(Watts)

Minimum Power
Required to boot
(Watts)

XE3-4TN Yes (Max
30W)

802.3at 64 15

XV2-2 No 802.3at 21 7.6

XV2-2T0 Yes (Max
30W)

802.3at 51 13.3

XV2-2T1 Yes (Max
30W)

802.3at 51 13.3

XV2-21X No 802.3af 12.95 8

XV2-22H Yes (Max
10W)

802.3af 22.95 8

XV2-23T No 802.3af 12.95 8

XV3-8 No 802.3bt 35 22.9

XE3-4 No 802.3bt 32 15.6

XE5-8 No 802.3bt 60 32.9

Note

Accurate time on the AP is critical for features such as WLAN Scheduled Access and Syslogs.
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Figure 5 Power policy configuration

Table 9 lists the Cambium PoE injectors and cnMatrix models supported on the APs.

Table 9 Supported Cambium PoE Injectors and cnMatrix models

AP Model Cambium PoE Injector cnMatrix Recommended Model

XE3-4TN N000000L142A EX3028R-P / EX3052R-P / EX2016M-P

XV2-2 N000000L142A EX3028R-P / EX3052R-P / EX2016M-P

XV2-2T0 N000000L142A EX3028R-P / EX3052R-P / EX2016M-P

XV2-2T1 N000000L142A EX3028R-P / EX3052R-P / EX2016M-P

XV2-21X N000000L142A / N000000L034B /
N000900L017A

EX3028R-P / EX3052R-P / EX2016M-P /
EX2052-P / EX2052R-P / EX2028-P / EX2010-
P / EX1028-P / EX1010-P

XV2-22H N000000L142A / N000000L034B EX3028R-P / EX3052R-P / EX2016M-P /
EX2052-P / EX2052R-P / EX2028-P / EX2010-
P / EX1028-P / EX1010-P

XV2-23T N000000L142A / N000000L034B /
N000900L017A

EX3028R-P / EX3052R-P / EX2016M-P /
EX2052-P / EX2052R-P / EX2028-P / EX2010-
P / EX1028-P / EX1010-P

XV3-8 N000000L142A EX3028R-P / EX3052R-P / EX2016M-P

XE3-4 N000000L142A EX3028R-P / EX3052R-P / EX2016M-P

XE5-8 N000000L142A EX3028R-P / EX3052R-P / EX2016M-P

Attention

Configure Power policy and power force type based on the input power source.
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Power over Ethernet (PoE) Out port
PoE out provision is provided to power on devices that are compatible with IEEE 802.3 af/at PoE IN as per
power consumption or Cambium 30V POE as shown in the below table.

Table 10 PoE-out capabilities

AP Model 10W 48V @ 15W 48V @ 30W 30V @ 30W Default State

Figure 6 PoE Output cnMaestro configuration

Link Layer Discovery Protocol (LLDP)
LLDP is a Layer 2 network protocol used to share information, such as the device manufacturer, model,
network capabilities, and IP address with other directly connected network devices. APs can both advertise
their presence by sending LLDP announcements and can also collect and display information sent by
neighbors.

LLDP settings are enabled by default on the AP. This implies that the power negotiation is also enabled over
LLDP when an AP is powered by a Power over Ethernet (PoE) PSE switch port.

This window allows you to establish your LLDP settings.

Power negotiation

LLDP discovers a device port (connected to a PoE PSE switch, for example) that supplies power to the AP.
The AP checks that the port can supply the maximum power that is required by the AP model. The AP sends
the required maximum power (in watts) via LLDP frames to the PoE source and expects the PoE source to
reply with the amount of power that can be allocated.

l If the AP receives a response confirming that the power allocated by the PoE PSE source is equal to or
greater than the maximum power requested, the AP enables radios and other Model Specific
peripherals (for example, USB port, Bluetooth).

l If the AP receives a power allocation that is less than the maximum but more than the minimum required
to keep the radios operational, the AP issues a Syslog message and shuts down the other peripherals
(for example, USB port, Bluetooth).
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l If the AP receives less than the minimum power required for the radios to operate, the radios are shut
down for five minutes. During this time, LLDP power negotiation continues to monitor the available
power to ensure it meets the minimum requirement for the AP radios to function.

l Click to check power status: show power

This provides a more graceful way of handling an underpowered situation on a Wi-Fi device. When the
radios are turned off, XMS can notify you so that you don’t have to hunt down an intermittent problem.

CLI Configuration

Consider the following tasks to configure the CLI:

To enable:

ap(config)# lldp

ap(config)#

To disable:

ap(config)# no lldp

ap(config)#

To list LLDP configuration:

show lldp configuration

show lldp interfaces

Request power

To enable/disable power negotiation via LLDP:

ap(config)# lldp

request-power : Enable power negotiation (default:enabled)

tx-hold : Set transmit hold multiplier (default:4, used to calculate the time-
to-live (tx-interval * tx-hold))

tx-interval : Set LLDP packet transmit delay (in Sec, default:30 sec)

ap(config)# lldp request-power

<ENTER>

ap(config)# lldp request-power

Transmit hold

It is used to compute the Time To Live (TTL) value. This is the time during which the receiving device
maintains information before the validity of information expires.

ap(config)# lldp

request-power : Enable power negotiation (default:enabled)

tx-hold : Set transmit hold multiplier (default:4, used to calculate the time-
to-live (tx-interval * tx-hold))

tx-interval : Set LLDP packet transmit delay (in Sec, default:30 sec)

ap(config)# lldp tx-hold
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Specify transmit hold multiplier value (max 65535)

Transmit interval

It is the time interval between two regular LLDP packets transmissions. The AP sends out LLDP
announcements, advertising its presence at this interval. The default value is 120 seconds.

ap(config)# lldp

request-power : Enable power negotiation (default:enabled)

tx-hold : Set transmit hold multiplier (default:4, used to calculate the time-
to-live (tx-interval * tx-hold))

tx-interval : Set LLDP packet transmit delay (in Sec, default:30 sec)

ap(config)# lldp tx-interval

Specify LLDP transmit delay in sec (max 65535)

Management
Administrator Access
To configure Administrator access parameters, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.

3. ClickManagement tab > Administrator Access section.

Table 11 lists configurable fields that are displayed in the Administrator Access section.

Table 11 Administrator Access parameters

Parameter Description Range Default

Admin
Password

Password for authentication of UI and CLI sessions. - admin

Telnet Enables Telnet access to the device CLI. - Disabled

SSH Enables SSH access to the device CLI. - Enabled

SSH Key Provision to login to device using SSH Keys. The user needs to add
Public Key in this section. If configured, the user has to login to AP
using Private Keys. This is applicable for both CLI and GUI.

- Disabled

HTTP Enables HTTP access to the device UI. - Enabled

HTTP Port Provision to configure HTTP port number to access device UI. 1-65535 80

HTTPS Enables HTTPS access to the device UI. - Enabled

HTTPS Port Provision to configure HTTPS port number to access device UI. 1-65535 443
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Parameter Description Range Default

RADIUS
Mgmt Auth

User has provision to control login to AP using RADIUS
authentication. If enabled, every credential that is provided by the
user undergo RADIUS authentication. If successful, allowed to login
to UI of the device. This is applicable for both CLI and GUI.

- Disabled

RADIUS
Server

Provision to configure RADIUS IPv4 server for Management
Authentication.

- -

RADIUS
Secret

Provision to configure RADIUS shared secret for Management
authentication.

- -

Figure 7 Administrator Access page

HTTPS Proxy server configuration
The proxy management service is established in the AP to proxy management of traffic for remote
management services originating from the AP.

For zero-touch configuration, refer to DHCP Option 43 - Zero-touch onboarding.

CLI Configuration:

ap(config)# management proxy

https : Enable HTTPS proxy support

ap(config)# management proxy https

host : Configure HTTPS proxy host
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password : Configure HTTPS proxy password

port : Configure HTTPS proxy port

username : Configure HTTPS proxy username

Time settings
Users can configure up to two NTP servers. These servers are used by the AP to set its internal clock to the
respective time zones configured on the device. Upon turning on, the AP's clock resets to the default and
resynchronizes the time, as the Enterprise Wi-Fi AP does not have battery backup. The servers can be
specified as an IPv4 address or a hostname (for example, pool.ntp.org).

To configure time parameters, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.

3. ClickManagement tab > Time Settings section.

Table 11 lists configurable fields that are displayed in the Time Settings section.

Table 12 Time Setting parameters

Parameter Description Range Default

Time zone The time zone can be set according to the location where the AP
is installed. Selecting the appropriate time zone from the drop-
down list ensures that the device clock is synced with the wall
clock time.

Note

Accurate time on the AP is critical for features such
as WLAN Scheduled Access and Syslogs.

- -

NTP Server 1 Name or IPv4 address of a Network Time Protocol server 1. - -

NTP Server 2 Name or IPv4 address of a Network Time Protocol server 2. - -

Figure 8 Time setting page
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Event logging
The Enterprise Wi-Fi AP devices support multiple troubleshooting methods. Event logging or Syslog is one
of the standard troubleshooting processes. If you have a Syslog server in your network, you can enable it on
an Enterprise Wi-Fi AP device. A maximum of two Syslog servers can be configured on an Enterprise Wi-Fi
AP device. Events are sent to both configured Syslog servers if they are up and running.

To configure event logging, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.

3. ClickManagement tab > Event Logging section.

Table 13 lists configurable fields that are displayed in the Event Logging section.

Table 13 Event logging parameters

Parameter Description Range Default

Syslog
Server 1

Hostname or IPv4 address of the Syslog server and respective port
number.

- 514

Syslog
Server 2

Hostname or IPv4 address of the Syslog server and respective port
number.

- 514

Syslog
Severity

Provision to configure severity of Logs that must be forwarded to the
server. The Log levels supported are as per RFC.

- Debug

Figure 9 Event logging page

SNMP
To configure SNMP, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.

3. ClickManagement tab > SNMP section.

Table 13 lists configurable fields that are displayed in the SNMP section.
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Table 14 SNMP parameters

Parameter Description Range Default

Enable Provision to enable SNMPv2 or SNMPv3 support on the device - -

SNMPv2c RO
community

SNMP v2c read-only community string. - public

SNMPv2c RW
community

SNMP v2c read-write community string. - private

Trap Receiver IP Provision to configure SNMP trap receiver IPv4 server. - -

SNMPv3
Username

Enter the username for SNMPv3. - -

SNMPv3
Password

Enter the password for SNMPv3. - -

Authentication Provision to choose the authentication type as MD5 or SHA. - MD5

Access Provision to choose Access type as read-only or read-write. - RO

Encryption Choose ON or OFF. APs use the AES algorithm for encryption. - ON

Note

The AP uses the AES algorithm for encryption. It uses the SNMPv3 password configuration
parameter for encryption and authentication.

Figure 10 SNMP parameters
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Configuring the Radio
This chapter describes the following topics:

l Overview

l Configuring Radio parameters

l BSS coloring

l Target Wake Time (TWT)

l Receive sensitivity configuration

l Multicast-snooping and Multicast-to-Unicast conversion

Overview
Enterprise Wi-Fi AP devices support numerous configurable radio parameters to enhance the quality of
service according to the deployment.

Configuring Radio parameters
The XV3-8 Tri-Band Indoor Wi-Fi 6 AP can operate in either Dual Band Simultaneous (DBS) or Single Band
Simultaneous (SBS). This feature provides the flexibility of splitting 5 GHz radio into two independently
configurable and operational radios. In DBS mode, 5 GHz radio operates as single radio with an 8x8
configuration. In SBS mode, 5 GHz Radio operates as split radio with each 4x4 configuration. Configurable
parameters under the Radio profile are listed below.

l Basic

l Software-Defined Radio (SDR) capabilities

l Enhanced Roaming

Basic
To configure radio parameters, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.

3. Click Radio tab > Basic section.

Table 15 lists the configurable fields that are displayed in the Radio > Basic section.
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Table 15 Configure Radio parameters

Parameter Description Range Default

Radio

Enable Enables the operation of radio. - Enabled

Band Select the appropriate radio band, if the radio supports
multiple bands.

- -

Channel Select the channel from the drop-down list. Channels in the
drop-down list are populated based on the country
configured.

Wi-Fi 6/6E APs

l 2.4 GHz: 1
- 14

l 5 GHz: 36
- 173

l 6 GHz: 1 -
233

Auto

Channel
Width

Specifies the channel widths for the operation. The following
widths are supported:

l For 2.4 GHz: Only 20 MHz channel width is supported.

l For 5 GHz: 20 MHz, 40 MHz, 80 MHz, and 160 MHz
channel widths are supported.

l For 6 GHz: 20 MHz, 40 MHz, 80 MHz, 160 MHz channel
widths are supported.

- l 2.4
GHz:
20
MHz

l 5
GHz:
40
MHz

l 6
GHz:
80
MHz

Transmit
Power

Total conducted transmit power, in decibel-milliwatt (dBm), of
each radio based on coverage and SLA. The maximum
transmit power of Enterprise Wi-Fi AP devices varies based
on model number.

Details of transmit power supported by each Enterprise Wi-Fi
AP device are available at
https://www.cambiumnetworks.com/products/wifi/. Transmit
power varies as per the country where the AP is deployed..
The default value is AUTO, which means radio transmit
power is configured to the maximum as per the county
configured.

l 2.4 GHz: 4
to 30

l 5 GHz: 4
to 30

l 6 GHz: 4
to 30

Auto

https://www.cambiumnetworks.com/products/wifi/
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Parameter Description Range Default

Beacon
Interval

Specifies the time duration (in milliseconds) between two
consecutive Beacons.

50ms -
3400ms.

100

Minimum
Unicast rate

Specifies the coverage area of the Enterprise Wi-Fi AP
device. The higher the rate selected, the lesser the range.
You can configure this value based on the SLA in the
deployment. The drop-down list contains all values
advertised by Enterprise Wi-Fi AP devices, including legacy,
HE, HT, and VHT rates.

Standard
802.11b and
802.11g data
rates

1Mbps

Candidate
Channels

Specifies selective channels based on user requirement.
Options vary based on a band of operation and are as
follows:

l For 2.4 GHz:

o All

o Specific

l For 5 GHz:

o All

o Specific

o Prefer Non-DFS

o Prefer DFS

l For 6 GHz:

o All

o Specific

Wi-Fi 6/6E APs

l 2.4 GHz: 1
- 14

l 5 GHz: 36
- 173

l 6 GHz: 1 -
233

All

Mode All Enterprise Wi-Fi AP devices support either 802.11ax,
802.11ac Wave 1, or 802.11ac Wave 2. Some legacy clients
might not work as expected; therefore, this parameter can be
tuned for backward compatibility based on wireless clients.

Wi-Fi 6/6E APs

l 2.4 GHz:
b/g/n/ax

l 5 GHz:
a/n/ac/ax

All mode

Short Guard
Interval

Standard 802.11 parameter to increase the throughput of an
Enterprise Wi-Fi AP device.

- Enabled

Off Channel Scan (OCS)
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Parameter Description Range Default

Enable Provision to enable OCS on a device to capture neighbor
clients and APs.

- -

Dwell-time Configure the time period to spend scanning of Wi-Fi devices
on a channel.

50-300 50ms

Auto-RF (Dynamic Power)

Enable Enable or disable dynamic power management. - -

Mode Select the required dynamic power modes. Two modes are
supported:

l By-Channel
l By-Band

- By-
Channel

Minimum
Transmit
Power

The minimum transmit power that the AP can assign to radio
when adjusting automatic cell sizes

5-15 dBm 8 dBm

Minimum
Neighbour
Threshold

The minimum number of neighbors to consider for power
reduction by automatic cell logic.

1-10 2

Cellsize
Overlap
Threshold

Cell overlap will be allowed when the AP is determining
automatic cell sizes.

0-100% 50%

Auto-RF (Dynamic Channel)

Enable Enable or disable the Dynamic Channel auto-RF functionality. Disabled

Packet Error
Rate

Enable channel change using unsuccessful packet
transmissions by the AP.

Packet Error
Rate
Threshold

Specifies the packet error rate threshold in percentage (%). 10-90% 30

Number of
Packet Error
Rate
samples

Specifies the number of packet error rate samples needed to
trigger a channel switch.

1-120 40

Channel
Utilization

Enable channel change using the channel efficiency.

Channel
Utilization
Threshold

Specifies the channel utilization threshold in percentage (%). 30-100% 70
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Parameter Description Range Default

Number of
Channel
Utilization
samples

Specifies the number of channel utilization samples needed
to trigger a channel switch.

5-300 100

Noise Enable channel change with higher noise.

Noise
Threshold

Specifies the noise threshold in dBm. -70 to -90 dBm -70

Number of
Noise
samples

Specifies the number of noise samples needed to trigger a
channel switch.

5-120 40

Auto-RF
Iterations

Specifies the number of times the Auto-RF channel change
function must run, at the configured frequency, before
stopping.

The iteration count resets when the AP restarts or when the
radio resets.

The default value is 0. It indicates that the Auto-RF channel
change function will run at the frequency configured in either
of the following parameters without stopping:

l Enable time range for Auto-RF

l Channel Hold Time

Note

When the AP exceeds the configured iteration
count, the Dynamic Channel Selection (DCS)
method of channel selection takes over.

For more information on Auto-RF, see Auto-RF.

0-100 0

Samples Specifies the minimum number of samples required to run
the channel selection.

1-20 3

Enable time
range for
Auto-RF

Specifies the time range (in the 24 hour format) at which the
Auto-RF channel change function must run everyday.

When enabled, select the start and end time.
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Parameter Description Range Default

Channel
Hold Time

Specifies the time (in minutes) for which the AP must hold the
channel.

l 1-44640
minutes
for APs
running
version
6.6.0.1 and
later

l 1-4320
minutes
for APs
running
versions
earlier
than
6.6.0.1.

1440

To configure Auto-RF (Dynamic Channel) using the CLI, execute the following commands:

ap(config-radio-1)# auto-rf dynamic-channel

acceptance-per-threshold : Configure Acceptance Packet Error Rate
(PER) threshold

channel-hold-time : specifies how much time AP needs to hold the
channel. Default is 1440 mins

cmbnbr-minsnr : Configure the cambium neighbour minimum SNR to
consider as part of autorf cambium neighbour factor

congestion-channel-switch : Enable / Disable Congestion based channel
switch, disabled by default

congestion-threshold : Configure Congestion threshold
count : Configure number of times autorf need to run;

'0' disables this feature
dcs-monitor-interval : Configure dcs monitor interval in minutes.
dcs-trigger-threshold : Configure dcs trigger threshold percentage
per-channel-switch : Enable / Disable PER based channel switch,

disabled by default
samples : Configure the minimum number of samples

required to run the channel selection
schedule-time : Configure time range (24 hour format) at which

autorf algorithm need to run everyday
weightage-map-index : Configure weightage map index

To configure Auto-RF (Dynamic Power) using the CLI, execute the following commands:
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ap(config-radio-1)# auto-rf dynamic-power

cellsize-overlap-threshold : Cell overlap that will be allowed when
the AP is determining automatic cell sizes

maximum-transmit-power : Maximum transmit power that the AP can assign
to a radio when adjusting automatic cell sizes

minimum-neighbor-threshold : The Minimum number of neighbors to
consider for power reduction by autocell logic

minimum-transmit-power : Minimum transmit power that the AP can assign
to a radio when adjusting automatic cell sizes

mode : Set dynamic power mode by-channel/by-band

Figure 11 Radio parameters in the Basic page

Figure 12 Channel Scan - Off Channel Scan option
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Figure 13 Channel Scan - Continuous Background Scan option

Figure 14 Auto-RF - Dynamic Channel
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Figure 15 Auto-RF - Dynamic Power

Software-Defined Radio (SDR) capabilities
Note

l In XV3-8, radio 3 is available only in the SBS mode.

l In XE5-8, radio 5 is available only in the SBS mode.

Table 16 Supported radios

Access Point
Model

Radio 1 (2.4
GHz)

Radio 2 Radio 3 Radio 4

(5 GHz)

Radio 5

(5 GHz)5 GHz 6 GHz 5 GHz 6 GHz

XV3-8 ü ü

(DBS)

ü

(SBS)

XV2-2 ü ü

XV2-2T0 ü ü

XV2-2T1 ü ü

XE3-4 ü ü ü ü

XE3-4TN ü ü ü ü

XE5-8 ü ü ü ü ü ü

(DBS)

ü

(SBS)
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Access Point
Model

Radio 1 (2.4
GHz)

Radio 2 Radio 3 Radio 4

(5 GHz)

Radio 5

(5 GHz)5 GHz 6 GHz 5 GHz 6 GHz

XV2-21X ü ü

XV2-23T ü ü

XV2-22H ü ü

Table 17 Factory reset behavior of multi-radio APs

Access Point
Model

Radio 1 (2.4
GHz)

Radio 2 Radio 3 Radio 4

(5 GHz)

Radio 5

(5 GHz)5 GHz 6 GHz 5 GHz 6 GHz

XV3-8 ON ON NA OFF NA - -

XE3-4 ON ON NA OFF ON - -

XE3-4TN ON ON NA OFF ON - -

XE5-8 ON ON OFF OFF ON ON

4x4 SBS

ON

4x4 SBS

The Radio page allows the user to enable or disable the Software-Defined Radio (SDR) operations. It allows
to configure Software Defined Radios, Basic, Enhanced Roaming, Off Channel Scan, Auto-RF, and
External Antennas.

Note

The software-defined radio creation and channel listing are populated based on the country-
specific restrictions, device type, and release version.

Software-Defined Radio

Software-Defined Radio (SDR) allows you to configure radio parameters for XV3-8, XE3-4, XE3-4TN, and
XE5-8 device models. By default these device models are configured for radio bands as shown in the above
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figure. The other radio bands for which the devices can be configured are as shown in Table 18.

Table 18 Supported Radio bands for Enterprise Wi-Fi Series (XE, XV-Series)

Models Radios Supported Radio
Bands

Channel Specification

Channel
width

Default
Channel
width

Supported channel
list

XV3-8 Radio 1 2.4 GHz 20/40 20 1 to 13

Radio 2 5 GHz (8x8 - single
radio) or 5 GHz
(Split 4x4 dual

radio)

20 / 40 / 80 40 100 to
165 in
Split 4x4
dual
radio

36 to 165
in 8x8 -
single
radio

Radio 3 20 / 40 / 80 40 36 to 64
in Split
4x4 dual
radio

XE3-4 Radio 1 2.4 GHz 20/40 20 1 to 13

Radio 2 5 GHz 20 / 40 / 80 40 36 to 64

Radio 3 5 GHz 20 / 40 / 80
/ 160

40 100 to 165

6 GHz 160 Any 6 GHz channel

XE3-4TN Radio 1 2.4 GHz 20/40 20 1 to 13

Radio 2 5 GHz 20 / 40 / 80 40 36 to 64

Radio 3 5 GHz 20 / 40 / 80
/ 160

40 100 to 165

6 GHz 160 Any 6 GHz channel

XE5-8 Radio 1 2.4 GHz 20/40 20 1 to 13

Radio 2 5 GHz or 6 GHz 20 / 40 / 80
/ 160

20*/80**

Refer to Table 19 for
supported channel
list in 5 GHz and 6
GHz.

Radio 3 5 GHz or 6 GHz 20 / 40 / 80
/ 160

20*/80**

Radio 4 5 GHz (8x8 - single
radio) or 5 GHz
(Split 4x4 dual

radio)

20 / 40 / 80 20

Radio 5 20 / 40 / 80

* 5 GHz **6 GHz
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Note:

l Split 4x4 is applicable only for 8x8 spatial streams supported devices. (Supported device
models are XV3-8 and XE5-8).

l Dual 5 GHz Radio (Only supported for XV3-8 and XE5-8 Access Points) Splits 8x8 5 GHz
radio into two 4x4 5 GHz radios.

Table 19 Supported Channel list 5 GHz or 6 GHz in XE5-8

Radio Index Radio 1 Radio 2 Radio 3 Radio
4

Radio
5

8x8 mode of operation: Radio 4 & 5 as single radio with 8x8

Radio 2 Radio 3 Radio 4 and 5

5 GHz 5 GHz 5 GHz NA 100 to 128 149 to 165 36 to 64

6 GHz 5 GHz 5 GHz NA Any 6 GHz
channel

100 to 165 36 to 64

5 GHz 6 GHz 5 GHz NA 100 to 165 Any 6 GHz
channel

36 to 64

6 GHz 6 GHz 5 GHz NA * 1 to 93 ** 97 to 233
/ 65 to 93

36 to 165

Split 4x4 mode of operation: Radio 4 and 5 as individual radio with 4x4

Radio 2 Radio 3 Radio 4 Radio 5

5 GHz 5 GHz 5 GHz 5 GHz NA 60 to 64 100 to 128 149 to
165

36 to
40

6 GHz 5 GHz 5 GHz 5 GHz NA Any 6 GHz
channel

100 to 128 149 to
165

36 to
64

5 GHz 6 GHz 5 GHz 5 GHz NA 100 to 128 Any 6 GHz
channel

149 to
165

36 to
64

6 GHz 6 GHz 5 GHz 5 GHz NA * 1 to 93 ** 97 to 233 100 to
165

36 to
64

Note: *FCC SKU 6GHz UNII-5 or 6 (1 - 93) EU SKU UNII-5 low (1 - 61)

**FCC SKU 6GHz UNII-7 or 8 (97 - 233) EU SKU UNII-5 High (65 - 93)

Note

You can use the no channels-distribution global configuration CLI
command for all multi-radio platforms, such as XE3-4, XE3-4TN, and XE5-8 APs.
When configured on device, default channel list can be overridden.
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Off Channel Scan (OCS)

The following figure illustrates how to configureOff Channel Scan using the CLI:

ap(config)# wireless radio 2

ap(config-radio-2)# off-channel-scan

dwell-time : Configure Off-Channel-Scan dwelltime

interval : Configure Off-Channel-Scan interval

type : Configure active/passive Off-Channel-Scan

ap(config-radio-2)# off-channel-scan type

active : active off channel scan

passive : passive off channel scan

Table 20 lists the fields that are required for configuringOff Channel Scan:

Table 20 Configuring Off Channel Scan

Parameter Description Range Default

dwell time Provision to configure Off Channel Scan dwell time. Needs to change
100 or more than 100+ ms for supporting passive scan method.

50-300 50ms

Enhanced Roaming
Table 21 lists configurable fields that are displayed in the Radio > Enhanced Roaming tab.

Table 21 Configuring Radio > Enhanced Roaming parameters

Parameter Description Range Default

Enhanced Roaming

Enable Provision to enable enhanced roaming on device. - Disabled

Roam SNR
threshold

Enterprise Wi-Fi AP device triggers de-authentication of the wireless
station when the wireless station is seen at configured SNR level or
below.

1-100 15dB
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BSS Coloring
Multiple APs operate on a shared channel by mitigating co-channel interference. This is achieved through a
spatial reuse technique known as BSS Coloring, which enables devices in one BSS to ignore frames from
other BSSs on the same channel that are typically some distance away.

Target Wake Time (TWT)
The Target Wake Time (TWT) feature, included in the IEEE 802.11ax amendment, provides a mechanism to
schedule transmissions at a specific time or set of times for individual STAs to wake to exchange frames with
AP. Using TWT, each STA negotiates awake periods with the AP to transmit and receive data packets
allowing the STA to go to doze mode to minimize energy consumption and reduce contention within the
basic service set (BSS).

Note

By default, BSS coloring and TWT are enabled.

Receive sensitivity configuration
This feature allows users to configure the receiver sensitivity per radio. The configuration hooks are
exposed from both CLI and XMS-Cloud. cnMaestro does not expose any hooks for configuring receiver
configuration. Receiver configuration determines the signal power required at the receiver to achieve the
targeted or configured bit rate. Every RF receiver comes with a default sensitivity, which may not be
sufficient for achieving the required RF performance in terms of meeting the bit rate. Therefore,
reconfiguration of receiver sensitivity is suggested.

Multicast-snooping and Multicast-to-Unicast conversion
Multicast-to-Unicast conversion heavily depends on multicast (IGMP) snooping. With IGMP snooping
enabled, the device monitors IGMP traffic on the network and forwards multicast traffic to only the
downstream interfaces that are connected to interested receivers. The device conserves bandwidth by
sending multicast traffic only to clients connected to devices that receive the traffic (instead of flooding the
traffic to all the downstream clients in a VLAN).

The functionality to preserve both multicast and unicast MAC addresses during multicast enhancement
implementation for packets in APs is introduced. The AP supports Directed Multicast Services (DMS) and
Multicast Enhancement (ME). ME is a feature provided in APs that allows multicast frames to be sent as
unicast frames to each member of the mentioned multicast group to improve the QoS of the transmission
between the STA and the AP. The multicast frame is received at the host WLAN driver as an 802.3 (Ethernet)
frame. This frame header contains the destination and source address, which are the multicast group
address and client address, respectively. Iteratively, the Ethernet header is replaced with the unicast
addresses of the clients present in the multicast group and sent out to the “air”. During this process, the
multicast group address is completely lost from the frame.

CLI Configuration:
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ap(config)# multicast-snoop

ap(config)# no multicast-snoop

ap(config)# save

ap(config)# wireless radio 1

ap(config-radio-1)# multicast-to-unicast

ap(config-radio-1)# multicast-to-unicast mode 802.3

ap(config-radio-1)# multicast-to-unicast mode amsdu

ap(config-radio-1)# multicast-to-unicast exclude-list 224.0.0.1

ap(config-radio-1)# show wireless radios multicast-to-unicast

======================================================================

RADIO BAND MC2UC MC2UC-MODE EXCLUDE-LIST

======================================================================

radio1 2.4GHz NO amsdu

radio2 5GHz YES amsdu

ap(config-radio-1)#

Auto-RF
This topic contains the following sections:

l Overview

l Dynamic Channel

l Dynamic Power
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l Auto-RF

l Configuring Dynamic Channel

l Configuring Dynamic Power

l Recommended Configuration

Overview
Auto-RF allows APs to obtain various RF statistics and utilize them to provide wireless clients with a better RF
environment by choosing the proper channel and transmitting power to each radio. This results in better
application performance and improved quality of calls for the end user.

Auto-RF consists of the following two functionalities:

l Dynamic Channel—Enables radios to choose the best channel both at device turn on and subsequently
if the channel or RF conditions change.

l Dynamic Power—Aids radios in determining the proper transmit power to deal with coverage gaps and
reduce RF interference.

Dynamic Channel
Channel selection by APs can involve any of the following methods:

l Auto Channel Selection (ACS)

l Dynamic Channel Selection (DCS)

Auto Channel Selection (ACS)

Auto-RF runs independently on each device in a deployment. You can enable the feature in all the bands
(2.4 GHz,5 GHz, and 6 GHz (if AP supports). In 2.4 GHz, channels 1, 6, and 11 are considered for channel
selection. AP continuously executes the Continuous Background Scan (CBS) to collect samples and feed
them to the ACS to choose the best channel based on the channel score. The packet queue is verified and
the RF is monitored continuously to ensure that high priority traffic is delivered before starting the CBS. CBS
is performed so that the device avoids background scan while voice and video traffic is transmitted. The
scan is split into multiple slots to avoid diverting from the operating channel for a longer duration which will
affect the performance of the AP.

Dynamic Channel Selection (DCS)

If the environment has lot of Wi-Fi interference or high packet error rate, Dynamic Channel Selection (DCS)
takes over and initiates Packet Error Rate (PER) and Channel Utilization (CU) based channel switch methods.
The AP monitors the error rate and Wi-Fi interference to see whether the threshold is crossed to initiate the
channel switch. The AP sends the channel switch announcement in a beacon before any channel change
occurs.
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Dynamic Power
In multi-AP deployments, APs must automatically determine the cell size (coverage area), that is, increase or
decrease transmit power to ensure the following:

l There are no coverage gaps—Increase transmit power

l There is no interference because of overlapping APs. Overlapping of APs creates interference and
clients roam between multiple APs if they see more than one AP with a good transmit power. —
Decrease transmit power

Packets and scan results from CBS are parsed and neighbor entries are created which contains data about
their transmission power and their neighbors. Periodically this data is processed and categorized to display
how neighbors have seen their SNR.

Auto-RF behavior on device turn on
When the AP turns on the first time, it performs an initial scan (for about 0-300 seconds) to select the best
operating channel. During this scan, CBS collects samples. The AP remains on the selected channel until
one of the following scenarios occur:

l channel hold time expires

l configuration changes

l the radio restarts

After the hold time expires, the AP reinitiates the Automatic Channel Selection (ACS) algorithm to reassess
and choose a new channel based on collected samples. If the current channel still has the highest score, it is
retained. In cases of configuration changes or radio restarts, the collected samples are reset, but historical
data remains, allowing CBS to automatically collect fresh samples.

Configuring Dynamic Channel
Dynamic channel configuration is achieved by the following methods:

l ACS method

l DCS method

ACS method

In the ACS method, to enable auto-RF Dynamic Channel in the cnMaestro UI, complete the following steps:

1. Go to Configuration >Wi-Fi Profiles > AP Groups page.

2. Click Add New.

3. Associate an existing WLAN and configure other AP group parameters.

4. Click Radio on the left menu.
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5. In the required radio band tab, expand the Auto-RF section.

6. In the Dynamic Channel tab, select the Enable check box.

Once Auto-RF Dynamic Channel is enabled, ACS runs at regular intervals based on the Samples and
Channel Hold Time, or the Enable time range for Auto-RF configuration parameters. For information on
these parameters, see Configuring the Radio.

DCS method

DCS configuration helps in avoiding instances when there is a spike in packet error rate (PER) or Channel
Busy. The following are the default configuration parameters and their values:

l DCS trigger threshold—80%

CLI command—auto-rf dynamic-channel dcs-trigger-threshold

l DCS monitor interval—10 minutes

CLI command—auto-rf dynamic-channel dcs-monitor-interval

Both these parameters are available only as CLI commands that you can configure in the AP Groups > User
Overrides section in cnMaestro.

Consider a scenario where the device detects that the PER or Congestion threshold is exceeded for a brief
period in a day. If the threshold breach occurred because of a spike in PER or Congestion, the AP must not
change the channel. You can avoid this scenario by configuring the DCS threshold and monitor interval.
When configured, the AP switches to a different channel if the PER or Congestion threshold is breached
continuously for the DCS duration and if the percentage of the breach exceeds the DCS threshold. DCS is
enabled if either Channel Utilization (CU) or Packet Error Rate (PER) parameter is enabled.

Packet Error Rate (PER)

Consider a scenario where an AP must switch channels if the PER is more than 30% in a 10 minute interval.
The AP monitors the PER, and if it exceeds 30% (default threshold) for 80% of the samples in a 10-minute
interval, it will initiate a channel switch. However, when the PER threshold is breached, other configurations,
such as sampling, channel hold time, and intervals are overridden. With the default DCS threshold and
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interval configured, Auto-RF manages the channel switch when the above conditions are met. Hence, the
AP changes channels if the PER remains consistently high (above 30%) for most of a 10-minute period.

Congestion channel switch

Consider a scenario where an AP must switch channels if the channel utilization exceeds a threshold of 70%
(default) in a 10-minute interval. The AP monitors channel utilization, and if it exceeds 70% (default threshold)
for 80% of the samples in a 10-minute interval, it will initiate a channel switch. However, when the congestion
threshold is breached, other configurations, such as sampling, channel hold time, and intervals are
overridden. With the default DCS threshold and interval configured, Auto-RF will handle the channel switch
when the above conditions are met. Hence, the AP changes channels if channel utilization remains
consistently high (above 70%) for most of a 10-minute period.

Configuring Dynamic Power
To enable auto-RF Dynamic Power in the cnMaestro UI, complete the following steps:

1. Go to Configuration >Wi-Fi Profiles > AP Groups page.

2. Click Add New.

3. Associate an existing WLAN and configure other AP group parameters.

4. Click Radio on the left menu.

5. In the required radio band tab, expand the Auto-RF section.

6. In the Dynamic Power tab, select the Enable check box.

Dynamic Power can be configured in the following two modes:

l By-Band: Considers neighbor APs across all channels of same band for operating Auto-RF dynamic
transmit power.

This is the default option in the Dynamic Power configuration.
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l By-Channel: Considers only operating channel neighbor APs (that also within the same AP group) for
operating Auto-RF dynamic transmit power.

When Auto-RF Dynamic Power is enabled, by default, CBS runs in the background with a 50% overlap
threshold between APs. The default minimum transmit power is set to 8 dBm. The dynamic-power algorithm
cannot reduce the transmit power below this level, even if there is overlap in AP signals. TheMinimum
Neighbor Threshold parameter defines the minimum number of neighboring APs required to enable
dynamic power selection.

With Auto-RF Dynamic Power enabled, the system manages transmit power while maintaining a minimum
level and considering AP overlap and neighbor requirements.

Recommended Configuration
For Auto-RF feature to function correctly, the following configuration is recommended:

l Basic section

l Channel Scan section

Basic section

Configure the following parameters in the Radio > Basic section with the recommended values:

l Channel—Auto

l Transmit Power—Auto

l Channel Width—20, 40, 80, or 160 MHz based on the deployment

l Candidates Channel—All.

If you want to restrict the APs to operate on specific channels, you must configure the required
channels.
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Channel Scan section

Configure the following parameters in the Radio > Channel Scan section with the recommended values:

l Select the Continuous Background Scan (CBS) option—Selected by default.

l Wait Time in minutes

l Rest Time, Dwell Split Time, and Dwell Rest Time in milliseconds

l Select the Channel Switch Announcement check box to enable the AP to send notifications before any
channel change.
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Configuring the Wireless LAN
This chapter describes the following topics:

l Overview

l Configuring the WLAN parameters

l Link Aggregation Control Protocol (LACP)

l RADIUS attributes

l Enterprise PSK (ePSK)

o Configuring ePSKs

o ePSK registration for WPA3 clients

o Creating a Personal Wi-Fi ePSK

l RADIUS-based ePSK

Overview
Enterprise Wi-Fi AP devices support up to 16 unique WLANs. Each of these WLANs can be configured as per
the customer requirement and type of wireless station.

Configuring the WLAN parameters
To configure WLAN parameters, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > WLANs page.

2. Click Add and select Enterprise Wi-Fi from the Type drop-down list.

Following are the configurable parameters under the WLAN profile:

l Basic

l Radius Server

l Guest Access

o Internal Access Point

o External Hotspot

o cnMaestro

l Usage Limits
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l Scheduled Access

l Access

l Passpoint

Basic
Table 22 lists configurable fields that are displayed in theWLANs > Basic Settings section.

Table 22 Basic parameters

Parameters Description Range Default

WLAN > Basic Settings

Enable Enables a WLAN profile. Once enabled, a Beacon is broadcasted
with the SSID and the corresponding parameters configured in a
WLAN profile.

- -

SSID Unique network name that wireless stations scan and associate.  - -

Mesh This parameter is required when a WDS connection is established
with Enterprise Wi-Fi devices. This parameter supports the
following options:

l Base: A WLAN profile configured with a mesh-base will
operate as a normal AP. Its radio will beacon on startup so its
SSID can be seen by radios configured as mesh-clients.

l Client: A WLAN profile configured with mesh-client will scan
all available channels on startup, looking for a mesh-base AP
to connect.

l Recovery: WLAN profile configured as mesh-recovery will
broadcast a pre-configured SSID upon detection of mesh link
failure after a successful connection. This needs to be
exclusively configured on a mesh-base device. Meshclient
will auto scan for mesh-recovery SSID upon failure of mesh
link.

l Off: Mesh support disabled on WLAN profile.

- Off
(Access
Profile
Mode)

VLAN Segregates wireless station traffic from AP traffic in the network.
Wireless stations obtain an IP address from the subnet configured
in the VLAN field of the WLAN profile.

1-4094 1

Security Determines key values that are encrypted based on the selected
algorithm. Following security methods are supported:

l Open

- Open
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Parameters Description Range Default

This method is preferred when Layer 2 authentication is built
into the network. With this configured on an Enterprise Wi-Fi
AP device, any wireless station will be able to connect. 

l OWE

This method ensures the communication between each pair
of endpoints is protected from other endpoints.

l Osen

This method is extensively used when Passpoint 2.0 is
enabled on Enterprise Wi-Fi AP devices. If Passpoint 2.0 is
disabled, this security plays no role in wireless station
association.

l >WPA2-Pre-Shared Keys

This mode is supported with AES and TKIP encryption. WPA-
TKIP can be enabled from the CLI with the allow-tkip CLI
option.

l WPA2 Enterprise

This security type uses 802.1x authentication to associate
wireless stations. This is a centralized system of
authentication methods.

l WPA2/WPA3 Pre-shared Keys

WPA3 comes with a transition mode where WPA2-only
capable clients can connect to SSID. WPA2-only capable
clients connect using the older PSK method while WPA3
capable clients connect using a more secure Simultaneous
Authentication of Equals (SAE) method.

l WPA3 Pre-shared Keys

WPA3 replaces the Pre-Shared Key (PSK) exchange with SAE
of Equals, which is more secure and provides forward-
secrecy as well as resistance to offline dictionary attack.

Note

When you selectWPA2/WPA3 Pre-shared
Keys orWPA3 Pre-shared Keys, you can
enable registration flow for WPA3 clients.
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Parameters Description Range Default

To enable the registration flow, you must create
an ePSK passphrase and follow the procedure
for the clients to undergo the registration flow.
For more information, see ePSK registration for
WPA3 clients.

l WPA3 Enterprise

WPA3 also introduces Enterprise AES CCMP encryption. This
level of security provides consistent cryptography and
eliminates the mixing and matching of security protocols that
are defined in the 802.11 standards.

l WPA3 Enterprise CNSA

WPA3 also introduces a 192-bit cryptographic security suite.
This level of security provides consistent cryptography and
eliminates the mixing and matching of security protocols that
are defined in the 802.11 standards. This security suite is
aligned with the recommendations from the Commercial
National Security Algorithm (CNSA) Suite and is commonly
used in high-security Wi-Fi networks in government, defense,
Finance, and industrial verticals.

l User Pre-shared keys

The U-PSK (User-PSK) Authentication settings are only used
in conjunction with XMS Cloud’s EasyPass Onboarding
Portals. The Cloud automatically configures this setting for an
WLAN when you create an Onboarding portal and you assign
that WLAN to the portal. Thus, you should not normally
change this setting manually. Note that the User- PSK
settings are only available on the WLAN profile.

Band Each SSID can be configured to be transmitted as per the
deployment requirement. For a regular access profile, options are
available to configure transmit mode of SSID:

l 2.4 GHz

l 5 GHz

l 6 GHz

- all

Client
Isolation

Enable this feature when there is a need for restriction of wireless
station-to-station communication across the network or on an AP.
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Parameters Description Range Default

Note

l For client isolation to work correctly, it is
recommended that clients obtain their IP
addresses through DHCP.

l You must manually update the default gateway
addresses in the IP configuration of clients that
are using static IP addresses.

l If the gateway MAC address changes due to
hardware replacement or any other reason, you
must restart the AP for the AP to learn the new
gateway MAC address and to make sure the
client isolation functions correctly.

The following options are available to configure based on
requirement:

l Disable

This option when selected disables the client isolation
feature. i.e. any wireless station can communicate to other
wireless stations.

l Local

This options when selected enable the client isolation
feature. This option prevents wireless station
communications connected to the same AP.

l Network Wide

This options when selected enable the client isolation
feature. It prevents wireless stations communications
connected to different AP deployed in the same L2 network.

Note

l Network-wide mode is not supported when
Redundancy Gateway protocol is used on
deployment.

l In the Redundancy Gateway case,
Network-wide static can be used to provide
a list of Gateway MAC addresses.

l Network Wide Static
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Parameters Description Range Default

This option when configured enables client isolation feature
across the network. Wireless stations can communicate only
to statically added MAC list. Communication to rest other
MAC addresses are blocked.

Note

When Network Wide and Network Wide Static
are selected, the user has the provision to add
the whitelist MAC addresses to allow the
communication. A maximum of 64 MAC
addresses can be added.

cnMaestro
Managed
Roaming

Provision to enable centralized management of roaming for
wireless clients through cnMaestro.

- -

Hide SSID This is the basic security mode of a Wi-Fi device. This parameter
when enabled, will not broadcast SSID.

- Disabled

Session
Timeout

This field applies to all wireless clients connected to the SSID.
When a wireless station connects, a session timer is triggered.
Once session time expires, the wireless station must undergo
either re-authentication or re-association based on the state of
the wireless station. By default, it is enabled.

Note

Following priority takes precedence for the session
timeout:

a. Configured from the RADIUS server

b. Configured from the AP

60-
604800

28800

Inactivity
Timeout

Inactivity timer triggers whenever there is no communication
between Enterprise Wi-Fi AP device and wireless station
associated to Enterprise Wi-Fi AP device. Once the timer reaches
the configured Inactivity timeout value, APs send a de-
authentication to that wireless station. By default, it is enabled.

Note

Following priority takes precedence for the inactivity
timeout:

a. Configured from the RADIUS server

b. Configured from the AP

60-
28800

1800
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Figure 16 Basic parameters

Table 23WLAN (Max clients) parameters

Number of clients 2.4 GHz 5 GHz 6 GHz Concurrent

XV3-8 512 1024* NA 1536

XE5-8 512 1024* 1024** 2560

XV2-2 512 512 NA 1024

XV2-2T0 512 512 NA 1024

XV2-2T1 512 512 NA 1024

XE3-4 512 512 512 1536

XE3-4TN 512 512 512 1536

XV2-21X 128 128 NA 256

XV2-23T 128 128 NA 256

XV2-22H 128 128 NA 256

e410/e430 and e510 256 256 NA 256

e600 and e700 512 512 NA 512
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* Two 5 GHz radios are available in Single Band Simultaneous (SBS) mode.

** Two 6 GHz radios are available in XE5-8 platform.

Maximum wireless client

At present, the WLAN profile provides an option to configure the maximum wireless clients association limit.
This configuration limits the maximum number of clients per SSID per radio. For example, if a user configures
the maximum wireless client as 10, on a device capable of 2.4 GHz and 5 GHz radios, the total number of
clients that can be associated is 10 across each radio. This has been enhanced in Release 6.5 to set the
maximum clients limit per SSID irrespective of the number of radios to which SSID has been mapped.

Maximum clients per device

Most customers commonly use more than a single SSID. They prefer to set the maximum number of wireless
clients connection per device, i.e. irrespective of the number of WLAN profiles and the number of radios, the
maximum number of clients that can be associated is equivalent to the value configured for the parameter
max-clients. This is a global configuration.

CLI configuration:

ap(config)# max-clients

0|<1-1536> '0' disables max client per device

Maximum clients per SSID

This option helps to limit the number of wireless clients connected to a WLAN profile (SSID) irrespective of
the number of radios. This configuration is supported at the WLAN level. This can be enabled as follows:

CLI configuration:

ap(config)# wireless wlan 1

ap(config-wlan-1)# enforce-max-clients-per-ssid

Maximum clients per SSID per radio

This is the default configuration of the device. This configuration limits the maximum number of clients per
SSID per radio. For example, if a user configures the maximum wireless client as 20, on a device capable of
2.4 GHz and 5 GHz radios, the total number of clients that can be associated is 20 across each radio. This
configuration is supported at the WLAN level.

CLI configuration:

ap(config)# wireless wlan 1

ap(config-wlan-1)# max-associated-clients

<1-1536>

The default priority order can be:
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1. Per device (Global limit)

2. Per SSID and (enforce at SSID level)

3. Per SSID per radio basis (present default option)

To keep backward compatibility with the existing deployments, the default option can be Per SSID per radio
basis.

Opportunistic Wireless Encryption (OWE)

OWE is a Wi-Fi standard, which ensures that the communication between each pair of endpoints is
protected from other endpoints. The OWE transition mode allows OWE-capable STAs to access the network
in OWE authentication mode. The OWE transition mode is implemented as follows:

You must create two WLANs on an AP.

For example,

1. WLAN-1:

open authentication

owe-transition-ssid: Provides WLAN-2 owe security SSID

2. WLAN-2:

owe authentication

owe-transition-ssid: Provides WLAN-1 open security SSID

CLI configuration:

ap(config-wlan-1)# owe-transition-ssid

owe-transition-ssid : Configure the matching open/owe transition ssid

Note

The OWE transition mode SSIDs do not apply to 6 GHz radios.

Table 24 Advanced parameters

Parameters Description Range Default

WLAN > Advanced

VLAN
Pooling

This parameter is required when a user requires to distribute clients
across multiple subnets. Different modes of VLAN pooling is
supported by Enterprise Wi-Fi AP devices, based on infrastructure
available at the deployment site. Modes supported are as follows:

l Disabled

─ Disabled
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Parameters Description Range Default

This feature is disabled for this WLAN.

l Radius Based

The user is expected to configure WPA2 Enterprise for this
mode to support. During the association phase, AP obtains
pool name from RADIUS transaction and based on the present
distribution of wireless station across VLANs, AP selects
appropriate VLAN and wireless station requests an IP address
from the VLAN selected by Enterprise Wi-Fi AP device.

l Static

For this mode to support, the user requires to configure VLAN
Pool details available under Configure > Network > VLAN
pool. During the association phase, AP obtains pool, and
based on the present distribution of wireless station across
VLANs, AP selects appropriate VLAN and wireless station
requests an IPv4 address from the VLAN selected by the
Enterprise Wi-Fi AP device.

Max Clients This specifies the maximum number of wireless stations that can be
associated with a WLAN profile. This varies based on the Enterprise
Wi-Fi AP device model number. Refer to Table 23 for more details.

1-512
(Refer
Table
23)

256

UAPSD When enabled, Enterprise Wi-Fi AP devices support WMM Power
Save / UAPSD.  This is required where applications such as VOIP
Calls, Live Video streaming are in use. This feature helps to
prioritize traffic. Below is the default traffic priority followed by the
Enterprise Wi-Fi AP device.

─ Disabled

QBSS When enabled, appends QBSS IE in Management frames. This IE
provides information on channel usage by AP, so that smart
wireless stations can decide better AP for connectivity. Station
count, Channel utilization, and Available admission capacity are the
information available in this IE.

─ Disabled
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Parameters Description Range Default

DTIM interval This parameter plays a key role when power save supported
mobile stations are part of the infrastructure. This field when
enabled controls the transmission of Broadcast and Multicast
frames. 

1-255 1

Monitored Host

Host This feature is required where there is an interrupted backbone
network. Enterprise Wi-Fi AP device monitors the reachability of
hostname/IP configured in this parameter and modifies the state of
WLAN.

- Disabled

Interval The frequency of monitoring the network health based on the
status of the keep-alive mechanism w.r.t configured monitored
host.

60-
3600
sec

300

Attempts The number of packets in the keep-alive mechanism to determine
the status.

1-20 1

DNS Logging
Host

By enabling this feature, the Administrator can monitor the
websites accessed by wireless stations connected to WLAN profile.

─ Disabled

Connection
Logging Host

When enabled provides information of all IP connections accessed
by a wireless station that is associated with WLAN and logs the
connection data seamlessly onto an external syslog server.

─ Disabled

Band
Steering

This feature when enabled steers wireless stations to connect to
5GHz. There are three modes supported by Enterprise Wi-Fi
devices. The mode can be selected based on either deployment or
wireless station type. Below is the order of modes, which forces the
wireless station to connect to the 5 GHz band.

l Low

l Normal

l Aggressive

─ Disabled

Proxy ARP Provision to avoid ARP flood in a wireless network. When enabled,
AP responds to ARP requests for the wireless stations connected to
that AP. This is for IPv4 infrastructure.

─ Enabled

Proxy ND When enabled, AP responds to IPv6 Neighbor Discovery (ND)
requests for the wireless stations connected to that AP.

Unicast
DHCP

Provision to transmit DHCP offer and ACK/NACK packets as
Unicast packets to wireless stations.

─ Enabled
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Parameters Description Range Default

Insert DHCP
Option 82

When enabled, DHCP packets generated from wireless stations
that are associated with APs are appended with Option 82
parameters. Option 82 provides a provision to append Circuit ID
and Remote ID. Following parameters can be selected in both
Circuit ID and Remote ID:

l Hostname

l AP MAC

l BSSID

l SSID

l VLAN ID

l SITEID

l Custom

l All

Note

In case DHCP Option 82 is configured at the device-,
WLAN profile-, and L3 interface-levels, the following
priority order is considered:

1. Device-level configuration

2. WLAN profile-level configuration

3. L3 interface-level configuration

─ Disabled

Tunnel Mode This option is enabled when user traffic is tunneled to the DMZ
network either using L2TP or L2GRE.

─ Disabled

Fast-
Roaming
Protocol

One of the important aspects to support voice applications on a Wi-
Fi network (apart from QoS) is how quickly a client can move its
connection from one AP to another. This should be less than 150
ms to avoid any call drop. This is easily achievable when the WPA2-
PSK security mechanism is in use. However, in enterprise
environments, there is a need for more robust security (the one
provided by WPA2-Enterprise). With WPA2-Enterprise, the client
exchanges multiple frames with the AAA server, and hence
depending on the location of the AAA server the roaming time will
be above 700 ms.

─ Disabled
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Parameters Description Range Default

Select any one of the following:

l OKC

This roaming method is a Cambium Networks proprietary
solution to share the client authentication information with
other Cambium Networks APs on the same network by
sending encrypted information on wire on SSID VLAN. This
information sharing does not require cnMaestro so even in
cases where AP is not connected to cloud, the roaming will be
seamless.

l 802.11r

Fast transition (FT) is an IEEE standard to permit continuous
connectivity aboard wireless devices in motion, with fast and
secure client transitions from one Basic Service Set
(abbreviated BSS, and also known as a base station or more
colloquially, an access point) to another, performed in a nearly
seamless manner. The terms handoff and roaming are often
used, although 802.11 transition is not a true handoff/roaming
process in the cellular sense, where the process is coordinated
by the base station and is generally uninterrupted.

RRM (802.11k) AP sends the SSID name of the neighbor APs (SSID configured on
multiple APs) to 802.11k clients.

The following parameter must be enabled: 

l Enable RRM

─ Disabled

802.11v Provision to enable 802.11v BSS Transition Management. ─ Disabled

PMF
(802.11w)

802.11w also termed as Protected Management Frames (PMF)
Service, defines encryption for management frames. Unencrypted
management frames make wireless connection vulnerable to DoS
attacks as well as they cannot protect important information
exchanged using management frames from eavesdroppers.

─ Optional

SA Query
Retry Time

The legitimate 802.11w client must respond with a Security
Association (SA) Query Response frame within a pre-defined
amount of time (milliseconds) called the SA Query Retry time.

100-500 100ms

Association
Comeback
Time

This value is included in the Association Response as
an Association Comeback Time information element. AP will deny
association for the configured interval.

1-20 1 Sec
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Figure 17 Advanced parameters

Band steering also supports client load balancing based on the below CLI configuration:
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ap(config)# wireless wlan 1

ap(config-wlan-1)# band-steer-load-balancing

client-counts : client counts for band steer to consider clients load
balancing

client-percentage : Client percentage for band steer to consider clients
load balancing

WLAN VLAN allowed list
This is an optional CLI to configure the allowed VLAN list upfront. It is needed in multiple VLAN scenarios
such as Dynamic VLAN, ePSK-based VLAN, and RADIUS VLAN.

CLI configuration:

ap(config)# wireless wlan 1

ap(config-wlan-1)# vlans-allowed

{vlan_list} <e.g 1-10,15,100>

ap(config-wlan-1)# vlans-allowed 1-10

ICMPv6 Router advertisement (RA) unicast conversion
Convert ICMPv6 RA Multicast packets to Unicast for all stations. ICMPv6 RA unicast conversion is needed in
multiple VLAN scenarios such as Dynamic VLAN, ePSK-based VLAN, and RADIUS-based VLANs.

This CLI configuration allows to configure the VLANs where ICMPv6 RA unicast conversion is needed.

CLI configuration:

ap(config)# wireless wlan 1

ap(config-wlan-1)# ipv6-router-advertisement-unicast

vlans : Configure vlans where IPV6 Router Advertisement unicast
conversion needed

ap(config-wlan-1)# ipv6-router-advertisement-unicast vlans

{vlan_list} <e.g 1-10,15,100>

ap(config-wlan-1)# ipv6-router-advertisement-unicast vlans 1-10

802.11k/v

802.11k

Radio Resource Measurement (RRM) defines and exposes radio and network information to facilitate the
management and maintenance of a wireless network. 802.11k is intended to improve the way traffic is
distributed within the network.

The client can request a neighbor report from the AP using the neighbor_report_req management message.
The client may request neighbors withmatching SSID or request for all neighbors in the vicinity. The AP
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collects the neighbor information using proprietary methods and provides the list of neighbors to the client
in the neighbor_report_rsp message.

802.11v

802.11v is deployed on the APs to govern the wireless networking transmission methods. It allows clients
and APs to exchange information regarding the network topology, and RF environment. This facilitates the
wireless devices to be RF-aware for participating in network-assisted power savings and network-assisted
roaming methods.

The client may send solicited BSS Transition Management messages to AP before making roaming
decisions. The idea is to identify the best APs to roam. The AP, after receiving the message from a client is
expected to respond with the best APs in the vicinity to assist the client in roaming. The neighbor
information is collected using proprietary methods.

RADIUS server
To configure a RADIUS server, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles WLAN tab, select Radius Server tab and provide the details
as given in Table 25:

Table 25 RADIUS Server parameters

Parameters Description Range Default

Authentication
Server

Provision to configure RADIUS Authentication server details
such as Hostname/IPv4, Shared Secret, Port Number and
Realm. A maximum of three RADIUS servers can be
configured.

Note

The Realm parameter can be left blank, unless
you would like to use this server only for certain
usernames where the network domain is
included.

For example, in <username>@cambium.com or
<domain-name>/<username>, the realms are
@cambium.com and <domain-name>/, and
this server will be selected only if the username
has the appropriate realm.

- Disabled

Accounting
Server

Provision to configure Accounting server details such as
Hostname/IPv4, Shared Secret, Port Number. A maximum of
three RADIUS servers can be configured.

- Disabled

Timeout This field indicates wait time period for a response from the
AAA server.

1-30 3
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Parameters Description Range Default

Attempts Parameter to configure many attempts that a device should
send AAA request to server if no response is received within
the configured timeout period.

1-3 1

Accounting
Mode

This field is enabled based on customer requirements. The
accounting packet is transmitted based on the mode selected.

l Start-Stop

Accounting packets are transmitted by AP to the AAA
server when a wireless station is connected and then
disconnects.

l Start-Interim-Stop

Accounting packets are transmitted by AP to the AAA
server when a wireless station connects and then at
regular intervals of configured Interim Update Interval and
then when it disconnects.

l None

The accounting mode will be disabled.

- Disabled

Accounting
Packet

When enabled, Accounting-On is sent for every client when
connected.

- Disabled

Sync
Accounting
Records

Provision to configure accounting records to be synced across
neighboring APs.

- -

Server Pool
Mode

Users can configure multiple Authorization and Accounting
servers. Based on a number of wireless stations, the user can
choose Failover mode.

l Load Balance—AP communicates with multiple servers
and ensures that authorization and accounting are equally
shared across configured servers.

l Failover—AP selects the RADIUS server which is up and
running based on the order of configuration.

- Failover

NAS-Identifier This is a configurable parameter and is appended in the
RADIUS request packet.

- Hostname/

System
Name

Dynamic
Authorization

This option is required, where there is CoA request from
AAA/RADIUS server.

- Disabled
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Parameters Description Range Default

Dynamic VLAN When enabled, AP honors the VLAN information provided in
the RADIUS transaction. Wireless station requests IP address
from the same VLAN learned through RADIUS.

- Enabled

Called Station
ID

The following information can be communicated to the
RADIUS server:

l AP-MAC
l AP-MAC: SITE-NAME
l AP-MAC: SSID
l AP-MAC: SSID-SITE-NAME
l AP-NAME
l AP-NAME: SITE-NAME
l AP-NAME: SSID
l SITE-NAME
l SSID
l CUSTOM

- AP-MAC:
SSID
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Figure 18 The RADIUS Server parameters
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Proxy Through Controller

cnMaestro On-Premises can act as a proxy server for a AAA request coming from Enterprise Wi-Fi Access
Points. In this scenario, cnMaestro acts as Network Access Server (NAS) for the AAA server.

The AP sends AAA packets to cnMaestro On-Premises, and cnMaestro forwards them to the AAA server.
When the Proxy Through Controller feature is enabled, CoA is supported other than AAA requests.

CLI configuration:

ap(config-wlan-1)# radius-server through-controller

Note: Applicable only with On-Premises controller

For activating Proxy Through Controller feature in cnMaestro On-Premises:

1. Go to Administration > Settings.

2. Enable RADIUS Proxy checkbox as shown in below figure.

Figure 19 RADIUS proxy

EAP-FAST support

EAP-FAST authentication occurs in two phases. In the first phase, EAP-FAST employs the TLS handshake to
provide an authenticated key exchange and to establish a protected tunnel. Once the tunnel is established
the second phase begins with the peer and server engaging in further conversations to establish the
required authentication and authorization policies.

Guest Access

Internal Access Point

Below table lists configurable fields that are displayed in theWLANs > Guest Access > Internal Access
Point page.

Table 26 Internal Access Point parameters

Parameters Description Range Default

WLAN > Guest Access > Internal Access Point
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Parameters Description Range Default

Enable Enables the Guest Access feature. - Disabled

Access Policy There are four types of access types provided for the
user:

1. Clickthrough

This mode allows the users to get access
data without any authentication
mechanism. User can access the internet
as soon as he is connected and accepts
Terms and Conditions

2. RADIUS

This mode when selected, the user has to
provide a username and password, which
is then redirected to the RADIUS server for
authentication. If successful, the user is
provided with data access.

3. Local Guest Account

Users must configure username and
password on the device, which has to be
provided on the redirection page for
successful authentication and data access.

- Clickthrough

Redirect Mode This option helps the user to configure the HTTP or
HTTPS mode of redirection URL.

1. HTTP

AP sends an HTTP POSTURL to the associated
client, in the http://<Pre-defined-URL>
format.

2. HTTPS

AP sends HTTPS POSTURL to the success
associated client, in the https://<Pre-
defined-URL> format.

- HTTP

Redirect
Hostname

Users can configure a friendly hostname, which is added
to the DNS server and is resolvable to Enterprise Wi-Fi
AP IP address. This parameter once configured will be
replaced with an IP address in the redirection URL
provided to wireless stations.

- -
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Parameters Description Range Default

Title Users can configure a Title to the splash page.
Configured text in this parameter will be displayed on
the redirection page. This text is usually Bold.

Up to 255
characters

Welcome To
Cambium
Powered
Hotspot

Contents Users can configure the contents of the Splash page
using this field. Displays the text configured under the
Title section of the redirection page.

Up to 255
characters

Enter
username and
password to
get Web
Access

Terms Splash page displays the text configured when the user
accepts the Terms and Agreement.

Up to 255
characters

-

Logo Displays the logo image updated in URL http
(s)://<ipaddress>/logo.png. Either PNG or JPEG format of
the logo is supported.

- -

Background
Image

Displays the background image updated in URL http
(s)://<ipaddress>/backgroundimage.png. Either PNG or
JPEG format of the logo is supported.

- -

Success Action Provision to configure redirection URL after successful
login to captive portal services. Users can configure
three modes of redirection URL:

1. Internal Logout Page

After successful login, the wireless client is
redirected to the logout page hosted on AP.

2. Redirect user to External URL

Here users will be redirected to the URL which is
configured on the device in Redirection URL
configurable parameter.

3. Redirect user to Original URL

Here users will be redirected to the URL that is
accessed by the user before successful captive
portal authentication.

- Internal
Logout page

Redirect user to
External URL

Provision to configure re-direction URL after successful
login and additional information of AP and wireless
station information can be appended in the URL.

l Prefix Query Strings in Redirect URL

- -
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Parameters Description Range Default

This option is selected by default. The following
information is appended in the redirection URL:

l SSID

l AP MAC

l NAS ID

l AP IP

l Client MAC

l Redirection URL

l Users can provide either HTTP or HTTPS URL

Redirection user
to Original URL

Users will be redirected to the URL that is accessed by
the user before successful captive portal authentication.
There are additional parameter Prefix Query Strings in
Redirection URL that is enabled by default and details
given below:

l Prefix Query Strings in Redirect URL

This option is selected by default. The following
information is appended in the redirection URL:

l SSID

l AP MAC

l NAS ID

- -

Success
message

Provision to configure the text to display upon
successful Guest Access authentication. This is
applicable only when Success Action mode is Internal
Logout Page.

- -

Redirect l If enabled, only HTTP URLs will be redirected to the
Guest Access login page.

l If disabled, both HTTP and HTTPs URLs will be
redirected to the Guest Access login page.

- Enabled

Redirect User
Page

IPv4 address configured in this field is used as logout
URL for Guest Access sessions.

- 1.1.1.1

Proxy
Redirection Port

The proxy port can be configured with which proxy
server is enabled. This allows URLs accessed with proxy

1 - 65535 -
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Parameters Description Range Default

port to be redirected to the login page.

Session Timeout This is the duration of time, the client will be allowed to
access the internet if quota persists, after which AP
sends de-authentication. The wireless station has to
undergo Guest Access authentication after session
timeout.

Note

Following priority takes precedence for the
session timeout:

a. Configured from the RADIUS server

b. Configured from the AP

60 -
2592000

28800

Inactivity
Timeout

Provision to configure timeout period to disconnect
wireless stations that are associated but have no data
traffic. AP starts a timer when there is no data received
from a wireless station and disconnects when the timer
reaches zero.

Note

Following priority takes precedence for the
inactivity timeout:

a. Configured from the RADIUS server

b. Configured from the AP

60 -
2592000

1800

MAC
Authentication
Fallback

It is a mechanism in which wireless stations will be
redirected to the Guest Access login page after any
supported type of MAC address authentication fails.

- Disabled

Whitelist Provision to configure either IPv4 or URLs to bypass
traffic, therefor user can access those IPs or URLs
without Guest Access authentication.

- -
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Figure 20 The Internal Access Point parameters

External Hotspot

Below table lists the configurable fields that are displayed in theWLANs > Guest Access > External Hotspot
tab.

Table 27 External Hotspot parameters

Parameters Description Range Default

WLAN > Guest Access > External Hotspot

Access Policy There are four types of access types provided for the
end user:

1. Clickthrough

This mode allows users to get access
data without any authentication
mechanism. The user can access the
internet as soon as he is connected and
accepts the Terms and Conditions.

─ Clickthrough
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Parameters Description Range Default

2. RADIUS

The user has to provide a username
and password, which is then redirected
to a RADIUS server for authentication. If
successful, the user is provided with
data access.

3. Local Guest Account

The user has to configure username
and password on the device, which has
to be provided on the redirection page
for successful authentication and data
access.

Redirect Mode Provision to configure the HTTP or HTTPS mode of
redirection URL.

1. HTTP

AP sends an HTTP POSTURL to the associated
client, in the http://<Pre-defined-URL>
format.

2. HTTPS

AP sends an HTTPS POSTURL to the associated
client, in the http://<Pre-defined-URL>
format.

─ HTTP

Redirect Hostname Users can configure a friendly hostname, which is
added to the DNS server and is resolvable to
Enterprise Wi-Fi AP IP address. This parameter once
configured will be replaced with an IP address in the
redirection URL provided to wireless stations.

- -

External Page 
URL

Users can configure a landing/login page that is
posted to wireless stations that are not Guest Access
authenticated.

─ ─

External Portal Post
Through cnMaestro

This is required when HTTPS is only supported by an
external guest access portal. This option when
enabled minimizes certification. The certificate is
required to install only in cnMaestro On-Premises.

─ Disabled

External Portal Type Enterprise Wi-Fi AP products are supported by
standard mode configuration.

l Standard

─ Standard
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Parameters Description Range Default

This mode is selected, for all third-party
vendors whose Guest Access services
are certified and integrated with
Enterprise Wi-Fi AP products.

Success Action Provision to configure redirection URL after
successful login to captive portal services. User can
configure three modes of redirection URL:

1. Internal Logout Page

After successful login, the wireless client is
redirected to the logout page hosted on AP.

2. Redirect user to External URL

Here users will be redirected to the URL which is
configured on a device in Redirection URL
configurable parameter.

3. Redirect user to Original URL

Here users will be redirected to a URL that is
accessed by the user before successful captive
portal authentication.

─ Internal
Logout Page

Redirect user to
External URL

Provision to configure re-direction URL after
successful login and additional information of AP and
wireless station information can be appended in the
URL.

l Prefix Query Strings in Redirect URL

This option is selected by default. The following
information is appended in the redirection URL:

o SSID

o AP MAC

o NAS ID

o AP IP

o Client MAC

o RedirectionURL

o Users can provide either HTTP or HTTPS
URLs. 

─ ─
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Parameters Description Range Default

Redirection user to
Original URL

Users will be redirected to the URL that is accessed
by the user before successful captive portal
authentication. There are additional parameter Prefix
Query Strings in Redirection URL that is enabled by
default and details given below:

l Prefix Query Strings in Redirect URL

This option is selected by default. The following
information is appended in the redirection URL:

o SSID

o AP MAC

o NAS ID

o AP IP

o Client MAC

─ ─

Success message Provision to configure the text to display upon
successful Guest Access authentication. This is
applicable only when Success Action mode is
Internal Logout Page.

─ ─

Redirection URL
Query String

The following information is appended in the
redirection URL, if Prefix Query Strings in Redirect
URL is enabled.

l Client IP
l RSSI
l AP Location

- Disabled

Redirect l If enabled, only HTTP URLs will be redirected to the
Guest Access login page.

l If disabled, both HTTP and HTTPs URLs will be
redirected to the Guest Access login page.

─ Enabled

Redirect User Page The IP address configured in this field is used as
logout/disconnect/redirect to captive portal URL for
Guest Access sessions. The IP address configured
should not be reachable to the internet.

─ 1.1.1.1

Proxy Redirection
Port

The proxy port can be configured with which proxy
server is enabled. This allows URLs accessed with
proxy port to be redirected to the login page.

1 - 65535 ─
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Parameters Description Range Default

Session Timeout This is the duration of time, the client will be allowed
to access the internet if quota persists, after which AP
sends de-authentication. The wireless station has to
undergo Guest Access authentication after session
timeout.

Note

Following priority takes precedence for
the session timeout:

a. Configured from the RADIUS server

b. Configured from the AP

60 -
2592000

28800

Inactivity Timeout Provision to configure timeout period to disconnect
wireless stations that are associated but have no data
traffic. AP starts a timer when there is no data
received from a wireless station and disconnects
when the timer reaches zero.

Note

Following priority takes precedence for
the inactivity timeout:

a. Configured from the RADIUS server

b. Configured from the AP

60 -
2592000

1800

MAC Authentication
Fallback

It is a mechanism in which wireless stations will be
redirected to the Guest Access login page after any
supported type of MAC address authentication
failures.

─ Disabled

Extend Interface Provision to support the Guest Access on the
Ethernet interface.

─ Disabled
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Figure 21 External Hotspot parameters

cnMaestro

The following table lists configurable fields that are displayed in theWLANs > Guest Access > cnMaestro
page:

Table 28 The cnMaestro parameters

Parameters Description Range Default

WLAN > Guest Access > cnMaestro

Guest Portal 
Name

Provision to configure the name of the Guest Access profile
which is hosted on CnMaestro.

─ ─

Redirect l If enabled, only HTTP URLs will be redirected to the Guest
Access login page.

l If disabled, both HTTP and HTTPs URLs will be redirected to
Guest Access login page.

─ Enabled

Redirect User
Page

The IP address configured in this field is used as a logout URL for
Guest Access sessions. The IP address configured should be not

─ 1.1.1.1
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Parameters Description Range Default

reachable to the internet.

Proxy
Redirection
Port

The proxy port can be configured with which proxy server is
enabled. This allows URLs accessed with proxy port to be
redirected to the login page.

1 - 65535 ─

Inactivity
Timeout

Provision to configure timeout period to disconnect wireless
stations that are associated but have no data traffic. AP starts a
timer when there is no data received from a wireless station and
disconnects when the timer reaches zero.

Note

Following priority takes precedence for the
inactivity timeout:

a. Configured from the RADIUS server

b. Configured from the AP

60 -
2592000

1800

Whitelist Provision to configure either IPs or URLs to bypass traffic, such
that user can access those IPs or URLs without Guest Access
authentication.

─ ─
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Figure 22 cnMaestro parameters

Usage Limits
Below table lists configurable fields that are displayed in theWLANs > Access Control > Usage Limits
section.

Table 29 Usage Limits parameters

Parameters Description Range Default

Rate Limit per
Client

Provision to limit throughput per client. Default allowed
throughput per client is unlimited. i.e., maximum allowed by
802.11 protocols. The traffic from/to each client on an SSID can be
rate-limited in either direction by configuring the client rate limit
available in usage limits inside the WLAN Configuration. This is
useful in deployments like public hotspots where the backhaul is
limited and the network administrator would like to ensure that
one client does not monopolize all available bandwidth.

─ 0
[Unlimited]
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Parameters Description Range Default

Rate Limit per
WLAN

Provision to limit throughout across WLAN irrespective of a
number of associated wireless stations to WLAN.  All
upstream/downstream traffic on an SSID (aggregated across all
wireless clients) can be rate-limited in either direction by
configuring usage limits inside the WLAN configuration section of
the GUI. This is useful in cases where multiple SSIDs are being
used and say one is for corporate use, and another for guests.
The network administrator can ensure that the guest VLAN traffic
is always throttled, so it will not affect the corporate WLAN.

─ 0
[Unlimited]

Figure 23 The Usage Limits parameters

Scheduled Access
Below table lists configurable fields that are displayed in theWLANs > Access Control > Scheduled Access
section.

Table 30 The Scheduled Access parameters

Parameters Description Range Default

Scheduled
Access

Provision to configure the availability of Wi-Fi services for a
selected time duration. Enterprise Wi-Fi AP has the capability of
configuring the availability of Wi-Fi services on all days or a specific
day (s) of a week. The time format is in Hours.

Note

00:00
Hrs. -
23:59
Hrs.

Disabled
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Parameters Description Range Default

From release version 6.3 onwards, users are allowed
to configure up to a maximum of 12 scheduled access
rules per day on a particular WLAN instead of one rule
per day.

Figure 24 The Scheduled Access parameters

CLI Configuration:

ap(config)# wireless wlan 1

ap(config-wlan-1)# scheduled-access

all : all

friday : friday

monday : monday

saturday : saturday

sunday : sunday

thursday : thursday

tuesday : tuesday

wednesday : wednesday

weekday : weekday

weekend : weekend

ap(config-wlan-1)# scheduled-access all

Time period in HH:MM-HH:MM,HH:MM-HH:MM format
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Access
Below table lists configurable fields that are displayed in theWLANs > Access Control tab.

Table 31 The Access parameters

Parameters Description Range Default

DNS-ACL

Precedence Provision to configure index of ACL rule. Packets are validated
and processed based on the Precedence value configured.

- 1

Action Provision to configure whether to allow or deny traffic. - Deny

Domain Provision to configure domain names and rules are applied based
on Action configured.

- -

MAC Authentication

MAC
Authentication
Policy

Enterprise Wi-Fi AP supports multiple methods of MAC
authentication. Following are the details of each mode:

1. Permit

Wireless station MAC addresses listed will be allowed to
associate to AP.

2. Deny

When the user configures a MAC address, those wireless
stations shall be denied to associate and the non-listed MAC
address will be allowed.

3. RADIUS

For every wireless authentication, AP sends a RADIUS
request and if RADIUS acceptance is received, then the
wireless station is allowed to associate.

In case authentication fails, you can enable AP to assign the
default WLAN VLAN to the clients. For this, you must
configure the failed-allow-traffic CLI command. For
more information, see Fallback to WLAN VLAN when
RADIUS-based MAC authentication fails.

4. cnMaestro

This option is preferable when the administrator prefers a
centralized MAC authentication policy. For every wireless
authentication, AP a sends query to cnMaestro if it is allowed
or disallowed to connect. Based on the configuration,
wireless stations are either allowed or denied.

- Deny
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To configure DNS ACL:

1. Select Precedence from the drop-down list.

2. Select type of action from Action drop-down list.

3. Enter a domain name in the Domain textbox.

4. Click Save.

To configureMAC Authentication:

1. SelectMAC Authentication Policy from the drop-down list.

2. EnterMAC in the textbox.

3. Enter Description in the textbox.

4. Click Save.
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Figure 25 The Access parameters

Sample DNS-ACL configuration

If any user wants to block Facebook or Youtube traffic and allow the rest of the traffic, the configuration is
shown in below figure:
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Figure 26 Sample DNS-ACL configuration

Fallback to WLAN VLAN when RADIUS-based MAC authentication fails

When a client passes RADIUS-based MAC authentication, the RADIUS server assigns the configured VLAN.
However, if clients fail the authentication, you can configure the AP to assign the default WLAN VLAN. This
enables the AP to allow limited access to clients, or redirects the clients to a captive portal page, that are not
available in the RADIUS MAC authentication list. Once the captive portal authentication is successful, the
RADIUS server dynamically disconnects the client and assigns the RADIUS VLAN when the clients try to
connect later.

To assign the default WLAN VLAN to such clients, you must include the mac-authentication radius
failed-allow-traffic CLI command in the AP Groups > User Overrides section in cnMaestro.

This feature is only available for RADIUS-based MAC authentication. The use case for this feature is to
provide limited access to clients not included in the approved RADIUS MAC authentication list, such as
granting access to a walled garden, the internet, or redirecting the clients to go through the captive portal
authentication.

Figure 27 failed-allow-traffic in RADIUS-based MAC authentication

Passpoint
Below table lists configurable fields that are displayed in theWLANs > Passpoint tab.
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Table 32 Passpoint parameters

Parameters Description Range Default

Passpoint parameters

Enable Passpoint (Release 2) enables secure hotspot network access,
online sign-up, and policy provisioning.

─ Disabled

DGAF Downstream Group Addressed Forwarding when enabled the
WLAN does not transmit any multicast and broadcast packets.

─ Disabled

ANQP
Domain ID

ANQP domain identifier is included when the HS 2.0 indication
element is in Beacon and Probe Response frames.

0-
65535

0

Comeback
Delay

Comeback Delay in milliseconds. 100-
2000

0

Access
Network
Type

The configured Access Network Type is advertised to STAs.
Following are the different network types supported:

l Private
l Chargeable Public
l Emergency Services
l Free Public
l Personal Device
l Private with Guest
l Test
l Wildcard

─ Private

ASRA This indicates that the network requires a further step for access. ─ Disabled

Internet The network provides connectivity to the Internet if not specified. ─ Disabled

HESSID Configures the desired specific HESSID network identifier or the
wildcard network identifier.

─ ─

Venue Info Configure venue group and venue type. ─ ─

Roaming
Consortium

The roaming consortium and/or SSP whose security credentials can
be used to authenticate with the AP.

─ ─

ANQP
Elements

Select any one of the following:

l 3GPP Cellular Network Information
l Connection Capability
l Domain Name List
l Icons
l IP Address Type information
l NAI Realm List

─ ─
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Parameters Description Range Default

l Network Authentication Type
l Operating Class Indication
l Operator Friendly Names
l OSU Provider List
l Venue Name Information
l WANMetrics

Figure 28 Passpoint parameters

RADIUS attributes
The table below shows the RADIUS attributes describes their interpretation.

Table 33 Radius attributes parameters

Type Attribute
Name

Attribute
Number

Purpose

Standard Acct-Interim-
Interval

85 Specifies the interval between accounting interim
updates
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Type Attribute
Name

Attribute
Number

Purpose

Standard Acct-Session-Id 44 Session identification (RFC 5176)

Standard Calling-Station-
Id

31 Session identification (RFC 5176)

Standard Class 25 Accounting classification

Standard Event-
Timestamp

55 Replay protection (RFC 5176)

Standard Filter-ID 11 l Assign station to a user group
l Re-assign station to a different user group (RFC
5176)

Standard Framed-IP-
Address

8 Session identification (RFC 5176)

Standard Idle-Timeout 28 Specifies the amount of time a station may remain idle
before its session is terminated

Standard NAS-IP-
Address

4 NAS identification (RFC 5176)

Standard NAS-Identifier 32 NAS identification (RFC 5176)

Standard Session-
Timeout

27 Specifies the interval at which session is terminated

Standard Termination-
Action

29 Specifies the action to take when the session is
terminated

Standard Tunnel-Type 64 Dynamic VLAN assignment (1 of 3 required), should be
set to VLAN (Integer = 13)

Standard Tunnel-
Medium-Type

65 Dynamic VLAN assignment (2 of 3 required), should be
set to 802 (Integer = 6)

Standard Tunnel-Private-
Group-ID

81 Dynamic VLAN assignment (3 of 3 required), should be
set to the VLAN ID or name

Standard User-Name 1 l Station username update
l Session identification (RFC 5176)

Microsoft
Vendor-Specific

MS-MPPE-
Send-Key

16 Session key distribution

Microsoft
Vendor-Specific

MS-MPPE-
Recv-Key

17 Session key distribution

Cambium Cambium-Vlan- 157 Radius based VLAN pool
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Type Attribute
Name

Attribute
Number

Purpose

Vendor-Specific Pool-Id

Nas Port ID NAS-Port-Id 87 NAS identification (RFC 5176)

Enterprise PSK (ePSK)
By using the ePSK feature, users can configure and support individual PSKs for different clients. This feature
can be configured under a given WLAN configuration in cnMaestro UI. For on devices, only CLI support is
available.

This feature also supports individual VLAN assignments for a given key which helps to put client traffic on
different VLANs for limiting broadcast traffic.

Note:

l Maximum key limit for cnMaestro Essentials: 300 per account

l Maximum key limit for cnMaestro X: 2000 per WLAN and 50000 per account

Configuring ePSKs
To create an ePSK, complete the following steps:

1. Navigate to Configuration >Wi-Fi Profiles.

2. SelectWLAN tab and click Add.

3. Select Enterprise Wi-Fi from the Type drop-down list and enter details in the Basic Information section.

4. In the Basic Settings section, ensure theWPA2 Pre-Shared Keys option is selected in the Security
drop-down list.

5. Click Save.

6. Click the ePSK tab and select the Local option in theMode field.

7. Select the type of Passphrase Strength as one of the following options:

l Easy—Supports a maximum of eight alphanumeric characters

l Strong—Supports a maximum of 16 alphanumeric and special characters

l Number—Supports a maximum of eight integers

8. Click Add New.

The Add ePSK window is displayed.

9. SelectMode type as one of the following options and configure the corresponding parameters:
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l Singlemode—Only one entry is created in this mode

Note:

The Passphrase field is optional and is automatically generated based on the
selected Passphrase Strength.

l Bulkmode—Multiple entries are created in this mode depending on the count configured
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10. To automatically expire ePSK details after a specific duration. The following options are available:

Note:

This feature is available from cnMaestro 4.1.0 and later versions only.

l None—ePSK details never expire. Select None to never expire the ePSK credentials.

l Date and Time— ePSK expires after the specified date and time (in dd/mm/yyyy hh:mm AM/PM
format)

Supported minimum time is 12 A.M. on the next day and the maximum is five years.

l Duration— ePSK expires after the specified (in hours, days, months, or years) in the Expiry by drop-
down.

Supported minimum duration is one hour and the maximum is five years. No decimal values are
supported, for example, 1.5 hours.

Note:

l The configured expiry time appears in the Expiration Date column on theWLANs >
<WLAN name> page.
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l The Status column on theWLANs > <WLAN name> page displays the status of the
ePSK details—Active, Expired, or None. None is displayed only when older ePSK
keys are imported to cnMaestro.

l Expired ePSK details are deleted from the AP only when the next configuration sync
functionality is initiated or when there is a configuration change in the AP.

ePSK registration for WPA3 clients
For the ePSK feature, when you configure WPA3-WPA2 (mixed mode)-PSK or WPA3-PSK as the WLAN
security, the clients connection in the WPA3 mode must go through an additional registration phase. This is
different from the flow when you configure WPA2-PSK as the WLAN security, where users can authenticate
by using only a passphrase.

When clients use WPA3-PSK security, Simultaneous Authentication of Equals (SAE) is the authentication
mechanism where an extra authentication is added, which is more secure than WPA2. For WPA2-PSK
clients, the passphrase is matched against a database to identify the user. However, this is not possible for
WPA3-PSK clients because of the extra authentication in WPA3-SAE. When WPA2-PSK security is used, the
Pairwise Master Key (PMK) is the same for every connection made by the client. This is due to the underlying
weaknesses in WPA2-PSK, which make it easier to validate the passphrase. In contrast, when WPA3-PSK
security is used, a new PMK is generated each time a client joins the network. Therefore, registration will
help us to know the passphrase upfront when a client tries to connect. This mandates the users to register
themselves with the ePSK passphrase to bind the client MAC with the passphrase to successfully connect to
the Wi-Fi network.

For WPA3 clients to connect to the network using ePSK flow:

1. First connect to the WLAN with the WLAN passphrase.

A simple password is recommended to be configured, for example, signmeup, or any other
appropriate passphrase.

2. Register themselves with the WPA3-ePSK unique passphrase.

After the MAC binding is complete, users can use the WPA3-ePSK unique passphrase for subsequent
WLAN connections.

This section describes the following topics:

l ePSK with WPA3 feature recommendations

l Scenarios while registering clients

l Enabling ePSK registration flow using the AP CLI

l Configuring ePSK registration for WPA3 clients

l Registration flow screenshots

l Recommended best practices
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ePSK with WPA3 feature recommendations

The following are the recommendations for this feature:

l This feature is supported only on cnMaestro Cloud 5.1.0 onwards.

l Supported AP firmware version is 6.6.1 or 7.0 and above.

l Security mode must be configured to eitherWPA2/WPA3 Pre-shared Keys orWPA3 Pre-shared Keys.

l APs must be managed from cnMaestro Cloud for client registration.

l The WLAN VLAN must be able to provide DHCP to clients and must have internet connectivity.

l This feature is not supported on Enterprise Wi-Fi 5 APs and Xirrus APs.

Scenarios while registering clients

When a client connects to the WLAN, the following scenarios are possible:

l When a client connects for the first time using WPA2 security and ePSK passphrase (either on 2.4 GHz
or 5 GHz radios), the AP performs an ePSK lookup. The following are the outcome:

o If a match is found, the MAC binding is created with the respective ePSK key.

AP shares this MAC binding information with the other APs in the network.

o If a match is not found, the connection fails.

l If the WPA2 client is connected using the WLAN passphrase, client registration steps are performed to
bind the passphrase to the client.

l When a client connects for the first time using WPA3 security, the following two possibilities may occur:

1. If MAC binding is not available for the client on the AP, the following procedure must be completed
for successful registration of clients:

a. User must authenticate using the configuredWLAN passphrase, for example, signmeup.

If the user tries to sign in with some other password other than the configuredWLAN password
(signmeup), the connection fails.

b. If the connection with the configured password (signmeup) is successful, the AP redirects the
client to the registration page.

This is the only traffic allowed for the client with thisWLAN passphrase.

c. User must now enter the configured ePSK passphrase and register.

The AP redirects the client to the registration page with instructions.
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d. Users must select the checkbox after reading the instructions (provided for different clients,
such as Android, Windows, and iOS), and then disconnect from the network.

e. User must forget the WLAN/SSID and reconfigure using the ePSK passphrase.

User then reconnects with ePSK passphrase and gets authenticated.

For a more detailed information, see Registration flow screenshots.

2. When MAC binding is available for the client on the AP, users can authenticate the client with the
passphrase present in the MAC binding, that is the ePSK passphrase.

Figure 29 Client registration flow for WPA3 clients

Enabling ePSK registration flow using the AP CLI

To enable ePSK registration for WPA3 clients in the AP CLI, execute the following commands:
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ap(config)# wireless wlan 1

ap(config-wlan-1)# epsk-registration-flow

Configuring ePSK registration for WPA3 clients

To enable WPA3-ePSK registration, you must create a WLAN profile and add ePSK entries in the ePSK grid.

To create WLAN profile and add ePSK entries, complete the following steps:

1. Navigate to Configuration >Wi-Fi Profiles page.

2. SelectWLANs tab and click Add.

3. Select Enterprise Wi-Fi from the Type drop-down list and configure the WLAN parameters.

4. In the Basic Settings section, ensure either theWPA2/WPA3 Pre-shared Keys orWPA3 Pre-shared
Keys option is selected in the Security drop-down list.

5. Enter the WLAN passphrase.

6. Click Save.

l When ePSK passphrase is not configured in theWLANs > ePSK page, the following message is
displayed explaining the registration flow.

Figure 30 Message on the ePSK page when no ePSK entries are added

l For existing WLANs where ePSK entries are present and whenWPA2/WPA3 Pre-shared Keys or
WPA3 Pre-shared Keys option is selected in the Security drop-down list, the following messages
appear respectively
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Figure 31WhenWPA3 Pre-shared Keys option is selected

Figure 32WhenWPA2/WPA3 Pre-shared Keys option is selected

7. Click the ePSK tab and add the passphrase.

After the ePSK passphrase is added, the following message is displayed explaining the registration
flow.

Figure 33 Message on the ePSK page when ePSK entries are added

Registration flow screenshots

To register the clients to the network using the ePSK passphrase, users must complete the following steps:
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1. Connect the client to the network using the WLAN passphrase.

Figure 34 Using WLAN passphrase for connecting to network

2. Click Join.

Clients are redirected to the Client Registration page for providing the ePSK passphrase.

3. Enter the ePSK passphrase in the Passphrase field and click Register.
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Figure 35 Using ePSK passphrase for client registration

The registration success page is displayed along with a set of instructions.

4. Read the instructions (provided for different devices, such as Android, Windows, and iOS) and select the
checkbox for confirmation.

The instructions provide details of the next steps for different devices.

The Disconnect button is enabled.
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Figure 36 Registration success page with instructions

5. Click Disconnect.

The client is disconnected and a disconnect success message is displayed.

Figure 37 Disconnect success page

6. Reconnect to the network using the ePSK passphrase that you provided in the Client Registration page
earlier.

The client connects to the network with the mapped VLAN.
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Figure 38 Using ePSK passphrase for connecting to network

Recommended best practices

Following are some of the best practices you can follow while configuring ePSK registration for WPA3
clients:

l WPA3 PSK is not recommended for unmanaged (BYOD) clients (For example, multi-dwelling unit (MDU),
hospitality, and educational institutions).

In MDUs, with IoT clients, making WPA3 mandatory with a single SSID may not be a successful
deployment.

l WPA2/WPA3 PSK is recommended for unmanaged clients and to transition from the current (WPA2-
PSK).

l Most of the WPA3-capable clients favor WPA3 PSK when available. This behavior is different among
other clients, where some fallback to WPA2 and some which do not.

l When the SSID is mapped to 2.4 GHz and 5 GHz radios, WPA2 PSK or WPA2/WPA3 PSK security is
recommended.

l When the SSID is mapped to 2.4 GHz, 5 GHz, and 6 GHz radios, or only the 6 GHz radio, then WPA3
PSK security is recommended.

Creating a Personal Wi-Fi ePSK
Note

This feature is available from cnMaestro 4.1.0 and later versions only.

In Multiple Dwelling Units (MDU), personal Wi-Fi allows a user to connect all the personal devices to a unique
SSID associated with a VLAN.

To configure personal W-Fi on the AP, complete the following steps in the cnMaestro UI:
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1. Add and enable the SSID details (to be used as personal Wi-Fi) in theWLANs tab, underManage and
Operation > Networks > <network name> > Configuration > Device Configuration > Advanced
Settings section.

a. Select the Enable SSID checkbox.

b. In the Passphrase field, configure the passphrase.

c. Configure the VLAN with which the SSID must be associated.

2. Enable personal Wi-Fi on the ePSK page for the WLAN profile by selecting the Base Personal SSID
checkbox.

By default, this feature is disabled. Once enabled, the Enable checkbox (underWLANs >WLAN > Basic
Settings > SSID) is cleared. Also, the local and RADIUS ePSKs are disabled.

For more information on configuring personal Wi-Fi, refer to the cnMaestro User Guide.

RADIUS-based ePSK Premium feature

Cambium Networks ePSK feature is an extension of WPA2 PSK where multiple passphrases can be
assigned to a single SSID. The Wi-Fi clients can have unique passphrases that can be used by each client
using this feature. The same feature has been now extended to RADIUS.

The RADIUS server can provide the matching PMK for a given client, and corresponding standard RADIUS
attributes can be enforced for a client session. This requires custom development on the RADIUS server.

Note

ePSK feature is not supported with WPA3.

Configuring RADIUS-based ePSK
To configure RADIUS-based ePSK, complete the following steps:

1. Navigate to Configuration >Wi-Fi Profiles.

2. SelectWLAN tab and click Add.

3. Select Enterprise Wi-Fi from the Type drop-down list and enter details in the Basic Information section.

4. In the Basic Settings section, ensure theWPA2 Pre-Shared Keys option is selected in the Security
drop-down list.

5. Click Save.

6. Click the ePSK tab and select the RADIUSX option in theMode field.
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You must configure AAA servers when configuring RADIUS-based ePSK. See cnMaestro User Guide for
information on configuring AAA servers.
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Groupwise Transient Key (GTK) per VLAN
The APs support dynamic VLAN via ePSK/RADIUS based/VLAN-pool feature on a given WLAN profile. The
client traffic is tagged as per the VLAN assigned dynamically. The unicast traffic works fine as each client
generates a unique PTK. However, the AP provides common GTK for all the clients associated with the
WLAN profile irrespective of the VLAN that belongs to. This causes all clients irrespective of the VLAN
assigned can receive broadcast/multicast data traffic of other VLAN traffic.

The solution is to generate the GTK per VLAN and forward it to clients as part of the WPA2 handshake. So
that the broadcast/multicast data traffic is encrypted using GTK based on the VLAN tag of the packet. The
maximum number of GTKs supported is 127 per radio. By default it is disabled.

cnMaestro configuration:
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Configuring the Network
This chapter describes the following topics

l Overview

l Configuring Network parameters

Overview
This chapter gives an overview of the Enterprise Wi-Fi AP configuration parameters related to LAN, VLAN,
Routes, DHCP server, ACL, and Firewall.

Configuring Network parameters
Enterprise Wi-Fi AP network configuration parameters are segregated into the following sections:

l VLAN

l Routes

l Ethernet Ports

o Port Control—802.1X Authentication

l DHCP

l Tunnel

l PPPoE

l VLAN Pool

l Wireless Wide Area Network (WWAN)

IPv4 network parameters

VLAN

Note

By default, the XRP messages are sent through the native VLAN. From release version 6.6.2
onwards, a new CLI command (roam management-vlan) is added to enable XRP messages
to be sent through any VLAN other than the native VLAN. When configured, the roaming VLAN
must have an L3 interface on the AP.

To configure network parameters, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.



Configuring the Network 113

3. Click Network tab > VLANs section.

Figure 39 Network > VLANs section

4. Click Add New and configure the IPv4 parameters described in the following table.

Table 34 VLAN IPv4 parameters

Parameters Description Range Default

VLAN > IPv4

Address Provision to configure the mode of IPv4 address configuration for
an interface selected. Two modes are supported:

l DHCP—This is the default mode in which the Enterprise Wi-Fi
AP device tries to obtain an IPv4 address from the DHCP
server.

l Static IP—Users must explicitly configure the IPv4 address and
Netmask for a VLAN selected.

─ DHCP

NAT This option enables wireless traffic gets NAT'ed with APs
respective uplink interface IP. This option is recommended when
DHCP pools are configured in AP.

─ Disabled

Zeroconf IP Zeroconf IP is recommended to be enabled. This interface is
available only in the VLAN1 configuration section. If VLAN 1 is not
allowed in Ethernet interfaces, this IP will not be accessible.

─ Enabled

DHCP Relay
Agent

This option is enabled when DHCP server is hosted on a VLAN
which is not same as client that is requesting the DHCP IP. Enabling
this appends Option 82 in the DHCP packets. Following information
is allowed to configure:

l DHCP Option 82 Circuit ID

Configurable parameters under this option are as follows:

o Hostname

o APMAC

o BSSID

o SSID

─ Disabled
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Parameters Description Range Default

o Custom

l DHCP Option 82 Remote ID

Configurable parameters under this option are as follows:

o Hostname

o APMAC

o BSSID

o SSID

o Custom

Note

In case DHCP Option 82 is configured at the device-,
WLAN profile-, and L3 interface-levels, the following
priority order is considered:

1. Device-level configuration

2. WLAN profile-level configuration

3. L3 interface-level configuration

Request
Option All

This configuration decides the interface on which Enterprise Wi-Fi
AP will learn the following: 

l IPv4 default gateway 

l DHCP client options like Option 43 and Option 15
(Controller discovery like controller host name / IPv4 address)

l DNS Servers

l Domain Name

─ Enabled
on VLAN1
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Figure 40 VLAN IPv4 parameters

DHCP Client Options

Enterprise Wi-Fi AP devices learn multiple DHCP options for all VLAN interfaces configured on the device.
Based on configured criteria, values of these options are used by the system. The below table lists the
different DHCP options.

Table 35 DHCP Options

Options Description Usage Reference
CLI

Option 1 The subnet mask option specifies the
client's subnet mask as per RFC 950.

Based on the state of “Request
Option All”, the device chooses a
subnet mask from the respective
VLAN interface.

show ip
route

Option 3 This option specifies a list of IP
addresses for routers on the client's
subnet.

Based on the state of “Request
Option All”, the device chooses a
route learned from the respective
VLAN interface. The only first route is
honored.

show ip
route
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Options Description Usage Reference
CLI

Option 6 The domain name server option
specifies a list of Domain Name
System (STD 13, RFC 1035) name
servers available to the client. Servers
SHOULD be listed in order of
preference.

Based on the state of “Request
Option All”, the device chooses a
subnet mask from the respective
VLAN interface. the top two DNS
servers are honored by Enterprise
Wi-Fi AP devices.

show ip
name-
server

Option 15 This option specifies the domain name
that the client should use when
resolving hostnames via the Domain
Name System.

More details are provided in Option
15.

show ip
dhcp-
client
info

Option 26 This option specifies MTU size in a
network.

More details are provided in
Configuring the Network.

show ip
dhcp-
client
info

Option 28 This option specifies the broadcast
address that the client should use.

A broadcast address learned for all
VLAN interfaces are used
respectively as per standards

show ip
dhcp-
client-
info

Option 43 This option is used to help the AP in
obtaining the cnMaestro IP address
from the DHCP server while a DHCP
request to get an IP address is sent to
the DHCP server.

More details are provided in Option
43 (cnMaestro On-Premises 2.4.0
User Guide).

show ip
dhcp-
client
info

Option 51 This option is used in a client request
to allow the client to request a lease
time for the IP address. In a server
reply, a DHCP server uses this option
to specify the lease time it is willing to
offer.

Enterprise Wi-Fi AP renew leases for
all VLAN interfaces configured based
on lease time that has been learned
from the DHCP server.

show ip
dhcp-
client
info

Option 54 DHCP clients use the contents of the
server identifier field as the
destination address for any DHCP
messages unicast to the DHCP server.

Enterprise Wi-Fi AP learns DHCP
server IP for all VLAN interfaces
configured.

show ip
dhcp-
client
info

Option 60 This option is used by DHCP clients to
optionally identify the vendor type and
configuration of a DHCP client.

For Enterprise Wi-Fi AP device, value
is updated as Cambium-Wi-Fi-AP.

show ip
dhcp-
client
info

DHCP Option 43—Zero-touch onboarding

This option is used to help the AP in obtaining the cnMaestro/XMS IP address from the DHCP server while a
DHCP request to get an IP address is sent to the DHCP server.

This option is used to learn HTTPS proxy server address from the DHCP server as well.
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DHCP Option 43 format

If HTTP proxy needs to be configured, then the following format must be used:

The cnMaestro/XMS URL and HTTPS proxy URL can be packed into Option 43 payload in a key-value pair
separated by ‘,’ like <key=value,key=value>. Key and its value are separated by '=' character.

For example,
0=CMBM;1=cloud.cambiumnetworks.com;2=http://user:userpass@IP/URL:port, where
identifiers are listed below:

l 0 is for header CMBM -Mandatory

l 1 is for the server’s URL

l 2 is for HTTP proxy URL

Note

If only cnMaestro URL configuration is needed then Option 43 payload can contain only that
too without key-value format as described above.

Routing and DNS

Table 36 AP Groups > Network > VLAN > Routes > IPv4 Routing and DNS parameters

Parameters Description Range Default

Default
Gateway

Provision to configure the default gateway. If this is provided,
Enterprise Wi-Fi AP device installs this gateway as this is the
highest priority.

─ ─

DNS Server Provision to configure Static DNS server on Enterprise Wi-Fi AP
device. A maximum of two DNS servers can be configured.

─ ─

Domain
Name

Provision to configure Domain Name. If this is provided, Enterprise
Wi-Fi AP device installs this Domain Name as this is the highest
priority.

─ ─

DNS Proxy Enterprise Wi-Fi AP device can act as DNS proxy server when this
parameter is enabled.

Note

DNS Proxy is allowed only when NAT mode is
enabled for the WLAN.

─ Disabled
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Figure 41 IPv4 Routing and DNS parameters

Routes
Below table lists the fields that are displayed in Configure > Network > Routes tab:

Table 37 IPv4 Gateway Source Precedence, Route entries, and Port forwarding parameters

Parameters Description Range Default

Gateway
Source
Precedence

Provision to prioritize default gateway and DNS servers when
Enterprise Wi-Fi AP device has learned from multiple ways. Default
order is Static and DHCP.

─ Static

Add Multiple
Route Entries

The user has provision to configure static Routes. Parameters that
are required to configure static Routes are as follows:

l Destination IP

l Mask

l Gateway

─ ─

Port
Forwarding

This feature is required when wireless stations are behind NAT.
Users can access the services hosted on wireless stations using this
feature. Following configurable parameters are required to gain
access to services hosted on wireless stations which are behind:

l Port

l IP Address

l Type

─ ─



Configuring the Network 119

Figure 42 IPv4 Gateway Source Precedence, Route entries, and Port forwarding parameters

IPv6 network parameters

VLAN

Table 38 VLAN IPv6 parameters

Parameters Description Range Default

Address Provision to configure the mode of IPv6 address configuration
for an interface selected. Five modes are supported:

l Disabled

l AutoConfig

l Static

l Stateless DHCPv6

l Stateful DHCpv6

─ AutoConfig

Request
Option All

This configuration decides the interface on which AP
will learn the following: 

l IPv6 default gateway 

─ Enabled on
VLAN1
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Parameters Description Range Default

l DHCP client options like Option 52 and Option 24
(Controller discovery like controller hostname / IPv6
address)

l DNS Servers

l Domain Name

Figure 43 VLAN IPv6 parameters

Routing & DNS

Table 39 IPv6 Routing and DNS parameters

Parameters Description Range Default

Default
Gateway

Provision to configure the default gateway. If this is provided,
Enterprise Wi-Fi AP device installs this gateway as this is the
highest priority.

─ ─

DNS Server Provision to configure Static DNS server on Enterprise Wi-Fi AP
device. A maximum of two DNS servers can be configured.

─ ─

Domain
Name

Provision to configure Domain Name. If this is provided, Enterprise
Wi-Fi AP device installs this Domain Name as this is the highest
priority.

─ ─

IPv6
Preference

When enabled, IPv6 is preferred over IPv4 based on DNS
response.

─ Disabled
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Figure 44 IPv6 Routing and DNS parameters

Routes

Table 40 IPv6 Gateway Source Precedence and Multiple Route Entries parameters

Parameters Description Range Default

Gateway
Source
Precedence

Provision to prioritize default gateway and DNS servers when
Enterprise Wi-Fi AP device has learned from multiple ways. Default
order is Static and AUTO-CONFIG/DHCPC.

─ Static

Add Multiple
Route Entries

The user has provision to configure static Routes. Parameters that
are required to configure static Routes are as follows:

l Destination IP/prefix

l Gateway

─ ─
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Figure 45 IPv6 Gateway Source Precedence and Multiple Route Entries parameters

General network parameters
Table 41 VLAN - General parameters

Parameters Description Range Default

Management
Access

Provision to restrict the access of devices in all modes CLI
(Telnet, SSH), GUI (HTTP, HTTPS), and SNMP. Users can
configure restriction of device access as follows:

l Block

l Allow fromWired

l Allow from both Wired and Wireless 

─ Allow from
both Wired
and
Wireless

Select Management Access to configure restriction of the device from the drop-down list.
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Figure 46 VLAN - General parameters

Ethernet Ports
Below table lists the fields that are displayed in AP Groups > Network > Ethernet Ports tab.

Table 42 Ethernet Ports 1 to 4 parameters

Parameters Description Range Default

Ethernet Port
<1-4>

Enterprise Wi-Fi AP devices Ethernet port is provisioned to
operate in the following modes:

l Access Single VLAN—Single VLAN traffic is allowed in this
mode.

l Trunk Multiple VLANs—Multiple VLANs are supported in
this mode.

─ Access
Single VLAN

VLAN VLAN ID to be associated with the Ethernet port. 1 to
4094

1

Port Speed Specifies the port speed in Mbps.

Following values are supported:

l Auto

l 10 Mbps

l 100 Mbps

l 1000 Mbps

l 2500 Mbps

l 5000 Mbps

─ Auto

Port Duplex Specifies the type of duplex communication configured for the
port.

─ Full Duplex
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Parameters Description Range Default

Following values are supported:

l Full Duplex

l Half Duplex

Tunnel Mode Only applicable for Ethernet ports 2, 3, and 4.

Specifies whether tunneling of wired traffic is enabled or not.

Figure 47 Ethernet Ports parameters

Port Control—802.1X Authentication

802.1X authentication on Ethernet ports enhance the network security of the AP. The AP supports 802.1X
port-based authentication in the single-host authentication mode. In this mode, only one client is allowed to
access the network after successful 802.1X port-based authentication. After successful authentication, the
port VLAN is assigned based on RADIUS assigned VLAN.

Note

l 802.1X port-based authentication does not support CoA messages.

802.1X port-based authentication requires a RADIUS AAA server for authentication and accounting.

The following table lists the parameters for configuring the RADIUS AAA server on Ethernet ports available
on the AP Groups > Network > Ethernet Ports > RADIUS Server page.

Table 43 RADIUS Server parameters

Parameters Description Range Default

Authentication
Server

Specifies the authentication server details, such as:

l Host—IPv4 or IPv6 address or hostname of the server

l Secret—Text string that is used to encrypt data in RADIUS
packets shared between the AP and the sever. Format—
Text string

l Port—Port number of the authentication server. Default—
1812

A maximum of three RADIUS authentication servers can be
configured.

- Disabled

Accounting
Server

Specifies the accounting server details, such as:

l Host—IPv4 or IPv6 address or hostname of the server

- Disabled
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Parameters Description Range Default

l Secret—Text string that is used to encrypt data in RADIUS
packets shared between the AP and the sever. Format—
Text string

l Port—Port number of the accounting server. Default—
1813

A maximum of three RADIUS accounting servers can be
configured.

Timeout Time (in seconds) to wait for a response from the RADIUS
server.

1-30 3

Attempts Number of retry attempts for contacting the RADIUS server. 1-3 1

Accounting
Mode

Specifies the accounting mode to be used. The following
modes are supported:

l Start-Stop—Accounting packets are transmitted by APs to
the AAA server when a wireless client is connected and
when the client disconnects.

l Start-Interim-Stop—Accounting packets are transmitted
by APs to the AAA server when a wireless client connects,
then at regular intervals (configured in the Interim Update
Interval field) and also when the client disconnects.

l None—Disables the accounting mode. This is the default
mode.

- None
(Disabled)

Server Pool
Mode

Users can configure multiple Authorization and Accounting
servers. Based on a number of wireless stations, the user can
choose Failover mode.

l Load Balance—AP equally distributes the requests
between the configured RADIUS servers,

l Failover—AP selects the RADIUS server that is functional
based on the order of configuration.

- Failover

Interim update
interval

Time (in seconds) to wait for sending RADIUS interim
accounting update packets.

Note: This interval is applicable only when you select the Start-
Interim-Stop option in the Accounting Mode parameter.

10-
65535

1800

Dynamic
Authorization

This option is required, where there is CoA request from
AAA/RADIUS server.

- Disabled
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Figure 48 RADIUS Server parameters

DHCP
Below table lists the fields that are displayed in the AP Groups > Network > DHCP page.

Figure 49 DHCP Pool parameters

Table 44 DHCP parameters

Parameters Description Range Default

DHCP Pool Specifies the DHCP pool ID. 1 to 16 ─
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Parameters Description Range Default

Address
Range

Indicates the start and end addresses for the DHCP Pool. ─ ─

Default
Router

Specifies the default router IP address. ─ ─

Domain
Name

Specifies the domain name for the DHCP pool. ─ ─

DNS Address Specifies the primary and secondary addresses of the DNS server
for a DHCP pool.

─ ─

Network Specifies the network IP address and subnet mask for the
DHCP pool.

─ ─

Lease Duration (in days, hours, and minutes) for which the IP address must
be leased to the client.

─ 1 day

Add Bind List

For every DHCP pool configured, the user can bind MAC and IP from
the address pool defined, so that the wireless station gets the same
IP address every time they connect. Following parameters are
required to bind IP address:

l MAC Address

l IP Address

─ ─

Figure 50 Add DHCP window

Tunnel
The following table lists the fields that are displayed in AP Groups > Network > Tunnel page.
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Figure 51 Tunnel - L2TP parameters

Figure 52 Tunnel - L2GRE parameters
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Table 45 Tunnel parameters

Parameters Description Range Default

Tunnel Encapsulation Provision to enable tunnel type.
Following tunnel types are
supported by Enterprise Wi-Fi AP
devices:

l L2TP

l L2GRE

l OFF

─ OFF

L2TP

Remote IP Configure L2TP end point. IPv4
address or Primary hostname of
the endpoint is supported.

─ ─

Username and
Password

Credentials required for L2TP
authentication.

─ admin/admin

Authentication Type Provision to select the PPP
authentication method.
Following are the options
available:

l DEFAULT

l CHAP

l MS-CHAP

l MS-CHAPv2

l PAP

─ DEFAULT

TCP MSS TCP Maximum Segment Size
(MSS) in bytes.

422- 1410 1400

PMTU Discovery Provision to enable to discover
PMTU in network.

─ Enabled

L2GRE-1

You can configure a maximum of two L2GRE tunnels. Configure L2GRE-1 tunnel by configuring the below
parameters in the AP Groups > Network > Tunnel tab. However, configuring L2GRE-2 tunnel is allowed
only using the device CLI. The following parameters for L2GRE-1 are also applicable for L2GRE-2.
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Parameters Description Range Default

Remote IP Configure L2GRE endpoint. IPv4
address or primary hostname of
an endpoint is supported.

─ ─

DSCP Users can configure priority of
GRE packets.

─ 0

TCP MSS TCP Maximum Segment Size
(MSS) in bytes.

472-1460 1410

PMTU Discovery Provision to enable to discover
PMTU in a network.

─ ─

MTU Maximum Transmission Unit in
bytes.

850-1460 1460

GRE in UDP GRE protocol is designed to
establish a tunnel between any
third-party vendor which
complies with RFC 8086.

─ Disabled

Point-to-Point Protocol over Ethernet (PPPoE)
PPPoE provides the ability to establish a connection to ISP with user authentication. Below table lists the
fields that are displayed in AP Groups > Network > PPPoE page.

Figure 53 PPPoE parameters
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Table 46 PPPoE parameters

Parameters Description Range Default

Enable Provision to enable PPPoE client. ─ Disabled

VLAN ID Users can configure VLAN ID where PPPoE clients should
obtain an IP address.

─ ─

Service Name Configure PPPoE service name. ─ ─

Authentication
Info

Provision to configure credentials required for PPPoE
authentication.

─ admin/admin

MTU Maximum Transmission Unit. 500-
1492

1492

TCP-MSS
Clamping

Configure PPPoE endpoint. Either IP or hostname of an
endpoint is supported.

─ Enabled

Management
Access

If enabled, the user can access the device either using UI or
SSH with PPPoE IP.

─ Disabled

VLAN Pool
The following table lists the fields that are displayed in AP Groups > Network > VLAN Pool page.

Table 47 The VLAN Pool parameters

Parameters Description Range Default

VLAN Pool
Name

Name for the VLAN pool. ─ ─

VLAN ID List List of VLAN IDs for the VLAN pool.

You can configure either a single VLAN ID or multiple VLAN IDs.

Multiple VLAN IDs can be configured either separated by comma or
hyphen. For example, 2-7, 45, 67.

─ ─

Figure 54 The VLAN Pool parameters
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Wireless Wide Area Network (WWAN)
The following table lists the fields that are displayed in Configure > Network > WWAN tab.

Note

This feature is supported in XV2-2, XV3-8, XE3-4, and XE5-8 platforms only.

Table 48WWAN parameters

Parameters Description Range Default

WWAN Provision to enable wireless WAN using a USB cellular
dongle for internet access.

─ ─

Failover Only Failover only can be configured in two modes:

l Enabled: Ethernet will be the primary connection and
WWAN will be backup.

l Disabled: 3G/4G (WWAN) will be the only working
connection.

Note: Cellular link can be configured as backup only to
Ethernet connection.

─ Enabled

APN Provision to configure network provider APN address. ─ ─

Authentication
Info

Provision to configure credentials required for WWAN
authentication.

─ admin/admin

Monitor Host Running a check in the background that constantly monitors
a user configured IP address (example: 8.8.8.8) for
reachability through ping.

─ ─

Figure 55WWAN parameters

Supported hardware

Cambium Networks currently support the following models, where local laws permit:
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l Huawei

o E8372

o E3372

l Alcatel

o Link Key 4G IK40V (recommended)

l ZTE

o MF833V
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Configuring Access Control
The Access Control page allows the users to enable or assign access control policies and configure user
group policies and device policies. It offers visibility into the configured rules, ensuring efficient and secure
network management.

Figure 56 Access Control page

Note

If an Access Control Policy is assigned at the AP group level, it does not appear under User
Group or Device Group policies.

This chapter describes the following topics

l Enabling Access Control Policy
l User Group Policy
l Device Policy

Enabling Access Control Policy
Users have the provision to enable or disable access control policies under Access Control tab.

Figure 57 Enabling Access Control Policy
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Users can select the available access control policies listed in the Wi-Fi profiles in the Access Control Policy
drop-down list. They can also view the configured rules associated with these policies by clicking View
Rules. This provides a comprehensive view of the policies and rules within the network.

Figure 58 Access Control Policy Rules

User Group Policy
User group policies allow you to categorize users into specific roles with customized access permissions
and restrictions, facilitating a fine-tuned control over network access.

To add a new to User Group Policy, perform the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups > Access Control page.

2. Click Add to create a new AP group.

3. Click the Access Control tab in the Add New page.

4. Click Add New in the User Group Policy section.

Figure 59 User Group Policy

5. Complete the details in the Add User Group window.
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Figure 60 Add User Group

Note

l The user must assign an Access Control Policy or VLAN to create a User Group Policy.

l A maximum of 64 User Group Policies are supported.

l Users can select Access Control Policies with non-MAC filters only from the Access
Control Policy drop-down list.

l Mapping an Access Control Policy to a User Group Policy enables its use for the AP
group, and vice versa. However, the same Access Control Policy cannot be shared
between the User Group Policy and the AP group. You can apply it either to the User
Group Policy or to the AP group only.

Device Policy
Device Policy allows users to apply specific rules and access control policies based on the type and
characteristics of devices, offering customized control over device behavior within the network.

To add a new Device Policy, perform the following steps:

1. Navigate to Configuration >Wi-Fi Profiles > AP Groups tab.

2. Click Add to create a new AP group.

3. Click the Access Control tab in the Add New page.

4. Click Add New in the Device Policy section.
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Figure 61 Device Policy

5. Complete the details in the Add Device Policy window.

Figure 62 Add Device Policy

Note

l A maximum of 64 Device Policies are supported.

l Users can select Access Control Policies with non-MAC filters only from the Access
Control Policy drop-down list.
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Managing Filters
This chapter describes the following topics:

l Overview

l Filter list

l Device class filter

l Wi-Fi Calling support

l Air cleaner

l Application control Premium feature

Overview
Filters are used to define the rules used for blocking or passing traffic and also to change QoS/DSCP and
rate-limiting for selected traffic. 

The Wireless AP’s integrated firewall uses stateful inspection to accelerate the decision of whether to allow
or deny traffic user connections managed by the firewall are maintained statefully. Once user flow is
established through the AP, it is recognized and passes through without the application of all defined
filtering rules. Stateful inspection runs automatically on the AP.

Filter list
Filters are organized in groups, called filter lists. A filter list allows users to apply a uniform set of filters to
SSIDs. AP supports 16 filter lists and each filter list supports 50 filter rules in precedence order.

Filters
These settings create and manage filters with precedence that belong to the current filter list, based on the
filter criteria you specify.

Filters can be configured in Layer 2 and Layer 3 or application/category control (Layer 7). Layer 2 rule takes
high precedence over Layer 3 application control and Layer 2 supports MAC/IP/protocol-based rules.  

Filters are an especially powerful feature when combined with the intelligence provided by the Application
Control Windows.

Based on Application Control’s analysis of your wireless traffic, you can create filters to enhance wireless
usage for your business needs:

1. Usage of non-productive and risky applications like BitTorrent can be restricted.

2. Traffic for mission-critical applications like VoIP and WebEx may be given higher priority (QoS).
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3. Non critical traffic from applications like YouTube may be given lower priority (QoS) or bandwidth
allowed may be capped per station or for all stations.

Configuring filter CLI
By configuring the filter CLI, the user can define ACL rules for blocking or passing traffic, DSCP/QoS rules for
modifying packets, and rate-limiting for selected traffic.

1. Create filter list/filter profile using global filter command (Filter: configure filter parameters).

ap(config)# filter

filter-list : Configure filter list

global-filter : Configure Global filter parameters

2. Global-filter is for global rules in AP. Global-filter includes the below options:

ap(config-global-filter)#

air-cleaner : Configure Preset air cleaner filters

application-control : Enable application control

clear : Clear command

disable : Disable filter list

filter : Configure filter rules in precedence order

stateful : Enable stateful filtering

apply : Apply configuration that has just been set

exit : Exit from filter list configuration

no : Delete/disable filter list parameters

save : Save configuration to Flash so it persists across reboots

show : Show command

l Stateful filtering : Stateful operation of the integrated firewall can be Enabled or Disabled. By
default, it is enabled.

l Application Control Premium feature: Operation of the Application Control feature may be Enabled or
Disabled.

l Disable: Disable or enable filter list.
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3. Each filter list includes below options:

Note

Global-filter rules will take precedence over filter-list rules

l Global filter and filter-list can include 50 filter rules with precedence order.

ap(config-filter-list-1)# filter precedence {1-50}

4. Then create filter rule from precedence level (1 to 50).

Note

The filter type is either Layer 2 or Layer 3 or application control can be added in one
precedence level.
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5. Layer 3 filter has the below provisions.

l QoS Premium feature: Set packets QoS level (0 to 3). Level 0 has the lowest priority; level 3 has the
highest priority

l DSCP Premium feature: Differentiated Services Code Point or DiffServ (DSCP). DSCP level (0 to
63. Level 0 has the lowest priority and level 63 has the highest priority.

l Rate limit Premium feature: Filters support rate limiting per station or all stations and support
Kbps/Mbps/pps.

l Schedule Premium feature: Filter support scheduling the activation of the layer3 /application control
rules based on the day and local time selected.

l Disable: Each filter and filter list can be turned on/off.

Note:

Application Control, QoS, DSCP, Schedule and Rate limit are Premium features.

6. Each layer 3 rule category has below types

7. For proto or port number-based rule, select proto.

Note

All fields are mandatory. If no parameter to configure, give ‘any’. Direction is the
direction of the rule. if it is ‘in’, the rule is applicable for traffic from the wireless side.
If it is ‘out’, the rule is applies for traffic to wireless.
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8. For non-proto or port number-based rules, select IP.

9. Layer 2 filter has below options:

10. Each layer 2 rule category has below two cases.

Layer 2 rule supports IP, MAC, Port, or Protocol-based rules.

11. ap(config-list-1-filter-precedence-1) # layer2-filter permit mac

Example:

12. ap(config-list-1-filter-precedence-1) # layer2-filter permit proto

Example:

Sample configuration
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13. To attach the filter list into the WLAN profile, filter-list < filter-list ID>.

14. To show filter statistics:

Device class filter
This feature applies wireless policies to the client-based device class (notebook, phone, tablet, and laptop)
and its type (Windows, Mac, and Android).

CLI configuration:

ap(config)# device-class-filter 1

ap(config-device-class-filter-1)# class

ap : Configure filter rules for the AP device class

appliance : Configure filter rules for the appliance device class

desktop : Configure filter rules for the desktop device class

game : Configure filter rules for the game device class

notebook : Configure filter rules for the notebook device class
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phone : Configure filter rules for the phone device class

player : Configure filter rules for the player device class

tablet : Configure filter rules for the tablet device class

ap(config-device-class-filter-1)# class notebook

all : Configure filter rules for all notebook device classes

chrome : Configure filter rules for the Chrome-OS device type

linux : Configure filter rules for the Linux device type

mac : Configure filter rules for the Mac device type

windows : Configure filter rules for the Windows device type

ap(config-device-class-filter-1)# class notebook linux

ap(config-device-class-filter-1)# filter-list

Filter list ID <1-16> or Name

Wi-Fi Calling support
Cambium Networks Access Point has the inbuilt application visibility engine, which can detect Wi-Fi calling
and provide better call quality by reducing the latency, jitter, and roaming delays for voice calls over Wi-Fi.

When the Access Point detects the Wi-Fi calling traffic, it classifies and puts the traffic in the voice priority
queue for achieving better call quality.

CLI configuration:

Note

Filter precedence can be from 1 to 50.

Air cleaner
The Air Cleaner feature offers several predetermined filter rules that eliminate a great deal of unnecessary
wireless traffic.

Configuration CLI:

ap(config)# filter global-filter

ap(config-global-filter)# air-cleaner

all : All air cleaner filters

arp : Eliminate station to station ARPs over the air

broadcast : Eliminate broadcast traffic from the air

dhcp : Eliminate stations serving DHCP addresses from the air

multicast : Eliminate chatty multicast traffic from the air
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When we configure the Air Cleaner rule, pre-defined filter rules will get populated automatically as
shown below:

ap(config-global-filter)# air-cleaner all

ap(config-global-filter)# show config filter

!

!

filter global-filter

stateful

application-control

air-cleaner all

filter precedence 1

layer2-filter deny proto arp any any in //Air-cleaner-Arp.1

wlan-to-wlan

exit

filter precedence 2

layer2-filter deny proto udp any any FF:FF:FF:FF:FF:FF 67 out //Air-
cleaner-Dhcp.1

exit

filter precedence 3

layer2-filter deny proto udp any any FF:FF:FF:FF:FF:FF 68 in //Air-
cleaner-Dhcp.2

exit

filter precedence 4

layer2-filter permit proto arp any FF:FF:FF:FF:FF:FF any //Air-cleaner-
Bcast.1

exit

filter precedence 5

layer2-filter permit proto udp any any FF:FF:FF:FF:FF:FF 67 any //Air-
cleaner-Bcast.2

exit

filter precedence 6

layer2-filter permit proto udp any any FF:FF:FF:FF:FF:FF 68 any //Air-
cleaner-Bcast.3

exit

filter precedence 7

layer2-filter permit proto udp any any FF:FF:FF:FF:FF:FF 22610 any
//Air-cleaner-Bcast.4

exit

filter precedence 8

layer2-filter deny mac any FF:FF:FF:FF:FF:FF any //Air-cleaner-Bcast.5
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exit

filter precedence 9

layer2-filter permit mac any 01:00:5E:00:00:FB any //Air-cleaner-mDNS.1

exit

filter precedence 10

layer2-filter deny mac any multicast any //Air-cleaner-Mcast.1

exit

Note

In Mesh link configuration, the Air Cleaner rules need customization like disabling
Precedence 2 and Precedence 3 (DHCP rules).

Application control Premium feature

The Application Control feature provides real-time visibility of application usage by users across the wireless
network. Network usage has changed enormously in the last few years, with the increase in smartphone and
tablet usage stressing networks. Increasing traffic from legitimate business needs such as cloud- and web-
based applications, streaming media, and VoIP must be handled with an adequate quality of experience. To
achieve this purpose Application Control filters are used to define the rules used for blocking or passing and
change QoS/DSCP and rate-limiting for the specific Application or a specific category of application. For
more details, refer to the Application Control Filters section in the user guide

Application Control can track application usage over time to monitor trends. Usage may be tracked by AP,
VLAN, or station. Many hundreds of applications are recognized and grouped into a number of categories.
The distributed architecture of Cambium Enterprise APs allows Application Control to scale naturally as you
grow the network.

This topic describes the following content:

l Deep Packet Inspection (DPI)

o Application control policy

o Risk and productivity

o Selection criteria

o DPI CLI configuration

o Global application policy

o SSID application policy

l Custom Applications X
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Deep Packet Inspection (DPI)
The AP uses Deep Packet Inspection (DPI) to determine what applications are being used and by whom, and
how much bandwidth they are consuming. These applications are rated by their degree of risk and
productiveness. Filters can be used to implement per-application policies that keep network usage focused
on productive uses.

Application control policy

When you find risky or unproductive applications consuming bandwidth on the network, you can easily
create Filters to control them. You may use filters to:

l Block problematic traffic, such as BitTorrent or Y8.

l Prioritize mission-critical traffic: By increasing the QoS assigned to the traffic, applications like VoIP and
WebEx may be given higher priority (QoS).

l Lower the priority of less productive traffic: Use filters to decrease the QoS assigned to traffic for
applications like YouTube and Facebook.

l A nonproductive specific application can be rate-limited to avoid impact on the productive application.
(for example, YouTube streaming can be rate-limited to avoid impact on applications like VoIP)

Risk and productivity

Application control ranks applications in terms of their levels of risk and productivity.

Productivity: Indicates how appropriate an application is useful for business purposes. The higher the rating
number, the more business-oriented an application is:

1. Primarily recreational

2. Mostly recreational

3. Combination of business and recreational purposes

4. Mainly used for business

5. Primarily used for business

Risk: indicates how likely an application is to pose a threat to the security of your network. The higher the
rating number, the riskier of an application is:

1. No threat

2. Minimal threat

3. Some risk: maybe misused

4. High risk: maybe malware or allow data leaks

5. Very high risk: threat circumvents firewalls or avoids detection

Selection criteria

From the AP CLI, the below options are available to view the Application Statistics:
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l Application: This gives detailed information about the application seen from the wireless traffic.

l Category: This gives the combined statistics of the application which belongs to a particular category (for
example, Games, Network monitor).

ap(config)# show application-statistics by-category

Application Categroy Statistics for All Applications

=======================================================================
=========

Application Productivity TX TX RX RX

category Index & Risk Packets Bytes Packets Bytes

------------------------------------------------------------------------
-------------

File-Transfer 1 1 81 17881 0 0

Mail 3 1 1351 1057897 1318 155897

Messaging 2 2 633 245164 558 68508

Network-Monitoring 3 4 43 2580 1 60

Networking 3 1 51911 4422799 2524 1488418

Proxy 2 2 8637 7892737 6454 1008520

Social-Networking 2 3 52038 68131289 19772 2285979

Streaming-Media 2 3 15030 18700791 9156 1366044
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Web-Services 2 2 38872 26757562 32219 7094216

l SSID: This gives the application list seen on a particular SSID. The SSID number is the BSS index
configured.

ap(config)# show application-statistics by-application ssid 1

Applications Count = 79

Application Statistics for wlan index 1

=======================================================================
=========

Protocol or Productivity TX TX RX RX

Application Index & Risk Packets Bytes Packets Bytes

------------------------------------------------------------------------
-------------

Ad Analytics 4 1 221 113639 204 27874

Admeta 4 1 20 8577 17 3470

Aggregate Knowledge 4 1 72 25718 67 11423

Amazon 2 1 1245 773227 1307 413188

Amazon Web Services 1 2 2102 2543236 1522 111343

Amp 4 1 163 144673 157 16258

AOL Ads 3 1 21 11459 24 3769

Appier 4 1 39 13552 26 5046

AppNexus 1 1 172 72763 167 62363

Bing 3 1 17 8140 12 1175

Bluekai 1 1 35 13127 23 2856

Bonjour 4 1 0 0 1067 332560

Casale 3 1 97 36559 85 12244

CloudFlare 3 2 31 12537 20 2286

Captive Network Ass 2 1 18 1194 10 918

Connexity 3 1 22 13348 27 3954

Contextweb 4 1 81 41240 100 20963

Criteo 4 1 376 171618 396 60013

Crashlytics 1 1 74 29571 82 10660

Doubleclick 1 1 3549 2691946 2587 759544

DHCP 4 1 52 17212 0 0

Dotomi 4 1 59 21308 64 8324

Drawbridge 4 1 28 6164 23 4780

Facebook 2 1 6053 5188935 4732 1217723
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Facebook Messages 2 2 202 71996 150 18393

Facebook Video 2 3 44585 61497202 14049 941942

Flurry 3 1 17 5694 27 15624

Font Awesome 4 1 94 98415 88 5341

gmail 3 1 1351 1057897 1318 155897

Google Ads 3 1 1356 903620 1066 123597

Google Analytics 4 1 475 165753 407 91298

Google APIs 3 1 5437 2829186 4775 1605169

GoogleDuo 4 1 84 22238 82 23226

Google 3 1 5381 3955811 4385 799374

Google Play 3 1 980 242763 880 254459

Google Video 2 2 0 0 20 23771

hotstar 1 4 100 64443 82 21328

HTTP 3 1 1184 371037 1100 173347

HTTP 2.0 3 1 1410 360603 1271 232993

HTTP VIDEO 3 2 3801 5360601 1841 105901

HWCDN 3 1 213 259756 200 12745

ICICI Bank 2 2 29 33613 21 2025

ICMP 3 4 5 300 1 60

Instagram 1 1 322 330979 242 33346

Krux 1 1 71 31719 53 6993

Lotame 1 1 109 63865 84 10168

MDNS 3 1 0 0 86 21324

Media Innovation Gr 3 1 45 14819 40 5662

Media Math 1 1 25 5413 8 1034

Mixpanel 3 1 451 139375 496 275463

NrData 4 1 371 56753 341 108525

NTP 1 3 1 76 1 76

OpenX 1 1 113 20680 86 12298

Outbrain 3 1 34 16363 46 6344

OwnerIQ 3 1 38 8977 29 5783

Paytm 2 3 2015 2201287 1177 146483

Psiphon 2 2 8562 7869967 6392 983509

PubMatic 3 1 331 103338 262 57072

Quantcast 1 1 47 23413 47 9495

Quic 3 1 0 0 817 1052805

Rapleaf 3 1 66 28602 65 8000

Rubicon Project 1 1 17 9524 24 7846
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Scorecard Research 1 1 96 35762 90 12758

Smart AdServer 3 2 35 13345 45 6116

SpotXchange 3 2 59 14418 49 14522

SSDP 4 1 0 0 287 43911

SSL 3 3 6029 4347809 5173 1029629

Taboola 3 2 2177 2715316 1082 123164

TCP 3 1 169 37436 194 26160

The Trade Desk 3 1 101 67145 67 13168

Turn 1 1 71 31424 81 9438

Twitter 3 4 867 1040706 593 73816

UDP 3 1 0 0 62 10664

Ultrasurf 2 2 31 10286 19 1848

WhatsApp Media Mess 2 2 145 167080 135 10680

WhatsApp 2 2 404 55846 341 34602

Xiaomi 3 1 1244 718018 1376 285219

Yahoo 3 3 204 77608 251 48694

YouTube 1 4 11031 13254451 7129 1156065

l Display for Station: This gives detailed information about a particular station. Provide the station MAC
address the user wants to check for statistics.
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l Tx means downlink traffic concerning AP and Rx mean uplink traffic with respect to AP.

Below CLI command gives a list of stations present along with station count per VLAN.

ap(config)# show application-statistics debug

============Station Count 3========================================

MAC IP VLAN SSID

9A-FD-AA-B4-9C-8E 0.0.0.0 0

FC-D9-08-A4-D4-55 0.0.0.0 0

52-78-93-70-38-35 0.0.0.0 0

=====vlan count 1======

VLAN STA_COUNT
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1 3

l Display for VLAN: This gives information about the particular VLANs.

ap(config)# show application-statistics by-application vlan 1

Applications Count = 79

Application Statistics for VLAN 1

=======================================================================
=========

Protocol or Productivity TX TX RX RX

Application Index & Risk Packets Bytes Packets Bytes

------------------------------------------------------------------------
-------------

Ad Analytics 4 1 221 113639 204 27874

Admeta 4 1 20 8577 17 3470

Aggregate Knowledge 4 1 72 25718 67 11423

Amazon 2 1 1245 773227 1307 413188

Amazon Web Services 1 2 2102 2543236 1522 111343
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Amp 4 1 163 144673 157 16258

AOL Ads 3 1 21 11459 24 3769

Appier 4 1 39 13552 26 5046

AppNexus 1 1 172 72763 167 62363

Bing 3 1 17 8140 12 1175

Bluekai 1 1 35 13127 23 2856

Bonjour 4 1 0 0 1067 332560

Casale 3 1 97 36559 85 12244

CloudFlare 3 2 31 12537 20 2286

Captive Network Ass 2 1 18 1194 10 918

Connexity 3 1 22 13348 27 3954

Contextweb 4 1 81 41240 100 20963

Criteo 4 1 376 171618 396 60013

Crashlytics 1 1 74 29571 82 10660

Doubleclick 1 1 3549 2691946 2587 759544

DHCP 4 1 52 17212 0 0

Dotomi 4 1 59 21308 64 8324

Drawbridge 4 1 28 6164 23 4780

Facebook 2 1 6053 5188935 4732 1217723

Facebook Messages 2 2 202 71996 150 18393

Facebook Video 2 3 44585 61497202 14049 941942

Flurry 3 1 17 5694 27 15624

Font Awesome 4 1 94 98415 88 5341

gmail 3 1 1351 1057897 1318 155897

Google Ads 3 1 1356 903620 1066 123597

Google Analytics 4 1 475 165753 407 91298

Google APIs 3 1 5437 2829186 4775 1605169

GoogleDuo 4 1 84 22238 82 23226

Google 3 1 5381 3955811 4385 799374

Google Play 3 1 980 242763 880 254459

Google Video 2 2 0 0 20 23771

hotstar 1 4 100 64443 82 21328

HTTP 3 1 1184 371037 1100 173347

HTTP 2.0 3 1 1410 360603 1271 232993

HTTP VIDEO 3 2 3801 5360601 1841 105901

HWCDN 3 1 213 259756 200 12745

ICICI Bank 2 2 29 33613 21 2025

ICMP 3 4 5 300 1 60
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Instagram 1 1 322 330979 242 33346

Krux 1 1 71 31719 53 6993

Lotame 1 1 109 63865 84 10168

MDNS 3 1 0 0 86 21324

Media Innovation Gr 3 1 45 14819 40 5662

Media Math 1 1 25 5413 8 1034

Mixpanel 3 1 451 139375 496 275463

NrData 4 1 371 56753 341 108525

NTP 1 3 1 76 1 76

OpenX 1 1 113 20680 86 12298

Outbrain 3 1 34 16363 46 6344

OwnerIQ 3 1 38 8977 29 5783

Paytm 2 3 2015 2201287 1177 146483

Psiphon 2 2 8562 7869967 6392 983509

PubMatic 3 1 331 103338 262 57072

Quantcast 1 1 47 23413 47 9495

Quic 3 1 0 0 817 1052805

Rapleaf 3 1 66 28602 65 8000

Rubicon Project 1 1 17 9524 24 7846

Scorecard Research 1 1 96 35762 90 12758

Smart AdServer 3 2 35 13345 45 6116

SpotXchange 3 2 59 14418 49 14522

SSDP 4 1 0 0 287 43911

SSL 3 3 6029 4347809 5173 1029629

Taboola 3 2 2177 2715316 1082 123164

TCP 3 1 169 37436 194 26160

The Trade Desk 3 1 101 67145 67 13168

Turn 1 1 71 31424 81 9438

Twitter 3 4 867 1040706 593 73816

UDP 3 1 0 0 62 10664

Ultrasurf 2 2 31 10286 19 1848

WhatsApp Media Mess 2 2 145 167080 135 10680

WhatsApp 2 2 404 55846 341 34602

Xiaomi 3 1 1244 718018 1376 285219

Yahoo 3 3 204 77608 251 48694

YouTube 1 4 11031 13254451 7129 1156065

l Time frame: This gives information about the application seen in last the duration (for example, 1 day).



Managing Filters 156

l For low-risk numbers, the productivity is high and vice versa. (example, for GitHub (shown in the below
figure) the risk index number is 1 and the productive index is 4, this means the application is low risk and
more productive).

ap(config)# show application-statistics by-application time-frame 86000

Applications Count = 6

Application Statistics for All Applications

========================================================================
========

Protocol or Productivity TX TX RX RX

Application Index & Risk Packets Bytes Packets Bytes

------------------------------------------------------------------------
-------------

Bonjour 4 1 3599 704477 1067 332560

DHCP 4 1 76 25156 0 0

ICMP 3 4 43 2580 1 60

MDNS 3 1 4414 633504 86 21324

NetBIOS NS 1 3 4785 376002 0 0

UDP 3 1 38944 2648192 62 10664
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ap(config)#

DPI CLI configuration

Users can enable Application Control globally by using the below commands:

To enable DPI support:

ap(config)# filter global-filter

ap(config-global-filter)# application-control

ap(config-global-filter)#

To disable DPI support:

ap(config)# filter global-filter

ap(config-global-filter)# no application-control

ap(config-global-filter)#
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Global application policy

Per application policy

Set per category policy

ap(config-global-filter-precedence-1)# category-control
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collab : Collaboration

database : Database

filexfer : File-Transfer

games : Games

mail : Mail

message : Messaging

monitor : Network-Monitoring

network : Networking

other : Other

proxy : Proxy

remote : Remote-Access

social : Social-Networking

stream : Streaming-Media

vpn_tun : VPN-Tunneling

web_srvc : Web-Services

ap(config-global-filter-precedence-1)# category-control games permit

ap(config-global-filter-precedence-1)#

SSID application policy

ap(config)# filter filter-list 1

ap(config-filter-list-1)# filter precedence 1

ap(config-list-1-filter-precedence-1)# application-control facebook deny

ap(config-list-1-filter-precedence-1)#

ap(config-list-1-filter-precedence-1)# wireless wlan 1

ap(config-wlan-1)# filter-list 1

ap(config-wlan-1)#

CLI Configuration



Managing Filters 160

Custom Applications X
Custom applications allow you to configure applications with a specific IP address or a domain name, and
apply filter rules, such as enable or disable traffic from these applications. By default, these applications are
applied on the devices along with the AP group configuration.

After creating the custom application, when you click Apply, cnMaestro creates a job for devices in the
AP group that has auto sync enabled. Devices in AP groups that do not have auto sync enabled, are marked
as Not in Sync, and users must manually apply the configuration on to the devices.

To disable cnMaestro from applying the custom application configuration on the devices, clear the Enable
Custom Application check box from the AP Groups > Services tab > Application Visibility X section.

To add a new custom application, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > Custom Applications X.

2. Click Add New on the Custom Applications X page.

The Add Custom Application(s) window is displayed.
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Configure the following parameters:

Parameter Description

Name Specifies the name for the custom application.

Supports a maximum of 20 characters.

Scope Specifies the availability of the custom application across managed accounts.

The following values are supported:

l Base Infrastructure—Custom application is available only for the global
account. It is not shared with other managed accounts.

l Shared—Custom application is shared across all managed accounts. It can
be mapped to devices in the managed account, but it cannot be modified.
To modify the configuration, it must be copied into the managed account
and then updated.

l Managed Account—Custom application is available only for that specific
managed account.

Note

Once the scope has been configured on a custom application, it
cannot be modified.

Category Specifies the category to which the application must belong.

Select the appropriate category from the drop-down list.

FQDN/IP Address Specifies the IPv4 address or the domain name of the custom application.

Productivity Index Indicates how appropriate an application is useful for business purposes. The
higher the rating number, the more business-oriented an application is.

Table 49 Custom Application Parameters
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Parameter Description

Risk Index Indicates how likely an application is to pose a threat to the security of your
network. The higher the rating number, the riskier of an application is.

Enable Select the check box to enable this custom application.

Table 49 Custom Application Parameters

3. Click Add.

4. To apply this configuration on the AP, click Save and Apply.
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WIDS/WIPS
Premium feature

Note

WIDS and WIPS are beta features.

This section describes the following topics:

l Wireless Intrusion Detection Systems (WIDS)

o Wireless flood detection

o Neighbor AP detection

o Rogue APs

o Honeypot APs

o Ad Hoc network detection

o Wired Devices

o Configuring WIDS

l Wireless Intrusion Prevention System (WIPS)

Wireless Intrusion Detection Systems (WIDS)
Wireless Intrusion Detection Systems (WIDS) is a powerful feature within cnMaestro that helps administrators
monitor and protect their wireless networks from unauthorized access and potential security threats. WIDS
works by continuously scanning the wireless spectrum to detect and mitigate potential intrusions, ensuring
the integrity and security of your network infrastructure.

Wireless flood detection
Wireless flood detection helps in identifying and mitigating flood attacks in wireless networks. A flood attack
occurs when a rogue client sends a large number of packets of a specific type to the AP to disrupt the
normal working of the AP. This feature can detect the following types of flood attacks:

l Association

l Authentication

l Disassociation

l Deauthentication

l Extensible Authentication Protocol over LAN (EAPoL)

CLI configuration:
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ap(config)# wids

association-flood : Detect floods of client associations from clients

authentication-flood : Detect floods of client authentication from
clients

deauthentication-flood : Detect floods of clients deauthentications from
clients

disassociation-flood : Detect floods of client disassociations from
clients

eap-flood : Detect floods of EAP messages from clients

num-of-minutes : Configure time duration for flood detection

num-of-packets : Configure threshold of flood packets

Neighbor AP detection
The AP can detect all neighbor APs. By default, all neighbors in the home channel are detected. To detect
neighbors in all channels, go to Radio > Basic >Off Channel Scan and select the Enable check box.

Note

Off Channel Scan is not required for XV3-8 platforms because they have inbuilt radio for
monitoring.

Rogue APs
Rogue APs are unauthorized APs that are not onboarded to cnMaestro, which may include Cambium or non-
Cambium devices causing interference. The authorized or onboarded APs scan all available channels and
collect details about neighboring APs. They send this information to cnMaestro for monitoring and
management.

CLI configuration:

To enable rogue AP detection:

ap(config)# wids

rogue-ap-detection : Enable unsanctioned AP detection

Honeypot APs
Honeypot APs are unauthorized APs that advertise the same SSID as managed or onboarded APs.
Detecting and monitoring these APs is crucial to prevent threats to the network infrastructure.

Ad Hoc network detection
A wireless Ad Hoc network is a type of Local Area Network (LAN) that is built spontaneously to enable two or
more wireless devices to be connected to each other without requiring typical network infrastructure
equipment, such as a wireless router or AP.

CLI configuration:

To enable ad hoc network detection:
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ap(config)# wids

ad-hoc-detection : Detect ad-hoc networks

To display ad hoc networks:

ap(config)# show wids adhoc-networks

Wired Devices
The Wired Devices section within cnMaestro provides administrators with insights into the wired devices
connected to the network infrastructure. This feature allows administrators to monitor and manage wired
devices effectively to ensure optimal network performance and security.

CLI configuration:

To enable wired devices discovery:

ap(config)# wids

wired-neighbour-discovery : Enable wired neighbour discovery

Configuring WIDS
To enable WIDS feature perform the following steps on the cnMaestro UI:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups tab.

2. Select the AP Group and navigate to the Security page.

3. Select the Enable Wireless Intrusion Detection System (WIDS) checkbox.
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Figure 63 Configuring WIDS

4. In theWireless Flood Detection section, configure the number of packets and duration from the
Packets and Per Minutes drop-down lists.

This indicates the number of flood attack packets that cnMaestro must detect in the specified duration
to identify and report the type of attack.

5. Select the type of flood attack detection types that you want to configure in theWireless Flood
Detection section.

Field Description

Association Detect floods of client associations from clients.

Authentication Detect floods of client authentication from clients.

Deauthentication Detect floods of client deauthentications from clients.

Disassociation Detect floods of client disassociations from clients.

EAP Detect floods of EAP messages from clients.

Table 50Wireless Flood Detection parameters

Wireless Intrusion Prevention System (WIPS)
WIPS is a critical feature within cnMaestro designed to enhance the security of wireless networks. When
enabled, WIPS triggers Wi-Fi devices to deauthenticate rogue APs and clients by sending spoofed



WIDS/WIPSPremium feature 167

deauthentication messages to the rogue APs and clients. You can also trigger Wi-Fi devices to
deauthenticate honeypot APs and clients by enabling this feature.

CLI configuration:

To configure AP to detect honeypot and rogue APs, and send deauth requests to respective connected
clients:

ap(config)# wips

deauth-honeypot-clients : Detect honeypot APs and send deauth to
respective clients

deauth-rogue-ap-clients : Detect rogue APs and send deauth to respective
clients
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Configuring Services
This chapter describes the following topics:

l Overview

l Configuring services

Overview
This chapter gives an overview of Enterprise Wi-Fi AP configurable parameters related to User Groups,
Location API, Speed Test, BT Location API, Bonjour Gateway, LACP, and RTLS.

Configuring services
This section provides information on how to configure the following services on Enterprise Wi-Fi AP.

To configure the services for the AP, complete the following steps:

1. Navigate to Configuration > Wi-Fi Profiles > AP Groups page.

2. Click Add New and select Enterprise Wi-Fi (E-Series, XE/XV/X7-Series) from the Type drop-down list.

3. Click Services tab and configure the following services:

l Lightweight Directory Access Protocol (LDAP)

l NAT Logging

l User Groups

l Wi-Fi API

l Bluetooth API

l Speed Test

l DHCP Option 82

l Bonjour Gateway

l Link Aggregation Control Protocol (LACP)

l Real-Time Location System (RTLS)

Lightweight Directory Access Protocol (LDAP)
The following table lists the fields that are displayed in the AP Groups > Services > Network > LDAP page.

#Real
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Table 51 LDAP parameters

Parameters Description Range Default

Server Host IP address or hostname of the LDAP server. ─ ─

Server Port Port number of the LDAP server. ─ ─

To configure the above parameter, navigate to the Configure > Services > LDAP tab and provide the details
as given below:

1. Enter the IP address of the LDAP server in the Server Host text box.

2. Enter the Port address of the LDAP server in the Server Port text box.

3. Click Save.

Figure 64 LDAP parameters

NAT Logging
NAT logging is same as the internet access log that is generated when NAT is enabled on AP. Each internet
access log PDU consists of one or more internet access log data in TLV format. The packet format for the
internet access log PDU is defined as below:

Table 52 PDU type code: 0x82

Type Mandatory Length Default Value

0x01 N 32 Bytes Includes IPv4 internet access log data structure.

Type 0x01 TLV includes the internet access log data structure as below:
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Table 53 NAT Logging packet structure

Length Description

4 Bytes NAT records UNIX time stamp which generates time in seconds from 1970-01-01 (00:00:00
GMT until now).

6 Bytes The MAC address of the client.

1 Bytes Reserved for future use.

1 Bytes The protocol type. The supported protocol types are:

l 0x06 TCP

l 0x11 UDP

2 Bytes The VLAN ID where the client is connected. If there is no VLAN ID, the value will be 0.

4 Bytes The client internal or the private IP address.

2 Bytes The internal port of the client.

4 Bytes The Internet IP address which is translated by NAT.

2 Bytes The Internet port which is translated by NAT.

4 Bytes The IP address of the visited server.

2 Bytes The port address of the visited server.

Below table lists the fields that are displayed in AP Groups > Services > Network > NAT Logging page.

Table 54 NAT Logging parameters

Parameters Description Range Default

Enable Provision to enable/disable NAT logging services. ─ ─

Server IP Provision to configure IP/Hostname of NAT logging server. ─ ─

Server Port Provision to configure custom port number for NAT Logging
services.

─ ─

Interval Provision to configure frequency of logging. 5-3600 5

Figure 65 NAT Logging parameters
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User Groups Premium feature

Some policies, like VLAN, require many RADIUS attributes to be sent by the RADIUS server and processed
by the AP. Some wireless network administrators do not have administrative access to the RADIUS server,
so making changes to wireless policies would require waiting for the RADIUS administrator to make
changes.

To simplify wireless administration and streamline changes, a feature called User Groups is provided that
allows the wireless administrator to apply a set of wireless policies to a user based on a single RADIUS
attribute. This eliminates the need for administrative rights on the RADIUS server and simplifies applying
complex policies to end-user stations.

A user group can also be assigned to a station based on the device type. This approach is dependent on the
accuracy and completeness of device identification functionality, which is not guaranteed to be accurate or
exhaustive.

The User Group feature is natively supported by XMS Cloud.

Figure 66 User Groups interaction

CLI Configuration:

ap(config)# group

Specify user group number <1-16>

ap(config)# group 1

ap(config-group-1)#

clear : Clear command

filter-list : Filter list selecion for this user group

radius-id : Radius Filter-ID (Attribute Type 11) mapped to this user group

shutdown : Disable the user group

vlan : Set the vlan id for client traffic on this user group

apply : Apply configuration that has just been set
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exit : Exit from user group configuration

no : Disable user group parameters

save : Save configuration to Flash so it persists across reboots

show : Show command

ap(config-group-1)#

Example:

User group properties and actions

A user group supports the following properties and actions:

Command Description

shutdown Disable this User Group

radius-id Radius Filter-ID (Attribute Type 11) mapped to this User Group

no shutdown Enable this User Group

no group <index> Delete User Group

User group policies

The policies available in a user group configuration are a subset of those for an SSID. The most commonly
used policies are filter-list and VLAN.

Policy Description

filter-list <index> Filter List setting for this User Group

vlan VLAN associated with this User Group

Real-Time Location System (RTLS)
RTLS is a method to send the discovered (probed) clients list to a specified server address. The reports are
sent as HTTP Post to the HTTP server every interval. The discovered client entries are deleted from the list if
the entry is aged out. The client aging timeout is 2 times of location API interval configured. If there are no
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new probe requests from the client within 2 x location API interval time, then the client entry will be removed
from the list.

The following RTLS systems are available:

l Wi-Fi API

l Bluetooth API

l Stanley AeroScout Premium feature

Wi-Fi API

Below table lists the fields that are displayed in the AP Groups > Services Network > RTLS (Real-Time
Location System) > Wi-Fi API page.

Table 55Wi-Fi API parameters

Parameters Description Range Default

Enable Provision to enable or disable Wi-Fi API services. - -

Server URL Provision to configure HTTP or HTTPS server to send a report
with the port number.

- -

Interval Provision to configure the custom frequency of information to
be shared on server.

2-3600 5

Ignore Anonymized
MACs

Avoid populating locally administrated MAC addresses in the
Wi-Fi API client list.

- -

Figure 67Wi-Fi API parameters

Note

For further details about this feature and sample reference output, go to
https://support.cambiumnetworks.com/files/cnpilot-tech-ref/ and downloadWireless client
Presence and Locationing API document.

Bluetooth API

XV3-8/XV2-2T APs with an integrated Bluetooth Low Energy (BLE) radio can detect and locate nearby BLE
devices. This data is then provided via API to third-party applications. Examples of such devices include
smartwatches, battery-based beacons, Apple iBeacons, fitness monitors, and remote sensors.

https://support.cambiumnetworks.com/files/cnpilot-tech-ref/


Configuring Services 174

Organizations can create use cases for indoor wayfinding and mapping, asset tracking, and more.

Below table lists the fields that are displayed in the AP Groups > Services Network > RTLS (Real-Time
Location System) > Bluetooth API page..

Figure 68 Bluetooth API

Table 56 Bluetooth API parameters

Parameters Description Range Default

Enable Enable or disable Bluetooth API services. - -

Server URL and
Port

Configure HTTP or HTTPS server and the port number, to send
a report.

- -

Interval Configure the custom frequency of information to be shared on
server.

2-3600 5

Sending report

After enabling BLE Scanning on AP it will start processing:

1. Convert the scanned data to a JSON array.

2. Send that data in one single HTTP/HTTPS POST.

To configure the BT Location-API in the CLI:

ap(config)# location-api

ignore-anonymized-mac : Ignore MAC addresses that are anonymized

interval : Configure reporting interval in secs

server : HTTP/HTTPS server to send report to with the port number

To disable the BT Location-API:

ap(config)# no location-bt-api
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Bluetooth API data elements

Table 57 Bluetooth API data elements

Parameters Description

apMac MAC address of the observing AP.

API Version API Version applied for particular data format.

AP Name Host name of the observing AP.

Timestamp Observation time in seconds seen by AP.

BT MAC BLE device MAC seen by AP.

UUID BLE device UUID seen by AP.

RSSI BLE device RSSI as seen by AP.

HTTP POST body format:

{

u’ap_mac’: ‘00-04-56-A5-5A-EC’,

‘version’: ‘2.2’,

‘ap_name’: ‘XV3-8-EC7708’,

‘ble_discoverd_clients’:{Array of 0-250 devices}

}

Bluetooth API Data Format

{

bt_rssi’: u’ -80 dBm ‘,

bt_mac’: 14-8F-21-FD-37-18’, u

‘bt_uuids’: Garmin International, Inc. (0xfe1f)\n’,

‘bt_timestamp’: u’ 1.811127’

}

Stanley AeroScout Premium feature

The Location Engine delivers accurate and reliable location data for assets and customers with STANLEY
Healthcare Wi-Fi tags. It is an integral component of STANLEY Healthcare's AeroScout RTLS solutions. The
AeroScout Location Engine determines location using signal strength measurements (RSSI) collected by the
CambiumWi-Fi Access Points, that can simultaneously serve location sensors and provide network access.
AeroScout utilizes a location engine to determine the position of Wi-Fi tags.

CLI Configuration:

ap(config)# rtls aeroscout

ble-tag : Enable Aeroscout BLE Tag

server : Configure Aeroscout Server IP or FQDN
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server-port : Configure Aeroscout Server Port (Default port:12092)

wifi-tag : Enable Aeroscout WiFi Tag

Below table lists the fields that are displayed in the AP Groups > Services Network > RTLS (Real-Time
Location System) > Stanley AeroScout page..

Figure 69 Stanley AeroScout

Table 58 Stanley AeroScout parameters

Parameters Description Range Default

l Enable Wi-Fi

l Enable
Bluetooth

Enable or disable Wi-Fi or Bluetooth Stanley AeroScout
services.

- -

Server URL and
Port

Configure HTTP or HTTPS server and the port number, to
send a report.

- Port: 12092

Speed Test
Wi-Fiperf is a speed test service available on Enterprise Wi-Fi AP devices. This tool is interoperable with
open source zapwireless tool (https://code.google.com/archive/p/zapwireless/).

The Wi-Fiperf speed test can be triggered by using zapwireless tool between two Enterprise Wi-Fi APs or
between Enterprise Wi-Fi APs and other third-party devices (or PC) that is having zapwireless endpoint
running.

Refer to https://code.google.com/archive/p/zapwireless/ to download the zap wireless tool to generate
zapwireless endpoint for third party device (or PC) and zap CLI to perform the test.

In this case, Wi-Fiperf endpoint should be enabled in Enterprise Wi-Fi AP through UI shown below.

To configure the above parameter, navigate to the AP Groups > Services > Network > Speed Test page.

Select theWi-Fiperf checkbox to enable the speed test.

https://code.google.com/archive/p/zapwireless/
https://code.google.com/archive/p/zapwireless/
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Figure 70 Speed Test parameters

DHCP Option-82
DHCP Option 82 parameter enabled at the device level with VLAN IDs inserts the Option 82 parameters in
all the DHCP client packets leaving the configured VLAN interfaces. This device-level configuration
precedes the DHCP Option 82 configuration at the WLAN profile or the L3 interface levels.

In case DHCP Option 82 is configured at the device-, WLAN profile-, and L3 interface-levels, the following
priority order is considered:

1. Device-level configuration

2. WLAN profile-level configuration

3. L3 interface-level configuration

The device-level configuration is recommended when it is desired to insert the DHCP Option 82 for the
following options:

l Guest access enabled wired traffic

l Guest and without guest access enabled wireless DHCP client traffic

To configure the above parameter, navigate to the AP Groups > Services > Network page and provide the
details in the DHCP Option 82 section:

1. Select the Enable checkbox.

2. Select the circuit ID from theOption 82 Circuit ID drop-down list.

Following are the supported values:

l None

l All

l Hostname

l APMAC

l SSID

l VLANID
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l SITEID

l Custom

3. Select the remote ID from theOption 82 Remote ID drop-down list.

Following are the supported values:

l None

l Hostname

l APMAC

l SSID

l VLANID

l SITEID

l Custom

4. Enter the VLAN ID in the VLAN ID text box.

5. Click Save.

Figure 71 DHCP Option 82 parameter

Bonjour Gateway
Bonjour enables the automatic discovery of devices such as printers, file servers, and other clients and
services on a local network. Bonjour Gateway feature on Wi-Fi AP extends the scope of Bonjour service
beyond the local network by forwarding Bonjour Multicast DNS (mDNS) packet across different VLANS, to
make Bonjour services and devices available between the different wireless and local networks.

Below table lists the fields that are displayed in the AP Groups > Services > Bonjour page.
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Figure 72 Bonjour page

Figure 73 Add Bonjour Gateway

Table 59 Bonjour Gateway parameters

Parameters Description Range Default

Enable Bonjour
Gateway

Provision to enable or disable Bonjour Gateway
services.

- -

Service Name Provision for user-defined Bonjour rule name. - -

Proto Select the required mDNS protocol. - -

From VLAN VLAN in which mDNS/Bonjour service is running. - -

To VLAN VLAN in which clients are listening. - -

CLI Configuration:

1. Enable Bonjour Gateway on AP.

ap(config)# bonjour-gw

2. To configure Bonjour rule.

ap(config)# bonjour-fw rules
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bonjour-fw rules <sname> <proto> <vidfrom> <vidto>

3. To control mDNS repeated packet to WAN side.

ap(config)# bonjour-fw bonjour-forward-to-wan

all : Forward all bonjour mdns packets queries and response repeated
with vlan to WAN side

queries : Forward bonjour mdns Query packets repeated with vlan to
WAN side

responses : Forward bonjour mdns Response packets repeated with vlan
to WAN side

Note

1. By default, mDNS repeated will not send to the WAN side.

2. WAN side indicates Eth 1 interface, Mesh client interface in case of mesh client mode,
tunnel interfaces like L2GRE, and L2TP.

Link Aggregation Control Protocol (LACP)
LACP provides the ability to group multiple physical ports as a logical port. This logical port is referred to as
port-channel and supported only on XV3-8 devices. LACP is a dynamic protocol used to form and maintain
the Link aggregation between two LACP supported devices.

LACP provides the following benefits:

l Increased Bandwidth: traffic may be balanced across the member ports to provide increased aggregate
throughput.

l Link redundancy: the LACP bundle can survive the loss of one or more member links.

Configuration:

To add Ethernet to port channels:

ap(config)# interface portchannel 1

ap(config-portchannel-1)# exit

ap(config)# interface eth 1

ap(config-eth-1)# channel-group 1

ap(config-eth-1)# exit

ap(config)# interface eth 2

ap(config-eth-2)# channel-group 1

ap(config-eth-2)#
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Port-channel configuration:

ap(config)# interface portchannel 1

ap(config-portchannel-1)#

advertise : Ethernet link speed advertisement

channel-group : Ethernet member channel group

clear : Clear command

duplex : Ethernet link duplex

shutdown : Shutdown interface

speed : Ethernet link speed

switchport : Configure switch port

tunnel-mode : Enable tunnelling of wired traffic over configured tunnel

apply : Apply configuration that has just been set

exit : Exit from interface configuration

no : Disable parameters

save : Save configuration to Flash so it persists across reboots

show : Show command

Syntax:

ap(config)# interface portchannel 1

ap(config-portchannel-1)# switchport mode trunk

ap(config-portchannel-1)# switchport trunk allowed vlan 1

ap(config-portchannel-1)# switchport trunk native vlan 1

ap(config-portchannel-1)#
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Operations
This chapter describes the following topics:

l Overview
l Firmware upgrade
l System
l Configuration

Overview
This chapter gives an overview of Enterprise Wi-Fi AP administrative functionalities, such as firmware
update, System, and Configuration.

Firmware upgrade
The running software on the Cambium Enterprise Wi-Fi AP can be upgraded to newer firmware. When
upgrading from the UI, the user can upload the firmware file from the browser. The same process can be
followed to downgrade the AP to a previous firmware version if required. Configuration is maintained across
the firmware upgrade process.

Note

Once a firmware upgrade has been initiated, you must not restart the AP or power
cycle until the process completes, as this might leave the AP inoperable.

To initiate a firmware update on the AP, complete the following steps:

1. Navigate toMonitor and Manage > System > Software Update.

2. Select Enterprise Wi-Fi (XE/XV/X7-Series) from the Device Type drop-down list.

3. Select the appropriate firmware version from the Versions drop-down list.

4. From the list of devices, select the devices for which you want to update the firmware.

5. Select the time when you want to perform the update from the Update section.

6. Select the appropriate options from the Job Options section.

7. If you select multiple devices, specify how many devices must be updated simultaneously in the text
box.

A maximum of 500 devices can be updated simultaneously.

8. Click Add Software Job to <no. of devices selected> devices.

#_Ref5608503
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Figure 74 Software update

System
This section provides multiple troubleshooting tools provided by Enterprise Wi-Fi AP.

Table 60 lists the fields that are displayed in theOperations > System tab:

Table 60 System parameters

Parameters Description Range Default

Reboot Users will be prompted with a Reboot pop-up requesting a reboot. If
yes, the device will go for a reboot.

─ ─

Download
Tech Support

Users will be prompted with permission to download tech support
from AP. If yes, the file will be saved in your default download path
configured on your system.

─ ─
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Parameters Description Range Default

Disconnect
All Clients

All clients connected to both the radios will be terminated by
sending a de-authentication packet to each client connected to the
radios.

─ ─

Flash LEDs LEDs on the device will toggle for the configured time period (in
seconds).

1-120 10

Factory
Default

A pop-up window appears requesting confirmation for factory
defaults. If yes, the device will delete all configurations to factory
reset and reboot.

─ ─

To configure the above parameter, navigate to theOperations > System tab and provide the details as
given below:

1. Click Reboot for rebooting the device.

2. Click Download Tech Support to generate tech support from the device and save it locally.

3. Click Disconnect All Clients to disconnect all wireless clients.

4. Select Flash LEDs value from the drop-down list to flash LEDs for the given duration of time.

5. Click Factory Default to delete all configurations on the device.

Figure 75 System parameters

LED Test flashing pattern
The LED test flashing pattern for the Enterprise Wi-Fi AP is as follows:

Flashing pattern (For , XV3-8, XV2-2, XV2-2T0, XV2-2T1, XE5-8, and XE3-4): Yellow -> Green -> Amber ->
Blue

Flashing pattern (For XV2-21X, XV2-23T, and XV2-22H): Green -> Amber -> Blue

CLI commands:

ap(config)# service flash-leds
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Number of seconds to flash <1-120> (optional: default 10sec)

ap(config)# service test leds
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Troubleshoot
Overview
This chapter provides detailed information about troubleshooting methods supported by Enterprise Wi-Fi
APs. Troubleshooting methods supported by Enterprise Wi-Fi AP devices are categorized as below:

l Logging

o Debug Logs

o Events

l Radio Frequency (RF)

o Wi-Fi Analyzer

l Packet capture

l Performance

o Connectivity

o Speedtest on Access Point

l XIRCON tool support

o XIRCON tool support for Linux 1.0.0.40

Logging
Enterprise Wi-Fi AP devices support multi-level logging, which will ease debug issues.

Events
Enterprise Wi-Fi AP devices generate events that are necessary for troubleshooting across various modules.
Below is the list of modules, Enterprise Wi-Fi AP device generates events for troubleshooting.

l Wireless station

o Connectivity

l Configuration updates

l RADIUS

o Authentication

o Accounting
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o CoA

l Roaming

o Enhanced roaming

l Auto-RF

o Channel change

l Reboot

l Guest Access

Events are available at Troubleshoot > Logs > Events.

Figure 76 Events parameters

Debug Logs
Enterprise Wi-Fi AP provisions enhanced debugging of each module as events generated by system and
scope of debugging is limited. Debug logs can be triggered when the user clicks Start Logs and can be
terminated when clicked on Stop Logs. By default, debug logs auto terminate after 1 minute when clicked on
Start Logs.   

Debug logs are available at Troubleshoot > Logs > Debug Logs tab.
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Figure 77 Debug Logs parameters

Radio Frequency (RF)
Wi-Fi Analyzer
This tool provisions customers to scan the channels supported as per regulatory domain and provides
information related to AP’s presence in each channel. Wi-Fi analyzer graphs are available in two modes:

l Interference

This tool shares more information about each channel as below:

l Noise

l Interference measured in RSSI

l List of top 64 neighbor APs

l Number of APs

This tool shares more information about each channel as below:

l Noise

l Number of neighbor APs

l List of top 64 neighbor APs

Channel analyzer is available at Troubleshoot > Wi-Fi Analyzer > Interference Mode.
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Figure 78 Interference Mode

Channel analyzer is available at Troubleshoot > Wi-Fi Analyzer > Number of APs Mode:

Figure 79 Troubleshoot > Wi-Fi Analyzer > Number of APs Mode

Packet capture
Allows the administrator to capture packets from the APs UI, cnMaestro UI, or XMS-Cloud. The administrator
can filter the packets being captured by specifying a particular MAC address, IP address, and port number.
The user can trigger packet capture on one or more interfaces, simultaneously view the progress of the
capture. The user can also download the captured pcap file on completion.

Enterprise Wi-Fi AP device allows packet capture on the following interfaces:
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l Ethernet

l Radio

l Wireless LAN

l VLAN

l SSID

l Tunnel

l Bridge

Multiple options of filtering are provided and are available at Troubleshoot > Packet Capture page.

Figure 80 Packet Capture page

Performance
Speedtest on Access Point
Speedtest can be used to measure speed across the WAN to Cambium hosted servers. The CLI output
displays uplink and downlink speed in Mbps. You can also host your server in your data center and measure
bandwidth to it using the ETSI option and specifying the URL. The server software can be obtained from the
LibreSpeed project https://github.com/librespeed/speedtest.

Configuration:

Syntax:

ap(config)# speedtest etsi

<server url> <download MB> <upload MB> [simultaneous connections] [mbps]

Example:

https://github.com/librespeed/speedtest
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Network Connectivity
This tool helps to check the accessibility of remote hosts from Enterprise Wi-Fi AP devices. The following
tools are supported:

l Ping

l DNS Lookup

l Traceroute

Table 61 Troubleshoot: Connectivity

Parameters Description Range Default

Ping

IP Address or
Hostname 

Provide IPv4 address or Hostname to validate the reachability
of the destined Host.

- -

Number of
Packets 

Provide a number of request packets that are required to be
transmitted to validate the reachability of the destined Host.

1-10 3

Buffer Size Configure ICMP packet size. 1-65507 56

Ping Result Displays the ICMP results. - -

DNS Lookup

Host Name Provide Hostname whose IP must be resolved. - -

DNS Test Result Displays the IPs that are associated with configured Hostname. - -

Traceroute

IP Address or
Hostname 

Provide IPv4 address or Hostname to validate the reachability
of the destined Host.

- -

Fragmentation Provision to allow or deny fragment packets. - Off

Trace Method  Provision to configure payload mechanism to check the
reachability of destined IPv4/Hostname.

- ICMP
Echo

Display TTL Provision to customize TTL display. - On

Verbose  Provision to display the output of traceroute. - On

Traceroute
Result

Displays the output of the traceroute command. - -

To configure the above parameter, navigate to the Troubleshoot > Connectivity tab and provide the details
as given below:

To configure Ping:
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1. Select Test type from the drop-down list.

2. Enter IP address or Hostname in the text box.

3. Enter the Number of Packets in the text box.

4. Select Buffer Size value from the drop-down list.

5. Click Start Ping.

To configure DNS Lookup:

1. Enter the Hostname in the text box.

2. Click DNS Test.

To configure Traceroute:

1. Enter IP address or Hostname in the text box.

2. Click Fragmentation to ON/Off.

3. Select Trace Method to either ICMP Echo/UDP.

4. Click Display TTL to ON/Off.

5. Click Verbose to ON/Off.

6. Click Start Traceroute.

Figure 81 Ping parameters

Figure 82 DNS Lookup parameters

Figure 83 Traceroute parameters

XIRCON tool support
The Xirrus console (Xircon) is a necessary tool for daily management, troubleshooting, and testing. Xirrus
customers and field engineers used them for initial configuration, troubleshooting individual AP problems,
changing IP addresses, and recovering units that would not boot. Since Cambium Networks acquired Xirrus
and we expect the XV series APs to be deployed along with legacy Xirrus APs, limited Xircon support is
added to the XV series APs.

The name "Xircon" refers to the feature in general, including the AP functionality, the communication
protocol, and the client software used for discovering and controlling Xirrus APs.

l Xircon detects APs by listening for Xircon beacon packets. These packets are sent via UDP to a defined
port and multicast address. These are the existing Multicast beacons sent by AOS.

l Control is established over unicast UDP on a different port from discovery. Only one client device can
control an AP at any given time.
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l Individual packets are RC4 encrypted. The payload includes a hash to ensure that any tampering or
packet corruption is detected, and the packet discarded.

l Starting with Release 6.2, Enterprise Wi-Fi APs can be detected by Xirrus AOS APs and the Xircon
client. It is not possible to establish a Xircon console connection to XV series APs – for that identify the
IP address from Xircon and use standard SSH to connect.

XIRCON tool support for Linux 1.0.0.40
XIRCON tool support for Linux 1.0.0.40 has been added which is used to discover APs in the network If the
IP address is not known.
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Management Access
This chapter describes different methods of authenticating users to access device UI. Following are the
authentication methods supported by Enterprise Wi-Fi AP devices:

l Local authentication
l SSH Key authentication
l RADIUS authentication

Local authentication
This is the default authentication mode enabled on the device. Only one username is supported which is
admin. The default password for the admin username is admin. The user has a provision to configure or
update password. 

Device configuration
The below figure shows how to configure or update the default password of the admin user.

1. Navigate to AP Groups > Management section.

2. Enter the administrator password in the Admin Password field.

3. Click Save.

Figure 84 Configure/update default password of the admin user

SSH Key authentication
SSH keys are also used to connect remote machines securely. They are based on the SSH cryptographic
network protocol, which is responsible for the encryption of the information stream between two machines.
Ultimately, using SSH keys users can connect to remote devices without even entering a password and
much more securely too. SSH works based on “public-key cryptography”. For simplicity, let us consider that
SSH keys come in pairs. There is a private key, that is safely stored to the home machine of the user and
a public key, which is stored to any remote machine (AP) the user wants to connect. So, whenever a user
initiates an SSH connection with a remote machine, SSH first checks if the user has a private key that
matches any of the public keys in the remote machine and if not, it prompts the user for a password.

Device configuration
SSH Key-based access method can be configured on the device from cnMaestro. Navigate to AP Groups >
Management section and complete the following steps.
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1. Select the SSH checkbox.

2. Provide the public key generated from the steps described in the SSH Key generation section.

Figure 85 Management parameters

SSH Key generation

Windows

You may use a tool, such as PUTTY to generate both public and private keys. Below is a sample
demonstration of configuring Enterprise Wi-Fi AP device and logging using SSH key via UI.

1. Generate a key pair in PUTTY Key Generator as shown in .

Figure 86 Generating public/private Key

2. Save the Public key and Private key once the key pair is generated as shown in .



Management Access 196

Figure 87 Public and Private Key

3. Save the Public key generated in the step above as described in Device configuration section.

4. Login to device using private key generated above with username as admin.

Linux

If using a Linux PC and SSH from the Linux host, then you can generate the keys with the following steps:
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1. Generate key pair executing below command on Linux console as shown in Figure 88.

Figure 88 Public Key location path

2. The public key is now located in PATH as mentioned in Figure 88.

PATH = “Enter the file to which to save the key”

3. The private key (identification) is now saved in PATH as mentioned in Figure 89.

PATH = “Your identification has saved in <>”

Figure 89 Private Key saved path

4. Save the public key generated in step above as described in the Device configuration section.

5. Login to device using private key generated above with username as admin.

RADIUS authentication
Device management access using RADIUS authentication allows multiple users to access using unique
credentials and is secured.
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Device configuration
Management access using the RADIUS authentication method can be configured on the device from
cnMaestro. Navigate to AP Groups > Management and configure the following:

1. Select the RADIUS Mgmt Authentication check box.

2. Configure RADIUS IPv4/Hostname and shared secret in the RADIUS Server and RADIUS Secret
parameters respectively.

3. Click Save.

Figure 90 RADIUS Server and RADIUS Secret parameters



Mesh 199

Mesh
From Release 6.4 onwards, Enterprise Wi-Fi Access Points support mesh connections between radios. The
suggested maximum hops are two. Mesh links can form between radios of the same band of operation (2.4
GHz, 5 GHz, and 6 GHz), but the two peers of the mesh link do not have to be of the same AP type. For
example, a link between Wi-Fi 6 XV2-2 and XV3-8 is supported. Given the larger set of available channels
and typically cleaner RF environment, Cambium Networks recommends using the 6 GHz radio for mesh
backhaul if the AP is 6 GHz-capable, else use the 5 GHz band.

A mesh link can be created between two radios by configuring one of them as a Base and the other as a
Client on the first WLAN of the AP. Typically, the wired connectivity AP would be configured as a Mesh Base
(MB). The radio setup for the MB selects a channel and starts transmitting beacons as soon as the AP comes
up. The Mesh Client (MC) radio setup scans all available channels, looking for an MB radio to connect with.
The SSID in the mesh WLAN is how the client and base radios of a mesh link identify each other, the same
SSID should be configured on the MBWLAN as well as the MCWLAN.

In addition to a simple topology between a base and a client, a star or hub-and-spoke mesh topology is also
supported; practically a mesh radio can service up to 10-12 Mesh Clients connected to it. When a radio is
configured with a mesh WLAN, on that WLAN other clients are allowed to connect, and the radio can service
clients on other WLANs mapped to it. Note that a client radio starts rescanning all available channels as soon
as it loses connectivity to the base. Other WLANs mapped to it are not operational during this scan period.

The mesh link can also be secured with WPA2/WPA3-Preshared-Keys (PSK). The same passphrase should
be configured on both the MB as well as the MC. Standard 802.11 security handshakes and AES-CCM
encryption are then used on the mesh link.

For WPA2-PSK, the maximum number of allowed characters is 64 whereas for WPA3-PSK, it is 63.

Deployment scenarios
Enterprise Wi-Fi APs support single and multi-hop mesh connections, although single hop mesh is highly
advisable.

Enterprise Wi-Fi APs support the following deployment scenarios:

l Between Wi-Fi 6 APs

l Mixed deployment (between Wi-Fi 6 APs and Wi-Fi 5 APs)

l With third-party APs - TP-Link, MikroTik, and LigoWave

The following figures illustrate the working scenario of a wireless mesh network.
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Figure 91 Single hop mesh connection in 5 GHz with two Mesh Clients

Figure 92 Single hop mesh connection in 5 GHz with two Mesh Client s and 2.4 GHz and 5 GHz as access
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Figure 93 Single hop mesh Connection in 6 GHz with two Mesh Clients

For a stable mesh link to be established, Enterprise Wi-Fi mesh is configurable in the following three modes:

l Mesh Base (MB)

Enterprise Wi-Fi device that operates in MB mode is the key to Mesh topology. MB is usually connected
to the wired network. The radio setup for MB selects a channel and starts transmitting beacons as soon
as the AP comes up.

l Mesh Client (MC)

Enterprise Wi-Fi device that operates in MC mode, scans all available channels supported as per
regulatory domain and establishes a link with MB.

l Mesh Recovery (MR)

When enabled, this mode helps maintain the mesh link if there is a disruption in the backhaul link
established with MB and MC. Mesh link disruption can cause due to PSK mismatch or due to
asynchronous configurations on MB and MC. This mode needs to be exclusively enabled on MB
devices.

This mode can also help in the Zero Touch Configuration of the Enterprise Wi-Fi device.

Mesh configurable parameters
The below table lists the configurable parameters that are exclusive to mesh:
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Table 62 Mesh configurable parameters

Parameter Description Range Default

Mesh This parameter is required when a mesh connection is established
with Enterprise Wi-Fi devices. Four options are available under this
parameter:

1. Base: A WLAN profile configured with a Mesh Base operates
like a normal AP. Its radio beacon is on startup so its SSID can
be seen by radios configured as Mesh Clients.

2. Client: A WLAN profile configured with a Mesh Client scans all
available channels on startup, looking for a mesh-based AP to
connect.

3. Recovery: A WLAN profile configured as mesh-recovery
broadcast pre-configured SSID upon detection of mesh link
failure after a successful connection. This needs to be
exclusively configured on the mesh-base device. Mesh Client
auto-scan for mesh-recovery SSID upon failure of mesh link.

- Off

SSID SSID is the unique network name to which MC connects and
establishes mesh links.

- -

VLAN Management VLAN to access all devices in a mesh topology. 1-4094 1

Security For configurable parameters, refer to Chapter 6: Security section. - Open

Passphrase A string that is a key value to generate keys based on the security
method configured.

- 12345678

Radios Each SSID can be configured to be transmitted as per the
deployment requirement. For a mesh WLAN profile, options
available to configure the band:

l 2.4 GHz

l 5 GHz

l 6 GHz

- 2.4 GHz

Hide SSID This is the basic security mode of a Wi-Fi device. This parameter
when enabled, will not broadcast SSID.

- Disabled

SNR-
threshold

Mesh Clients trigger a disconnect when SNR is below configured
value. This is the applicable configuration on the MB.

1-100 Disabled

Mesh
Recovery
Interval

Configure the interval for the consecutive ping loss seen after
which the mesh link is considered to be down and a reconnect is
attempted. One can configure the duration and interval to be the
same, in which case the first ping losses trigger the reconnect.

5-30
min

30
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Parameter Description Range Default

Mesh Auto
Detect
Backhaul

1. Single Hop

Both Mesh Client and MB profiles are configured on
the devices. When enabled, this feature triggers
when an MB losses Ethernet connectivity. Mesh
Client profile automatically gets enabled and
establishes a mesh link with the nearest MB. For the
MB profile to get auto-disabled, uncheck Mesh Multi-
Hop.

2. Multi-Hop

Consider Mesh Client AP is connected to an MB AP
which has an Ethernet backhaul connection. In case
MB which has the backhaul connection loses the
Ethernet connectivity, both APs disconnect from the
network. When Auto detected Backhaul is enabled
on the MB, it automatically enables the MC profile
and connects to the nearest MB ensuring the
connectivity for self as well as the client behind.
Mesh Multi-Hop check should be enabled for this
feature to be active.

3. Mesh Monitored Host

This parameter is exclusive to Mesh Client devices
when Auto-Detect Backhaul is enabled with an
extended network via the Ethernet of the device.
Configure IP or Hostname to check the link status.

- Disabled

Mesh Client
Monitor

1. Duration Duration in minutes of ping failure after which mesh
connectivity is re-established.

2. Host Configure a server to monitor with ping to decide if mesh
connectivity needs to be re-established.

- -

Mesh Vlan
Tagging

Enable the VLAN tagging over the mesh link. This applies only to
the Cambium mesh topology.

- Enabled

Order of Mesh profile configuration
If a device is configured as Mesh Base/client/recovery, the recommended order of WLAN configuration
should be as follows:

l WLAN profile 1: Mesh Base

l WLAN profile 2: Mesh Client
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l WLAN profile 3: Mesh Recovery

Mesh Base (MB)

To configure the MB:

cnMaestro configuration:

CLI configuration:

ap(config-wlan-1)# Mesh Base

ap(config-wlan-1)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-1)# security wpa2-psk

ap(config-wlan-1)# passphrase 12345678

ap(config-wlan-1)# VLAN 1
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ap(config-wlan-1)# band 5GHz

Mesh Client (MC)

To configure the MC:

cnMaestro configuration:

CLI configuration:
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ap(config)# wireless wlan 1

ap(config-wlan-1)# mesh client

ap(config-wlan-1)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-1)# vlan 1

ap(config-wlan-1)# security wpa2-psk

ap(config-wlan-1)# passphrase 12345678

ap(config-wlan-1)# band 5GHz

ap(config-wlan-1)# mesh-recovery-interval 30

ap(config-wlan-1)# mesh-client-monitor duration 5

ap(config-wlan-1)# mesh-client-monitor host 8.8.8.8

Mesh Recovery (MR)

To support plug and play Mesh deployment model, suggest configuring the MR profile on the MB AP. As a
result, factory reset APs/New APs can establish a mesh connection to the MB right away (out of the box).

A recovery profile is also useful when an MC loses connectivity to a base due to misconfiguration or a bad
connection that causes frequent drops.

To configure the MR:

cnMaestro configuration:

CLI configuration:
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ap(config-wlan-1)# mesh recovery

ap(config-wlan-1)# vlan 1

ap(config-wlan-1)# band 5GHz

Please refer to the Cambium Zero touch White paper on mesh for more information on Zero touch Mesh.

Mesh SNR-threshold

SNR-threshold configuration parameter is supported via CLI and can also be provisioned via cnMaestro on
the MBWLAN profile. This parameter helps in maintaining the quality of the mesh link by denying MCs which
has a low SNR value than the configured threshold.

cnMaestro configuration:

CLI configuration:

ap(config-wlan-1)# mesh snr-threshold 60

Mesh Mode

Enterprise Wi-Fi APs support multi-radio, and by default channel distribution, is enabled. When channel
distribution is enabled, each radio is mapped with a group of channels that it can operate.

When a device operates in MC, it will scan channels that are supported by the radio. Hence, there is a high
possibility that MC will never connect to MB. Mesh mode configuration is supported at the RADIO level. To
maintain the consistent link, the user has provision exclusively to configure mode on the radio to ensure that
Mesh Clients are always connected to the network. To configure the Mesh mode:

cnMaestro configuration:

https://community.cambiumnetworks.com/t/enterprise-wi-fi-ap-zero-touch-mesh/84420


Mesh 208

CLI configuration:

ap(config-radio-1)# allowed-wlan-modes mesh

Mesh ACL

ACL can be used to make sure that the Mesh Client connecting to the base AP is a known AP. The Mesh
Client radio MAC address can be added to the Mesh Base AP to achieve this.

Following are the various modes of MAC authentication supported by Enterprise Wi-Fi APs:

l Allow

To enable this mode, add the list of MAC addresses either to be allowed or denied under “mac-
authentication list <Radio MAC of Mesh Client>” and configure the device as below:

cnMaestro configuration:

CLI configuration:

ap(config-wlan-1)# mac-authentication policy allow

l Deny

To enable this mode, add the list of MAC addresses either to be allowed or denied under “mac-
authentication list <Radio MAC of Mesh Client>” and configure the device as below:

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-1)# mac-authentication policy deny

l RADIUS

To enable this mode, configure the device (described in Chapter 7: Radius server section) on
the MBWLAN profile as below:

cnMaestro configuration:

CLI configuration:

ap(config-wlan-1)# mac-authentication policy radius

l cnMaestro

To enable this mode, define the MAC addresses allowed or denied as described in the cnMaestro On-
Premises User Guide Association ACL section and configure the device on the MBWLAN profile as below:

cnMaestro configuration:

CLI configuration:

ap(config-wlan-1)# mac-authentication policy cnMaestro
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Mesh Auto Detect Backhaul
Mesh Auto Detect backhaul is a mechanism to enable MB or MCWLAN profile based on the status of
ethernet of a device that is operating in mesh mode. Enterprise Wi-Fi APs are multi-radio and multi-ethernet
supported, hence there are multiple ways of configuring this feature based on the number of ethernet ports
of a device.

In general, customers use a single AP group to configure any mesh devices in a network. When this feature
is enabled, the device is intelligent enough to decide whether it has to operate in MB or MC mode. Below
are different scenarios (AP2), where this feature can trigger a change in the mesh mode of the device.

Scenario 1
When a single AP Group is used for both MB and MC, AP2 can decide its mesh mode based on eth1 and
eth2 connections. To auto-trigger, the type of mesh mode below configuration needs to be pushed on all
APs in the mesh link.

Based on eth1 and eth2 physical link and reachability to 8.8.8.8 determines the state of mesh mode of AP2.
Below is a matrix that explains AP2 behavior:

Eth 1 Eth 2 8.8.8.8
Reachability

MB MC

l Connected

l No data
enabled

Connected with no network
reachability

No Disabled Enabled

l Connected

l No data
enabled

Connected with network reachability Yes Enabled Disabled

l Connected

l Data-
enabled

Connected with no network
reachability

No Disabled Enabled

l Connected

l Data-
enabled

Connected with no network
reachability

Yes Enabled Disabled

l Connected

l Data-
enabled

Connected with network reachability Yes Enabled Disabled
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Figure 94 Deployment Scenario 1

Scenario 2
When a single AP Group is used for both MB and MC, AP2 can decide its mesh mode based on eth1
connections. To auto-trigger, the type of mesh mode below configuration needs to be pushed on all APs in
the mesh link.

Eth 1 8.8.8.8 Reachability MB MC

l Connected

l No data enabled

No Disabled Enabled

l Connected

l Data-enabled

No Disabled Enabled

l Connected

l Data-enabled

Yes Enabled Disabled

Figure 95 Deployment Scenario 2

Scenario 3
When a single AP Group is used for both MB and MC, AP2 can decide its mesh mode based on eth1
connections. To auto-trigger, the type of mesh mode below configuration needs to be pushed on all APs in
the mesh link.
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Eth 1 8.8.8.8 Reachability MB MC

Connected No Disabled Enabled

Figure 96 Deployment Scenario 3

To enable this configuration either from cnMaestro or CLI, follow the below guidelines:

cnMaestro configuration:

Mesh Client
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Mesh Base

CLI configuration:

Mesh Client
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ap(config-wlan-1)# mesh client

ap(config-wlan-1)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-1)# vlan 1

ap(config-wlan-1)# security wpa2-psk

ap(config-wlan-1)# passphrase 12345678

ap(config-wlan-1)# band 5GHz

ap(config-wlan-1)# mesh-client-monitor duration 5

ap(config-wlan-1)# mesh-client-monitor host 8.8.8.8

Mesh Base

ap(config-wlan-7)# mesh base

ap(config-wlan-7)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-7)# vlan 1

ap(config-wlan-7)# security wpa2-psk

ap(config-wlan-7)# passphrase 12345678

ap(config-wlan-7)# band 5GHz

ap(config-wlan-7)# mesh-auto-detect-backhaul

ap(config-wlan-7)# mesh-auto-detect-backhaul monitor-host

Mesh Muti-Hop
This topology is not a recommended solution but can be deployed in foreseen situations. In this type of
deployment, intermediate devices (AP2) in mesh links require both MB and MC to be enabled.

Figure 97 Multi-Hop deployment Scenario

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-7)# mesh base

ap(config-wlan-7)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-7)# vlan 1

ap(config-wlan-7)# security wpa2-psk

ap(config-wlan-7)# passphrase 12345678

ap(config-wlan-7)# band 5GHz

ap(config-wlan-7)# mesh-auto-detect-backhaul

ap(config-wlan-7)# mesh-auto-detect-backhaul monitor-host

ap(config-wlan-7)# mesh-auto-detect-backhaul multi-hop

Mesh Roaming
From Release 6.4 onwards Enterprise Wi-Fi APs support mesh roaming. For this functionality to be active,
enable the below parameters (MB and MC) on mesh devices.

Mesh Base configuration
Enable 802.11r on the MBWLAN profile to support MC roaming.

cnMaestro configuration:



Mesh 216

CLI configuration:

ap(config-wlan-1)# fast-roaming 802.11r

Mesh Client configuration
For Mesh Client roaming to be operational, enable or configure the below parameters on the radio where
the mesh client is enabled.

Table 63 Mesh Client configuration parameter

Parameters Description Range Default

mesh-client-bgscan Provision to enable the Mesh Client background scan. - Disabled

mesh-client-bgscan
channel-list

The list of channels the Mesh Client needs to scan to
look for AP.

- -

mesh-client-bgscan
long-interval

Once APs RSSI goes above this value, scan intervals are
every configured interval.

1-600
seconds

300

mesh-client-bgscan
roaming-rssi-threshold

APs RSSI threshold to initiate a scan and roam. -100-0
dBm

-65

mesh-client-bgscan
short-interval

Once AP's RSSI drops below this value, the immediate
scan will be triggered and follows the scan interval.

1-300
seconds

60

cnMaestro configuration:
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CLI configuration:

ap(config-radio-2)# mesh-client-bgscan

ap(config-radio-2)# mesh-client-bgscan channel-list all-channels

ap(config-radio-2)# mesh-client-bgscan roaming-rssi-threshold -65

ap(config-radio-2)# mesh-client-bgscan long-interval 300

ap(config-radio-2)# mesh-client-bgscan short-interval 60

Mesh link-Sample configuration
This section briefs about the configuration of the device to get a mesh link established with different
deployment scenarios.

VLAN 1 as the management interface
Follow the below CLI commands to establish a mesh link with VLAN 1 as the management interface:

1. To configure MB and MR, following are the commands:

l WLAN MB profile

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-1)# mesh base

ap(config-wlan-1)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-1)# security wpa2-psk

ap(config-wlan-1)# passphrase 12345678

ap(config-wlan-1)# VLAN 1

ap(config-wlan-1)# band 5GHz

l WLAN MR profile

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-1)# mesh recovery

ap(config-wlan-1)# vlan 1

ap(config-wlan-1)# band 5GHz

2. To configure MC, following are the commands:

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-1)# mesh client

ap(config-wlan-1)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-1)# vlan 1

ap(config-wlan-1)# security wpa2-psk

ap(config-wlan-1)# passphrase 12345678

ap(config-wlan-1)# band 5GHz

ap(config-wlan-1)# mesh-recovery-interval

ap(config-wlan-1)# mesh-recovery-interval 30

ap(config-wlan-1)# mesh-client-monitor

ap(config-wlan-1)# mesh-client-monitor duration 5

ap(config-wlan-1)# mesh-client-monitor host 8.8.8.8

3. To configure the Management VLAN interface, following are the commands:
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cnMaestro configuration:

CLI configuration:

ap(config)# interface vlan 1

ap(config-vlan-1)# ip address dhcp

ap(config-vlan-1)# exit

ap(config)# interface eth 1

ap(config-eth-1)# switchport mode trunk

ap(config-eth-1)# switchport trunk native vlan 1

ap(config-eth-1)# switchport trunk allowed vlan 2-4094

Non-VLAN 1 as the management interface
Follow the below CLI commands to establish a mesh link with non-VLAN 1 as the management interface:

1. To configure MB and MR, following are the commands:

l WLAN MB profile

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-1)# mesh base

ap(config-wlan-1)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-1)# security wpa2-psk

ap(config-wlan-1)# passphrase 12345678

ap(config-wlan-1)# VLAN 10

ap(config-wlan-1)# band 5GHz

l WLAN MR profile

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-1)# mesh recovery

ap(config-wlan-1)# vlan 10

ap(config-wlan-1)# band 5GHz

2. To configure MC, following are the commands:

cnMaestro configuration:
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CLI configuration:

ap(config-wlan-1)# mesh client

ap(config-wlan-1)# ssid CAMBIUM_MESH_BASE

ap(config-wlan-1)# vlan 10

ap(config-wlan-1)# security wpa2-psk

ap(config-wlan-1)# passphrase 12345678

ap(config-wlan-1)# band 5GHz

ap(config-wlan-1)# mesh-recovery-interval

ap(config-wlan-1)# mesh-recovery-interval 30

ap(config-wlan-1)# mesh-client-monitor

ap(config-wlan-1)# mesh-client-monitor duration 5

ap(config-wlan-1)# mesh-client-monitor host 8.8.8.8

3. To configure the Management non-VLAN interface, the following are the commands:

cnMaestro configuration:
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CLI configuration:

ap(config)# interface vlan 10

ap(config-vlan-10)# ip address dhcp

ap(config-vlan-10)# ip dhcp request-option-all

ap(config)# interface eth 1

ap(config-eth-1)# switchport mode trunk

ap(config-eth-1)# switchport trunk native vlan 1

ap(config-eth-1)# switchport trunk allowed vlan 2-4094

Typical use-cases
l Wi-Fi access in areas with no cable run

o Add an AP indoor/outdoor APs for the areas that are difficult to reach

l Small retail location with one AP near an Ethernet outlet, and another in the middle of the lobby that has
no easy cable run.
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l Resolving coverage issues.

o Plug coverage holes

l Extend range outdoors

o An XV2-2T Hotspot in a parking lot outside a building, with XV2-2s providing Wi-Fi within the building

Additional mesh topology supported
Note

The following topology supports zero touch provisioning and single AP group configuration.

Wired devices behind mesh client AP

In this scenario, when wired devices are connected to the mesh client AP (AP2), the AP will support zero
touch provisioning and both base and client APs will have the same configuration (AP group). Mesh AP must
have the capability to connect a separate LAN segment (containing wired devices) to the WLAN.

When an AP, with factory default configuration, is connected in the above scenario, the device waits for 180
seconds to obtain the IP address from the wired side. If the device does not receive any IP address from the
wired side, then mesh recovery is triggered. If the device restarts, the device waits for 360 seconds to obtain
the IP address from the wired side. If the device does not receive any IP address from the wired side, then
mesh recovery is triggered.
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Guest Access Portal - Internal
Introduction
Guest Access Portal services offer a simple way to provide secure access to the internet for users and
devices using a standard web browser. Guest access portal allows enterprises to offer authenticated access
to the network by capturing and re-directing a web browser's session to a captive portal login page where
the user must enter valid credentials to be granted access to the network.

Modes of Captive Portal Services supported by Enterprise Wi-Fi AP devices:

l Internal Access: Captive Portal server is hosted on the access point and is local to the AP.

l External Access: Enterprise Wi-Fi AP is integrated with multiple third-party Captive Portal services vendors.
Based on the vendor, the device needs to be configured. For more information, see Guest Access Portal -
External.

l cnMaestro: Captive Portal services are hosted on cnMaestro where various features like Social login,
Voucher login, SMS login, and Paid login are supported. For more information, see Guest Access –
cnMaestro.

l EasyPass: EasyPass Access Services enable you to easily provide secure and controlled access to users
and visitors on your Wi-Fi network.

This chapter describes about Internal Captive Portal services supported by Enterprise Wi-Fi APs. The
following figure displays the basic topology of testing the Internal Captive Portal Service.
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Figure 98 Topology

Configurable parameters
The below figure displays multiple configurable parameters supported for Internal Guest Access hosted on
AP. Access Policy – Clickthrough.
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Figure 99 Guest Access Internal Access Point parameter

Access policy
Click through

When this policy is selected, the user will get a login page to accept Terms and Conditions to get access to
the network. No additional authentication is required.

Splash page

Title

You can configure the contents of the splash page using this field. Contents should not exceed more than
255 characters.

Contents

You can configure the contents of the splash page using this field. Contents should not exceed more than
255 characters.
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Terms and conditions

Terms and conditions to be displayed on the splash page can be configured using this field. Terms and
conditions should not exceed more than 255 characters.

Logo

Displays the logo image updated in URL http(s)://<ipaddress>/<logo.png>. Either PNG or JPEG format of logo
is supported.

Background image

Displays the background image updated in URL http(s)://<ipaddress>/background>/<image.png>. Either
PNG or JPEG format of logo is supported.

Redirect parameters

Redirect hostname

Users can configure a friendly hostname, which is added to the DNS server and is resolvable to Enterprise
Wi-Fi AP IP address. This parameter once configured will be replaced with an IP address in the redirection
URL provided to wireless stations.

Success action

Provision to configure redirection URL after successful login to captive portal services. Users can configure
three modes of redirection URL:

l Internal logout Page

After successful login, the wireless client is redirected to the logout page hosted on AP.

l Redirect users to external URL

Here users will be redirected to the URL which we configured on a device as below:

l Redirect users to the Original URL

Here users will be redirected to a URL that is accessed by the user before successful captive portal
authentication.

Redirect

By default, captive portal redirection is triggered when the user accesses either HTTP or HTTPS WWW. If
enabled, redirection to Captive Portal Splash Page is triggered when an HTTP WWW is accessed by end-
user.

Redirect Mode

There are two redirect modes available:

l HTTP Mode

When enabled, AP sends an HTTP POSTURL to the client.



Guest Access Portal - Internal 231

l HTTP(s) Mode

When enabled, AP sends HTTPS POST URL to the client

Success message
This we can configure so that we can display success message on the splash page after successful
authentication

Timeout

Session

This is the duration of time which wireless clients will be allowed internet after guest access authentication.

Inactivity

This is the duration of time after which wireless clients will be requested for re-login.

Whitelist
Provision to configure either Ips or URLs to bypass traffic, therefor users can access those IPs or URLs
without Guest Access authentication.

Configuration examples
This section briefs about configuring different methods of Internal Guest Access captive portal services
hosted on AP.
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Access Policy – Clickthrough

Figure 100 Authentication – redirected splash page

Figure 101 Successful login – redirected splash page
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Guest Access Portal - External
Introduction
Guest access WLAN is designed specifically for BYOD (Bring Your Own Device) setup, where large
organizations have both staff and guests running on the same WLAN or similar WLANs. Cambium Networks
provides different options to the customers to achieve this based on where the captive portal page is hosted
and who will be validating and performing the authentication process.

External Hotspot is a smart Guest Access provision supported by Enterprise Wi-Fi AP devices. This method
of Guest Access provides the flexibility of integrating an external 3rd party Web/Cloud hosted captive portal,
fully customized. More details on third-party vendors who are integrated and certified with Cambium are
listed in the URL https://www.cambiumnetworks.com/wifi_partners/.

Configurable parameters
Figure 102 displays multiple configurable parameters supported for External Guest Access hosted on AP.

Figure 102 External Hotspot parameter

https://www.cambiumnetworks.com/wifi_partners/
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Access policy
Clickthrough

When this policy is selected, the user will get a login page to accept Terms and Conditions to get access to
the network. No additional authentication is required.

WISPr

WISPr clients external server login

Provision to enable re-direction of guest access portal URL obtained through WISPr.

External portal post through cnMaestro
This is required when HTTPS is only supported by an external guest access portal. This option when
enabled minimizes certification. The certificate is required to install only in cnMaestro.

External portal type
Only standard mode configuration is supported by Enterprise Wi-Fi AP products.

Standard

This mode is selected, for all third-party vendors whose Guest Access services is certified and integrated
with Enterprise Wi-Fi AP products.  

Redirect parameters

Success action

Provision to configure redirection URL after successful login to captive portal services. Users can configure
three modes of redirection URL:

l Internal logout Page

After successful login, the wireless client is redirected to the logout page hosted on AP.

l Redirect users to external URL

Here users will be redirected to the URL which we configured on the device as below:

l Redirect users to the original URL

Here users will be redirected to a URL that is accessed by the user before successful captive portal
authentication.

Redirect

By default, captive portal redirection is triggered when the user accesses either HTTP or HTTPS WWW. If
enabled, redirection to Captive Portal Splash Page is triggered when an HTTP WWW is accessed by end-
user.
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Redirect mode

There are two redirect modes available:

l HTTP Mode

When enabled, AP sends an HTTP POSTURL to the client.

l HTTP(s) Mode

When enabled, AP sends HTTPS POST URL to the client

Success message
This we can configure so that we can display success message on the splash page after successful
authentication

Timeout

Session

This is the duration of time which wireless clients will be allowed internet after guest access authentication.

Inactivity

This is the duration of time after which wireless clients will be requested for re-login.

Whitelist
Provision to configure either Ips or URLs to bypass traffic, therefor users can access those IPs or URLs
without Guest Access authentication.

Configuration examples
This section briefs about configuring different methods of External Guest Access captive portal services
hosted on AP.
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Access Policy – Clickthrough

Figure 103 Authentication – redirected splash page

Figure 104 Successful Login – redirected splash page
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Guest Access – cnMaestro
Cambium supports end-to-end Guest Access Portal services with a combination of Enterprise Wi-Fi AP and
cnMaestro. cnMaestro supports various types of authentication mechanisms for wireless clients to obtain
Internet access. For further information about Guest Access Portal:

l For On-Premises, go to https://support.cambiumnetworks.com/files/cnmaestro/ and download the latest
cnMaestro On-Premises User Guide.

l For cnMaestro Cloud, refer to the cnMaestro Cloud User Guide.

https://support.cambiumnetworks.com/files/cnmaestro/
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Auto VLAN
The Auto VLAN is intended to support zero-touch detection and configuration for connected Enterprise Wi-
Fi APs. New Cambium vendor-specific LLDP TLVs are introduced starting with cnMatrix Release 3.1 to
support “pushing” PBA policy data from Enterprise Wi-Fi APs to cnMatrix. The new PBA TLVs are
implemented as an extension to the LLDP standard, using its flexible extension mechanism.

From a functional perspective, cnMatrix, acting as the upstream device, includes the PBA authentication TLV
in the regularly generated LLDPDUs for a port. The downstream device receives the PBA authentication
TLV, and, if policy action data (for example VLANs) is present to be pushed to cnMatrix, a PBA device
settings TLV is constructed and added to the LLDPDU for the port.

The below table lists the fields that are required for configuring Auto-VLAN:

Table 64 Configuring Auto-VLAN parameters

Parameters Description Range Default

lldp pba New PBA TLVs is shared with cnMatrix switch. ─ Enabled

lldp pba-
auth-key

The shared private key used during PBA TLV authentication can
be updated or reset from its default value (by using the ‘no’ option).

─ Enabled
with
default key

Note

lldp pba-auth-key default value cannot be shared due to security concerns.

CLI configuration:

Syntax:

ap(config)# lldp

ap(config)# lldp pba-auth-key

Example:

ap(config)# lldp pba

ap(config)# lldp pba-auth-key 123456789
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Device Recovery Methods
Factory reset via ‘RESET’ button
Table 65 Factory reset via RESET button

Access
Point

Procedure LED Indication

XV3-8 Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XE5-8 Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XV2-2 Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XV2-2T0 Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XV2-2T1 Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XE3-4 Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XE3-4TN Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XV2-21X Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XV2-23T Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

XV2-22H Press and hold the Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

Boot partition change via power cycle
Table 66 Boot partition change via power cycle

Access Point Procedure

XV3-8 Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XE5-8 Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XV2-2 Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)
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Access Point Procedure

XV2-2T0 Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XV2-2T1 Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XE3-4 Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XE3-4TN Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XV2-21X Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XV2-23T Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

XV2-22H Follow power ON and off 9 times with an interval of 120 Sec (ON) and 5 Sec (OFF)

Disable factory Reset Button
User can disable the physical Reset Button on the device by using the below CLI command:

ap(config)# no system hw-reset

Warning

The Reset Button is a key recovery option in situations when an AP gets misconfigured and
you are unable to connect to the AP.

By disabling the Reset Button, you lose the ability to recover the AP in such scenarios.
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Command-Line Interface (CLI)
The Enterprise Wi-Fi products support Command-Line Interface (CLI) which helps in configuring as well as
monitoring the devices.

Show commands
The below table provides Show commands supported in Enterprise Wi-Fi AP:

Table 67 Show commands supported in Enterprise Wi-Fi AP

SL
No

CLI Command Description

Deep Packet Inspection (DPI)

1 show application-
statistics by-application Displays statistics of each application that is accessed by

the station connected to the AP.

2 show application-
statistics by-category Displays statistics of application category that is accessed

by the station connected to the AP.

Network Information

3 show arp Displays list of ARP entries learned by AP.

4 show conntrack Displays current connection track entries along with
application ID Mapping.

5 show route Displays IP route information.

6 show dhcp-pool <Index
number> Displays the DHCP pool configuration.

7 show interface brief Displays interface details such as IP, Netmask, and traffic
statistics.

8 show ip dhcp-client-info Displays the DHCP options learned by device across all
interfaces.

9 show ip domain-name Displays learned domain name information.

10 show ip gw-source-
precedence Displays the Precedence of gateway sources.

11 show ip interface Displays IP interface parameters.

12 show ip name-server Displays DNS server information.

13 show ip neighbour Displays IPv4 neighbour entries.

14 show ip route Displays IP route information.

15 show ipv6 dhcp-client-info Displays learned DHCPv6 client information.
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SL
No

CLI Command Description

16 show ipv6 domain-name Displays learned domain name information.

17 show ipv6 gw-source-
precedence Displays the precedence of gateway sources.

18 show ipv6 interface brief Displays IPv6 interface parameters.

19 show ipv6 name-server Displays DNS server information.

20 show ipv6 neighbour Displays neighbour entries.

21 show ipv6 route Displays IP route information.

Radio Information

22 show auto-rf channel-info Displays Auto-RF channel information.

23 show auto-rf history Displays Auto-RF history.

24 show wireless band-steer
client-cache Displays band steered client cache.

25 show wireless mesh ipv6 Displays IPv6 address of associated mesh clients .

26 show wireless mesh-xtnded-
list Displays mesh extended device list for 2.4 GHz when

mesh-xtnded-dev-list is enabled.

27 show wireless neighbors
2.4GHz Displays 2.4 GHz wireless neighbors.

28 show wireless neighbors
5GHz Displays 5G Hz wireless neighbors.

29 show wireless neighbors
6GHz Displays 6 GHz wireless neighbors.

30 show wireless neighbors
autocell Displays Auto-cell neighbors.

31 show wireless radios
channels Displays supported channels.

32 show wireless radios mu-
mimo-statistics Displays MU-MIMO statistics of Radios.

33 show wireless radios
multicast-to-unicast Displays multicast-to-unicast configuration.

34 show wireless radios
ofdma-statistics Displays OFDMA statistics of Radios.

35 show wireless radios rf-
statistics Displays statistics of Radios.

36 show wireless radios
statistics Displays statistics of Radios.

37 show wireless wlans
aggregate-statistics Displays aggregate statistics of wireless LANs.

38 show wireless wlans
interface Displays wireless WLAN interface details.
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SL
No

CLI Command Description

39 show wireless wlans
monitor-host Displays monitor host information for wireless LANs.

40 show wireless wlans
statistics Displays statistics of wireless LANs.

Bonjour Information

41 show bonjour-services Displays Bonjour services available.

42 show bonjour-statistics Displays Bonjour rule statistics.

System Information

43 show upgrade-status Displays last upgrade status.

44 show version Displays device firmware information.

45 show timezones Displays list of timezone locations.

46 show management details Displays management status in detail.

47 show mfgrom Displays manufacturing ROM details.

48 show country-codes Displays a list of supported countries and corresponding
country codes.

49 show boot Displays device firmware active-backup versions.

50 show cambium-id Displays configured Cambium-ID (if any).

51 show clock Displays system time.

52 show config all Displays current configuration including defaults.

53 show config dhcp-pools all Displays DHCP pools configuration including defaults.

54 show config filter Displays Filter configuration.

55 show config wireless all Displays wireless configuration including defaults.

56 show config system all Displays infra configuration including defaults.

57 show config system
interfaces Displays network interface configuration.

58 show events Displays recent event messages.

Guest Access

59 show ext-guest clients Displays information of ext-guest clients.

Filters

60 show filter-statistics Displays filter statistics.
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SL
No

CLI Command Description

LLDP

61 show lldp chassis Displays local chassis data.

62 show lldp configuration Displays configuration.

63 show lldp interfaces Displays interfaces data.

64 show lldp neighbors Displays neighbors data.

65 show lldp statistics Displays statistics.

66 show power Displays power conditions.

67 show packet-capture status Displays status of packet capture.

Real-Time Location System

68 show rtls aeroscout ble-
tag-summary Displays AeroScout BLE-tag summary.

69 show rtls aeroscout
configuration Displays AeroScout Wi-Fi-tag configuration.

70 show rtls aeroscout wifi-
tag-summary Displays AeroScout Wi-Fi-tag summary.

Tunnel

71 show tunnel-statistics Displays tunnel statistics.

72 show tunnel-status details Displays tunnel parameters.

73 show ip pppoe-client-info Displays learned PPPoE client information.

74 show pppoe-status Displays PPPoE status.

Service commands
Service show
The below table provides Service show commands supported in Enterprise Wi-Fi AP:

Table 68 Service show commands supported in Enterprise Wi-Fi AP

SL
No

CLI Command Description

1 service show bridge Displays AP bridge table entries.

2 service show client-
cache Displays current client status and history of clients connected

and respective parameters.

3 service show config Displays configuration from data base.
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SL
No

CLI Command Description

4 service show cores Displays process cores (if any).

5 service show debug-logs
<Process Names> Displays debug logs of various processes.

6 service show df Displays flash status.

7 service show dmesg Displays system kernel logs.

8 service show epsk Displays ePSK information.

9 service show ethtool Displays information and statistics w.r.t Ethernet interfaces.

10 service show guest-
portal whitelist wlan
<wlan index>

Displays whitelist entries either configured or auto-selected by a
device in a guest portal WLAN profile.

11 service show ifconfig Displays status and statistics of all interfaces configured and
supported on the device.

12 service show iperfd-
logs Display IPERF logs when iperfd daemon is enabled on device.

13 service show iwconfig Displays status and statistics of all Wireless interfaces
configured on the device.

14 service show last-
reboot-reason Displays the reason for the last reboot of the AP.

15 service show last-
reboot-state watchdog Displays if the last reboot reason is due to watchdog.

16 service show mcastsnoop Displays multicast-snoop tables.

17 service show mdnsd-
statistics Displays mDNS packet stats on mdnsd.

18 service show memory Displays memory information.

19 service show netstat Displays network socket connections.

20 service show ps Displays a list of processes.

21 service show ps-
restart-history Displays history of process restart on the AP.

22 service show route Displays routing table.

23 service show top Displays process activity status.

Service system
The below table provides Service system commands supported in Enterprise Wi-Fi AP:
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Table 69 Service system commands supported in Enterprise Wi-Fi AP

SL
No

CLI Command Description

1 service boot backup-
firmware Helps to boot to other partition.

2 service clear-cores Clear system core files (if any).

3 service clear-dhcp-pool Clear DHCP pool allocated addresses.

4 service debug <process
name>logging-level
<logging-level>

Commands to enable debugging of processes at various
logging levels.

5 service flash-leds Flash system LEDs help identify this device visually.

6 service radio apstats Displays aggregate statistics of all wireless interfaces.

7 service radio athstats Displays aggregate Radio traffic statistics.

8 service radio iwpriv Displays supported iwpriv commands.

9 service radio thermaltool Displays radio current operating temperature.

10 service schedule reload Reboot AP at the specified time.

11 service ssh host add Add a host and key to the known hosts list.

12 service ssh host del Delete a host and key from the known hosts list.

13 service system-trace Start a trace session for troubleshooting.

14 service test leds Displays test LEDs.

15 service test radio Displays status and configured Radio.
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cnMaestro X Assurance
Note

This feature is available from cnMaestro 4.1.0 and later versions only.

The cnMaestro X Assurance feature provides enhanced visibility into the health of Wi-Fi client connections,
including root cause analysis of failures with possible recommended actions. It also provides analytics on
aggregated data that can help to improve clients connectivity in the Wi-Fi network.

Note

This feature is currently available as a free trial to all cnMaestro X customers. In future, this
feature will require a separate paid subscription.

The cnMaestro X Assurance feature analyzes the Wi-Fi client connection events and helps to troubleshoot
common network connectivity and performance issues such as the following:

l Connectivity—Association, authentication, and network connectivity services, such as DHCP and DNS
transaction failures.

l Poor Performance—Low RSSI, low data rate, AAA, DHCP, DNS transaction latency.

For more information, refer to the cnMaestro User Guide.
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MarketApps
The MarketApps feature in cnMaestro offers customized solutions for efficiently managing Wi-Fi services in
residential settings, such as multi-dwelling units (MDUs) and apartment complexes. It provides specialized
tools (applications or Apps) that enhance operational efficiency and cater to the distinct requirements of
both property managers and residents.

Target audience
l Property managers—The MarketApps feature empowers property managers to centrally administer Wi-
Fi access across their properties. They can set up community-wide Wi-Fi networks and manage
personal Wi-Fi networks for local residents.

l Residents—Residents can set up and manage their own Wi-Fi networks within the community, ensuring
personalized and secure Internet access.

l Solution providers—Solution providers can utilize MarketApps to offer tailored Wi-Fi solutions,
enhancing network performance and user satisfaction in multi-dwelling units and apartment complexes.

Benefits
l Centralized management—Property managers can oversee and control Wi-Fi access across multiple
units or buildings from cnMaestro.

l Customization—Residents can set up personal Wi-Fi networks with customized SSIDs and passwords,
enhancing their user experience.

To access MarketApps, navigate to Network Services >MarketApps in cnMaestro.

For more information on configuring and viewing MarketApps, refer to the cnMaestro User Guide.

CLI configuration

To enable MarketApps using AP CLI, execute the following command:

ap(config)# wireless wlan 2

ap(config)# epsk cnMaestro
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Glossary
Term Definition

AP Access Point Module. One module that distributes network or Internet services to subscriber
modules.

API Application Program Interface

ARP Address Resolution Protocol. A protocol defined in RFC 826 to allow a network element to
correlate a host IP address to the Ethernet address of the host.

BT Bluetooth

DFS See Dynamic Frequency Selection

DHCP Dynamic Host Configuration Protocol defined in RFC 2131. The protocol that enables a device
to be assigned a new IP address and TCP/IP parameters, including a default gateway,
whenever the device reboots. Thus, DHCP reduces configuration time, conserves IP
addresses, and allows modules to be moved to a different network within the system.

Ethernet
Protocol

Any of several IEEE standards that define the contents of frames that are transferred from one
network element to another through Ethernet connections.

FCC Federal Communications Commission of the U.S.A.

GPS Global Positioning System. A network of satellites that provides absolute time to networks on
earth, which use the time signal to synchronize transmission and reception cycles (to avoid
interference) and to provide reference for troubleshooting activities.

UI User interface.

HTTP Hypertext Transfer Protocol, used to make the Internet resources available on the World Wide
Web.

HTTPS Hypertext Transfer Protocol Secure

HT High Throughput

IP
Address

The 32-bit binary number identifies a network element by both network and host. See also
Subnet Mask.

IPv4 The traditional version of Internet Protocol, defines 32-bit fields for data transmission.

LLDP Link Layer Discovery Protocol

MAC
Address

Media Access Control address. The hardware address that the factory assigns to the module
for identification in the Data Link layer interface of the Open Systems Interconnection system.
This address serves as an electronic serial number.

MIB Management Information Base. Space that allows a program (agent) in the network to relay
information to a network monitor about the status of defined variables (objects).



Glossary 250

Term Definition

MIR See Maximum Information Rate.

PPPoE Point to Point Protocol over Ethernet. Supported on SMs for operators who use PPPoE in
other parts of their network operators who want to deploy PPPoE to realize per-subscriber
authentication, metrics, and usage control.

Proxy
Server

Network computer that isolates another from the Internet. The proxy server communicates for
the other computer, and sends replies to only the appropriate computer which has an IP
address that is not unique or not registered.

PoE Power over Ethernet.

SLA Service Level Agreement

VLAN Virtual local area network. An association of devices through software that contains broadcast
traffic, as routers would, but in the switch-level protocol.

VPN A virtual private network for communication over a public network. One typical use is to
connect remote employees, who are at home or in a different city, to their corporate network
over the Internet. Any of several VPN implementation schemes are possible. SMs support
L2TP over IPSec (Level 2 Tunneling Protocol over IP Security) VPNs and PPTP (Point to Point
Tunneling Protocol) VPNs, regardless of whether the Network Address Translation (NAT)
feature enabled.
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Appendix
This appendix contains the following topics:

l Supported RADIUS Attributes

l Supported DFS channels

l Supported 6 GHz countries

l Priority order for parameters

l Best practices for wireless clients seamless roaming across APs
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Supported RADIUS Attributes
This topic lists the following RADIUS override attributes that are supported on Enterprise Wi-Fi APs:

l WISPr VSAs (Vendor ID: 14122)

l Cambium VSAs (Vendor ID: 17713)

l Standard RADIUS attributes

l RADIUS attributes in authentication and accounting packets with WPA2-Enterprise security

l Supported CoA messages

WISPr VSAs (Vendor ID: 14122)
Table 70 lists the WISPr vendor-specific attributes (VSAs) supported on Enterprise Wi-Fi APs.

Table 70WISPr VSAs

Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages WPA2 / WPA3 - Enterprise
Authentication Support

Guest Access
Support

Request Response /
Challenge

Accept Start Interim Stop

2 WISPr-Location-Name string Yes -NA- No Yes Yes Yes Yes Yes

7 WISPr-Bandwidth-
Max-Up

integer No No Yes No No No Yes Yes

8 WISPr-Bandwidth-
Max-Down

integer No No Yes No No No Yes Yes

9 WISPr-Session-
Terminate-Time

string No No Yes No No No Yes Yes

Table 71 lists the WISPr VSAs supported on Enterprise Wi-Fi APs with CoA support.
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Table 71WISPr VSAs with CoA

Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages CoA Support
with Guest
Access

CoA Support with WPA2 / WPA3
- Enterprise Authentication

Request Response /
Challenge

Accept Start Interim Stop

2 WISPr-Location-
Name

string Yes -NA- No Yes Yes Yes -NA- -NA-

7 WISPr-Bandwidth-
Max-Up

integer No No Yes No No No Yes Yes

8 WISPr-Bandwidth-
Max-Down

integer No No Yes No No No Yes Yes

9 WISPr-Session-
Terminate-Time

string No No Yes No No No Yes Yes

Cambium VSAs (Vendor ID: 17713)
Table 72 lists the Cambium Networks VSAs supported on Enterprise Wi-Fi APs.

Table 72 Cambium VSAs

Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages WPA2 / WPA3 - Enterprise
Authentication Support

Guest
Access
SupportRequest Response /

Challenge
Accept Start Interim Stop

151 Cambium-Wi-Fi-Quota-
Up

integer No No Yes No No No -NA- Yes

152 Cambium-Wi-Fi-Quota-
Down

integer No No Yes No No No -NA- Yes

155 Cambium-Wi-Fi-Quota-
Total

integer No No Yes No No No -NA- Yes

153 Cambium-Wi-Fi-Quota-
Up-Gigaword

integer64 No No Yes No No No -NA- Yes
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Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages WPA2 / WPA3 - Enterprise
Authentication Support

Guest
Access
SupportRequest Response /

Challenge
Accept Start Interim Stop

154 Cambium-Wi-Fi-Quota-
Down-Gigaword

integer64 No No Yes No No No -NA- Yes

156 Cambium-Wi-Fi-Quota-
Total-Gigaword

integer64 No No Yes No No No -NA- Yes

157 Cambium-VLAN-Pool-ID string No No Yes No No No Yes No

159 Cambium-Traffic-
Classes-Acct

TLV

159.2 Cambium-Acct-Input-
Octets

integer No No No No Yes Yes

159.3 Cambium-Acct-Output-
Octets

integer No No No No Yes Yes

159.4 Cambium-Acct-Input-
Packets

integer No No No No Yes Yes

159.5 Cambium-Acct-Output-
Packets

integer No No No No Yes Yes

161 Cambium-ePSK TLV -NA- Yes

161.1 Cambium-ePSK-Anonce octet Yes -NA- No -NA- Yes

161.2 Cambium-ePSK-M2 octet Yes -NA- No -NA- Yes

161.3 Cambium-ePSK-BSSID octet Yes -NA- No -NA- Yes

161.4 Cambium-ePSK-AP-MAC octet Yes -NA- No -NA- Yes

161.5 Cambium-ePSK-SSID string Yes -NA- No -NA- Yes

161.6 Cambium-ePSK-PMK string No -NA- Yes -NA- Yes

Table 73 lists the Cambium Networks VSAs supported on Enterprise Wi-Fi APs with CoA.
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Table 73 Cambium VSAs with CoA

Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages CoA Support
with Guest
Access

CoA Support with WPA2 /
WPA3 - Enterprise
AuthenticationRequest Response /

Challenge
Accept Start Interim Stop

151 Cambium-Wi-Fi-
Quota-Up

integer No No Yes No No No Yes

152 Cambium-Wi-Fi-
Quota-Down

integer No No Yes No No No Yes

155 Cambium-Wi-Fi-
Quota-Total

integer No No Yes No No No Yes

153 Cambium-Wi-Fi-
Quota-Up-Gigaword

integer64 No No Yes No No No Yes

154 Cambium-Wi-Fi-
Quota-Down-Gigaword

integer64 No No Yes No No No Yes

156 Cambium-Wi-Fi-
Quota-Total-
Gigaword

integer64 No No Yes No No No Yes

157 Cambium-VLAN-Pool-
ID

string No No Yes No No No

159 Cambium-Traffic-
Classes-Acct

TLV

159.2 Cambium-Acct-Input-
Octets

integer No No No No Yes Yes

159.3 Cambium-Acct-
Output-Octets

integer No No No No Yes Yes

159.4 Cambium-Acct-Input-
Packets

integer No No No No Yes Yes
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Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages CoA Support
with Guest
Access

CoA Support with WPA2 /
WPA3 - Enterprise
AuthenticationRequest Response /

Challenge
Accept Start Interim Stop

159.5 Cambium-Acct-
Output-Packets

integer No No No No Yes Yes

161 Cambium-ePSK TLV -NA- -NA-

161.1 Cambium-ePSK-Anonce octet Yes -NA- No -NA- -NA-

161.2 Cambium-ePSK-M2 octet Yes -NA- No -NA- -NA-

161.3 Cambium-ePSK-BSSID octet Yes -NA- No -NA- -NA-

161.4 Cambium-ePSK-AP-MAC octet Yes -NA- No -NA- -NA-

161.5 Cambium-ePSK-SSID string Yes -NA- No -NA- -NA-

161.6 Cambium-ePSK-PMK string No -NA- Yes -NA- -NA-

Standard RADIUS attributes
Table 74 lists the standard RADIUS attributes supported on Enterprise Wi-Fi APs.

Table 74 Standard RADIUS attributes

Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages WPA2 / WPA3 - Enterprise
Authentication Support

Guest Access
Support

Request Response /
Challenge

Accept Start Interim Stop

11 Filter-Id (text) -
Group-ID

text No -NA- Yes No No No Yes

24 State string Yes Yes No Yes -NA-

25 Class string No -NA- Yes Yes No No Yes Yes

27 Session-Timeout integer No -NA- Yes No No No Yes Yes
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Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages WPA2 / WPA3 - Enterprise
Authentication Support

Guest Access
Support

Request Response /
Challenge

Accept Start Interim Stop

28 Idle-Timeout integer No -NA- Yes No No No Yes

64 Tunnel-Type enum No -NA- Yes No No No Yes Yes

65 Tunnel-Medium-Type enum No -NA- Yes No No No Yes Yes

81 Tunnel-Private-
Group-Id

text No -NA- Yes No No No Yes Yes

85 Acct-Interim-
Interval

integer No -NA- Yes No No No Yes Yes

Disconnect RADIUS
packet

40 Disconnect-Request - RADIUS
packet

-NA- -NA- -NA- -NA- -NA- -NA- -NA-

41 Disconnect-ACK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA-

42 Disconnect-NAK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA-

43 CoA-Request - RADIUS
packet

-NA- -NA- -NA- -NA- -NA-

44 CoA-ACK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA-

45 CoA-NAK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA-

Table 75 lists the standard RADIUS attributes supported on Enterprise Wi-Fi APs with CoA support.
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Table 75 Standard RADIUS attributes with CoA

Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages CoA Support
with Guest
Access

CoA Support with WPA2 / WPA3
- Enterprise Authentication

Request Response /
Challenge

Accept Start Interim Stop

11 Filter-Id (text)
- Group-ID

text No -NA- Yes No No No Yes Yes

24 State string Yes Yes No Yes

25 Class string No -NA- Yes Yes No No -NA- -NA-

27 Session-Timeout integer No -NA- Yes No No No -NA- -NA-

28 Idle-Timeout integer No -NA- Yes No No No -NA- -NA-

64 Tunnel-Type enum No -NA- Yes No No No -NA- -NA-

65 Tunnel-Medium-
Type

enum No -NA- Yes No No No -NA- -NA-

81 Tunnel-Private-
Group-Id

text No -NA- Yes No No No No Yes

85 Acct-Interim-
Interval

integer No -NA- Yes No No No

Disconnect RADIUS
packet

40 Disconnect-
Request

- RADIUS
packet

-NA- -NA- -NA- -NA- -NA- Yes Yes

41 Disconnect-ACK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA- Yes Yes

42 Disconnect-NAK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA- Yes Yes
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Attribute
Value

Attribute Description Attribute
Type

RADIUS Message Types Accounting Messages CoA Support
with Guest
Access

CoA Support with WPA2 / WPA3
- Enterprise Authentication

Request Response /
Challenge

Accept Start Interim Stop

43 CoA-Request - RADIUS
packet

-NA- -NA- -NA- -NA- -NA- Yes Yes

44 CoA-ACK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA- Yes Yes

45 CoA-NAK - RADIUS
packet

-NA- -NA- -NA- -NA- -NA- Yes Yes

RADIUS attributes in authentication and accounting packets with WPA2-Enterprise security
Table 76 lists the RADIUS attributes supported in authentication and accounting packets with WPA2-Enterprise security.

Table 76 RADIUS attributes in authentication and accounting packets with WPA2-Enterprise security

Attribute
Value

Attribute
Description

Attribute
Type

Access-
Request

Access-
Challenge

Access-
Accept

Accounting-
Start

Accounting-
Interim

Accounting-
Stop

1 User-Name string Yes No Yes Yes Yes Yes

2 User-Password string Yes No No No No No

4 NAS-IP-Address ipv4addr Yes No No Yes Yes Yes

5 NAS-Port integer Yes No No Yes Yes Yes

6 Service-Type enum Yes No No Yes Yes Yes

8 Framed-IP-
Address

ipv4addr No No No Yes Yes Yes

12 Framed-MTU integer Yes No No Yes Yes Yes

24 State string Yes Yes No No No No
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Attribute
Value

Attribute
Description

Attribute
Type

Access-
Request

Access-
Challenge

Access-
Accept

Accounting-
Start

Accounting-
Interim

Accounting-
Stop

25 Class string No No Yes Yes Yes Yes

27 Session-
Timeout

integer No No Yes No No No

28 Idle-Timeout integer No No Yes No No No

30 Called-
Station-Id

string Yes No No Yes Yes Yes

31 Calling-
Station-Id

text Yes No No Yes Yes Yes

32 NAS-Identifier string Yes No No Yes Yes Yes

40 Acct-Status-
Type

enum No No No Yes Yes Yes

41 Acct-Delay-
Time

integer No No No Yes Yes Yes

42 Acct-Input-
Octets

integer No No No No Yes Yes

43 Acct-Output-
Octets

integer No No No No Yes Yes

44 Acct-Session-
Id

text Yes No No Yes Yes Yes

45 Acct-Authentic enum No No No Yes Yes Yes

46 Acct-Session-
Time

integer No No No No Yes Yes

49 Acct-
Terminate-
Cause

enum No No No No No Yes
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Attribute
Value

Attribute
Description

Attribute
Type

Access-
Request

Access-
Challenge

Access-
Accept

Accounting-
Start

Accounting-
Interim

Accounting-
Stop

50 Acct-Multi-
Session-Id

text Yes (Empty) No No Yes Yes Yes

52 Acct-Input-
Gigawords

integer No No No No No No

53 Acct-Output-
Gigawords

integer No No No No No No

55 Event-
Timestamp

time No No No Yes Yes Yes

61 NAS-Port-Type integer Yes No No Yes Yes Yes

77 Connect-Info text Yes No No Yes Yes Yes

79 EAP-Message concat Yes Yes Yes No No No

80 Message-
Authenticator

string Yes Yes Yes No No No

85 Acct-Interim-
Interval

integer No No Yes No No No

87 NAS-Port-Id text Yes No No Yes Yes Yes

Supported CoA messages
Table 77 lists the supported CoA messages.

Table 77 CoA messages

CoA Message Supported by MAB (Wired Clients) Supported by the AP

Disconnect client Yes Yes

Update VLAN Yes Yes
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CoA Message Supported by MAB (Wired Clients) Supported by the AP

Session Timeout No Yes

Accounting Interval Yes Yes

Quota Limit No Yes

Note

Following are the mandatory parameters to be included in the CoA message:

l When sent through cnMaestro—User-Name, Calling-Station-Id, and Session ID

l When sent directly through the AP—User-Name, Calling-Station-Id, and NAS-Identifier
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Supported DFS channels
Table 78 lists the DFS channel support for various platforms in conformance with FCC standards.

Table 78 DFS channel support for FCC

AP
Model

5250-5350 MHz (U-NII-2A) 5470-5725 MHz (U-NII-2C) 5725-5850 MHz (U-NII-3)

XE3-4TN Yes Yes Yes

XV2-
22H

Yes Yes Yes

XV2-21X Yes Yes Yes

XV2-23T Yes Yes Yes

XE3-4 Yes Yes Yes

XE5-8 Yes Yes Yes

XV2-2 Yes Yes Yes

XV3-8 Yes Yes Yes

XV2-2T0 Yes Yes Yes

XV2-2T1 Yes Yes Yes

Table 79 lists the DFS channel support for various platforms in conformance with IC standards.

Table 79 DFS channel support for IC

AP
Model

5250-5350 MHz (U-NII-2A) 5470-5725 MHz (U-NII-2C) 5725-5850 MHz (U-NII-3)

XE3-4TN Yes Yes Yes

XV2-
22H

Yes Yes Yes

XV2-21X Yes Yes Yes

XV2-23T Yes Yes Yes

XE3-4 Yes Yes Yes

XE5-8 Yes Yes Yes

XV2-2 Yes Yes Yes

XV3-8 Yes Yes Yes
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AP
Model

5250-5350 MHz (U-NII-2A) 5470-5725 MHz (U-NII-2C) 5725-5850 MHz (U-NII-3)

XV2-2T0 Yes Yes Yes

XV2-2T1 Yes Yes Yes

Table 80 lists the DFS channel support for various platforms in conformance with CE standards.

Table 80 DFS channel support for CE

AP
Model

5250-5350 MHz (U-NII-2A) 5470-5725 MHz (U-NII-2C) 5725-5850 MHz (U-NII-3)

XE3-4TN Yes Yes Yes

XV2-
22H

Yes Yes Yes

XV2-21X Yes Yes Yes

XV2-23T Yes Yes Yes

XE3-4 Yes Yes Yes

XE5-8 Yes Yes Yes

XV2-2 Yes Yes No

XV3-8 No Yes No

XV2-2T0 Yes Yes Yes

XV2-2T1 Yes Yes Yes

Supported 6 GHz countries
Table 81 lists the countries where 6 GHz band is available and the frequencies supported.

Note

Availability of these channels is subjected to respective country regulations.

6 GHz frequency is supported only on the following Enterprise Wi-Fi APs:

l XE3-4

l XE3-4TN

l XE5-8
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Table 81 List of countries where 6 GHz band is supported

Country XE3-4 XE5-8

Frequencies
Supported

Channels
Supported

Frequencies
Supported

Channels
Supported (No
Channel
Distribution)

Channels Supported
(With Channel
Distribution Enabled)

Radio 2 Radio 3

Australia (AU) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

Brazil (BR) 5945-7125
MHz

1-233 5945-7125
MHz

1-233 1-93 129-233

Canada (CA) 5945-7125
MHz

1-233 5945-7125
MHz

1-233 1-93 97-233

Colombia
(CO)

5945-7125
MHz

1-233 5945-7125
MHz

1-233 1-93 129-233

France (FR) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

Germany (DE) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

Ireland (IE) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

Italy (IT) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

Jordan (JO) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

South Korea
(KR)

5945-7125
MHz

1-233 5945-7125
MHz

1-233 1-93 97-233

Netherlands
(NL)

5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

New Zealand
(NZ)

5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

South Africa
(ZA)

5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

Spain (ES) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93
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Country XE3-4 XE5-8

Frequencies
Supported

Channels
Supported

Frequencies
Supported

Channels
Supported (No
Channel
Distribution)

Channels Supported
(With Channel
Distribution Enabled)

Radio 2 Radio 3

Sweden (SE) 5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

United
Kingdom (GB)

5945-6425
MHz

1-93 5945-6425
MHz

1-93 1-61 65-93

United States
(US)

5945-7125
MHz

1-233 5945-7125
MHz

1-233 1-93 129-233
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Priority order for parameters
This section provides information on the order of priority for the following parameters:

l Session timeout and inactivity timeout—Following priority is considered when configuring session
timeout and inactivity timeout:

a. Configured from the RADIUS server

b. Configured from the AP

Note

l Inactivity timeout is triggered when there is no data packets from the client to the AP.

l A five minute static idle time is configured from the driver, which is triggered when
there are no wireless packets from the client.

l VLAN assignment—Following priority is considered when assigning VLANs to clients:

a. RADIUS dynamic VLAN for guest access clients

b. RADIUS dynamic VLAN (Filter-ID/RADIUS-ID)

c. RADIUS dynamic VLAN

d. RADIUS-based ePSK

e. RADIUS-based dynamic VLAN Pool

f. Local ePSK VLAN setting

g. VLAN pool (Static)

h. SSID/WLAN profile VLAN

l User group filter—Following priority is considered for assigning policy:

a. Global policy

b. User Group policy

c. Device Group policy

d. SSID/WLAN policy
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Best practices for wireless clients seamless roaming across APs
Note

l Inactivity timeout is triggered when there is no data packets from the client to the AP.

l A five minute static idle time is configured from the driver, which is triggered when there
are no wireless packets from the client.

This appendix explains the recommended configuration for Cambium Networks APs and external network
to facilitate a seamless roaming across the APs for the wireless clients. Additionally, this appendix also lists
the recommended network best practices for minimizing broadcast and multicast packets processing.

This appendix contains the following topics:

l External network recommendation

l APWLAN profile configuration recommendations

l AP group configuration recommendations

External network recommendations
The Cambium APs work in the distributed architecture mode and it is important to facilitate AP-to-AP
communication for the wireless clients seamless roaming. The APs uses the Cambium propriety XRP
protocol to exchange clients information with the neighboring APs.

Following are the recommendations:

l The intermediate network switches, to which the APs are connected, must not block the following XRP
messages:

XRP message packet information

o Source MAC—APs ethernet MAC

o Destination MAC—Ethernet broadcast

o Source IP Address—APs exit interface IP address

o Destination IP Address—255.255.255.255 Broadcast IP address

o Protocol—UDP with a random source port and a fixed destination port

A sample pcap capture of the XRP message is displayed in Figure 105.
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Figure 105 Sample XRP message

l APs send the XRP messages on the ethernet port’s native VLAN.

l All the APs must be part of the same native VLAN.

l Make sure that the APs have the L3 interface for the native VLAN with a valid IP address.

AP WLAN profile configuration recommendations
If the WLAN profile is configured with WPA2 and WPA3 security, it is recommended to enable the following:

l 802.11r fast roaming

l OKC

Note

A few clients use 802.11k and 802.11v protocols for fast roaming. We can enable the same.
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Figure 106 Enabling OKC and 802.11r

l Enable client isolation with the Network Wide option to prevent clients communicating with other
clients on the same L2 network.

Figure 107 Enabling Client Isolation

Note

From AP version 6.6.0.2 onwards, the AP drops the ARP packets when the client isolation
feature is enabled. To enable this in APs running firmware version lesser than 6.6.0.2,
execute the client-isolation dynamic drop-arp CLI command from the AP
group User-Defined Overrides section.
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Figure 108 Enabling Client Isolation in User-Defined Overrides

AP group configuration recommendations
l In large public Wi-Fi and campus deployments, it is common to see large number of network discovery
protocols, such as mDNS, LLMNR, SSDP and other service discovery packets coming from the wireless
clients.

Disable these packets using Access Control Policy.

l If IPv6 is not required, disable IPv6 packets from the wireless clients using Access Control Policy.

l Use Air Cleaner Rules to:

o prevent unauthorized rogue DHCP server from wireless clients

o prevent unwanted DHCP client packets from wired network side

o drop L2 broadcast packets

o drop IPv4 and IPv6 multicast packets

o drop ARP discovery packets from one SSID to another SSID interface

o disable mDNS packets in the default Air Cleaner rules

Note

Allow the mDNS packet to enable bonjour discovery service to work.

l Sample AP group policy with Air Cleaner Rules.
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Figure 109 Sample AP group policy with Air Cleaner Rules

Sample user-defined rule for blocking IPv6 traffic and allowing the rest of the traffic.

!

filter global-filter

filter precedence 14

enable

layer3-filter deny proto6 any any any any any any //BLOCK IPv6
TRAFFIC

exit

filter precedence 15

enable

layer3-filter permit ip any/any any/any any //ALLOW TRAFFIC

exit

!
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Cambium Networks
Cambium Networks delivers wireless communications that work for businesses, communities, and cities
worldwide. Millions of our radios are deployed to connect people, places, and things with a unified wireless
fabric that spans multiple standards and frequencies of fixed wireless and Wi-Fi, all managed centrally via
the cloud. Our multi-gigabit wireless fabric offers a compelling value proposition over traditional fiber and
alternative wireless solutions. We work with our Cambium certified Connected Partners to deliver purpose
built networks for service provider, enterprise, industrial, and government connectivity solutions in urban,
suburban, and rural environments, with wireless that just works.

Support website https://support.cambiumnetworks.com

Support enquiries

Technical training https://learning.cambiumnetworks.com/learn

Main website http://www.cambiumnetworks.com

Sales enquiries solutions@cambiumnetworks.com

Warranty https://www.cambiumnetworks.com/support/standard-warranty/

Telephone number list http://www.cambiumnetworks.com/contact-us/

User Guides http://www.cambiumnetworks.com/guides

Address Cambium Networks Limited,

Unit B2, Linhay Business Park, Eastern Road, Ashburton,

Devon, TQ13 7UP

United Kingdom

www.cambiumnetworks.com

Cambium Networks and the stylized circular logo are trademarks of Cambium Networks, Ltd. All other
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WPA2™-Personal 2021-01
WPA3™-Enterprise 2022-12
WPA3™-Personal 2022-06

Security

WMM®
Wi-Fi Agile Multiband™

Optimization

2.4 GHz Spectrum Capabilities
5 GHz Spectrum Capabilities
Wi-Fi CERTIFIED 6®
Wi-Fi CERTIFIED™ a
Wi-Fi CERTIFIED™ ac
Wi-Fi CERTIFIED™ b
Wi-Fi CERTIFIED™ g
Wi-Fi CERTIFIED™ n

Connectivity

Passpoint® Release 3Access

CERTIFICATIONCLASSIFICATION

Enterprise/Service Provider Access Point, Switch/Controller or RouterSub-category

RoutersCategory

XV2-21XModel Number

XV2-21XProduct Model Variant

Cambium XV2-21X Indoor Wi-Fi 6 Access PointProduct Name

Cambium Networks Ltd.Company

June 1, 2023Date of Certification

Wi-Fi CERTIFIED™ Certificate
This certificate lists the features that have successfully completed Wi-Fi Alliance 

interoperability testing. Learn more: www.wi-fi.org/certification/programs

Certification ID: WFA125208

Product Info

Summary of Certifications

www.wi-fi.org/certification/programs
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WMM®

WPA2™-Enterprise 2018-04

EAP methods

WPA2™-Personal 2021-01

WPA3™-Enterprise 2022-12

EAP methods

192-bit security

WPA3™-Personal 2022-06

Wi-Fi Agile Multiband™

Wi-Fi CERTIFIED 6®

A-MPDU with A-MSDU

Basic Trigger frame in HE MU PPDU

Beamforming sounding

BSRP Trigger frame

Compressed Block Ack Rx (buffer size 256)

Compressed Block Ack Tx (buffer size 256)

2.4 GHz Spectrum Capabilities

20 MHz Channel Width in 2.4 GHz

5 GHz Spectrum Capabilities

20 MHz Channel Width in 5 GHz

40 MHz Channel Width in 5 GHz

80 MHz Channel Width in 5 GHz

Passpoint® Release 3

Online Sign Up and Policy provisioning

Online Sign Up using single SSID

Roaming Consortium Selection

Venue Information

Terms and Conditions

Protected Management Frames

Spectrum & Regulatory

802.11d

802.11h

RF Architecture

Bands Supported Transmit (Tx) Receive (Rx)

2.4 GHz 2 2

5 GHz 2 2

Wi-Fi Component Operating System
Linux

Wi-Fi Component Firmware
6.5.2-a0

Page  of 2 3

Wi-Fi CERTIFIED™ Certificate
Certification ID: WFA125208

Role: Access Point

Wi-Fi Components

Certifications



This certificate was downloaded on  at  UTC2025-02-11 19:47:45

Wi-Fi CERTIFIED™ n (continued)

A-MPDU Tx

OBSS on Extension Channel

Short Guard Interval

STBC

Wi-Fi CERTIFIED 6® (continued)

DL OFDMA

Individual Target Wake Time

LDPC Rx

LDPC Tx

MCS 8-9 Rx

MCS 8-9 Tx

MCS 10-11 Rx

MCS 10-11 Tx

MU EDCA Parameter Set element

MU-BAR Trigger frame

MU-RTS Trigger frame

Operating mode indication

SU beamformer

SU-MIMO

TXOP RTS Threshold

UL OFDMA

Wi-Fi CERTIFIED™ a

Wi-Fi CERTIFIED™ ac

Extended 5 GHz Channel Support

A-MPDU with A-MSDU

LDPC Rx

LDPC Tx

MCS 8-9 Rx

Short Guard Interval

STBC

SU beamformer

Wi-Fi CERTIFIED™ b

Wi-Fi CERTIFIED™ g

Wi-Fi CERTIFIED™ n

Page  of 3 3

Wi-Fi CERTIFIED™ Certificate
Certification ID: WFA125208

Role: Access Point
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Spectrum & RegulatorySpectrum & Regulatory 
Features

Protected Management Frames
WPA2™-Enterprise 2018-04
WPA2™-Personal 2021-01
WPA3™-Enterprise 2022-12
WPA3™-Personal 2022-06

Security

WMM®
Wi-Fi Agile Multiband™

Optimization

2.4 GHz Spectrum Capabilities
5 GHz Spectrum Capabilities
Wi-Fi CERTIFIED 6®
Wi-Fi CERTIFIED™ a
Wi-Fi CERTIFIED™ ac
Wi-Fi CERTIFIED™ b
Wi-Fi CERTIFIED™ g
Wi-Fi CERTIFIED™ n

Connectivity

Passpoint® Release 3Access

CERTIFICATIONCLASSIFICATION

Enterprise/Service Provider Access Point, Switch/Controller or RouterSub-category

RoutersCategory

XV2-23TModel Number
XV2-23TProduct Model Variant

Cambium XV2-23T Two Radio Dual Band Wi-Fi 6 2x2 Outdoor Access 
Point

Product Name

Cambium Networks Ltd.Company

June 14, 2023Date of Certification

Wi-Fi CERTIFIED™ Certificate
This certificate lists the features that have successfully completed Wi-Fi Alliance 

interoperability testing. Learn more: www.wi-fi.org/certification/programs

Certification ID: WFA126875

Product Info

Summary of Certifications

www.wi-fi.org/certification/programs


This certificate was downloaded on  at  UTC2025-02-11 19:48:30

WMM®

WPA2™-Enterprise 2018-04

EAP methods

WPA2™-Personal 2021-01

WPA3™-Enterprise 2022-12

EAP methods

192-bit security

WPA3™-Personal 2022-06

Wi-Fi Agile Multiband™

Wi-Fi CERTIFIED 6®

A-MPDU with A-MSDU

Basic Trigger frame in HE MU PPDU

Beamforming sounding

BSRP Trigger frame

Compressed Block Ack Rx (buffer size 256)

Compressed Block Ack Tx (buffer size 256)

2.4 GHz Spectrum Capabilities

20 MHz Channel Width in 2.4 GHz

5 GHz Spectrum Capabilities

20 MHz Channel Width in 5 GHz

40 MHz Channel Width in 5 GHz

80 MHz Channel Width in 5 GHz

Passpoint® Release 3

Online Sign Up and Policy provisioning

Online Sign Up using single SSID

Roaming Consortium Selection

Venue Information

Terms and Conditions

Protected Management Frames

Spectrum & Regulatory

802.11d

802.11h

RF Architecture

Bands Supported Transmit (Tx) Receive (Rx)

2.4 GHz 2 2

5 GHz 2 2

Wi-Fi Component Operating System
Linux

Wi-Fi Component Firmware
6.5.2-a0

Page  of 2 3

Wi-Fi CERTIFIED™ Certificate
Certification ID: WFA126875

Role: Access Point

Wi-Fi Components

Certifications
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Wi-Fi CERTIFIED™ n (continued)

A-MPDU Tx

OBSS on Extension Channel

Short Guard Interval

STBC

Wi-Fi CERTIFIED 6® (continued)

DL OFDMA

Individual Target Wake Time

LDPC Rx

LDPC Tx

MCS 8-9 Rx

MCS 8-9 Tx

MCS 10-11 Rx

MCS 10-11 Tx

MU EDCA Parameter Set element

MU-BAR Trigger frame

MU-RTS Trigger frame

Operating mode indication

SU beamformer

SU-MIMO

TXOP RTS Threshold

UL OFDMA

Wi-Fi CERTIFIED™ a

Wi-Fi CERTIFIED™ ac

Extended 5 GHz Channel Support

A-MPDU with A-MSDU

LDPC Rx

LDPC Tx

MCS 8-9 Rx

Short Guard Interval

STBC

SU beamformer

Wi-Fi CERTIFIED™ b

Wi-Fi CERTIFIED™ g

Wi-Fi CERTIFIED™ n

Page  of 3 3

Wi-Fi CERTIFIED™ Certificate
Certification ID: WFA126875

Role: Access Point
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Protected Management Frames
WPA2™-Enterprise 2018-04
WPA2™-Personal 2021-01
WPA3™-Enterprise 2022-12
WPA3™-Personal 2022-06

Security

WMM®
Wi-Fi Agile Multiband™

Optimization

2.4 GHz Spectrum Capabilities
5 GHz Spectrum Capabilities
6 GHz Spectrum Capabilities
Wi-Fi CERTIFIED 6®
Wi-Fi CERTIFIED™ a
Wi-Fi CERTIFIED™ ac
Wi-Fi CERTIFIED™ b
Wi-Fi CERTIFIED™ g
Wi-Fi CERTIFIED™ n
Wi-Fi Enhanced Open™ 2023-12

Connectivity

Passpoint® Release 3Access

CERTIFICATIONCLASSIFICATION

Enterprise/Service Provider Access Point, Switch/Controller or RouterSub-category

RoutersCategory

XE3-4Model Number

XE3-4Product Model Variant

XE3-4 Three Radio Tri Band Wi-Fi 6E 4x4 Indoor Access PointProduct Name

Cambium Networks Ltd.Company

February 15, 2024Date of Certification

Wi-Fi CERTIFIED™ Certificate
This certificate lists the features that have successfully completed Wi-Fi Alliance 

interoperability testing. Learn more: www.wi-fi.org/certification/programs

Certification ID: WFA129114

Product Info

Summary of Certifications

www.wi-fi.org/certification/programs
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Spectrum & RegulatorySpectrum & Regulatory 
Features

CERTIFICATIONCLASSIFICATION

Page  of 2 4

Wi-Fi CERTIFIED™ Certificate
Certification ID: WFA129114

Summary of Certifications (continued)
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Protected Management Frames

Spectrum & Regulatory

802.11d

802.11h

WMM®

WPA2™-Enterprise 2018-04

EAP methods

WPA2™-Personal 2021-01

WPA3™-Enterprise 2022-12

EAP methods

192-bit security

WPA3™-Personal 2022-06

Wi-Fi Agile Multiband™

2.4 GHz Spectrum Capabilities

20 MHz Channel Width in 2.4 GHz

5 GHz Spectrum Capabilities

20 MHz Channel Width in 5 GHz

40 MHz Channel Width in 5 GHz

80 MHz Channel Width in 5 GHz

6 GHz Spectrum Capabilities

20 MHz Channel Width in 6 GHz

40 MHz Channel Width in 6 GHz

80 MHz Channel Width in 6 GHz

160 MHz Channel Width in 6 GHz

Passpoint® Release 3

Roaming Consortium Selection

Terms and Conditions

Venue Information

RF Architecture

Bands Supported Transmit (Tx) Receive (Rx)

2.4 GHz 2 2

5 GHz 2 2

6 GHz 4 4

Wi-Fi Component Operating System
Linux

Wi-Fi Component Firmware
6.6.0.1

Page  of 3 4

Wi-Fi CERTIFIED™ Certificate
Certification ID: WFA129114

Role: Access Point

Wi-Fi Components

Certifications
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Wi-Fi CERTIFIED™ ac (continued)

Short Guard Interval

STBC

SU beamformer

Wi-Fi CERTIFIED™ b

Wi-Fi CERTIFIED™ g

Wi-Fi CERTIFIED™ n

A-MPDU Tx

OBSS on Extension Channel

Short Guard Interval

STBC

Wi-Fi Enhanced Open™ 2023-12

Wi-Fi CERTIFIED 6®

A-MPDU with A-MSDU

Basic Trigger frame in HE MU PPDU

Beamforming sounding

BSRP Trigger frame

Compressed Block Ack Rx (buffer size 256)

Compressed Block Ack Tx (buffer size 256)

DL MU-MIMO

DL OFDMA

Individual Target Wake Time

LDPC Rx

LDPC Tx

MCS 8-9 Rx

MCS 8-9 Tx

MCS 10-11 Rx

MCS 10-11 Tx

MU EDCA Parameter Set element

MU-BAR Trigger frame

MU-RTS Trigger frame

Operating mode indication

SU beamformer

SU-MIMO

TXOP RTS Threshold

UL OFDMA

Wi-Fi 6E

Wi-Fi CERTIFIED™ a

Wi-Fi CERTIFIED™ ac

A-MPDU with A-MSDU

DL MU-MIMO

Extended 5 GHz Channel Support

LDPC Rx

LDPC Tx

MCS 8-9 Rx

Page  of 4 4

Wi-Fi CERTIFIED™ Certificate
Certification ID: WFA129114

Role: Access Point
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cnMaestro™ X Management System 
 
 
 
 

 
 

DATA SHEET  

c n M a e s t r o  Q u i c k  L o o k  
 

A simple, yet sophisticated AI-based network 
management system for Cambium Networks wireless 
and wired solutions.  
• Elastic scalability in a single-pane-of-glass 

experience for Cambium’s ONE Network 
• Secure, end-to-end network management with 

zero-touch provisioning 
• Simplified operations and ongoing maintenance 

for the network administrator 

Key Highlights 
• Single console for your entire Cambium 

network: Wi-Fi, switching, fixed wireless, 
security, and SD-WAN 

• Simple and easy-to-navigate user interface for 
fast time to productivity 

• Powerful AI-based tools for drill down 
troubleshooting and rapid problem resolution 

• Flexible integration via APIs and Webhooks for 
third party extensibility and customization 

• Includes Cambium Care Pro software support 
with 24x7 L2 engineer access and all software 
updates for cnMaestro and managed devices 

Note: cnMaestro X is an account level construct and all devices in the account 
require a cnMaestro X subscription. 
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Advanced Functionality in cnMaestro X 

• X Assurance provides AI-powered analytics to identify and 
fix wireless network issues, helping IT admins improve user 
experience by proactively finding root cause of problems. 

 
• EasyPass offers diverse Wi-Fi onboarding options for 

employees, guests, attendees, and IoT, featuring advanced 
captive portals and one-year client login history. 

 
• Application visibility and control provides analytics and policy 

control for 2400+ applications at the Wi-Fi and WAN edge 
 

• Advanced cnMatrix switch features including QinQ, Auto Device 
Recovery (ADR) and cable diagnostics 

 
• Customizable MSP dashboard with ability to create different 

brands with multi-tier customizations including guest portals 
 

• Consolidated MSP tenant statistics with ability to drill down to 
manage a specific tenant without impacting data from others. 
Support for up to 200 managed tenants.  

 
• Restful APIs and Webhooks for integration with existing 

OSS/BSS systems and event monitoring 
 

• Assists function scans device configurations to identify 
potential vulnerabilities and recommends improvements 
to save time troubleshooting. 
 

• Long-term historical data retention: 2-year data for FWB 
and 1-year data for Enterprise and IIoT devices 

 
• RADIUS, TACACS+, LDAP, and AD Login for user administration 

 
 
 
 
 

 
cnMaestro X allows 
MSPs to create a 
custom branding 
experiences for their 
customers. 
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cnMaestro 
On-Premises 
Server 
Requirements 

 
 
 
Key Functionalities 

• Zero-touch provisioning: Create, provision, monitor and 
manage the entire network of wireless and wired devices 
from a single dashboard login with key performance metrics, 
alarms, and alerts. The cloud-first UI design is easy to learn 
and apply across the portfolio and helps network 
administrators simplify operations and deliver an optimal client 
experience. 

• With centralized visibility and control for Cambium Networks' 
wireless and wired products, network administrators can 
quickly and easily deploy networks with minimal training. 
Whether you work on small sites or large distributed 
networks with thousands of sites, cnMaestro makes 
deployment and operations easy. Administrators have 
access to information needed to enforce policies and 
optimize performance. Remote support capability is 
integrated into the architecture, along with powerful help desk 
tools to debug remote issues without going onsite. 
Troubleshooting tools such as ping, traceroute, throughput, and 
live packet captures are included, dramatically reducing resolution 
times and enabling remote troubleshooting. 

• Deployment flexibility and TCO: Choice of public cloud, 
private cloud, or on-premises deployment with best TCO. 
cnMaestro helps reduce operating costs and accelerate 
return on investment. cnMaestro does not require Wi-Fi 
controllers, thereby reducing the complexity and cost of 
deploying Wi-Fi networks. 

• Built for scale and security at all levels: Devices connect to 
cnMaestro Cloud using SSL-enabling deployments without 
changes to the firewall configuration. Cambium Intelligent 
edge architecture enables fault-tolerant networks where the 

network continues to operate even when the cloud is 
unreachable due to a WAN outage. With cnMaestro X, you 
can manage networks with up to thousands of sites, and up 
to 25,000 devices. 

• Tailored views for enterprise, access and backhaul, and 
IIoT: The access and backhaul view provides visualization 
and control of devices from service provider towers to the 
network edge.  

• Supports network hierarchy, enabling easy configuration, 
monitoring, and debugging at network nodes to reduce 
operational costs. This is especially critical for large networks 
or small distributed networks with small on-site IT staff. 

• Provides a bird’s-eye view of network health with insights on 
performance, connectivity, and client experience. 
Administrators can quickly identify potential trouble spots 
and drill down from network to client-level details. 

• Extensible platform for managing third-party endpoints. 

• cnMaestro X supports the following Cambium solutions: 
» Wi-Fi 6/6E/7 Access Points (APs) 
» cnPilot™ E-series and R-series APs 
» Xirrus XD, XH, XA, and XR 11ac APs 
» cnMatrix™ EX1000/2000/3000, and TX1000/2000 Series 

Switches 
» Network Service Edge (NSE) 
» cnWave™ 60 GHz and 28 GHz 
» PTP (point-to-point) 
» PMP and ePMP™ (point-to-multipoint) 
» PON 
» cnReach 
» cnRanger™ 

 
Resources Enterprise Fixed Wireless Enterprise and Fixed Wireless 
8vCPUs, 16 GB RAM, 
250 GB Hard Disk 

10,000 Enterprise devices 
(Wi-Fi, cnMatrix, NSE) 

20,000 Fixed Wireless devices 
(PMP, ePMP, PTP, cnReach, cnRanger) 

10,000 total devices – Fixed Wireless and Enterprise 
(PMP, ePMP, PTP, PON, Wi-Fi, cnMatrix, NSE) 

16vCPUs, 32 GB RAM, 
500 GB Hard Disk 

25,000 Enterprise devices 
(Wi-Fi, cnMatrix, NSE) 

40,000 Fixed Wireless devices 
(PMP, ePMP, PTP, cnReach, cnRanger) 

25,000 total devices Fixed Wireless and Enterprise (PMP, 
ePMP, PTP, PON, Wi-Fi, cnMatrix, NSE) 
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cnMaestro™ X Management System 
Product Summary Features marked X require cnMaestro X subscription 

 

Onboarding & Provisioning 
• Zero-touch onboarding 
• Template configuration 
• Object configuration (enterprise) 
• Claim PMP SMs associated with AP 
• cnMaestro Installer installation summary 

upload (PMP & ePMP) X 
•  Mass provisioning for ePMP/PMP/cnWave 

60 GHz (using LINKPlanner) X  
• Webhooks support  X 

 
Network Services 

• Branded tenant login page X  
• Support for software-defined radios (SDR) on 

XV3-8, XE3-4, & XE5-8 Wi-Fi 6 APs 
• ePSK Types 

o ePSK Local – ePSKs are cached locally on 
the Wi-Fi APs  
- 2,000 per WLAN (Wi-Fi 6+) 
- 300 per WLAN (Wi-Fi 5) 

o ePSK RADIUS – ePSKs are limited via 
external radius server X 

o ePSK Cloud – ePSKs are unlimited & cloud 
managed (Wi-Fi 6+) X 

• Personal Wi-Fi  X 
• Number of guest portals: 500 X  
• EasyPass 

o One-click 
o Sponsored guest X  
o Voucher 
o Paid X 

• Payment gateway X 
» PayPal 
» IPPay 
» QuickPay 
» mPesa 

o WiFi4EU 
o Azure guest portal X 
o Google authentication X 
o Self-registration: SMS & email X 
o Onboarding X 
o Combined options 

•  Max number of login events: Unlimited event 
records for 30 days X 

• Max number of guest client sessions at a 
time: 10,000 X  

•  Max number of managed devices: X 
25,000 for enterprise 
40,000 for FWB 

• Application visibility & control of over 2,400 
different applications across the Wi-Fi access 
network X  

 
Wi-Fi 

• Simplified wireless LAN view 
• Stateful firewall support 
• Dynamic channel listing based on country, 

release, & SKU 
• AP group & WLAN configuration 
• Site support for collocated APs 
• WIDS support X 

 

X Assurance X 
• Client connection lifecycle monitoring & 

analysis 
•  Root cause analysis of connection & service 

failures 
•  Network-wide client health monitoring & 

scoring 
NOTE: X Assurance is available in cnMaestro X Cloud, 
but not in cnMaestro X On-Premises. 
 
Troubleshooting & Forensics 

• Tower-to-edge view 
• Technical support dump export 
• Rogue AP detection 
• Wi-Fi packet capture 
• ePMP/PMP link test 
• Cambium Care Pro – 24/7 technical 

support, accelerated access to L2 
engineers, & software updates/upgrades X  

 
Security 

• Communication over SSL 
• No Inbound internet access 
• Not-in-traffic path 
• Disaster recovery 

 
Deployment 

• Cloud-hosted, delivered as a service 
• Customer-hosted VMware OVA 
• Amazon Marketplace AMI 

 
Visualization 

• Full Visibility across network 
•  Supports ePMP, cnMatrix, enterprise & 

residential Wi-Fi, PMP, PTP, cnReach, 
cnRanger 

• Multiple product views 
o Access & backhaul view 
o Enterprise wireless view 
o Industrial internet view 

• Hierarchical device tree 
• PMP/ePMP sector display 
• Spectrum analyzer: PMP X 
• cnWave 60GHz Interference Scan X 

 
Configuration & Monitoring 

• Redundant cloud services 
• Scheduled system backup 
• Automatic bulk software update 
• Dedicated device dashboards 
• Statistics & trending 
• Email alerts 
• Supporting concurrent device jobs X 
• Configuration lock X  
• Managed service provider accounts X 
• Support for up to 200 accounts 
• High availability (1+1) for On-Premises X 
•  Monitor Wi-Fi performance from client 

or AP to cnMaestro (On-Premises 
NMS; Cloud NMS – N/A) X   

• Assists for cnMatrix, Wi-Fi, cnPilot-R, PMP, 
ePMP, cnWave 5G Fixed, & PTP 670/700 X  

 

Data & Reporting 
• Statistics reports exported in CSV 
• Export UI tables in CSV or PDF X 
• RESTful monitoring/provisioning API X 
• Graphical reports X 
• Long-term data retention X 

o 2 years for FWB 
o 1 year for enterprise & IIoT 

 
Administration 

• Management users: 200 X 
• Role-based access 
• Auto-provisioning X 
• RADIUS, TACACS+, LDAP, & AD login X 
• Advanced troubleshooting X 

o Audit logs 
o Audit syslog & event syslog (On-Premises 

NMS; Cloud NMS – N/A) 
• Advanced monitoring X  

o Session management 
o  User authentication (On-Premises 

NMS; Cloud NMS – N/A) 
• cnWave 60 GHz MAP features 

o Extensive network map RF link visualization X 
o Auto-manage route 

• Open ID/SAML authentication X 
 
MarketApps X 

• Managed Wi-Fi 
• Self-Service Personal Wi-Fi 

 
cnMatrix 

• Zero-touch remote provisioning 
• Policy-based automation (PBA) 

on EX2000/EX3000 
• Cambium Sync on TX series 
• DHCP client/server 
• Automated voice VLAN 
• Assists X 
• QinQ X 
• Auto-device recovery 
• Cable diagnostics X 
• PBA on EX1000 X 
• MAC lists & location services for PBA X 

 
Network Service Edge (NSE) 

• Site-to-site VPN 
• WAN flow preferences 
• DHCP/RADIUS/DNS services 
• Load balancing 
• WAN QoS 
• Firewall 
• LAN vulnerability assessment 
• Granular content filtering 
• WAN failover policy & IP groups 
• High Availability 
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cnMaestro X Part Numbers 
 

Tier Product cnMaestro X Subscription SKU 
Free Tier ePMP Hotspot 1000 Hotspot No subscription needed 

cnPilot Home All R-Series APs 
cnRanger All SM Models 
cnVision MAXr, MAXrp, MICRO, MINI 
cnWave 60 GHz All Client Nodes 
ePMP All SM Models 
PMP All SM Models 

Tier 3 Enterprise Wi-Fi All cnPilot E-Series, XE/XV/X7-Series 
and Xirrus (AOS) APs 

MSX-SUB-[Model]-1/3/5* 

Tier 5 60 GHz cnWave All Distribution Nodes MSX-SUB-T5-1/3/5 
Tier 6 cnWave 5G Fixed All CPE Models MSX-SUB-T6-1/3/5 

Tier 7 cnWave 5G Fixed All BTS Models MSX-SUB-T7-1/3/5 
Tier 20 cnMatrix All cnMatrix Switches MSX-SUB-[Model]-1/3/5* 
Tier 21 cnVision FLEXr, HUB360 MSX-SUB-EPMP-1/3/5 

ePMP All AP Models 
Tier 22 PMP All AP Models except 450m and 450mv MSX-SUB-PMP450i-1/3/5 
Tier 23 PMP 450m MSX-SUB-PMP450m-1/3/5 
Tier 24 cnRanger All BBU Models MSX-SUB-PTP-1/3/5 

cnReach All cnReach Models 
PTP All PTP Models 

Tier 30 NSE 3000 Security NSE 3000 No subscription needed 

Tier 30 NSE 3000 Security Plus NSE 3000 NSE-SUB-3000-1/3/5** 
 
*cnMatrix Switches and Wi-Fi APs: 
 
These products use model-based SKUs for subscription. 
 
For Wi-Fi access points, the corresponding cnMaestro X SKU follows a specific format: 
 
The base part of the SKU will be ""MSX-SUB-"" followed by the model name of the access point (e.g., XV2-21X). 
The ending part will be ""-1/3/5"", indicating the subscription term duration (1, 3, or 5 years). 
Similarly, for cnMatrix switches, the cnMaestro X SKU follows the same format based on the switch model name (e.g., EX3024F) 
 
For example: 
The SKU for 3-year cnMaestro X subscription for XV2-21X AP and a 5-year cnMaestro X subscription for an EX3024F switch would be: 
  
 

SKU Description 
MSX-SUB-XV2-21X-3 cnMaestro X for one XV2-21X AP. Creates one Device Tier3 slot. Includes Cambium Care Pro support. 3-year 

subscription 
MSX-SUB-EX3024F-5 cnMaestro X for one EX3024F. Creates one Device Tier20 slot. Includes Cambium Care Pro support. 5-year 

subscription 
 
** Unlike other products, NSE3000 & RV22 devices need a subscription to be used on either cnMaestro X or cnMaestro Essentials. 
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GET STARTED at 

cloud.cambiumnetworks.com 

Free 90-day trial of cnMaestro X: 

cambiumnetworks.com/cnmaestro-x 
 

 
 

 

 

 

 

 

 

 

 

 

 

ABOUT CAMBIUM NETWORKS 

Cambium Networks enables service providers, enterprises, industrial organizations, and governments to deliver exceptional digital experiences 
and device connectivity with compelling economics. Our ONE Network platform simplifies management of Cambium Networks’ wired and 
wireless broadband and network edge technologies. Our customers can focus more resources on managing their business rather than the 
network. We make connectivity that just works. 

 

cambiumnetworks.com 
 

02102025 

http://cloud.cambiumnetworks.com/
http://cambiumnetworks.com/cnmaestro-x

	Contents
	About This User Guide
	Overview of Enterprise Wi-Fi AP products
	Intended audience
	Purpose
	Related documents
	Supported hardware platforms
	Premium feature list

	Quick Start – Device Access
	Powering up the device
	PoE switches (802.3af/802.3at/802.3bt)
	PoE adapter
	DC power supply

	Accessing the device
	Device access using default or fallback IP
	Device access using zeroconf IP
	Device access using DHCP IP address

	LED status

	Onboarding the Device
	Overview
	Device onboarding and provisioning
	cnMaestro
	XMS-Cloud


	Configuring the System
	Basic
	Power over Ethernet (PoE) in
	Power over Ethernet (PoE) Out port
	Link Layer Discovery Protocol (LLDP)

	Management
	Administrator Access
	HTTPS Proxy server configuration

	Time settings
	Event logging
	SNMP

	Configuring the Radio
	Overview
	Configuring Radio parameters
	Basic
	Software-Defined Radio (SDR) capabilities
	Enhanced Roaming

	BSS Coloring
	Target Wake Time (TWT)
	Receive sensitivity configuration
	Multicast-snooping and Multicast-to-Unicast conversion
	Auto-RF
	Overview
	Dynamic Channel
	Dynamic Power
	Auto-RF behavior on device turn on
	Configuring Dynamic Channel
	Configuring Dynamic Power
	Recommended Configuration


	Configuring the Wireless LAN
	Overview
	Configuring the WLAN parameters
	Basic
	WLAN VLAN allowed list
	ICMPv6 Router advertisement (RA) unicast conversion
	802.11k/v
	RADIUS server
	Guest Access
	Usage Limits
	Scheduled Access
	Access
	Passpoint

	RADIUS attributes
	Enterprise PSK (ePSK)
	Configuring ePSKs
	ePSK registration for WPA3 clients
	Creating a Personal Wi-Fi ePSK

	RADIUS-based ePSK Premium feature
	Configuring RADIUS-based ePSK

	Groupwise Transient Key (GTK) per VLAN

	Configuring the Network
	Overview
	Configuring Network parameters
	IPv4 network parameters
	Routes
	IPv6 network parameters
	General network parameters
	Ethernet Ports
	DHCP
	Tunnel
	Point-to-Point Protocol over Ethernet (PPPoE)
	VLAN Pool
	Wireless Wide Area Network (WWAN)


	Configuring Access Control
	Enabling Access Control Policy
	User Group Policy
	Device Policy

	Managing Filters
	Overview
	Filter list
	Filters
	Configuring filter CLI

	Device class filter
	Wi-Fi Calling support
	Air cleaner
	Application control Premium feature
	Deep Packet Inspection (DPI)
	Custom Applications X


	WIDS/WIPSPremium feature
	Wireless Intrusion Detection Systems (WIDS)
	Wireless flood detection
	Neighbor AP detection
	Rogue APs
	Honeypot APs
	Ad Hoc network detection
	Wired Devices
	Configuring WIDS

	Wireless Intrusion Prevention System (WIPS)

	Configuring Services
	Overview
	Configuring services
	Lightweight Directory Access Protocol (LDAP)
	NAT Logging
	User Groups Premium feature
	Real-Time Location System (RTLS)
	Speed Test
	DHCP Option-82
	Bonjour Gateway
	Link Aggregation Control Protocol (LACP)


	Operations
	Overview
	Firmware upgrade
	System
	LED Test flashing pattern


	Troubleshoot
	Overview
	Logging
	Events
	Debug Logs

	Radio Frequency (RF)
	Wi-Fi Analyzer

	Packet capture
	Performance
	Speedtest on Access Point
	Network Connectivity

	XIRCON tool support
	XIRCON tool support for Linux 1.0.0.40


	Management Access
	Local authentication
	Device configuration

	SSH Key authentication
	Device configuration
	SSH Key generation

	RADIUS authentication
	Device configuration


	Mesh
	Deployment scenarios
	Mesh configurable parameters
	Order of Mesh profile configuration

	Mesh Auto Detect Backhaul
	Scenario 1
	Scenario 2
	Scenario 3

	Mesh Muti-Hop
	Mesh Roaming
	Mesh Base configuration
	Mesh Client configuration

	Mesh link-Sample configuration
	VLAN 1 as the management interface
	Non-VLAN 1 as the management interface

	Typical use-cases
	Additional mesh topology supported

	Guest Access Portal - Internal
	Introduction
	Configurable parameters
	Access policy
	Splash page
	Redirect parameters
	Success message
	Timeout
	Whitelist

	Configuration examples

	Guest Access Portal - External
	Introduction
	Configurable parameters
	Access policy
	WISPr
	External portal post through cnMaestro
	External portal type
	Redirect parameters
	Success message
	Timeout
	Whitelist

	Configuration examples

	Guest Access – cnMaestro
	Auto VLAN
	Device Recovery Methods
	Factory reset via ‘RESET’ button
	Boot partition change via power cycle
	Disable factory Reset Button

	Command-Line Interface (CLI)
	Show commands
	Service commands
	Service show
	Service system


	cnMaestro X Assurance
	MarketApps
	Target audience
	Benefits

	Glossary
	Appendix
	Supported RADIUS Attributes
	WISPr VSAs (Vendor ID: 14122)
	Cambium VSAs (Vendor ID: 17713)
	Standard RADIUS attributes
	RADIUS attributes in authentication and accounting packets with WPA2-Enterpri...
	Supported CoA messages

	Supported DFS channels
	Supported 6 GHz countries
	Priority order for parameters
	Best practices for wireless clients seamless roaming across APs
	External network recommendations
	AP WLAN profile configuration recommendations
	AP group configuration recommendations


	Cambium Networks
	Advanced Functionality in cnMaestro X
	Key Functionalities
	cnMaestro™ X Management System

	cloud.cambiumnetworks.com
	cambiumnetworks.com/cnmaestro-x

